Cisco Video Surveillance Manager
Operations Manager User Guide
Release 7.0.1
CONTENTS

Preface xi

Obtaining Documentation, Obtaining Support, and Security Guidelines xi

CHAPTER 1
Overview 1-1
Operations Manager Feature Summary 1-2
Requirements 1-3
Main Elements of the User Interface 1-5
Summary Steps: Basic Configuration 1-7
Summary Steps: Advanced Configuration 1-15
Logging In and Managing Passwords 1-17
Logging In 1-17
Default User Accounts and Passwords 1-18
Changing Your Password 1-18
Changing Another User’s Password 1-19
Understanding Cisco Video Surveillance Software 1-20
Installing Licenses 1-21
Usage Notes 1-21
License Part Numbers 1-22
Displaying License Information 1-22
Obtaining and Installing Licenses 1-23
Deleting Licenses 1-23
Using Find 1-25

CHAPTER 2
Viewing Video 2-1
Understanding the Video Viewing Options 2-2
Operations Manager Requirements 2-3
Using the Monitor Video Page 2-3
Selecting a Multi-Pane “View” 2-4
Controlling Live and Recorded Video 2-6
Overview 2-7
Viewing Live Video 2-8
Viewing Recorded Video 2-11
Creating Video Clips 2-15
CHAPTER 3
Configuring Video Viewing Options 3-1
Creating Pre-Defined Views 3-2
Configuring Video Walls 3-9
Enabling Record Now 3-11

CHAPTER 4
Adding Users, User Groups, and Permissions 4-1
Overview 4-1
Understanding Roles, Groups and Users 4-2
Understanding the System-Defined User Roles, Groups and Accounts 4-3
Understanding Permissions 4-4
Example Roles For Different Types of Users 4-7
Defining User Roles 4-8
Adding User Groups 4-10
Adding Users 4-13
Adding Users from an LDAP Server 4-15
LDAP Usage Notes 4-15
Upgrade Requirements 4-15
LDAP Server Settings 4-16
LDAP Search Filter Settings 4-20
LDAP Configuration Examples 4-20
LDAP Configuration Procedure 4-23

CHAPTER 5
Creating the Location Hierarchy 5-1
Overview 5-2
Summary Steps 5-2
Understanding Permission-Based and Partition-Based Resources 5-3
Simple Deployments (User Access to All Devices and Resources) 5-4
Permission-Based Resources: Limiting User Access to Devices 5-4
Examples: Locations in Simple vs. Large Deployments 5-7
Understanding a Camera’s Installed Location Vs. the Pointed Location 5-9
Creating and Editing the Location Hierarchy 5-10
Impact of Device Location Changes on Alerts 5-11
Deleting a Location 5-11

CHAPTER 6
Configuring Media Servers 6-1
Overview 6-3
Requirements 6-3
Summary Steps to Add or Revise a Media Server 6-5
Media Server Settings 6-6
  General Information Settings 6-6
  Access Information Settings 6-7
  Hardware Information Settings 6-8
  Network Information 6-9
  NTP Information 6-10
  High Availability Options 6-12
  SMTP Management Settings 6-12
  Partition Settings 6-13
  Storage Management Settings 6-13
  Media Out Settings 6-14
  Recording Settings 6-16
Adding or Editing Media Servers 6-17
  Prerequisites 6-17
  Adding or Editing a Single Media Server 6-17
  Importing or Updating Media Servers Using a CSV File 6-19
Deleting a Media Server 6-23
Bulk Actions: Revising Multiple Media Servers 6-25
Viewing Media Server Status 6-27
Resetting the Media Server Device State 6-28
Repairing the Configuration or Restarting the Server 6-28

CHAPTER 7
Adding and Managing Cameras 7-1
Overview 7-3
  Understanding Network and Analog Cameras 7-3
  Requirements 7-3
  Summary Steps 7-4
  Viewing Cameras 7-5
## Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Motion Detection Settings</td>
<td>7-78</td>
</tr>
<tr>
<td></td>
<td>Configuring Motion Detection</td>
<td>7-79</td>
</tr>
<tr>
<td></td>
<td>Enabling Motion Detection on All Existing Cameras (Bulk Actions)</td>
<td>7-81</td>
</tr>
<tr>
<td></td>
<td>Upgrading Camera and Encoder Driver Firmware</td>
<td>7-82</td>
</tr>
<tr>
<td></td>
<td>Replacing a Camera</td>
<td>7-85</td>
</tr>
<tr>
<td></td>
<td>Bulk Actions: Revising Multiple Cameras</td>
<td>7-87</td>
</tr>
</tbody>
</table>

**Chapter 8**  
**Defining Schedules**  

**Chapter 9**  
**Adding and Editing Camera Templates**  
- Overview  
- Creating or Modifying a Template  
- Creating a Custom Template for a Single Camera  
- Configuring Video Recording  
  - Configuring Continuous, Scheduled, and Motion Recordings  
- Using Advanced Events to Trigger Actions  
  - Configuration Overview  
  - Configuration Summary  
  - Trigger and Action Descriptions  
  - Configuring Soft Triggers  
- Configuring Multicast Video Streaming  

**Chapter 10**  
**Adding Encoders and Analog Cameras**  
- Overview  
- Requirements  
- Adding External Encoders and Analog Cameras  
- Bulk Actions: Revising Multiple Encoders  
- Using “Split Model” Multi-Port Multi-IP Encoders  

**Chapter 11**  
**High Availability**  
- Overview  
- Requirements  
- Summary Steps  
- Understanding Redundant, Failover, and Long Term Storage Servers  
- Understanding Failover  
- Installing and Configuring the HA Servers  
- Add the HA Servers to Cisco VSM
Assign the HA Server(s) to the Primary or Redundant Servers 11-9
Configuring the Camera Template HA Options 11-11
Configuring the Redundant and Failover Options 11-11
Archiving Recordings to a Long Term Storage Server 11-15
Defining the Recording Options 11-19
Viewing the Server HA Status 11-21

CHAPTER 12
Monitoring System and Device Health 12-1
Overview 12-2
Health Dashboard: Viewing a Summary of Device Health for a Location 12-4
Device Status: Identifying Issues for a Specific Device 12-6
   Understanding the Overall Status 12-6
   Understanding Device Status 12-9
   Viewing Device Error Details 12-11
Health Notifications 12-12
Reports 12-14
   Create a Report 12-14
   Delete a Report 12-14
Synchronizing Device Configurations 12-15
   Overview 12-15
   Viewing Device Synchronization Errors 12-17
   Repairing a Mismatched Configuration 12-19
   Manually Triggering a Media Server Synchronization 12-20
   Device Data That Is Synchronized 12-20
   Synchronization During a Media Server Migration 12-21
Viewing the Server Management Console Status and Logs 12-22
Understanding Jobs and Job Status 12-23
   Viewing Job Status and Details 12-23
   Understanding Job Status 12-25
   Viewing All Jobs in the System 12-26
Viewing Audit Logs 12-29

CHAPTER 13
System Settings and Downloads 13-1
Revising the System Settings 13-1
   General System Settings 13-1
   Password Settings 13-2
   Records Settings 13-3
   Software Downloads 13-3
Preface

Revised: April 30, 2014

This document, the Cisco Video Surveillance Operations Manager User Guide provides an overview of Cisco Video Surveillance Operations Manager Release 7.0.1, including basic procedures that should be performed when you first start to use the system, and detailed information about advanced features and configurations.

Obtaining Documentation, Obtaining Support, and Security Guidelines

For information about obtaining documentation, submitting a service request, and gathering additional information, see the monthly What’s New in Cisco Product Documentation. This document also lists all new and revised Cisco technical documentation. It is available at:


Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free service and Cisco currently supports RSS version 2.0.

Tip

See Related Documentation for more information and links to Cisco Video Surveillance documentation.
Overview

The Cisco VSM Operations Manager is a browser-based configuration and administration tool used to manage the devices, video streams, archives, and policies in a Cisco Video Surveillance deployment. Refer to the following topics for a summary of the main Operations Manager capabilities, basic and advanced configurations, and other information.

Contents

- Operations Manager Feature Summary, page 1-2
- Requirements, page 1-3
- Main Elements of the User Interface, page 1-5
- Summary Steps: Basic Configuration, page 1-7
- Summary Steps: Advanced Configuration, page 1-15
- Logging In and Managing Passwords, page 1-17
- Understanding Cisco Video Surveillance Software, page 1-20
- Installing Licenses, page 1-21
- Using Find, page 1-25
The following table summarizes the main Operations Manager features.

**Table 1-1 Feature Summary**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>More information</th>
</tr>
</thead>
</table>
| Manage physical devices       | Add, configure and monitor the cameras, Media Servers, and encoders that provide live and recorded video. | • Configuring Media Servers, page 6-1  
• Adding and Managing Cameras, page 7-1 |
| Monitor video                 | View live and recorded video, save video clips, search thumbnail summaries of recorded video, use the camera, Pan, Tilt and Zoom (PTZ) controls, or configure pre-defined video Views and Video Walls. | • Viewing Video, page 2-1  
• Configuring Video Viewing Options, page 3-1 |
| Define recording and event policies | Create recording schedules, define event-triggered actions, configure motion detection, and other features. | • Configuring Continuous, Scheduled, and Motion Recordings, page 9-7  
• Configuring Camera PTZ Controls, Presets, and Tours, page 7-64  
• Configuring Motion Detection, page 7-76  
• Using Advanced Events to Trigger Actions, page 9-11 |
| Monitor system and device health | View a summary of system health for all devices, or device status, alerts and events. | Monitoring System and Device Health, page 12-1 |
| Backup and restore            | Backup the system configuration, and optionally include historical data (such as alerts). You can also backup recorded video to a separate server. | • Backup and Restore, page 14-1  
• Archiving Recordings to a Long Term Storage Server, page 11-1 |
Requirements

Cisco VSM Operations Manager requires the following.

<table>
<thead>
<tr>
<th>Requirements</th>
<th>Requirement Complete?</th>
</tr>
</thead>
<tbody>
<tr>
<td>At least one Cisco Video Surveillance server must be installed on the network.</td>
<td>false</td>
</tr>
<tr>
<td>• At least one Media Server and Operations Manager must be enabled.</td>
<td>false</td>
</tr>
<tr>
<td>• The Media Server and Operations Manager applications can be enabled on a single physical server (co-located) or on separate servers.</td>
<td>false</td>
</tr>
<tr>
<td>• Multiple Media Servers can be hosted by a co-located Operations Manager, or a stand-alone Operations Manager.</td>
<td>false</td>
</tr>
<tr>
<td>• See the Cisco Physical Security Multiservices Platform Series User Guide for instructions to install a physical server. See the Cisco Video Surveillance Virtual Machine Deployment Guide for UCS Platforms, Release 7.0 for instructions to install a virtual machine.</td>
<td>false</td>
</tr>
<tr>
<td>• See the Cisco Video Surveillance Management Console Administration Guide for instructions to enable the Media Server and Operations Manager applications.</td>
<td>false</td>
</tr>
<tr>
<td>The IP address or hostname of the Operations Manager.</td>
<td>false</td>
</tr>
<tr>
<td>A valid Cisco VSM Operations Manager username and password.</td>
<td>false</td>
</tr>
<tr>
<td>The Cisco Media Server(s) IP address and password.</td>
<td>false</td>
</tr>
<tr>
<td>At least one camera physically installed and connected to the network.</td>
<td>false</td>
</tr>
<tr>
<td>• See the camera documentation for instructions to install the camera.</td>
<td>false</td>
</tr>
<tr>
<td>• You can also install network or analog cameras.</td>
<td>false</td>
</tr>
<tr>
<td>• Analog cameras require a video encoder to enable network connectivity.</td>
<td>false</td>
</tr>
<tr>
<td><strong>Tip</strong> You can pre-provision cameras by adding them to the Operations Manager before they are available on the network. See the “Pre-Provisioning Cameras” section on page 7-10.</td>
<td>false</td>
</tr>
<tr>
<td>All the server hostnames (Operations Manager server, Media Server) must either resolve to a local address (inside a NAT) or public address (outside a NAT). Having a mix of hostnames/IP addresses inside and outside a NAT can cause connection errors and other issues (such as camera discovery problems). All edge devices (such as cameras and encoders) must be added to a server using a local (non-NAT) addresses.</td>
<td>false</td>
</tr>
</tbody>
</table>
### Table 1-2  Requirements (continued)

<table>
<thead>
<tr>
<th>Requirements</th>
<th>Requirement Complete?</th>
</tr>
</thead>
<tbody>
<tr>
<td>A PC or laptop with the following:</td>
<td></td>
</tr>
<tr>
<td>• Windows 7 (32-bit or 64-bit)</td>
<td></td>
</tr>
<tr>
<td>• Minimum resolution of 1280x1024</td>
<td></td>
</tr>
<tr>
<td>• You must log in with a standard Windows 7 user account. Logging in with a Guest account can prevent video streaming and result in an error to be displayed in the video pane: “Cannot create RTSP connection to server. Check network connection and server health status.”</td>
<td></td>
</tr>
<tr>
<td>See the <a href="#">Cisco Video Surveillance Monitoring Workstation Performance Baseline Specification</a> for the complete baseline performance specifications for a video surveillance monitoring workstation.</td>
<td></td>
</tr>
<tr>
<td>The 32-bit or 64-bit Internet Explorer (IE) 8 web browser.</td>
<td></td>
</tr>
<tr>
<td>• The 32-bit version can display a maximum of 4 video panes (for example, in a 2x2 layout).</td>
<td></td>
</tr>
<tr>
<td>• The 64-bit version can display a maximum of 16 video panes (for example, in a 4x4 layout).</td>
<td></td>
</tr>
<tr>
<td>The Cisco Multi-Pane client software installed on the PC.</td>
<td></td>
</tr>
<tr>
<td>• The Multi-Pane client is an Active X client that enables video playback and other features.</td>
<td></td>
</tr>
<tr>
<td>• You will be prompted to install Multi-Pane client the first time you log in to the Operations Manager, or if you are using a the 64-bit Internet Explorer (IE) 8 web browser for the first time. Follow the on-screen instructions if prompted.</td>
<td></td>
</tr>
<tr>
<td>• You must have administrative privileges on the PC workstation to install the software.</td>
<td></td>
</tr>
</tbody>
</table>
Main Elements of the User Interface

All windows include a basic set of links and features, as described in Figure 1-1.

Tip
See the “Summary Steps: Basic Configuration” section on page 1-7 for instructions to add and configure a basic set of devices.

Figure 1-1 Main User Interface Elements

1 Feature tabs:
   - **Monitor Video**—View live and recorded video from up to four panes. See the “Viewing Video” section on page 2-1.
   - **Cameras**—Add, configure and modify video surveillance cameras, templates and encoders. See the “Adding and Managing Cameras” section on page 7-1.
   - **Users**—Manage user accounts and access permissions, including access for LDAP users. See the “Adding Users, User Groups, and Permissions” section on page 4-1.
   - **System Settings**—Configure system attributes, including system settings, Media Servers, locations, schedules, software licenses, Video Walls, and other attributes.
   - **Operations**—Links to documentation, desktop monitoring software, logs, Reporting and Health features, and the Cisco VSM Management Console.

2 Find—Search for devices and attributes (see the “Using Find” section on page 1-25).

3 Location Hierarchy—Allows you to organize devices, resources, and access permissions according to the locations in your deployment. See the “Creating the Location Hierarchy” section on page 5-1.
<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Devices, users, or other attributes available for the selected location.</td>
<td></td>
</tr>
<tr>
<td>Action buttons. For example, Thumbnail Search or Add Cameras. The buttons vary depending on the screen.</td>
<td></td>
</tr>
<tr>
<td>Video Monitoring panes or configuration window. The fields and contents of the main window vary depending on the feature you are accessing.</td>
<td></td>
</tr>
<tr>
<td>Views—(Monitor Video window) Select a blank layout or pre-defined View (set of video panes). See the “Selecting a Multi-Pane “View”” section on page 2-4.</td>
<td></td>
</tr>
<tr>
<td>Connection—Defines if the Operations Manager is receiving real time status updates (from the ActiveMQ service).</td>
<td></td>
</tr>
<tr>
<td>Help—Opens the online help system that contains this document. For more information and additional documentation, refer to the Help links in the Operations tab.</td>
<td></td>
</tr>
<tr>
<td>Logout—Click to log out of the Cisco VSM Operations Manager.</td>
<td></td>
</tr>
<tr>
<td>Username—Displays the username for the currently logged in user.</td>
<td></td>
</tr>
<tr>
<td><strong>Tip</strong></td>
<td>Click the username to change your password. See the “Changing Your Password” section on page 1-18.</td>
</tr>
</tbody>
</table>
Summary Steps: Basic Configuration

Complete the following steps to create a basic configuration. A basic configuration allows you to verify that basic system components and devices are online, configured, and working properly.

Table 1-3  Summary Steps: Basic Configuration

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Log on to the Cisco VSM Operations Manager.</td>
</tr>
<tr>
<td></td>
<td>See the “Logging In and Managing Passwords” section on page 1-17.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Install the system licenses.</td>
</tr>
<tr>
<td></td>
<td>Purchase and install a license for each Media Server and non-Cisco camera</td>
</tr>
<tr>
<td></td>
<td>added to your deployment.</td>
</tr>
<tr>
<td></td>
<td>See the “Installing Licenses” section on page 1-21.</td>
</tr>
</tbody>
</table>
Table 1-3  Summary Steps: Basic Configuration (continued)

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 3</td>
<td>Revise the system settings.</td>
</tr>
<tr>
<td></td>
<td>Revise the default user password properties, record storage rules, backup</td>
</tr>
<tr>
<td></td>
<td>file rules, and other settings.</td>
</tr>
<tr>
<td>Tip</td>
<td>The default settings are sufficient for a basic setup, but you should</td>
</tr>
<tr>
<td></td>
<td>review and revise the settings to meet the needs of your deployment.</td>
</tr>
</tbody>
</table>

For example:

a. Choose Settings > System Settings.

b. Revise the following properties, as necessary:
   - General System Settings, page 13-1
   - Password Settings, page 13-2
   - Records Settings, page 13-3

See the “Revising the System Settings” section on page 13-1 for more information.
Create at least one location. Define the locations that are assigned to devices (such as cameras) user groups, and policies. Locations allow administrators to restrict user access to the cameras, policies, and data (such as alerts) required by the user’s role. For example, a security guard can have access to view video at a specific location, but not to configure the camera properties.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 4</td>
<td>Create at least one location. Define the locations that are assigned to devices (such as cameras) user groups, and policies. Locations allow administrators to restrict user access to the cameras, policies, and data (such as alerts) required by the user’s role. For example, a security guard can have access to view video at a specific location, but not to configure the camera properties.</td>
</tr>
</tbody>
</table>

a. Select **Locations** from the **System Settings** menu.
b. Click **Add**.
c. Enter the location name and press **Enter**.

See the “Creating the Location Hierarchy” section on page 5-1 for more information.
## Table 1-3 Summary Steps: Basic Configuration (continued)

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 5</strong></td>
<td>Create at least one user account.</td>
</tr>
<tr>
<td></td>
<td>Create the user accounts and access permissions that restrict the locations and tasks available to a user. For example:</td>
</tr>
<tr>
<td></td>
<td><strong>Create a User Role</strong></td>
</tr>
<tr>
<td></td>
<td>The Role defines the access permissions for different types of users. Roles are assigned to User Groups.</td>
</tr>
<tr>
<td></td>
<td>a. Select <strong>Users</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Select the <strong>Roles</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>c. Click <strong>Add</strong>.</td>
</tr>
<tr>
<td></td>
<td>d. Enter the basic settings (see Table 4-5).</td>
</tr>
<tr>
<td></td>
<td>e. Select the Role permissions (see Table 4-2 and Table 4-3).</td>
</tr>
<tr>
<td></td>
<td>f. Click <strong>Create</strong>.</td>
</tr>
<tr>
<td></td>
<td>See the “Defining User Roles” section on page 4-8.</td>
</tr>
<tr>
<td></td>
<td><strong>Create a User Group</strong></td>
</tr>
<tr>
<td></td>
<td>User Groups allow you to create groups of users. The access Role for the User Group grants those access permissions to all users in the group.</td>
</tr>
<tr>
<td></td>
<td>a. Select the <strong>User Groups</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>b. Click <strong>Add</strong>.</td>
</tr>
<tr>
<td></td>
<td>c. Enter the group settings, including the Role that defines the access permissions for the group (see Table 4-6).</td>
</tr>
<tr>
<td></td>
<td>d. Click <strong>Create</strong>.</td>
</tr>
<tr>
<td></td>
<td>See the “Adding User Groups” section on page 4-10.</td>
</tr>
<tr>
<td></td>
<td><strong>Create a User Account</strong></td>
</tr>
<tr>
<td></td>
<td>The User account defines the username and password. Users gain access permissions through the User Group assignments. A user can be assigned to multiple groups, and gains the combined access permissions of all groups.</td>
</tr>
<tr>
<td></td>
<td>a. Select the <strong>User</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>b. Click <strong>Add</strong>.</td>
</tr>
<tr>
<td></td>
<td>c. Enter the basic user settings (see Table 4-7).</td>
</tr>
<tr>
<td></td>
<td>d. Add the user to one or more user groups.</td>
</tr>
<tr>
<td></td>
<td>– Click <strong>Add</strong> under the User Groups box.</td>
</tr>
<tr>
<td></td>
<td>– Select one or more user groups from the pop-up window.</td>
</tr>
<tr>
<td></td>
<td>– Select <strong>OK</strong>.</td>
</tr>
<tr>
<td></td>
<td>e. Click <strong>Create</strong>.</td>
</tr>
<tr>
<td></td>
<td>See the “Adding Users” section on page 4-13.</td>
</tr>
<tr>
<td></td>
<td>See also the “Adding Users, User Groups, and Permissions” section on page 4-1 for more information.</td>
</tr>
</tbody>
</table>
### Table 1-3  Summary Steps: Basic Configuration (continued)

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 6</td>
<td>Add at least one Media Server.</td>
</tr>
</tbody>
</table>

A Media Server is an application that runs on physical Cisco Video Surveillance server, and provides video streaming, recording and storage for the cameras associated with that server. You must add the Media Server to the Operations Manager configuration to communication between the applications.

a. Click **System Settings**.
b. Click **Media Servers**.
c. Click **Add**.
d. Enter the basic server settings and click **Add**.
e. Click **Save**.

See the “Adding or Editing Media Servers” section on page 6-17 for more information.
Chapter 1  Summary Steps: Basic Configuration

Table 1-3  Summary Steps: Basic Configuration (continued)

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 7</td>
<td>Add at least one camera.</td>
</tr>
</tbody>
</table>

The surveillance video camera must be installed on the network.

**Note**  Although cameras can be pre-provisioned (added before they are installed on the network), you should add at least one installed camera to the basic configuration to verify network connectivity, video monitoring, and other features.

a. Click Cameras.
b. Click Add.
c. Select the camera type:
   - **IP Camera**—networked IP camera
   - **Analog Camera**—analog camera are attached to an encoder to provide network connectivity and digitize the analog video. See the Adding Encoders and Analog Cameras, page 10-1 for more information.
d. Enter the basic camera settings and click **Add**.

See the “Manually Adding a Single Camera” section on page 7-12 for more information.
### Table 1-3  Summary Steps: Basic Configuration (continued)

<table>
<thead>
<tr>
<th>Step 8</th>
<th>Task Description</th>
<th>Description</th>
</tr>
</thead>
</table>
| View video from the camera to verify that the system is working properly. | View the live or recorded video from the camera to verify that the settings are correct and that the devices are available on the network.  
See the “Controlling Live and Recorded Video” section on page 2-6 for more information. |
### Table 1-3  Summary Steps: Basic Configuration (continued)

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 9</strong></td>
<td>Backup the Operations Manager configuration and other data, or create an automatic backup schedule. See the “Backup and Restore” section on page 14-1 for more information.</td>
</tr>
<tr>
<td><strong>Tip</strong></td>
<td>We highly recommend that you also back up the Media Server application data using the Cisco Video Surveillance Management Console interface. The Media Server application backup is separate from the Operations Manager backup and includes critical server settings and data necessary to restore the system in the event of a hardware failure. See the “Backing Up the Media Server Configuration” section on page 14-7 for more information.</td>
</tr>
<tr>
<td><strong>Step 10</strong></td>
<td>Troubleshoot problems or verify the system and device status. See the “Monitoring System and Device Health” section on page 12-1 for more information.</td>
</tr>
</tbody>
</table>
Summary Steps: Advanced Configuration

After completing the basic configuration, you can utilize advanced features, as summarized in Table 1-4.

Note: Table 1-4 describes a sub-set of options available in the Cisco Video Surveillance deployment. Review the other topics in this guide for additional features and configuration instructions.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Create a more sophisticated location hierarchy to reflect the needs of your deployment. See the “Understanding Permission-Based and Partition-Based Resources” section on page 5-3.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Add additional users (or add LDAP servers to authenticate users from other systems). • Adding Users, User Groups, and Permissions, page 4-1 • Adding Users from an LDAP Server, page 4-15</td>
</tr>
<tr>
<td>Step 3</td>
<td>Add additional Media Servers and configure the high availability options. High availability servers provide redundant or failover support for the primary Media Server. Long Term Storage servers can back up recordings and remove them from the primary Media Server. • Configuring Media Servers, page 6-1 • High Availability, page 11-1</td>
</tr>
<tr>
<td>Step 4</td>
<td>Create camera templates. Templates define configurations that can be applied to multiple cameras. See the Adding and Editing Camera Templates, page 9-1.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Add additional cameras. You can import cameras from a file or discover them on the network. • Importing or Updating Cameras or Encoders Using a CSV File, page 7-17 • Discovering Cameras on the Network, page 7-22 • Adding Cameras from an Existing Media Server, page 7-38</td>
</tr>
<tr>
<td>Step 6</td>
<td>Configure camera recordings. Configure cameras to record in a continuous loop, on a recurring schedule, or both. See the “Configuring Continuous, Scheduled, and Motion Recordings” section on page 9-7</td>
</tr>
</tbody>
</table>
### Table 1-4  Summary Steps: Advanced Configuration (continued)

<table>
<thead>
<tr>
<th>Step 7</th>
<th>Configure additional camera and monitoring features.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Configuring Camera PTZ Controls, Presets, and Tours, page 7-64</td>
</tr>
<tr>
<td></td>
<td>• Configuring Motion Detection, page 7-76</td>
</tr>
<tr>
<td></td>
<td>• Creating Pre-Defined Views, page 3-2</td>
</tr>
<tr>
<td></td>
<td>• Configuring Video Walls, page 3-9</td>
</tr>
<tr>
<td></td>
<td>• Enabling Record Now, page 3-11</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 8</th>
<th>Define the system events that trigger actions.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Use <em>Advanced Events</em> to trigger an immediate one-time action when a specified event occurs. For example, when motion starts or a contact is closed, the system can trigger an alert, aim the camera to a PTZ preset position, or trigger an action on an external system.</td>
</tr>
<tr>
<td></td>
<td>See the “Using Advanced Events to Trigger Actions” section on page 9-11 for more information.</td>
</tr>
</tbody>
</table>
Logging In and Managing Passwords

- Logging In, page 1-17
- Default User Accounts and Passwords, page 1-18
- Changing Your Password, page 1-18
- Changing Another User’s Password, page 1-19

Logging In

To log in to the Cisco Video Surveillance Operations Manager:

**Step 1** Launch the 32-bit or 64-bit version of Internet Explorer 8 on your Windows 7 computer.

**Step 2** Enter the Operations Manager URL or IP address.

**Step 3** Enter your username and password.

**Step 4** Select a Domain:
   - Choose the default “localhost” if your account was created using the Operations Manager.
   - Select an alternative domain if instructed by your system administrator.

**Step 5** Enter a new password, if prompted.

You must enter a new password the first time you log in, or when your password periodically expires.

**Step 6** If prompted, complete the on-screen instructions to install or upgrade the Cisco Multi-Pane client software on your computer.
   - This application is an Active X client that enables video playback and other features.
   - Video will not play unless the Cisco Multi-Pane client software is correctly installed.
   - If upgrading to the 64-bit version of Internet Explorer 8, you will be prompted to install the 64-bit version of the Cisco Multi-Pane client, if necessary.
   - You must have administrative privileges on the PC workstation to install the software.

**Note**
You must log in with a standard Windows 7 user account. Logging in with a Guest account can prevent video streaming and result in an error to be displayed in the video pane: “Cannot create RTSP connection to server. Check network connection and server health status.”
Default User Accounts and Passwords

The Operations Manager includes two default users: the super-admin account and an operator account.

<table>
<thead>
<tr>
<th>Default Account</th>
<th>Default Username and Password</th>
<th>Access Privileges</th>
</tr>
</thead>
<tbody>
<tr>
<td>admin</td>
<td>username: admin</td>
<td>Super-admin privileges with full rights to configure, view and manage all system settings and features.</td>
</tr>
<tr>
<td></td>
<td>password: admin</td>
<td></td>
</tr>
<tr>
<td>operator</td>
<td>username: operator</td>
<td>Ability to view live and recorded video, control PTZ movements, push views to a Video Wall, and export recordings.</td>
</tr>
<tr>
<td></td>
<td>password: operator</td>
<td></td>
</tr>
</tbody>
</table>

You are prompted to change the default passwords the first time you log in.

Changing Your Password

To change your password, click your username in the top right corner of the browser (Figure 1-2).

**Note**

Users from external systems (LDAP servers) cannot change their password using the Cisco VSM Operations Manager.

If you forgot your password, contact your system administrator and ask them to create a new password (you will be prompted to change it when you log in).

**Step 1**
Log in to the Operations Manager (see Logging In Figure 1-1).

**Step 2**
Click your username in the top right (Figure 1-2).

**Step 3**
Enter your current password.

**Step 4**
Enter and re-enter a new password.

**Figure 1-2** Changing Your Password
Changing Another User’s Password

To change another user’s password, you must belong to a User Group with permissions to manage *Users & Roles*.

**Procedure**

**Step 1** Select *Users*, and then select the *User* tab (Figure 1-3).

**Step 2** Highlight a username.

**Step 3** Enter and re-enter a new password in the password fields.

**Note**
The user is required to change the password the first time they log in.

See the “Adding Users, User Groups, and Permissions” section on page 4-1 for more information.

**Figure 1-3   Changing a User Password**
Understanding Cisco Video Surveillance Software

The following table summarizes the software that can be upgraded in a Cisco VSM deployment.

<table>
<thead>
<tr>
<th>Software Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device firmware</td>
<td>Device firmware is provided by the device manufacturer. The firmware for Cisco devices can be upgraded using Operations Manager (as described in the following procedure). Firmware for other manufacturers is upgraded using a direct connection (refer to the device documentation).</td>
</tr>
</tbody>
</table>
| Device driver packs | Device driver packs are the software packages used by Media Server and Operations Manager to inter-operate with video devices. Driver packs are included with the Cisco VSM software, or may be added to a server at a later time to add support for new devices.  
  • Use the Management Console to update driver packs, as described in the Manage Drivers section of the Cisco Video Surveillance Management Console Administration Guide.  
  • Go to Operations > Management Console to launch the browser-based interface. See your system administrator for login information.  
  • Driver pack versions must be the same on the servers that host the Media Server and Operations Manager or a driver pack mismatch error. Templates cannot be revised when a driver pack mismatch error is present. |
| System software     | System software denotes the Cisco VSM software, including Media Server, Operations Manager, Management Console, Safety and Security Desktop and Multipane clients. The Operations Manager and all associated Media Servers must run the same software version.  
  • Use the Management Console to update System Software, as described in the Server Upgrade section of the Cisco Video Surveillance Management Console Administration Guide.  
  • Go to Operations > Management Console to launch the browser-based interface. See your system administrator for login information. |

Tip
For information about supported software releases, and how to locate device or system software, see the Release Notes for Cisco Video Surveillance Manager, Release 7.0.1.
Installing Licenses

A license must be purchased and installed for each Media Server and non-Cisco camera added to your deployment.

Review the following topics for more information.

- Usage Notes, page 1-21
- License Part Numbers, page 1-22
- Displaying License Information, page 1-22
- Obtaining and Installing Licenses, page 1-23

Usage Notes

- Licenses are installed in the Operations Manager only (not on the individual Media Servers).
  - Licenses can only be installed on a single instance of Operations Manager.
  - The same license file cannot be installed more than once on the same Operations Manager.
  - Do not rename the license file before installing it on the Operations Manager. Use the original file name only.
- A license must be purchased and installed for each Media Server and non-Cisco camera added to your deployment.
- A license for 10,000 Cisco cameras is included by default (you do not need to purchase and install an additional license for Cisco cameras).
- Licenses are cumulative: each additional license is added to the capacity of existing licenses. For example, if you initially installed a license for 100 non-Cisco cameras, you can purchase an additional license for 200 cameras to support a total of 300 non-Cisco cameras.
- The maximum number of devices in a system is 200 Media Servers and 10,000 cameras. This including Cisco and non-Cisco devices.
- Soft deleted cameras are included in the camera license count. See the “Device Status: Identifying Issues for a Specific Device” section on page 12-6 for more information.
- Installed licenses are included in the Operations Manager backup and restore archives. We recommend backing up Operations Manager data after installing new licenses (or anytime major changes are performed). If the license file is installed after the backup is performed, the license file is not backed up and not available to be restored. You must re-install the missing license file. See the “Backup and Restore” section on page 14-1 for more information, including how to configure scheduled backups.
License Part Numbers

For a summary of the Cisco VSM licenses, see the Release Notes for Cisco Video Surveillance Manager. Multiple camera and Media Server licenses can be included in a single license file. For example, a single license file might include support for 25 additional cameras and two additional Media Servers. See the “Displaying License Information” section on page 1-22.

Displaying License Information

Select System Settings > Software Licensing to view information about each installed license, and a summary of all installed licenses (Figure 1-4).

Figure 1-4 Software Licensing

1 The License Summary displays the total number of Cisco cameras, non-Cisco cameras and Media Servers that can be managed by the current Operations Manager. The total number of device licenses used and available is also shown.

Note Up to 200 Media Servers and 10,000 cameras can be managed by the system, although you can install more that number of licenses.

2 The license for Cisco cameras (included).

3 Licenses for additional Media Servers and non-Cisco cameras.

4 Highlight a license name to display information about the license file, such as the upload date and the number of devices enabled by the license.
Obtaining and Installing Licenses

To install a license, purchase the license and obtain the license file, then upload the file to Operations Manager.

Procedure

Step 1
Purchase additional licenses:
   a. Determine the part number for the license you want to purchase. See the “License Part Numbers” section on page 1-22.
   c. When the purchase is complete, you are issued a Product Authorization Key (PAK) in paper form, or in an email message.

Step 2
Obtain the license file:
   a. Locate the Product Authorization Key (PAK) created with the purchase.
   b. In a Web browser, open the Cisco Product License Registration Web page.
      http://www.cisco.com/go/license/
   c. Follow the onscreen instructions to complete the form and enter the Product Authorization Key (PAK). When you are done, a license file with the extension .lic is sent to your email address.
   d. Transfer the file to the drive of the PC used for the configuration.

Step 3
Install the license file in Cisco VSM:
   a. Log in to the Operations Manager.
   b. Select System Settings > Software Licensing (Figure 1-4).
   c. Click Add and select the license file located on your local drive.
   d. Click Save to install the file and activate the additional capacity.

Tip
The additional capacity is available immediately. You do not need to restart the server or take additional steps.

Deleting Licenses

Deleting a license will reduce the number of cameras and Media Server supported in your Cisco Video Surveillance deployment.

You cannot delete a license if the number of licenses devices will be less than the number added to the Operations Manager. View the number of licenses Used to verify that the license can be removed (see the “Displaying License Information” section on page 1-22).

Procedure
To remove a license:
Step 1  Select System Settings > Software Licensing.
Step 2  Highlight a license entry and click Delete (Figure 1-4).
Step 3  Click Yes to confirm.
Using Find

Enter a term or name in the *Find* field to quickly locate cameras, Media Servers, users, or other Cisco VSM attributes. The *Find* field is located at the top of the left column (Figure 1-5) and dynamically locates any item in the open window (not just for the location selected).

*Figure 1-5 Find*

For example, open *Cameras* and then enter a name of a camera. The results are displayed below the *Find* field, and is dynamically updated to display even partial matches. The example in Figure 1-6 shows the results of a partial search: entering “Lo” returns the camera “Lobby Door”.

*Figure 1-6 Find Results*

Tip: Click the icon to clear the *Find* entry and return to normal view. All entries are displayed.
Chapter 2

Viewing Video

The following topics describe how to view live and recorded video using a supported Cisco Video Surveillance application, such as the Cisco Video Surveillance Safety and Security Desktop (Cisco SASD) application or the Cisco VSM Operations Manager.

Contents
- Understanding the Video Viewing Options, page 2-2
- Operations Manager Requirements, page 2-3
- Using the Monitor Video Page, page 2-3
- Selecting a Multi-Pane “View”, page 2-4
- Controlling Live and Recorded Video, page 2-6
  - Overview, page 2-7
  - Viewing Live Video, page 2-8
  - Viewing Recorded Video, page 2-11
  - Creating Video Clips, page 2-15
  - Using Record Now, page 2-22
  - Using the Pop-Up Menu, page 2-23
  - Using the Smooth Video Options When Viewing Live Video, page 2-25
  - Synchronizing Video Playback in Multiple Panes, page 2-26
  - Using Pan, Tilt, and Zoom (PTZ) Controls, page 2-29
- Viewing a Thumbnail Summary of Video Archives, page 2-33
  - Using Thumbnail Search, page 2-35
# Understanding the Video Viewing Options

Live and recorded Cisco Video Surveillance video can be viewed using a Cisco-provided application, as summarized in Table 2-1, or a third-party application that supports ActiveX controls.

<table>
<thead>
<tr>
<th>Viewing Tool</th>
<th>Application</th>
<th>Description</th>
<th>Documentation</th>
</tr>
</thead>
</table>
| Desktop monitoring application | Cisco Video Surveillance Safety and Security Desktop (Cisco SASD)            | • Allows simultaneous viewing of up to 16 cameras.  
• Create Video Matrix windows for display in separate monitors.  
• View Video Walls.  
• Create unattended workstations.  
• View and manage alerts.  
• View cameras, video, and alerts based on a graphical map. | Cisco Video Surveillance Safety and Security Desktop User Guide  
Tip: Go to Operations > Software to download and install the application. |
| Web-based configuration and monitoring tool | Cisco Video Surveillance Operations Manager (Operations Manager) | • Allows simultaneous viewing of multiple video panes:  
  – View up to 4 cameras with the 32-bit version of Internet Explorer 8.  
  – View up to 16 cameras with the 64-bit version of Internet Explorer 8.  
• Create the Views and Video Walls available in the desktop Cisco SASD application.  
• Configure the camera, streams and recording schedules. | Cisco Video Surveillance Operations Manager User Guide |
| Desktop video clip player     | Cisco Video Surveillance Review Player (Cisco Review Player)                 | Simple player used to view video clip files.                                                                                                                                                              | Cisco Video Surveillance Review Player  
Tip: Go to Operations > Software to download and install the application. |
| Web-based server console      | Cisco Video Surveillance Management Console (Cisco VSM Management Console)  | Provides basic viewing features for a single stream (Stream A) from a single camera.                                                                                                                        | Cisco Video Surveillance Management Console Administration Guide |
Operations Manager Requirements

See the following to monitor video using the browser-based Operations Manager:

- “Requirements” section on page 1-3
- See the Cisco Video Surveillance Monitoring Workstation Performance Baseline Specification for the complete baseline performance specifications for a video surveillance monitoring workstation.

Using the Monitor Video Page

Open the Monitor Video window to view video using the Cisco VSM Operations Manager.

Procedure

**Step 1** Log on to the Cisco VSM Operations Manager.

*Note* See the “Logging In” section on page 1-17. You must belong to a User Group with permissions for View Live Video or View Recordings.

**Step 2** If prompted, complete the on-screen instructions to install or upgrade the Cisco Multi-Pane client software on your computer.

*Note* This application is an Active X client that enables video playback and other features. Video will not play unless the Cisco Multi-Pane client software is correctly installed.

**Step 3** Click Monitor Video.

**Step 4** (Optional) Select View Menu to select a video grid of multiple cameras.

- Select—select a blank layout.
- Select Views—select a pre-defined View.

See the “Selecting a Multi-Pane “View”” section on page 2-4 for more information.

**Step 5** Expand the location tree and drag a camera from the list onto a viewing pane.

*Tip* Enter a partial or complete camera name in the Find field to display matching cameras.

*Tip* You can also select a video pane by clicking in it, and then double-click the camera name.

**Step 6** See the “Controlling Live and Recorded Video” section on page 2-6 to use the video playback controls.
Selecting a Multi-Pane “View”

To view video from more than one camera, select an option from the View Menu:

- **Blank Layouts**—Choose Select to select a blank layout (Figure 2-1).
- **Pre-Defined View**—Choose Select View to select a pre-defined multi-pane view. Views can be configured to rotate video from multiple cameras to provide a virtual tour of a building or area. The video panes can (optionally) rotate video from different cameras to provide a virtual tour of a building or area.
- Choose **Current View > Save As** to save a layout or view under a new name. Enter a name and location for the view. Views can be assigned to the same location as the cameras, or to a higher level location. The new View appears under the Select View menu. Views that are displayed in both the Operations Manager and Cisco Video Surveillance Safety and Security Desktop (Cisco SASD) application. See the “Creating Pre-Defined Views” section on page 3-2.
- Choose **Current View > Reset** to reload the last view or layout and discard any changes.

---

**Figure 2-1 Video Layouts**

Tip

- To change the video in a View pane, drag and drop a camera name onto the pane.
- Views can be accessed using either the browser-based Operations Manager or the Cisco Video Surveillance Safety and Security Desktop (Cisco SASD) application. The Operations Manager can display a maximum of 4 video panes using the 32-bit version of Internet Explorer, and up to 16 panes when using the 64-bit version. Cisco SASD can display up to 16 panes.
- Double-click a video pane to fill the screen with that video (Figure 2-2). A preview of the other video panes is shown in a smaller grid at the bottom of the screen. Double-click the video pane again to return the grid to normal size.
Figure 2-2  Enlarge a Video Pane
Controlling Live and Recorded Video

Each video viewing pane in a Cisco Video Surveillance monitoring application supports the following controls and features.

The features available on your workstation depend on the following:

- The camera and system configuration.
- Your user account access permissions.
- The features supported by the video monitoring application.

Contents
Refer to the following topics for more information.

- Overview, page 2-7
- Viewing Live Video, page 2-8
- Viewing Recorded Video, page 2-11
- Creating Video Clips, page 2-15
- Using Record Now, page 2-22
- Using the Pop-Up Menu, page 2-23
- Understanding Video Pane Border Colors, page 2-24
- Using the Smooth Video Options When Viewing Live Video, page 2-25
- Synchronizing Video Playback in Multiple Panes, page 2-26
- Using Pan, Tilt, and Zoom (PTZ) Controls, page 2-29
Overview

To view live and recorded video, log on to the monitoring application and drag and drop camera names onto the available viewing panes (you can also select a pane and double-click the camera name). Use Views to view multiple panes in a single window.

For example, Figure 2-3 shows a multi-pane view using the Cisco Video Surveillance Safety and Security Desktop (Cisco SASD) application.

![Multi-Pane View using the Cisco Video Surveillance Safety and Security Desktop](image)

Each viewing pane includes various controls that allow you to do the following:

- Switch between live and recorded video.
- Select the playback timespan.
- Pause, play, or skip forward and back.
- Create and save video clips from recorded video
- Mute or un-mute the audio (if available).
- Synchronize the playback of multiple recordings.
- Control the Pan Tilt and Zoom (PTZ) movements of a camera (if supported by the camera).
- Additional options are available by right-clicking the image. Options include synchronizing multiple viewing panes, recording live video, expanding the image to fill the screen, creating a snapshot image, and configuring smooth video options to improve playback performance when network performance is poor.
Controlling Live and Recorded Video

Note
The available controls depend on the camera model and system configuration. For example, pan-tilt-zoom (PTZ) controls are available only on cameras that support PTZ. Recording options are available only if the camera is configured to record video. Synchronized playback is available for recorded video (not live video). See your system administrator for more information.

Viewing Live Video

Live video is displayed by default when you log in to the viewing application. Figure 2-4 summarizes the controls available in each viewing pane.

Tip
To control the playback in multiple video panes, Shift-Click or Ctrl-Click to select the panes. The borders of all selected panes turn to orange. Controls and actions performed in one pane also affect the other selected panes. To deselect panes, select a single pane, or use Shift-Click or Ctrl-Click to deselect the panes.

Note
- Live video may be delayed 1-2 seconds. Live video can be further delayed if the smooth video option is enabled. See the “Using the Smooth Video Options When Viewing Live Video” section on page 2-25 for more information.
- Soft-deleted cameras (shown with a [x] icon) are cameras that were removed from the system but still allow access to the camera’s recorded video. You cannot display live video from soft-deleted cameras.
- The control bar and audio icon will not display if your workstation monitor is set to 16-bit color setting. Change your monitor color setting to 32-bit.
Figure 2-4   Video Pane Controls

1. Camera name—The source of the displayed video.

2. Indicates the quality of the primary live video stream. If the live video quality is poor, an alternative secondary or iFrame video stream can be automatically applied. See the “Using the Smooth Video Options When Viewing Live Video” section on page 2-25 for more information.

3. Indicates live or recorded video (recorded video displays a time stamp such as 4/27/2012 11:45:30 PM).

4. Range Bar—Used with recorded video (see the “Viewing Recorded Video” section on page 2-11 for more information).

5. Seek—Used with recorded video to choose a playback time (see the “Viewing Recorded Video” section on page 2-11 for more information).

6. The green icon indicates live video. Click the icon to switch to the recorded view.

7. Live video playback controls.
   - —Pause the video playback.
   - —Play the video forward at normal speed.
   Note The other playback controls are used with archived video only. See Figure 2-5 on page 2-12 for more information.

8. —Click the triangle to pin the control bar to the screen, or auto-hide the bar when the cursor is moved.
   Note The control bar and audio icon will not display if your workstation monitor is set to 16-bit color setting. Change your monitor color setting to 32-bit.
Controlling Live and Recorded Video

Video image.

Camera menu.
Right-click the image to open the menu and select an option. Options not supported by the camera are disabled (shown in gray). See the “Using the Pop-Up Menu” section on page 2-23 for more information.

Control icons.

- **Audio.** The audio icon appears if the camera supports audio. Click the icon to enable or mute live audio volume. This control does not affect recorded video.
- **PTZ.** Click to enable or disable the Pan, Tilt and Zoom (PTZ) controls. See the “Using Pan, Tilt, and Zoom (PTZ) Controls” section on page 2-29.
- **—** See the “Synchronizing Video Playback in Multiple Panes” section on page 2-26.

Additional Information
Refer to the following topics for additional options:

- Using Record Now, page 2-22
- Using the Pop-Up Menu, page 2-23
- Using the Smooth Video Options When Viewing Live Video, page 2-25
- Synchronizing Video Playback in Multiple Panes, page 2-26
- Using Pan, Tilt, and Zoom (PTZ) Controls, page 2-29

Note: The control bar and audio icon will not display if your workstation monitor is set to 16-bit color setting. Change your monitor color setting to 32-bit.
Viewing Recorded Video

You can view recorded video from a continuous loop, for a motion event, or from a video clip. The camera must be configured to support each of these options, and you must have access to a video viewing application that supports these functions (some applications are used for viewing only).

For example, a camera can be configured to record the following:

- Continuous recordings that include video from a set amount of time, such as the past 60 minutes.
- Motion event recordings that are triggered whenever a motion event occurs. Video is recorded when the motion occurs, and for a configured number of seconds before and after the event. Use a video viewing application (such as the Cisco Video Surveillance Safety and Security Desktop) to view motion event video.

Tip

To control the playback in multiple video panes, press Shift-Click to select multiple concurrent panes, or Ctrl-Click to select individual panes. The borders of all selected panes turn to orange. Controls and actions performed in one pane also affect the other selected panes. To deselect panes, select a single pane, or use Shift-Click or Ctrl-Click to deselect the panes.

Usage Notes

- Multi-pane video clips can also be saved to your desktop and played using the Cisco Video Surveillance Review Player.
- If the Record Now feature is enabled, right-click the image and choose Record Now to record live video.
- If a camera is soft-deleted, you can still access the camera’s recorded video but cannot display live video. Recordings are retained on the system until removed according to the recording retention settings.
- Click the icon to toggle between live and recorded video. The icon appears when recorded video is displayed.
- The first time you select a camera’s recorded video, the playback begins slightly behind the live (current) time. When you toggle between live and recorded, recorded video returns to the previously selected timestamp.
Figure 2-5 describes the main recording features and controls.

**Figure 2-5 Viewing Recorded Video**

1. **Camera Name**—Source of the recorded video.
2. Indicates the video quality, which can be affected by network and system performance. The icon turns red if the video quality is poor.
   - **Note** This icon is for informational purposes only when displayed with recorded video (the Smooth Video options do not apply).
3. Pop-up menu options. See the “Using the Pop-Up Menu” section on page 2-23.
4. Timestamp for the currently displayed video image. For example: **7/12/2012 4:08:39:886 AM**.
   - **Note** Changes to **live** when live video is displayed.
5. Range Bar—The span of video to work with.
   - The entire range bar represents the entire span of available recorded video. Slide the range bar selectors to shorten the range (see below).
   - The lower (green) seek bar represents the selected range (see below).
Range Bar selectors—Drag the range bar selectors to narrow the timespan of video you want to review.
For example, drag the selectors to create a 10 minute range. You can then drag that range left or right to the appropriate place in the recorded span.
In the following example, the entire range of recorded video is selected (the range bar selectors are to the far right and left). To display the timestamps, click a selector.

Click and drag the range bar selectors to choose a shorter period of time. In the following example, the range bar selectors are used to select approximately 10 minutes of video. Drag the selected range left or right to locate the desired range of recorded video.

Tip  The green seek bar represents the selected span. If the span in the top range bar is 10 minutes, then the green seek bar represents 10 minutes of video. Slide the seek bar selector to choose the playback time (see below).

Tip  Double-click a range bar selector to playback the video from the beginning of that range.

Seek Bar —Represents the video range, and is used to select a playback time.
For example, if the range is 10 minutes, then the seek bar represents 10 minutes of video.

Tip  Right-click the seek bar and select Seek to... to select a specific date and time.

Note  Gaps in the recorded video are shown in gray. Recording gaps occur if there is a manually-triggered Record Now session, if recording was manually stopped, if recording was stopped by a schedule, or if video was unavailable due to network connectivity issues, device malfunctions, or other events.

Seek Bar selector—Drag the selector to play video from the selected time (as indicated by the timestamp).

Note  When you move the scroll bar for a video pane that is synchronized, that pane becomes the new synchronization master pane. The other synchronized panes play video according to the master pane. See the “Synchronizing Video Playback in Multiple Panes” section on page 2-26.
Bookmarks—Create bookmarks to save a video clip or a repeating segment (see below).

To create a bookmark, Ctrl-Click-drag the seek bar. The bookmark span is shown in orange.

To create a bookmark, Ctrl-Click-drag the seek bar. The bookmark span is shown in orange.

Bookmarks menu—Right-click the seek bar to display the bookmark menu. You can save the bookmarked video as a clip in one of the supported formats, remove all bookmarks, or create a repeating segment.

See the following for more information:
- Creating Video Clips, page 2-15
- Creating a Repeat Segment, page 2-21

Indicates live or recorded video. Click the icon to switch between live and recorded video.

- Live video is displayed.
- Recorded video is displayed.

Tip
The first time you select a camera’s recorded video, the playback begins slightly behind the live (current) time. When you toggle between live and recorded, recorded video returns to the previously selected timestamp.

Recorded video playback controls.

- Step Reverse button—(Archived video only) Pauses the playback and steps back one frame at a time.
- Play Reverse button—(Archived video only) Plays the video archive in reverse at normal speed.
- Pause button—Pause the video playback.
- Play Forward button—Play the video forward at normal speed.
- Step Forward button—(Archived video only) Pauses the playback and steps forward one frame at a time.

Variable Speed Playback
Right-click the Play Reverse or Play Forward button to play the video slower or faster.

For example, select 0.50X to play the video at half speed (forward or reverse). Select 4.00X to play at 4 times the normal rate (forward or reverse).
Creating Video Clips

Video clips can be created in multiple formats for playback using the Cisco VSM Review Player, or a third party player.

Note Timestamps are not displayed in third-party video viewers. Use the Cisco Review Player to display timestamps (see the Cisco Video Surveillance Review Player User Guide for more information).

This section includes the following topics:

- Supported File Formats, page 2-15
- Creating Video Clips, page 2-16
- Accessing and Playing Video Clips, page 2-18

Supported File Formats

Cisco Video Surveillance supports the creation and playback of the following video formats:

<table>
<thead>
<tr>
<th>File Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MP4</td>
<td>A standard video file format that is playable on most computers and useful for sending to third parties. MP4 clips support a single video pane and can include audio (CVA/CVX files do not support audio). MP4 clips are saved on the server for 24 hours and must be downloaded using the Select Streams menu option (the MP4 clips are automatically deleted from the server 24 hours after creation).</td>
</tr>
</tbody>
</table>

- MP4 audio playback is supported only with the Cisco VSM Review Player or VLC media player.
- You can use the Cisco VSM Review Player to save MP4 files in the tamper proof MPX format.
- See the Cisco Video Surveillance Review Player User Guide for more information.
Chapter 2      Viewing Video

Controlling Live and Recorded Video

Tip
You can also right-click a video pane and select Take Snapshot to save a still image in BMP, JPEG, PNG, and TIFF formats. See the “Using the Pop-Up Menu” section on page 2-23 for more information.

Creating Video Clips
To create video clips, create a bookmark span and select the file format, as described in the following procedure.

Notes:
- The Media Server hard disk volume must have sufficient disk space to create the video clip or the operation will fail. See your system administrator for more information.
- MP4 clips:
  - MP4 files are stored on the server until you download them. Clips are automatically deleted after 24 hours, or when downloaded to a local disk.
  - MP4 clips can only be downloaded by the user who created the clip.
  - You can only create up to five MP4 clips at a time per Media Server.
  - MP4 clipping failure can only be viewed in the Cisco Video Surveillance Safety and Security Desktop (Cisco SASD) Alert workspace.
- CV A/CVX clips are downloaded immediately and not stored on the server.
- If the clipping fails, see your system administrator for assistance.

Procedure:

Step 1
Select a video pane from the viewing application (such as Cisco SASD or Operations Manager).

Tip
To create a multi-pane clip in the CVA format, press Shift-Click to select multiple concurrent panes, or Ctrl-Click to select individual panes.

Step 2
In the green seek bar, Ctrl-Click and drag the mouse cursor to create a bookmark span. The bookmark span is shown in orange (Figure 2-6).

Step 3
Right-click the bookmark and select Use connected bookmarks (Figure 2-6) to create a file in the desired format.

---

Table 2-2   Video Clip File Formats (continued)

<table>
<thead>
<tr>
<th>File Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CVA</td>
<td>Cisco video archives (CVA) can include multiple video panes that synchronize to the same time. CVA files can only be opened in applications that support the CVA format (such as the Cisco Review Player). CVA files do not support audio playback.</td>
</tr>
<tr>
<td>CVX</td>
<td>A tamper proof CVA file. CVX files require a password that is entered when the file is created. You must enter the password to open and view the video file. CVX video playback will shut down if the file is tampered with. CVX files do not support audio.</td>
</tr>
</tbody>
</table>

CV A Cisco video archives (CVA) can include multiple video panes that synchronize to the same time. CVA files can only be opened in applications that support the CVA format (such as the Cisco Review Player).

CVX A tamper proof CVA file. CVX files require a password that is entered when the file is created. You must enter the password to open and view the video file. CVX video playback will shut down if the file is tampered with.

---

Tip
You can also right-click a video pane and select Take Snapshot to save a still image in BMP, JPEG, PNG, and TIFF formats. See the “Using the Pop-Up Menu” section on page 2-23 for more information.
Step 4  Save the file:

CVA/CVX files

a. (Optional) Revise the start and end date and time (Figure 2-7). Enter a time between 30 seconds and 4 hours (the range cannot include more than one codec and the start time must be before the end time).

b. (Optional) Select **Enable tamper proof** and enter a password to create a password-protected CVX file.

c. Click **OK**.

d. Select a location on a local disk and click **Save**.

e. Wait for the clip to be generated and downloaded. Video streaming is paused during CVA/CVX clip generation.
MP4 clips

a. (Optional) Revise the start and end date and time (Figure 2-8). Enter a time between 30 seconds and 4 hours (the range cannot include more than one codec and the start time must be before the end time).

Figure 2-8 MP4 Clip Settings

b. (Optional) Enter a clip name that identifies the recording on the server (Figure 2-9). For example, if you enter “My 4500 Camera” then the clip selection will be “My 4500 Camera__1347005138141”. If blank, the default name is “My Clip__system-timestamp”.

c. (Optional) Select or deselect Record Audio (if the camera supports audio recordings) to include or exclude audio. Audio playback is supported only with the Cisco VSM Review Player or VLC media player.

d. Click OK to save the clip to the server.

Step 5

Download and play the clip as described in the “Accessing and Playing Video Clips” section on page 2-18.

Note  MP4 clips are automatically deleted from the server if not downloaded within 24 hours.

Accessing and Playing Video Clips

- CVA and CVX files are saved to your local disk when created. Use the Cisco VSM Review Player to open and play CVA and CVX clips.

- MP4 clips:
  - MP4 files are saved to the server and must be downloaded before being viewed. Clips are automatically deleted from the server after 24 hours, or when downloaded to a local disk.
  - You can create up to five MP4 clips at a time per Media Server.
  - MP4 clips play automatically in the pane when downloaded. The clips can also be viewed using the Cisco VSM Review Player or VLC media player.
MP4 clips can only be downloaded by the user who created the clip.

MP4 clips require that the clipping repository be selected on the Media Server associated with the camera.

To save and play MP4 clips, do the following:

**Step 1** Right-click the video pane and choose **Select Streams** (Figure 2-9).

**Step 2** Select the **Recorded:Clip** file.

**Figure 2-9   Accessing a MP4 Clip**

**Note** Clips are automatically deleted from the server if not downloaded within 24 hours.

**Step 3** Enter a file name and location.

**Step 4** Click **Save**.

**Step 5** Wait for the clip to download.

**Step 6** The clip will automatically play in the pane the first time it is downloaded (Figure 2-10). To view the clips again, use a viewing application such as the Cisco Review Player.
Controlling Live and Recorded Video

Chapter 2      Viewing Video

Figure 2-10  MP4 Clip Viewing Pane

1. MP4 file name and location

2. Timestamp for currently displayed image.

Tip: Choose Select Streams and select a different live or recorded stream when you are finished viewing the clip.

Tip: You can also open the clip in the Cisco VSM Review Player and create a tamper-proof MPX file. See the Cisco Video Surveillance Review Player User Guide for more information.
Creating a Repeat Segment

A repeating segment is a range selected on a recording that plays continuously in a loop. When the end of the segment is reached, playback starts over from the beginning of the segment. The video segment loops indefinitely until you cancel the segment or seek video outside the selected range (seeking inside the selected range does not cancel the segment).

**Figure 2-11 Create a Repeating Segment**

**Procedure**

1. **Ctrl-Click-drag** the seek bar in a recording to create a bookmark (Figure 2-11). The bookmark span is shown in orange.
2. Right-click the seek bar and select as a repeat segment.
3. (Optional) Enter a specific start and end date and time.
4. To cancel the segment, right click the segment and choose Remove all Bookmarks. You can also click on the seek bar outside the selected range.

**Note**

Repeating segments are used with recordings only.
Using Record Now

To manually trigger recording of a live video stream, right-click the image and choose **Record Now**.

**Requirements**

- The Record Now option must be enabled for the camera configuration in the Operations Manager.
- Your use account must include access permissions to view recorded video.
- You can record video from the live primary video stream only.

**Usage Notes**

- Audio is not recorded.
- Video is recorded for a system-defined length of time (the default is 5 minutes).
- The recording is retained on the system according to the event retention settings for the camera. For example, if the camera’s event recordings are retained for 30 days, then the Record Now recordings will also be available for 30 days. When the retention time is exceeded, the recording is automatically deleted (see the “Creating Video Clips” section on page 2-15 to save the video to a separate file).

**Procedure**

**Step 1** Log in to the video viewing application and select a camera.

**Step 2** Choose live video (see the “Viewing Live Video” section on page 2-8).

**Step 3** Right click the image and choose **Record Now** (Figure 2-12).

- The recording is performed in the background. You can continue to use the other playback controls.
- The recording status is displayed in red text (Figure 2-12) when the recording time nearly complete.

**Figure 2-12  Record Now**
Step 4 To view the recorded video, review the following notes.

- Record Now clips are available from the primary stream only. Right click the image and choose Select Streams to view the recorded primary stream (disabled if the pane is synchronized).

- If the video is within the time span of other recorded video, there is no separate indication of the Record Now video. You can access the video as described in the “Viewing Recorded Video” section on page 2-11).

- If the Record Now video is older than the continuous loop, the gap between the recording times is shown in gray:

<table>
<thead>
<tr>
<th>Time span (for all recordings)</th>
</tr>
</thead>
</table>

Record Now recording included within the time span of other continuous and event recordings.

- A gap in the time span indicates a missing recording. When the event retention time is exceeded, the Record Now recording is automatically deleted. To save the recording, see the “Creating Video Clips” section on page 2-15.

Using the Pop-Up Menu

Select a video pane and right-click on the image to open a menu with the following options (see Figure 2-4 on page 2-9).

<table>
<thead>
<tr>
<th>Camera Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pan, Tilt, and Zoom</td>
<td>(Live video only) Open the PTZ preset list that allows you to quickly adjust the camera view. See the “Using Pan, Tilt, and Zoom (PTZ) Controls” section on page 2-29</td>
</tr>
<tr>
<td>Digital zoom</td>
<td>Digitally enlarges the image to zoom in on a specific area. Double click the enlarged image to use a window-in window view. Adjust the viewing area in the small window to define the portion of enlarged video to display.</td>
</tr>
<tr>
<td>Sync selected panes with this pane</td>
<td>Synchronizes the playback from multiple video panes to the same time. After a pane is synchronized, the menu item changes to Remove this pane from sync. To synchronize additional panes, right-click an un-synchronized pane and select Add selected panes to sync. See the “Synchronizing Video Playback in Multiple Panes” section on page 2-26.</td>
</tr>
</tbody>
</table>
Controlling Live and Recorded Video

Chapter 2  Viewing Video

Table 2-4 Video Pane Border Colors

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gray</td>
<td>The pane is not highlighted. All panes have a gray border by default.</td>
</tr>
<tr>
<td>Orange</td>
<td>The pane is selected as the active pane, and the controls and actions apply to that pane. If multiple panes are selected as active panes, the controls and actions performed on one pane apply to all active panes.</td>
</tr>
</tbody>
</table>
Using the Smooth Video Options When Viewing Live Video

If live video playback is choppy due to network or other performance issues, use the Smooth video settings to automatically do the following:

- Create a video data buffer (in seconds) that delays live playback while video data is cached. Live video can then be played back smoothly despite network delays between the camera, Media Server, and workstation.
- Automatically switch to a different stream if the live video quality is poor.

Icon Colors

The video quality icons in each pane indicate the following:

- Green indicates everything is fine.
- Yellow indicates that the client workstation has detected the playback is not smooth.
- Red indicates a severe adverse situation. Action will be taken to correct the situation, such as switching to secondary stream or iFrame streaming.

Usage Notes

- The Smooth Video Options are available only for live video on non-PTZ cameras (the Smooth Video Options are automatically disabled on PTZ cameras).
- The settings are applied to all non-PTZ cameras and are persistent for the current PC workstation. For example, the settings will remain if you log out and back in, or view a different camera and then return to the current camera.
- The settings also apply to the non-PTZ cameras when using the Cisco Safety and Security Desktop (SASD) application and the Cisco Video Surveillance Management Console.
- The Smooth Video options are disabled if you manually select a stream (right-click a video pane and choose Select Streams). The pane will display the selected stream even if the video quality is poor (the video will not automatically switch to the Smooth Video alternative stream). To cancel the manually selected stream and re-enable the Smooth Video settings, reload the view or drag and drop the camera again.
- If a video stream is selected from a redundant media server, the Smooth Video option is disabled (the camera will not use a secondary stream even if the video quality icon is red).

Procedure

Step 1 Right-click a live video image to open the pop-up menu.
Step 2 Select or deselect Enable Smooth Video for Live non-PTZ Camera to enable the smooth video options.
Step 3 (Optional) Enter the Preroll Buffer Size in Seconds to define the number of seconds that live video will be delayed.

Video data is saved in a cache on your PC to avoid pauses caused by network bandwidth and other issues. We recommend a value between 1.5 and 3 seconds.
Caution

We strongly recommend that the **Preroll Buffer** be disabled (enter 0 or leave the field blank) since streaming delays can cause a potential security risk. We recommend that you address the network bandwidth or performance issues causing the delays. Use the **Preroll Buffer** only when significant stuttering occurs and a network resolution is not available.

**Step 4**

Use the **Smooth Video Options** to define an alternative video stream that will be used if video quality is poor despite the smooth video buffer (video quality is indicated by the icon on the live viewing pane).

- **Secondary Stream**—(Only if configured on the camera) If the live video quality is poor, the secondary video stream is used. Secondary streams typically present a lower-quality image that requires less bandwidth and processing.

- **I frame only**—If the live video quality is poor, then only the iFrame video is displayed. iFrame video reduces the bandwidth requirement to correct the situation.

- **None**—If the live video quality is poor, no change is made and the selected stream is displayed even if it results in choppy or paused playback.

**Note**

- These options are not used if the video quality is acceptable or if the icon is yellow (**intermediate**). The selected stream is displayed normally.

- A down arrow is displayed when the secondary or iFrame stream is applied.

- If an alternative stream is applied, the settings remain until you close and reopen the video source (camera).

**Synchronizing Video Playback in Multiple Panes**

To synchronize video playback from multiple panes, select multiple panes, right-click the pane that defines the master time, and choose **Sync Selected Panes With This Pane**. All panes will play video from the same date and time.

**Usage Notes**

- All panes will play forward when synchronization begins, even if one or more of the panes was playing in reverse.

- Synchronization for recorded video is performed only if the time in the selected panes overlap. If the time for a video pane does not overlap with the master pane, the pane is excluded from synchronization.

- When you move the scroll bar for a video pane that is synchronized, that pane becomes the new synchronization master pane. The other synchronized panes play video according to the new master pane.

- If the seek controls are used to search video, the other synchronized panes pause until the seek completes, then continue to display video that is synchronized with the new master pane time.

- You can switch the synchronized panes between live and recorded video.
To remove a pane from the synchronized playback, right-click the pane and choose **Remove This Pane From Sync** to remove it.

To add un-synchronized panes, right-click the pane and choose **Add selected panes to sync**.

The **Select Streams** menu item is disabled when a pane is synchronized.

Figure 2-13 describes the main synchronization attributes.

---

**Figure 2-13  Synchronized Playback of Recorded Video**

1. The synchronization icon appears in the video panes that display synchronized video.
2. The timestamp for synchronized video is the same.
3. Roll over a synchronized pane to display the playback controls. Changes to any pane are mirrored by the other panes.
4. Unsynchronized panes can continue to display live or recorded video.
   - To add a pane to the synchronized group, right-click the pane and select **Add selected panes to sync**.
Procedure
To play recorded video from multiple video panes synchronized to the same time, do the following:

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Select a layout or pre-defined view from the View menu.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Shift-click or Control-click to select multiple video panes for synchronization. The selected panes are displayed with a light yellow border.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Right-click a video pane and select Sync Selected Panes With This Pane from the menu. The selected pane becomes the master pane.</td>
</tr>
<tr>
<td>Step 4</td>
<td>(Optional) To remove a pane from the synchronized group, right-click the pane and choose Remove This Pane From Sync.</td>
</tr>
<tr>
<td>Note</td>
<td>The pane continues to play video from the same timestamp, but the video can be stopped or altered without affecting the other panes.</td>
</tr>
<tr>
<td>Step 5</td>
<td>(Optional) To add un-synchronized panes, right-click the pane and choose Add selected panes to sync.</td>
</tr>
</tbody>
</table>
Using Pan, Tilt, and Zoom (PTZ) Controls

Cameras that support pan, tilt and zoom (PTZ) movements display a PTZ icon 🔄. To pan and tilt, left-click the image (the movement icons 🏼 appear) and drag the mouse right, left, up and down. To zoom, shift-click the image and drag the mouse up and down (to zoom in and out).

You can also use a USB joystick. See the “Calibrating a Joystick for Windows 7” section on page 2-31.

In addition, PTZ presets allow the camera to quickly jump to a preset position. For example, a PTZ preset could zoom in on a doorway, or pan to the opposite end of a parking lot. PTZ presets can be triggered using a mouse, joystick or automatically triggered event.

Note
Cameras can also be configured with PTZ tours that automatically cycle between PTZ preset positions. You can interrupt the tour using the PTZ controls, and the tour will resume after a set amount of time. See your system administrator for more information.

Figure 2-14 summarizes the controls and information available on each PTZ camera viewing pane.

Figure 2-14 Camera PTZ Controls

<table>
<thead>
<tr>
<th>1</th>
<th>Selected Camera</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>PTZ Enabled/Disabled Icon (click to toggle)</td>
</tr>
<tr>
<td>2</td>
<td>PTZ is available in Live mode only</td>
</tr>
<tr>
<td>4</td>
<td>PTZ Preset Menu (right-click to access)</td>
</tr>
</tbody>
</table>

Usage Notes
- PTZ movements are available only when viewing live video.
- PTZ can only be enabled for a single video pane if multiple panes are displayed. See the “Using PTZ Controls When Multiple Video Windows are Displayed” section on page 2-32.
- You must also belong to a user group with Perform PTZ permissions.
Procedure
To control a camera’s PTZ movement or trigger a PTZ preset position, do the following:

Step 1 Display the live video from a PTZ-enabled camera:
   a. Click Monitor Video.
   b. Expand the location tree and select the camera.
   c. Highlight a video pane and double-click a camera name.

Step 2 Verify that the PTZ controls are enabled:
   • —PTZ controls are supported by the camera and enabled in the viewing pane.
   • —PTZ controls are disabled. Click the icon to enable PTZ controls.

Note If a higher-priority user is using the PTZ controls, the PTZ controls remain locked and you cannot control the PTZ movements until released by the higher priority user.

Step 3 To move the camera position, use the following controls.

Using a Mouse
   - Pan and Tilt—Left-click the image and drag the mouse ( ) right, left, up and down.
   - Zoom—Shift-click the image and drag the mouse ( ) up and down to zoom in and out.

Using a USB Joystick
   - Pan—move the joystick bar horizontally.
   - Tilt—move the joystick bar vertically.
   - Zoom—twist the joystick.

Tip See the “Calibrating a Joystick for Windows 7” section on page 2-31 for information to set up a USB joystick for the first time.

Step 4 (Optional) Select a PTZ preset position.

Using a Mouse
   - Right-click the image and choose Pan, Tilt, and Zoom and then Presets (Figure 2-14).
   - Choose a preset to move the camera to the defined position.

Using a USB Joystick
   - Press the joystick button that corresponds to the PTZ preset number.
   - For example, joystick button 1 triggers PTZ preset 1, joystick button 2 triggers PTZ preset 2, etc.
Calibrating a Joystick for Windows 7

To use a USB joystick to control PTZ camera movements, connect the joystick to a USB port on the client PC and calibrate the device for Window 7. You can use the software and instructions included with the joystick, or use the built-in Windows calibration utility, as described in the following procedure.

Procedure

Step 1  Install and configure the USB joystick according to the manufacturer instructions.

- See the device documentation for more information.
- The manufacturer may also include a calibration utility that can be used instead of the built-in Windows utility.

Step 2  In Windows 7, calibrate the device using the Game Controllers control panel.

  a. Select Control Panel from the Start menu.
  b. Select Hardware and Sound.
  c. Select Devices and Printers.
  d. Double-click Game Controllers.
  e. Highlight the joystick device and click Properties.
  f. Click Calibrate in the pop-up window.
  g. Follow the on-screen instructions to complete the process.

Tip  You can also use the Windows search function: choose Search from the Start menu and enter “set up USB game controllers” to open the Game Controllers control panel. Highlight the joystick icon and click Calibrate. Follow the on-screen instructions to complete the process.

Step 3  Click Finish or OK to close the windows.
Using PTZ Controls When Multiple Video Windows are Displayed

When multiple viewing panes are displayed, only a single pane can have PTZ controls enabled at a time (Figure 2-15). This prevents a USB joystick from affecting more than one pane.

- The pane with PTZ enabled displays a icon. The icon indicates that PTZ controls are disabled.
- Click the disabled icon to enable the controls for a pane (and disable the controls for the other panes).
- If a pane does not display an icon, then the camera does not support PTZ movements.

![PTZ Controls in a Multi-Pane View](image)

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PTZ enabled viewing pane</td>
</tr>
<tr>
<td>2</td>
<td>PTZ disabled viewing pane</td>
</tr>
<tr>
<td>3</td>
<td>PTZ not supported by camera (no icon)</td>
</tr>
</tbody>
</table>

**Note**

PTZ movements are available only when viewing live video.

**Tip**

If multiple browser windows are used to display video, joystick PTZ commands will affect the enabled PTZ pane in each browser window.

**Tip**

See the “Configuring Camera PTZ Controls, Presets, and Tours” section on page 7-64 for instructions to configure a camera’s pan-tilt-zoom (PTZ) controls.
Viewing a Thumbnail Summary of Video Archives

Use Thumbnail Search to quickly locate specific scenes or events in recorded video. Thumbnails are an alternative way to search through recorded video without fast-forwarding or rewinding. Figure 2-16 provides an overview of the search and display controls. See the “Using Thumbnail Search” section on page 2-35 for step-by-step instructions.

**Figure 2-16  Thumbnail Window**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Selected Camera</td>
</tr>
<tr>
<td></td>
<td>Select a location and double-click a camera name to display a thumbnail summary of recorded video for the camera.</td>
</tr>
<tr>
<td></td>
<td>• Use the Recordings menu to select a camera stream.</td>
</tr>
<tr>
<td></td>
<td>• Cameras are displayed as tabs along the top of the window. Double-click multiple cameras to open a tab for each camera.</td>
</tr>
<tr>
<td></td>
<td>• Double-click an archive to play video in an Archive Player tab.</td>
</tr>
</tbody>
</table>

| 2 | Skip back |
|   | Skip back by the Duration time increment (see #7). This icon is disabled if the entire archive is selected. |

| 3 | Archive start time |
|   | The start date and time for the entire video archive. |
|   | See #4 to select a new start time, or right-click a thumbnail and choose Set Start. |
**Viewing a Thumbnail Summary of Video Archives**

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td><strong>Set Start Time</strong></td>
<td>The start date and time for the first thumbnail (in the top left corner of the window pane). To change the start thumbnail, select a new date and time and click <strong>Set Start</strong>. <strong>Tip</strong> You can also select a thumbnail image and select <strong>Actions &gt; Set Start</strong> to set the start time to a specific thumbnail (or right-click the thumbnail image and select <strong>Set Start</strong>).</td>
</tr>
<tr>
<td>5</td>
<td><strong>Timeline</strong></td>
<td>Timeline representing the entire video archive.</td>
</tr>
<tr>
<td>6</td>
<td><strong>Start time slider</strong></td>
<td>The slider represents the Duration setting relative to the length of the entire archive. If the Duration setting is for the entire archive, the black slider covers the entire time line and cannot be moved. To use the slider, choose a <strong>Duration</strong> that is less than the entire archive time and drag the slider to a different start time (the time is displayed above the slider). Release the mouse button to choose the new time.</td>
</tr>
<tr>
<td>7</td>
<td><strong>Duration</strong></td>
<td>Choose the time span for the displayed thumbnails. The top left thumbnail displays an image from the beginning of the time span and the bottom left thumbnail displays an image from the end of the time span. The number of thumbnails and the intervals between them depend on the size of the Forensic Search window and the thumbnail size that you choose from the <strong>Thumbnail Size</strong> menu.</td>
</tr>
<tr>
<td>8</td>
<td><strong>Show Timestamp</strong></td>
<td>Check this check box to show the date and time displayed at the top of each thumbnail.</td>
</tr>
<tr>
<td>9</td>
<td><strong>Archive end time</strong></td>
<td>End date and time for the entire video archive.</td>
</tr>
<tr>
<td>10</td>
<td><strong>Skip forward</strong></td>
<td>Skip forward by the <strong>Duration</strong> time increment.</td>
</tr>
<tr>
<td>11</td>
<td><strong>Timestamp</strong></td>
<td>Displays the date and time for each thumbnail. Select the <strong>Show Timestamp</strong> check box to turn timestamps on or off.</td>
</tr>
<tr>
<td>12</td>
<td><strong>Video thumbnails</strong></td>
<td>Thumbnails are displayed for the time span that is selected in the Duration drop-down menu. Use the <strong>Thumbnail Size</strong> menu to display larger or smaller thumbnails.</td>
</tr>
<tr>
<td>13</td>
<td><strong>Actions Menu</strong></td>
<td>Right click a thumbnail to select an option from the Actions menu (see #17).</td>
</tr>
<tr>
<td>14</td>
<td><strong>Display length</strong></td>
<td>The duration of the displayed thumbnails.</td>
</tr>
<tr>
<td>15</td>
<td><strong>Camera tabs</strong></td>
<td>A tab is displayed for each selected camera. Click the <strong>Recordings</strong> menu to select an available camera stream or recording.</td>
</tr>
<tr>
<td>16</td>
<td><strong>Archive Player tab</strong></td>
<td>An Archive Player tab plays video when you select a thumbnail and select <strong>Actions &gt; Play</strong> (or right-click a thumbnail and click <strong>Play</strong>).</td>
</tr>
</tbody>
</table>
### Viewing a Thumbnail Summary of Video Archives

**Summary Steps**

To view a thumbnail summary of a camera’s recordings:

1. Select Monitor and click **Thumbnail Search** (Thumbnail Search) to open the forensic search tool in a separate window (Figure 2-16).
2. Select a location and double-click a camera name.
3. Use the tools described in Figure 2-16 to locate specific video.
4. Select a different stream from the **Recordings** menu.
5. Double-click a thumbnail to play the video. You can also select a thumbnail and select **Play** from the **Actions** menu.
6. See the “**Detailed Procedure**” for more information.

| Selections | **Thumbnail Size**—select a smaller size to display more thumbnails for the displayed video duration. Select a larger size to display fewer thumbnails.
| **Recordings**—select a video stream or recording.
| **Actions**—choose one of the following options:
| **Note** You can also right-click a thumbnail to access the **Actions** (see #13). |

- **Set Start**—Sets the selected thumbnail as the first thumbnail in the range. *(Tip: to select a specific date and time as the start time, use the menu at that appears beneath the thumbnails as described in #4 “**Thumbnail Start Time**”).
- **Play**—Plays the video from the selected thumbnail in an **Archive Player** tab.
  - You can also double-click a thumbnail to play video.
  - Playback begins from the start timestamp. If a start timestamp is not available, the next available frame is displayed.
- **Zoom To**—Set the beginning and ending thumbnail for the display. Shift-click or Ctrl-click to select multiple thumbnails and choose **Zoom To** from the **Actions** menu. The first frame in the selected thumbnails becomes the new start time. The last frame in the selected thumbnails becomes the new end time.
- **Zoom In**—Decreases the displayed thumbnail duration to the next available duration value. If no frames are selected, the start time does not change. If one frame is selected, that frame becomes the start time. If more than one frame is selected the frame closest to the beginning of the archive becomes the start time.
  
  **Zoom In** is not available when the minimum duration is set.
- **Zoom Out**—Increases the duration of the displayed thumbnail duration to the next available duration value. The start time remains the same. For example, if the Duration is 3 hours, choose the **Zoom Out** option to increase the Duration to approximately 6 hours.
  
  If the start time plus the duration would exceed the length of the archive, the start time will be adjusted to the archive’s end time minus the duration.
  
  **Zoom out** is not available when the maximum duration is set.
Detailed Procedure

Step 1  Click Monitor.

Step 2  Click Thumbnail Search (Thumbnail Search) to open the forensic search window (Figure 2-16).

Step 3  Select a location and double-click a camera name.

The camera name appears as a tab at the top of the thumbnail display. You can select multiple cameras to open multiple tabs.

Step 4  Use the controls described in Figure 2-16 to refine the search.

For example:

- To change the first thumbnail in the display, select a date and time from the menu below the thumbnails (12/04/2012 00:00:00 Standard Time) and click Set Start. The thumbnail for the selected date and time is displayed in the top left corner (you can also right-click a thumbnail and choose Set Start).

- Choose the Duration (Duration) of the thumbnail display. For example, choose 1 Hour to display thumbnails for a single hour. The default is Entire Archive.

- Click the skip icons to skip back or forward by the Duration time. For example, if the Duration is 1 hour, click the skip buttons to skip forward or back by 1 hour.

- Click and drag the slider to a new start time.

  - The slider date and time appears when the slider is selected.

  - Release the mouse button to refresh the thumbnail display with the time displayed above the slider.

  Note  The slider length represents the thumbnail duration relative to the entire length of the archive. The gray time line equals 100 percent of the archive. The black slider covers the entire time line if the selected Duration is Entire Archive (default).

- Choose a Thumbnail Size to enlarge or reduce the size of each thumbnail. Larger sizes display fewer thumbnails, and each thumbnail represents a greater time span.

Step 5  (Optional) Further refine your search by choosing one or more thumbnails and choosing one of the following options in the Actions menu.

Tip  You can also right-click a thumbnail to access the Actions.

- Set Start—Sets the selected thumbnail as the first thumbnail in the range (you can also select a specific date and time using the Set Start menu below the thumbnail display).

- Play—Plays the selected thumbnail video in an Archive Player tab.

  - You can also double-click a thumbnail to play video.

  - Playback begins from the start timestamp. If a start timestamp is not available, the next available frame is displayed.
• **Zoom To**—Set the beginning and ending thumbnail for the display. Shift-click or Ctrl-click to select multiple thumbnails and choose **Zoom To** from the **Actions** menu. The first frame in the selected thumbnails becomes the new start time. The last frame in the selected thumbnails becomes the new end time.

• **Zoom In**—Decreases the displayed thumbnail duration to the next available duration value. If no frames are selected, the start time does not change. If one frame is selected, that frame becomes the start time. If more than one frame is selected the frame closest to the beginning of the archive becomes the start time. **Zoom in** is not available when the minimum duration is set.

• **Zoom Out**—Increases the duration of the displayed thumbnail duration to the next available duration value. The start time remains the same. For example, if the Duration is 3 hours, choose the **Zoom Out** option to increase the Duration to approximately 6 hours.

  If the start time plus the duration would exceed the length of the archive, the start time is be set to the end of the archive minus the duration.

  **Zoom out** is not available when the maximum duration is set.
CHAPTER 3

Configuring Video Viewing Options

Refer to the following topics to configure the viewing options that can be accessed using the Cisco Video Surveillance Safety and Security Desktop application, the Cisco VSM Operations Manager, or other supported video viewing applications.

Tip
For instructions to view video using the Cisco Safety and Security desktop application, see the Cisco Video Surveillance Safety and Security Desktop User Guide.

Contents
- Creating Pre-Defined Views, page 3-2
- Configuring Video Walls, page 3-9
- Enabling Record Now, page 3-11

Additional Documentation
- Configuring Camera PTZ Controls, Presets, and Tours, page 7-64
- Configuring Motion Detection, page 7-76
- Editing the Camera Settings, page 7-42
- Adding and Editing Camera Templates, page 9-1
Creating Pre-Defined Views

Use Operations Manager to create Views that can be displayed in either Operations Manager or the Cisco Safety and Security desktop application. You can create Views in one of the following ways:

- **Saving a Basic View, page 3-2**—Quickly create and save a View with up to four video panes using the Monitor Video page.
- **Creating Rotating Views, page 3-4**—Create Views with more than four video panes. View can include static panes that always display video from a specific camera, or rotating panes that rotate the video from multiple camera sources. For example, a View might include 3 video panes that rotates the video from 8 cameras to provide a virtual tour of a building, and a static pane that always displays video from a specified camera.

**Saving a Basic View**

You can create a basic View by saving a layout in the Monitor Video page. The panes in a basic View are static and do not rotate. Views can be accessed using either Operations Manager or the Cisco Safety and Security desktop application.

Tip

Operations Manager can display Views with up to four video panes. To create Views with more than four panes for use by the Safety and Security desktop application, see the “Creating Rotating Views” section on page 3-4.

**Procedure**

**Step 1**

Log on to the Operations Manager.

You must belong to a User Group with permissions for Views.

**Step 2**

Click Monitor Video.

**Step 3**

Click View Menu and then Select Layout.

**Step 4**

Select a blank Layout from the list.

**Step 5**

Drag and drop cameras from the camera list in the left column to the available video panes.

**Step 6**

Save the layout as a new View.

a. Choose Current View > Save As from the View Menu (Figure 3-1).
b. Enter a name and *Access Location*.
   - Views can be assigned to the same location as the cameras, or to a higher level location.
   - Only users assigned to a user group with this location can access the View.

c. Click *Save*.

**Step 7** Verify that the new View appears under *View Menu > Select View*. 
Creating Rotating Views

The Views feature allows you to create Views with up to 16 video panes (Figure 3-2). The panes in a View can be static (always display the video from a single camera, or rotate video from multiple cameras. For example, you can create a virtual tour of all Lobby Doors that rotates the video from 8 cameras between 3 panes while a 4th static pane always shows the rear door.

The Current Rotation Order defines which camera is displayed first, second, etc.

Note: Views with more than four video panes can be displayed using the Cisco Safety and Security desktop application (Operations Manager can only display Views with four or less panes).

Figure 3-2 View Configuration

- Static camera panes always display video from the same camera, even if the other panes rotate video from multiple cameras.
  - Click the camera icon to select the camera source.
  - Not Assigned panes do not have a camera assigned to the pane. The video pane will appear blank in the View.
- Rotating camera panes rotate the video between cameras included in the Current Rotation Order.
  - Click Add Camera to add the cameras that will rotate between the available panes.
  - Use the arrows in the Current Rotation Order to change the order of the rotation.
Procedure
To create Views that include static and/or rotating panes, do the following.

**Step 1** Log on to the Operations Manager.
- You must belong to a User Group with permissions for Views.

**Step 2** Click System Settings and then Views.

**Step 3** Edit or add a View (Figure 3-3):
- To edit a View, select an existing entry.
- To add a View, click the Add button.

**Figure 3-3 Defining the Camera View**

**Step 4** Enter the basic View properties (Figure 3-3):

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>(Required) enter a descriptive name for the View. For example: Exterior Doors.</td>
</tr>
<tr>
<td>Access Location</td>
<td>(Required) click the icon and select a location. Only users assigned to a user group with this location can access the View.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> The cameras included in a View must be at the same View access location, or a sub-location. For example, a View assigned to a Texas location cannot include cameras from a California location. See the “Understanding Permission-Based and Partition-Based Resources” section on page 5-3 for more information.</td>
</tr>
<tr>
<td>Tags</td>
<td>(Optional) Words that assist in a Find.</td>
</tr>
</tbody>
</table>
Step 5  Define the static panes.

Static camera panes always display video from the same camera, even if the other panes rotate video from multiple cameras. Static panes display the lock icon (Figure 3-4).

### Figure 3-4  Select the Static Cameras

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>(Optional) enter a meaningful description for the View. For example: Lobby Tour.</td>
</tr>
<tr>
<td>Layout</td>
<td>(Required) select a layout grid that includes the required number of video panes.</td>
</tr>
</tbody>
</table>

a. Click the icon to toggle the pane to static , if necessary (Figure 3-4).
b. Click the camera icon.
c. Select a camera from the location tree and click Set.
d. Repeat these steps for each additional static video pane.
Tip
Roll over the pane to display additional icons (Figure 3-4). Click to clear the camera selection (the pane changes to Not Assigned and the video pane will appear blank). Click for camera information. Click to select a different camera.

Step 6 (Optional) Define the rotating panes and Rotation Order (Figure 3-5).
Rotating panes rotate the video between cameras included in the Current Rotation Order. Cameras rotate clockwise: left to right and then top to bottom. For example, when the View is first displayed, the first camera in the Current Rotation Order is displayed in the Rotating 1 pane, the second camera is displayed in the Rotating 2 pane, etc. The camera set is displayed until the number of Rotate seconds is exceeded. The next set of cameras are then displayed in Rotating 1 and Rotating 2 in the Current Rotation Order, etc.

Figure 3-5 Defining the Camera Rotation

a. Define the panes that will rotate the cameras included in the Current Rotation Order.
   - Panes with the icon are included in the rotation.
   - Click the lock icon to toggle the pane to rotation, if necessary.

b. Add cameras to the Current Rotation Order.
   - Click Add Camera (Add Camera).
   - Select a camera from the location tree.
   - Click Set.
   - Add additional cameras to the Current Rotation Order. For example, you could add six cameras that rotate between two rotating panes.
Creating Pre-Defined Views

Tip  Click to remove a camera from the *Current Rotation Order*.

c. Select the *Rotate* seconds (the number of seconds the View is displayed between rotations).
   The View will pause on a set of cameras before rotating to the next camera in the list.

d. Reorder the cameras in the *Current Rotation Order* using the up ▲ and down ▼ arrows.
   When the View is first displayed, the first camera in the *Current Rotation Order* is displayed in the *Rotating 1* pane, the second camera is displayed in the *Rotating 2* pane, etc.

**Step 7**  Click **Save**.
Configuring Video Walls

Video Walls are unattended screens that display a pre-defined set of video panes. Video Walls are typically monitored by a security guard or other attendant.

Use the following procedure to create Video Walls and define the default View.

**Tip**
- Refer to the *Cisco Video Surveillance Safety and Security Desktop User Guide* for instructions to display the Video Walls.
- To automatically display video from a different camera when an event occurs, see the “Using Advanced Events to Trigger Actions” section on page 9-11. This feature allows you to switch all instances of a Video Wall to the live or recorded video from a camera that triggers an event. For example, if motion occurs or a door is opened, the Video Wall can automatically switch to the video from the camera that triggered the event.
- This feature is similar to the Virtual Matrix client available in Cisco VSM release 6.x.

**Procedure**
Complete the following procedure to create or edit Video Walls.

**Note**
Any changes to existing Video Walls will be automatically published to all instances of that Video Wall. For example, if you change the default View, all workstations viewing that Video Wall will automatically change to the new View.

**Step 1**
Log on to the Operations Manager.
- You must belong to a User Group with permissions for Video Walls.

**Step 2**
Create one or more Views.
- See the “Creating the Location Hierarchy” section on page 5-1 for more information.

**Step 3**
Choose System Settings > Video Wall.

**Step 4**
Click Add or select an existing entry.

**Step 5**
Complete the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name selected by users.</td>
</tr>
<tr>
<td>Access Location</td>
<td>SASD users can view Video Wall that are assigned to the same location or lower.</td>
</tr>
<tr>
<td></td>
<td>For example, if a user is assigned to a user group with the location “California”, they can access Video Walls assigned to that location, or a sub-location. The user cannot access Video Walls assigned to higher-level locations.</td>
</tr>
<tr>
<td></td>
<td>See the “Creating the Location Hierarchy” section on page 5-1 for more information.</td>
</tr>
</tbody>
</table>
Chapter 3      Configuring Video Viewing Options

Configuring Video Walls

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default View</td>
<td>(Optional) The View displayed when a Video Wall is selected in the SASD application.</td>
</tr>
<tr>
<td></td>
<td>• If a SASD user chooses a different View and clicks Publish to Wall, then all other instances of that Video Wall will display the new View until the rollback time expires (see below). All displays will then revert back to the default View.</td>
</tr>
<tr>
<td></td>
<td>• The Publish to Wall feature is enabled for user groups with the Push Video to Wall permission.</td>
</tr>
<tr>
<td>Tip</td>
<td>Select the No Default View option to disable the rollback time and display any selected View. A blank screen is displayed when the Video Wall is first selected, and any Views published to that wall (including video from Advanced Events) are displayed until a new View is selected.</td>
</tr>
<tr>
<td></td>
<td>Refer to the Cisco Video Surveillance Safety and Security Desktop User Guide for more information.</td>
</tr>
<tr>
<td>Rollback Time</td>
<td>The amount of time that an alternative View can be displayed on a Video Wall before the default View is restored.</td>
</tr>
</tbody>
</table>

Step 6  Click Add or Save.

Step 7  (Optional) Configure Advanced Events to use Push to Video Wall when an event occurs.

• This feature automatically switches all instances of a Video Wall to the live or recorded video from a camera that triggers an event. See the “Using Advanced Events to Trigger Actions” section on page 9-11.

Step 8  Access the Video Walls using the Cisco SASD application:

a. Launch the SASD application and log in.

b. Select a Video Wall from the Wall menu.

c. (Optional) Select a View and click Publish to Wall.

  – The new View will appear on all other windows that display the same Video Wall. When the rollback time expires, the default Video Wall view is restored (if configured).

  – The Publish to Wall feature is enabled for user groups with the Push Video to Wall permission.
Enabling Record Now

Record Now allows users to trigger an immediate recording that is performed in addition to any other scheduled, continuous or event recordings. These recordings are retained on the system for the number of days specified in the camera’s Retain event recordings setting.

HA Availability for Record Now
The Record Now feature is available on the primary server, or on the failover server if the primary is down. The Record Now feature is not available on redundant servers.

See the “High Availability” section on page 11-1 for more information.

Using Record Now
See the “Using Record Now” section on page 2-22 for end-user instructions to trigger recordings.

Summary Steps to Enable Record Now
To enable the Record Now option, you must define the following:

- Add the users to a User Group with Operate permissions to View Live Video and View Recordings.
- In the camera template, enable the Record Now option and define the number of retention days. Assign the camera(s) that should allow Record Now to that template.
- Define the Record Now Duration in system settings.

Procedure to Enable Record Now

**Step 1** Add user access permissions to view live and recorded video.
   a. Select Users.
   b. Select the Roles tab.
   c. Edit or add a Role:
      - To edit a Role, click an existing entry to highlight it.
      - To add a Role, click the Add button.
   d. Select the Operate permissions to View Live Video and View Recordings.
   e. Click Save.
   f. Select the User Groups tab.
   g. Select the Role that includes the view permissions.
   h. Add the users to the role.
   i. Click Save.
      - See the “Adding Users, User Groups, and Permissions” section on page 4-1 for more information.

**Step 2** Enable the Record Now option in the camera template.
   a. Click Cameras.
   b. Click Templates.
   c. Select a location and template name.
   d. Click the Streaming, Recording and Events tab.
e. In the Retain event recordings setting, enter the number of days the recordings (and other event video) should be retained on the system.

f. Scroll down to Record Now and select Enable.

g. Click Save.

h. Assign cameras to the template, if necessary (click Cameras, select a sample, click the Streaming, Recording and Events tab, and assign the template to the camera).

For more information, see the “Adding and Editing Camera Templates” section on page 9-1 and the “Streaming, Recording and Event Settings” section on page 7-49.

**Step 3** Define the duration of all Record Now recordings.

a. Choose Settings > System Settings.

b. Select the General tab.

c. In the Record Now Duration field, enter the number of seconds that video will be recorded for all Record Now requests.

The minimum value (and default) is 300 seconds (5 minutes).

d. Click Save.
Adding Users, User Groups, and Permissions

Refer to the following topics to create user accounts and define the features and functions that can be accessed by those users. Access permissions include operator permissions and manage (configuration) permissions.

You can also provide access to users that are managed on an external (LDAP) server.

Contents
- Overview, page 4-1
- Defining User Roles, page 4-8
- Adding User Groups, page 4-10
- Adding Users, page 4-13
- Adding Users from an LDAP Server, page 4-15

Overview

Cisco Video Surveillance Manager (Cisco VSM) users can monitor video or configure the system based on the following:

- The user group(s) to which the user is assigned: user groups are associates with a user Role, which defines the access permissions for the group.
- The location assigned to the user group(s).
- Users can be assigned to multiple user groups, and gain the combined access permissions for all groups.

Before you begin, create the location hierarchy as described in the “Creating the Location Hierarchy” section on page 5-1. Carefully review the “Examples: Locations in Simple vs. Large Deployments” section on page 5-7.

Tip
User accounts provide access to both the browser-based Operations Manager and the Cisco Safety and Security desktop application.
Overview

Review the following topics to understand how to configure users and user access permissions in Cisco VSM.

- Understanding Roles, Groups and Users, page 4-2
- Understanding the System-Defined User Roles, Groups and Accounts, page 4-3
- Understanding Permissions, page 4-4
- Example Roles For Different Types of Users, page 4-7

Understanding Roles, Groups and Users

Figure 4-1 summarizes the user Roles, groups and user accounts.

Roles define the access permissions for different types of users (such as Administrators and Operators). Roles are assigned to one or more user groups.

Each User Group is assigned a single Role. Any user added to that User Group inherits the access permissions defined by the Role. User Groups are also associated with a location and other attributes to further restrict user access to cameras and other data.

Users define the usernames and passwords for individual users. Users are assigned to one or more User Groups, and inherit the permissions defined by the Role for each of those Groups.

Roles define the access permissions for different types of users. For example, create an operator Role that allows users to view live and recorded video, and an administrator Role that allows users to configure cameras and add new users.

When the Roles are assigned to a user group, any user added to that group will inherit the Role permissions. Users also gain access to different types of resources based on the user group location.

For example, create an Operator Role that allows users to view video, but does not allow configuration of cameras or other system resources. When you add that Role to a user group, any user added to the group will inherit the Role permissions. In addition, users can access the devices at the group location (including sub-locations), and the templates, schedules and other resources for any location in the same location tree.

Tip

See the “Examples: Locations in Simple vs. Large Deployments” section on page 5-7 for more information on user access based on a group’s location.
Understanding the System-Defined User Roles, Groups and Accounts

By default, Cisco VSM includes system-defined Roles, groups and users to aid in the initial configuration (see Table 4-1). System-defined Roles, groups and users cannot be updated or deleted.

Table 4-1  System-Defined User Roles, Groups and Accounts

<table>
<thead>
<tr>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| Roles   | • super_admin_role—includes all management and operation access permissions.  
         | • local_admin_role—provides all operator functions, but limited and commonly used management tasks such as managing cameras, Media Servers, encoders, Video Walls, locations & maps, views and alerts.  
         | • operator_role—provides all operator permissions. |
| User Groups | • super_admins—assigned the super_admin_role.  
              | • operators—assigned the operator_role. |
| Users    | • admin—assigned to the super_admins user group, which gives the user super_admin_role permissions. The admin is a root system user and cannot be modified or deleted. The default admin username and password is admin/admin.  
         | Note A super-user is anybody that has all permissions at the root location.  
         | • operator—assigned to the operators user group, which gives the user operator_role permissions. The default username and password is operator/operator.  
         | Note A local-admin user account is not included by default. You must add a user and add them to a user group associated with the local_admin_role, if necessary. |
| LDAP Users | Members of an external Lightweight Directory Access Protocol (LDAP) Active Directory user database can be granted access to Cisco VSM. See the “Adding Users from an LDAP Server” section on page 4-15 for more information. |
Understanding Permissions

User Roles define the permissions for different types of users. Click the Roles tab to view or modify the permissions assigned to a Role (Figure 4-2). Permissions are divided into two categories: Manage and Operate. Select or de-select the check boxes to add or remove permissions.

Default Roles
The default Roles are read-only and cannot be revised or deleted. For example:

- **operator_role**—Includes most Operator permissions.
- **super_admin_role**—Includes all operate and manage permissions (a super-admin is any user that has access to all permissions).
- **local_admin_role**—Includes a combination of operate and manage permissions.

Tip
Select a Role to view the permissions assigned to that Role. See Table 4-2 and Table 4-3 for descriptions of the Operate and Manage roles. See the “Defining User Roles” section on page 4-8 to create or revise Roles.

Figure 4-2 Permissions
Note

- Selecting a permission may automatically result in the selection of other dependent permissions if the permissions overlap. For example, if you select the Manage Cameras permission, the View Live Video and Perform PTZ permissions are automatically selected. The automatically selected dependent permission(s) cannot be deselected unless the parent permission is deselected first.
- See the “Defining User Roles” section on page 4-8 for detailed instructions.

Table 4-2 summarizes the Manage permissions:

Tip

Click Manage All to select all of the permissions.

<table>
<thead>
<tr>
<th>Manage Permission</th>
<th>Description</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users &amp; Roles</td>
<td>Create, update, or delete user accounts, groups and Roles.</td>
<td>Adding Users, User Groups, and Permissions, page 4-1</td>
</tr>
<tr>
<td>Cameras</td>
<td>Create, delete, or update Cisco VSM cameras.</td>
<td>Adding and Managing Cameras, page 7-1</td>
</tr>
<tr>
<td></td>
<td>Includes access to camera discovery, auto-configuration and the Pending Approval functions.</td>
<td></td>
</tr>
<tr>
<td>Media Servers and Encoders</td>
<td>Create, update, or delete Cisco media servers and analog camera encoders.</td>
<td>Configuring Media Servers, page 6-1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Adding Encoders and Analog Cameras, page 10-1</td>
</tr>
<tr>
<td>Video Walls</td>
<td>Create, update, or delete Video Walls.</td>
<td>Configuring Video Walls, page 3-9</td>
</tr>
<tr>
<td>Templates</td>
<td>Create, update, or delete camera templates.</td>
<td>Adding and Editing Camera Templates, page 9-1</td>
</tr>
<tr>
<td>Schedules</td>
<td>Create, update, or delete schedules.</td>
<td>Defining Schedules, page 8-1</td>
</tr>
<tr>
<td>Locations &amp; Maps</td>
<td>Create, update, or delete Cisco VSM locations and associated map images.</td>
<td>Creating the Location Hierarchy, page 5-1</td>
</tr>
<tr>
<td>Views</td>
<td>Create, update, or delete pre-set video views used to monitor multiple video cameras.</td>
<td>Creating Pre-Defined Views, page 3-2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Selecting a Multi-Pane “View”, page 2-4</td>
</tr>
<tr>
<td>System Settings</td>
<td>Update Cisco VSM system settings.</td>
<td>Revising the System Settings, page 13-1</td>
</tr>
<tr>
<td>Images</td>
<td>Allows the user to upload firmware images, define the recommended firmware version, and upgrade devices.</td>
<td>Upgrading Camera and Encoder Driver Firmware, page 7-82</td>
</tr>
</tbody>
</table>
Some permissions are mutually exclusive. For example, you can select either View Live Video or View Secondary Stream Only but not both at the same time. If you select View Secondary Stream, the mutually exclusive permission will be automatically deselected.

Click Operate All to select all of the permissions, except View Secondary Stream Only.

Table 4-3 Operate Permissions

<table>
<thead>
<tr>
<th>Operation Permissions</th>
<th>Description</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Live Video</td>
<td>View live video streams from Cisco VSM cameras.</td>
<td>Viewing Live Video, page 2-8</td>
</tr>
<tr>
<td>Note</td>
<td>If selected, View Secondary Stream Only will be automatically deselected.</td>
<td></td>
</tr>
<tr>
<td>View Recordings</td>
<td>View recorded video from Cisco VSM cameras.</td>
<td>Viewing Recorded Video, page 2-11</td>
</tr>
<tr>
<td>Listen To Audio</td>
<td>Play live or recorded audio from cameras that support audio.</td>
<td>Editing the Camera Settings, page 7-42</td>
</tr>
<tr>
<td>Export Recordings</td>
<td>Export a video clip to a file.</td>
<td>Creating Video Clips, page 2-15</td>
</tr>
<tr>
<td>Perform PTZ</td>
<td>Use the pan, tilt and zoom controls on cameras that support PTZ.</td>
<td>Using Pan, Tilt, and Zoom (PTZ) Controls, page 2-29</td>
</tr>
<tr>
<td>Push Video to Wall</td>
<td>Enables the Publish to Wall feature in the Cisco Safety and Security Desktop (SASD) application. This feature allows users to change the view shown by all other instances of a selected video wall. The new view is displayed until the dwell time is exceeded.</td>
<td>Configuring Video Walls, page 3-9 Cisco Video Surveillance Safety and Security Desktop User Guide</td>
</tr>
<tr>
<td>Note</td>
<td>If selected, View Secondary Stream Only will be automatically deselected.</td>
<td></td>
</tr>
<tr>
<td>Alerts</td>
<td>Allows all operators to view the alerts for cameras they can access. Users can acknowledge, clear, or comment on an alert (ack/clear/add_user_comment).</td>
<td>Cisco Video Surveillance Safety and Security Desktop User Guide</td>
</tr>
<tr>
<td>View Secondary Stream Only</td>
<td>Members of user groups with this permission can only view the secondary stream of cameras. If the secondary stream is not available, no video feed is shown.</td>
<td>Editing the Camera Settings, page 7-42</td>
</tr>
<tr>
<td>Note</td>
<td>If selected, View Live Video and Push Video to Wall will be automatically deselected.</td>
<td></td>
</tr>
</tbody>
</table>
Example Roles For Different Types of Users

Table 4-4 describes sample Roles and associated permissions.

Table 4-4 Sample Roles in a Cisco Video Surveillance Deployment

<table>
<thead>
<tr>
<th>Role</th>
<th>Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guard</td>
<td>View Live Video</td>
</tr>
<tr>
<td></td>
<td>View Recordings</td>
</tr>
<tr>
<td></td>
<td>Listen to Audio</td>
</tr>
<tr>
<td></td>
<td>Export Recordings</td>
</tr>
<tr>
<td></td>
<td>Perform PTZ</td>
</tr>
<tr>
<td>Area Admin</td>
<td>View Live Video</td>
</tr>
<tr>
<td></td>
<td>View Recordings</td>
</tr>
<tr>
<td></td>
<td>Export Recordings</td>
</tr>
<tr>
<td></td>
<td>Perform PTZ</td>
</tr>
<tr>
<td></td>
<td>Manage Cameras</td>
</tr>
<tr>
<td></td>
<td>Manage Media Servers and Encoders</td>
</tr>
<tr>
<td>Admin</td>
<td>View Live Video</td>
</tr>
<tr>
<td></td>
<td>View Recordings</td>
</tr>
<tr>
<td></td>
<td>Export Recordings</td>
</tr>
<tr>
<td></td>
<td>Perform PTZ</td>
</tr>
<tr>
<td></td>
<td>Manage Users &amp; Roles</td>
</tr>
<tr>
<td></td>
<td>Manage Cameras</td>
</tr>
<tr>
<td></td>
<td>Manage Media Server and Encoders</td>
</tr>
<tr>
<td></td>
<td>Manage Templates</td>
</tr>
<tr>
<td></td>
<td>Manage Schedules</td>
</tr>
<tr>
<td></td>
<td>Manage Location and Maps</td>
</tr>
<tr>
<td></td>
<td>Manage System Settings</td>
</tr>
</tbody>
</table>
Defining User Roles

User Roles define the functions and features available to members of a user group. For example, you can create a Role for Operators who only monitor video, and another Role for Administrators who also configure the cameras, schedules, users, or other features of the Cisco VSM deployment.

Tip
See Understanding Permissions, page 4-4 for more information.

Once created, Roles are assigned to one or more user groups. Users gain the access permissions of the user groups Role.

Procedure
To create user Roles, do the following:

Step 1 Log on to the Operations Manager.
- See the “Logging In” section on page 1-17.
- You must belong to a User Group with permissions to manage Users & Roles.

Step 2 Select Users.

Step 3 Select the Roles tab.

Step 4 Edit or add a Role:
- To edit a Role, click an existing entry to highlight it.
- To add a Role, click the Add button.
Step 5 Enter the basic settings:

Table 4-5 Role Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>(Required) Enter a meaningful name.</td>
</tr>
<tr>
<td>Location</td>
<td>(Required) Select the location where the Role can be used.</td>
</tr>
<tr>
<td>Tags</td>
<td>(Optional) Enter keywords used by the Find function.</td>
</tr>
<tr>
<td>Description</td>
<td>(Optional) Enter a description of the permissions granted by the Role.</td>
</tr>
</tbody>
</table>

Step 6 (Required) Select or deselect the Role permissions.

See the “Understanding Permissions” section on page 4-4 for more information.

Step 7 (Optional) Add one or more user groups to the Role.

a. Click Add under the user groups box.

b. Select an existing user group.

c. Click OK.

See the “Adding User Groups” section on page 4-10 for more information.

Step 8 Select Create or Save.

Step 9 (Optional) Add the Role to one or more user groups.

See the “Adding User Groups” section on page 4-10 for instructions.
Adding User Groups

User groups allow multiple users to be assigned the same set of access permissions. For example, all lobby attendants can be assigned to a user group *Lobby* and security personnel to an *Administrator* group. Although members of the Lobby group can view live and recorded video, they cannot make configuration changes. Security administrators, however, can manage templates, schedules cameras, users, or other resources. These permissions are defined by the user Role assigned to the user group.

User groups are also associated with a specific location, allowing you to limit access to the Cisco VSM resources in a specific location (such as a campus, building, or floor). See the “Creating the Location Hierarchy” section on page 5-1 for more information.

If a user belongs to more than one user group, the user inherits the combined rights and permissions of all the groups.

**Figure 4-4   Creating User Groups**

![Creating User Groups](image)

**Procedure**

To create a user group, do the following:

**Step 1** Select *Users*, and then select the *User Groups* tab.

- The currently configured user groups are listed in the left column.

**Step 2** Edit or add a user group:

- To edit a group, click an existing entry to highlight it, and continue to Step 3.
- To add a group, click the *Add* button.
Step 3 Enter the group settings (see Table 4-6):

Table 4-6 User Group Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>(Required) Enter a meaningful name.</td>
</tr>
<tr>
<td>Access Location</td>
<td>(Required) Select the location that the users in this group will have access to. For example, select California to restrict access to equipment and associated video (such as cameras, Media Servers and video streams) that are also assigned to California or a sub-location.</td>
</tr>
<tr>
<td>Location Exception(s)</td>
<td>(Optional) Select the locations within the Access Location that users should not be able to access. For example, if you select the Access Location California, and the Location Exception San Francisco, users in the group can access all California locations except San Francisco.</td>
</tr>
<tr>
<td>Role</td>
<td>(Required) Select the Role that defines the access permissions for the group. To create or modify the available Roles, see the “Defining User Roles” section on page 4-8.</td>
</tr>
<tr>
<td>PTZ priority over other User Groups</td>
<td>(Required) Select a number from 1 to 100 that defines use user group priority (relative to members of other user groups) to use a camera’s pan, tilt and zoom (PTZ) controls. User groups with a higher number have priority over groups with a lower number. For example, assign Operators a priority of 50, and Administrators a priority number 60. Assign security personnel priority 70, and building managers priority 80. See the “Defining the User Group PTZ Priority” section on page 7-68 for more information. The default is 100 (highest priority).</td>
</tr>
<tr>
<td>Note</td>
<td>If two users belong to user groups with the same priority, then the first user to access the PTZ controls gains priority and can continue to use the controls.</td>
</tr>
<tr>
<td>Note</td>
<td>You can also define the idle time that a lower priority user must wait to use the PTZ controls after a higher priority user stops using the controls. See the “PTZ Advanced Settings” section on page 7-75.</td>
</tr>
<tr>
<td>Live QoS</td>
<td>(Required) Defines the priority of the user group to receive live video if network traffic is heavy. The video quality is not affected, but user groups with a low QoS setting may have dropped packets so user groups with a higher QoS setting can continue to receive uninterrupted video.</td>
</tr>
<tr>
<td></td>
<td>• Low—If network traffic is heavy, video packets may be dropped for users assigned to this group.</td>
</tr>
<tr>
<td></td>
<td>• Medium—the user group has secondary priority to receive video packets over the network. If network traffic is heavy, video packets may be dropped for users assigned to this group.</td>
</tr>
<tr>
<td></td>
<td>• High—the user group has the highest priority to receive video packets over the network.</td>
</tr>
</tbody>
</table>
**Table 4-6  User Group Settings (continued)**

| Archive QoS | (Required) Defines the priority of the user group to receive recorded (archive) video if network traffic is heavy. The video quality is not affected, but user groups with a low QoS setting may have dropped packets so user groups with a higher QoS setting can continue to receive uninterrupted video.  
|---|---|
| • Low—If network traffic is heavy, video packets may be dropped for users assigned to this group.  
| • Medium—the user group has secondary priority to receive video packets over the network. If network traffic is heavy, video packets may be dropped for users assigned to this group.  
| • High—the user group has the highest priority to receive video packets over the network. |
| Tags | (Optional) Enter keywords used by the Find function. |
| Description | (Optional) Enter a description of the rights granted by the Role. |

**Step 4**  
Add users who will be granted the group permissions.

a. Click **Add** under the User box (Figure 4-4).

b. Select one or more users from the pop-up window.

c. Select **OK**.

Tip  
Press **Shift-click** or **Ctrl-click** to select multiple users. To create or modify the list of available users, see the “Adding Users” section on page 4-13.

**Step 5**  
(Optional) Add an LDAP server filter, if necessary.

- See the “Adding Users from an LDAP Server” section on page 4-15.

**Step 6**  
Click **Create** or **Save** to add or edit the user group.
Adding Users

Users provide login access to individuals. Once user accounts are created, you can assign the users to one or more user groups. User groups provide the users with access permissions and limit access to specific locations. See the “Overview” section on page 4-1 for more information.

### Procedure

To create users, do the following:

**Step 1** Select Users, and then select the User tab.

- The currently configured users groups are in the left column.

**Step 2** Edit or add a user:

- To edit a user, click an existing entry to highlight it, and continue to Step 3.
- To add a user, click the Add button.

**Step 3** Enter the basic user settings (Table 4-7):

#### Table 4-7 User Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>(Required) The username is used to log in to the Operations Manager and Cisco Video Surveillance Safety and Security Desktop.</td>
</tr>
<tr>
<td>First Name</td>
<td>(Required) Enter the user’s first name.</td>
</tr>
<tr>
<td>Last Name</td>
<td>(Required) Enter the user’s last name.</td>
</tr>
</tbody>
</table>
### Step 4
(Optional) Add the user to one or more user groups.

- **Click Add** under the User Groups box.
- **Select one or more user groups from the pop-up window.**
- **Select OK.**

#### Tip
See the “Adding User Groups” section on page 4-10 for instructions to add or edit groups.

### Step 5
Select **Create** or **Save** to save the changes.

---

**Table 4-7 User Settings (continued)**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email</td>
<td>(Optional) Enter an email address for the user. The email address is for informational purposes only.</td>
</tr>
<tr>
<td>Password</td>
<td>(Required) Enter the initial password for the user.</td>
</tr>
<tr>
<td></td>
<td>- The password must include 8 characters including one uppercase character and one digit.</td>
</tr>
<tr>
<td></td>
<td>- The user is prompted to change the password the first time they log in.</td>
</tr>
<tr>
<td></td>
<td>- If the user forgets their password, an administrator can change the password, which will again require the user to enter a new password on first login.</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>Re-enter the password.</td>
</tr>
<tr>
<td>Tags</td>
<td>(Optional) Enter the keywords used by the Find feature.</td>
</tr>
<tr>
<td>Description</td>
<td>(Optional) Enter a description for the user.</td>
</tr>
</tbody>
</table>
### Adding Users from an LDAP Server

Add an LDAP (Lightweight Directory Access Protocol) server to the Cisco VSM user configuration to provide access to members of an external user database. After the LDAP server is added, users from that system can log in to Cisco VSM using the credentials configured on the LDAP server (the users do not need to be added individually to the Operations Manager configuration).

Refer to the following topics for more information:

- LDAP Usage Notes, page 4-15
- Upgrade Requirements, page 4-15
- LDAP Server Settings, page 4-16
- LDAP Search Filter Settings, page 4-20
- LDAP Configuration Examples, page 4-20
- LDAP Configuration Procedure, page 4-23

### LDAP Usage Notes

- LDAP users can be added or removed from the source database without affecting Cisco VSM. When the LDAP user logs in to Cisco Video Surveillance, their credentials are authenticated with the LDAP server, and access is granted or denied based on the LDAP response.
- Use LDAP filters to limit the users who can access Cisco VSM.
- To delete an LDAP server, you must un-associate the LDAP server from all Cisco VSM user groups.

### Upgrade Requirements

New fields were added in Cisco VSM release 7.0.1 to simplify the LDAP server configuration. After upgrading from release 7.0.0, the administrator must reconfigure the LDAP server settings including the following:

- Review all LDAP server configurations in the Operations Manager and update missing information after the upgrade.
- Verify and reconfigure the binding requirements.
- Reconfigure the LDAP filters and Usergroup associations for each server.

**Note**

- These settings are not imported automatically upon upgrade. Operations Manager will not prompt the administrator or display messages that indicate the new fields that need to be updated. Carefully review the LDAP configuration descriptions and instructions to implement the required changes.
- You must be logged in to the localhost domain to apply these changes (see Figure 4-6).
### LDAP Server Settings

The LDAP server settings define the network address of the LDAP server, the method used to bind (connect) Cisco VSM with the server, the location of the LDAP user information, and the filters that define the specific LDAP users that can access the Cisco VSM system.
The following table describes the purpose and requirements for each setting. Refer to the “LDAP Configuration Examples” section on page 4-20 for additional information. See the “LDAP Configuration Procedure” section on page 4-23 to complete the configuration.

**Table 4-8 LDAP Server: General Information Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anonymous Binding</td>
<td>(Optional) Select this option, if the LDAP server being configured supports anonymous access.</td>
</tr>
<tr>
<td>Name</td>
<td>(Required) Enter a descriptive name for the server.</td>
</tr>
<tr>
<td>Hostname</td>
<td>(Required) Enter the server hostname or IP address.</td>
</tr>
<tr>
<td>Port</td>
<td>(Required) Enter the server port. Port 389 is typically used for LDAP communication.</td>
</tr>
</tbody>
</table>
Principal (Required) The Principal setting is used to bind Cisco VSM to the LDAP server. In other words, the Principal setting defines the user information used to authenticate individual users with the LDAP server.

The Principal entry includes the `%USERID%` variable, which represents the userID configured on the LDAP server. The `%USERID%` and password are entered when the user logs into Cisco VSM, and is sent to the LDAP server for authentication.

- If the Principal path (Bind DN) contains userid, enter the Principal in the following pattern: `CN=%USERID%,OU=Company Users,DC=mycompany,DC=com`
- If Principal path (Bind DN) contains user's full name instead of userid (eg. CN represents full name instead of userid) especially for AD servers, then enter the Principal in the following pattern: `%USERID%@domain.com`.

The following illustration shows an LDAP configuration that uses the userID as the CN.

### Anonymous Binding

Select this option if the LDAP server allows anonymous access and you prefer to connect and search the LDAP server anonymously in order to authenticate the users logging in to Cisco VSM.

Anonymous Binding requires only the base DN, and does not require the `%USERID%` variable. For example:

```
ou=employees,ou=people,o=mycompany.com
```

**Note**  
The following error is returned if the LDAP server does not support Anonymous Binding:

```
Operation failed: User <user id> is not found in LDAP or given distinguished name does not support anonymous access.
```
### Adding Users from an LDAP Server

#### User Search Base

(Required, except for Anonymous Binding) The Search Base indicates the lowest level of LDAP hierarchy where users will be found. User information includes attributes such as first name, last name, email address, etc.

For example: `OU=Company Users,DC=Mycompany,DC=com`

**Anonymous Binding**

This field is optional field for Anonymous Binding.

#### Userid Attribute

(Required) Enter the name of the LDAP mapping field where the User ID is stored. For example:

- `cn`
- `uid`
- `userid`
- `sAMAccountName` (Active Directory only—this value is used only with Active Directory servers). The following illustration shows an LDAP configuration that uses the `sAMAccountName` field for the userID.

#### Firstname Attribute

(Optional, if defined on the LDAP server). The name of the LDAP server attribute that holds the users’ first name. For example: `givenName` or `displayName`.

#### Lastname Attribute

(Optional) The name of the LDAP server attribute that holds the users’ surname. For example: `sn` (if defined on the LDAP server).

#### Email Attribute

(Optional) The name of the LDAP server attribute that holds the users’ email address. For example: `mail` (if defined on the LDAP server).

#### Tags

(Optional) Words that assist in a Find.

#### Description

(Optional) Description of the LDAP server. For example: the server purpose, location, or user base.

---

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>myldap.example.com</td>
<td>Host</td>
</tr>
<tr>
<td>Port</td>
<td>389</td>
<td>Port</td>
</tr>
<tr>
<td>Base</td>
<td>DC=Mycompany,DC=com</td>
<td>Base</td>
</tr>
<tr>
<td>User Search</td>
<td>OU=Company Users,DC=Mycompany,DC=com</td>
<td></td>
</tr>
<tr>
<td>Userid Attribute</td>
<td><code>sAMAccountName</code></td>
<td></td>
</tr>
</tbody>
</table>

---

Table 4-8 LDAP Server: General Information Settings (continued)
LDAP Search Filter Settings

Filters restrict authentication to a subset of users (the filter represents a user group that is defined on the LDAP server). Each filter can be associated with a different user group, which grants LDAP users in that filter the access permissions of the Cisco VSM user group. This allows you to grant different permissions to different sets of users.

For example, a filter for the dept_eng users can be associated with an admin user group while rest everyone in company_eng will be made an operator.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name for the filter. For example: Security users</td>
</tr>
</tbody>
</table>
| Search Path | The directory path where user groups are stored on the LDAP server.  
In some LDAP configurations, the user information (User Search Base) and user group information are in different locations. This field specifies where the user group information is located.  
For example: ou=groups,o=mycompany.com. |
| Filter | Enter the syntax that limits access to members of a specific group on the LDAP server.  
For example: (&(cn=%USERID%)(memberOf=CN=vsom-admins,OU=Grouper,DC=mycompany,DC=com)) |

Tip: See the “LDAP Configuration Examples” section on page 4-20 for additional configuration examples.

LDAP Configuration Examples

To enable LDAP connectivity, the Operations Manager configuration must correspond with the LDAP server configuration. A few possible variations are:

- Non Active Directory Server
  - Anonymous Binding
  - Regular Binding:
    - uid= user id (the user has uid attribute in the LDAP server equal to the User ID used to login)
    - cn = user id (the user has a cn attribute in the LDAP server equal to the User ID used to login)
    - cn=full name (CN contains full name)

- Active Directory Server
  - sAMAccountName = userid (the user has the sAMAccountName attribute value in AD equal to the ID used to login)
  - userPrincipalName = user ID (the user has userPrincipal attribute value in AD equal to the login ID)
- `cn` = user id (i.e., the user has a `cn` attribute in the LDAP server equal to the User ID used to login)

Review the following table for additional information and configuration summaries.

**Table 4-10 LDAP Configuration Options**

<table>
<thead>
<tr>
<th>LDAP Configuration</th>
<th>Description</th>
<th>Configuration Example</th>
</tr>
</thead>
</table>
| Active Directory Server  
CN = `userid` | When the LDAP Common Name (CN) field includes the userID, the Cisco VSM “Principal” setting includes the `%USERID%` variable and the complete User Search Base path. **Note** The `%USERID%` variable is replaced with the username entered when logging into Cisco VSM. | *Anonymous Binding: Off*  
*Principal example:* `cn=%USERID%,ou=active,ou=employees,ou=people,dc=mycompany,dc=com`  
*User Search Base example (corresponding to the above Principal):* `ou=employees,ou=people,dc=mycompany,dc=com`  
*Filter example:*  
  - Name: `vsom-admins`  
  - Search path: `dc=mycompany,dc=com` (corresponding to the above examples)  
  - Filter: `(&(cn=%USERID%)(memberOf=CN=vsom-admins,OU=Grouper,DC=mycompany,DC=com))` |
| Active Directory Server  
CN = the users full name | When the LDAP Common Name (CN) field includes the user’s full name:  
  - The Principal setting includes the `%USERID%` variable as a pattern, such as an email address.  
  - The User Search Base defines where the user information is located.  
  - The UserID Attribute defines the LDAP field where the userID is stored. | *Anonymous Binding: Off*  
*Principal example:* `%USERID%@mycompany.com`  
*User Search Base example:* `dc=mycompany,dc=com` (corresponding to the example shown in the following filter)  
*Filter example:*  
  - Name: `vsom-admins`  
  - Search path: `ou=active,ou=employees,ou=people,o=mycompany.com`  
  - Filter: `(&(cn=%USERID%)(memberOf=CN=vsom-admins,OU=Grouper,DC=mycompany,D C=com))` |
### Regular LDAP binding (non-Active Directory)
A non-Active Directory server uses the User Search Base path where the user information is stored in both the Principal and User Search Base fields. The Userid Attribute defines the LDAP field where the userId is stored.

- **Principal example:** `CN=%USERID%,OU=people,OU=US,DC=mycompany,DC=com`
- **User Search Base example:** `ou=people,ou=us,dc=mycompany,dc=com` (corresponding to the above Principal)
- **Filter example:** `(&(objectClass=posixGroup)(memberuid=%USERID%)(cn=vsomadmins))`

### Anonymous Binding (non-Active Directory)
If the LDAP server is configured to be accessed as anonymous, the `%USERID%` variable is not required. Only the correct server hostname, port and principal is required to bind Cisco VSM to the LDAP server.

- **Principal example:** `ou=people,ou=us,dc=mycompany,dc=com`
- **User Search Base:** Leave blank
- **Filter example:** `(&(objectClass=posixGroup)(memberuid=%USERID%)(cn=vsomadmins))`

### Notes
- Although the communication (binding) can occur anonymously between Cisco VSM and the LDAP server, Cisco VSM also verifies that the username and password entered by the user are valid on the LDAP server.
- The **Test** button does not require you to enter a username or password since the test is only checking for server connectivity (not valid user credentials). The **Test** will complete successfully if the LDAP server is configured for Anonymous Binding and if the server address and port are correct.
LDAP Configuration Procedure

Complete the following procedure to bind a LDAP server to Cisco VSM, and associate the LDAP user with a Cisco VSM user group.

**Note**

To configure LDAP servers, you must log in with *super-admin* privileges, using the **localhost** Domain.

**Procedure**

**Step 1** Log on to the Cisco VSM using the following *(Figure 4-6):*

- An account that belongs to a User Group with *super-admin* access permissions (for example, *admin*)
- See the “Logging In” section on page 1-17.
- Select the **localhost** Domain.

*Figure 4-8  Localhost Login for LDAP Configuration Changes*

**Step 2** Select the **LDAP Server** tab.
Chapter 4  Adding Users, User Groups, and Permissions

Adding Users from an LDAP Server

Step 3  Click Add (or select an existing entry to edit a server).

Figure 4-9  Sample LDAP Server Settings

Step 4  (Required) Enter the General LDAP server settings (Figure 4-9).

a. Enter the settings as described in the “LDAP Server Settings” section on page 4-16 (see Table 4-8).

b. Click Test and enter the test username and password (credentials are not required if Anonymous Binding is selected).

c. If the test fails, correct the settings and try again.

Note  The LDAP server settings were changed for Release 7.0.1. If you are upgrading from Release 7.0.0, you must revise the configuration to conform to the new fields and requirements.

Tip  See the “LDAP Configuration Examples” section on page 4-20 for configuration examples.

Step 5  (Required) Define one or more LDAP Search Filters.

a. Click Add (Figure 4-9).

b. Enter the settings as described in the “LDAP Search Filter Settings” section on page 4-20 (see Table 4-9).
b. Click **Test** to verify the filter. You must enter a valid username and password for the LDAP server and filter. If the test fails, correct your entries and try again.

**Note** The LDAP filter settings were changed for Release 7.0.1. If you are upgrading from Release 7.0.0, you must revise the configuration to conform to the new fields and requirements.

**Tip** See the “LDAP Configuration Examples” section on page 4-20 for configuration examples.

c. (Optional) Repeat **Step 5** to add additional filters. Each filter allows those LDAP users to access Cisco VSM (based on the user group assignments (see **Step 7**).

**Step 6** (Required) Click **Create** or **Save** to save the LDAP server settings.

**Step 7** (Required) Add the LDAP server/filters to a Cisco VSM user group.

The user group(s) define the Cisco VSM access permissions for the LDAP users (defined by the filter).

The LDAP server/filters can be added to multiple user groups. The users gain the combined access permissions of all associated user groups.

---

**Figure 4-10** Adding an LDAP Server to a User Group

---

a. Select the **User Groups** tab 🔍 (Figure 4-10).

b. Select a user group (or create a new group as described in the “Adding User Groups” section on page 4-10).

c. In the LDAP Server section, click **Add**.

d. Select the **LDAP Server** name that includes the appropriate filter and click **OK**.
Tip: The filter defines a sub-set of LDAP users that will gain the user group access permissions.

e. Click Save.

Step 8 (Optional) Click the LDAP Server tab to verify that the user group appears in the LDAP server configuration.

Step 9 (Optional) Log out and log back in using the credentials for an LDAP user (Figure 4-11).

Figure 4-11 Select an LDAP Login Domain

a. Click Log Out.

b. In the Cisco VSM Login page, enter the Active Directory username and password.

c. From the Domain menu, select the LDAP server name and filter combination.

d. Click Log In.
Creating the Location Hierarchy

Locations allow you to organize your deployment according to the real-world location of equipment and users. Locations also allow administrators to restrict user access to the specific cameras, policies, and data (such as alerts) required by the user’s role within the organization. For example, while a super-admin has full access to all locations and devices, a local campus administrator might have access only to the devices and policies required to manage a specific site.

This chapter describes how to create the location hierarchy, assign locations to devices, policies, and user groups, and how those assignments impact a user’s ability to access Cisco VSM resources.

Since all servers, user groups and cameras must be assigned to a location, create the location hierarchy before performing other configuration tasks. Review the information in this section carefully, and then create a location plan to ensure the users in your deployment can access only the equipment, video and policies required for their role.

Contents
- Overview, page 5-2
- Understanding Permission-Based and Partition-Based Resources, page 5-3
  - Simple Deployments (User Access to All Devices and Resources), page 5-4
  - Permission-Based Resources: Limiting User Access to Devices, page 5-4
  - Partition-Based Resources: User Access to Templates, Schedules and Other Resources, page 5-5
- Examples: Locations in Simple vs. Large Deployments, page 5-7
- Understanding a Camera’s Installed Location Vs. the Pointed Location, page 5-9
- Creating and Editing the Location Hierarchy, page 5-10
- Impact of Device Location Changes on Alerts, page 5-11
- Deleting a Location, page 5-11
Overview

Locations define the physical location of devices, such as cameras, and the logical location of attributes, such as camera templates. This allows system administrators to restrict user access to only the devices and resources required by the different users in a deployment. For example, in a simple deployment, users are assigned to the root level and gain access to all devices and resources. In larger deployments, however, users can belong to user groups that are assigned to locations at lower levels. This restricts the users’ access to the devices at that location (and sub-locations). The users also have access to system resources (such as templates and schedules) that are assigned to other locations.

Summary Steps

To create a location hierarchy, do the following:

Table 5-1  Summary Steps: Location Hierarchy and Assignments

<table>
<thead>
<tr>
<th>Task</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Review the overview topics to understand how locations impact users’ ability to access devices and resources.</td>
</tr>
<tr>
<td></td>
<td>• Contents, page 5-1</td>
</tr>
<tr>
<td></td>
<td>• Understanding Permission-Based and Partition-Based Resources, page 5-3</td>
</tr>
<tr>
<td></td>
<td>• Examples: Locations in Simple vs. Large Deployments, page 5-7</td>
</tr>
<tr>
<td>Step 2</td>
<td>Create the location hierarchy for your deployment.</td>
</tr>
<tr>
<td></td>
<td>Creating and Editing the Location Hierarchy, page 5-10</td>
</tr>
<tr>
<td>Step 3</td>
<td>Assign devices, user groups and resources to the locations.</td>
</tr>
<tr>
<td></td>
<td>• Creating or Modifying a Template, page 9-3</td>
</tr>
<tr>
<td></td>
<td>• Editing the Camera Settings, page 7-42</td>
</tr>
<tr>
<td></td>
<td>• Understanding a Camera’s Installed Location Vs. the Pointed Location, page 5-9</td>
</tr>
<tr>
<td></td>
<td>• Adding External Encoders and Analog Cameras, page 10-4</td>
</tr>
<tr>
<td></td>
<td>• Media Server Settings, page 6-6</td>
</tr>
<tr>
<td></td>
<td>• Adding User Groups, page 4-10</td>
</tr>
<tr>
<td>Step 4</td>
<td>Assign users to one or more user groups. Users gain access to the locations assigned to the user groups.</td>
</tr>
<tr>
<td></td>
<td>Adding Users, page 4-13</td>
</tr>
</tbody>
</table>
Understanding Permission-Based and Partition-Based Resources

Locations assigned to Cisco VSM resources define the following:

- The physical location of Media Servers and encoders.
- The installed (physical) and pointed at location of cameras.
- The logical location of Cisco VSM attributes, such as camera templates, schedules, Video Walls and preset Views.
- The location of user groups and user roles.

In addition, the following rules apply:

- Resources such as devices, user groups and view are permission-based, meaning that they can only be accessed by users at that same location or lower (sub-location).
- Partition-based resources (such as templates and schedules) can be accessed by users within the same location hierarchy (locations higher or lower in the same location tree).
- Global resources can be accessed by all users who have the required access permissions.
- Super-admin resources (such as system settings and audit logs) can only be accessed by super-admin users.

Table 5-2 summarizes the resource types.

<table>
<thead>
<tr>
<th>Type</th>
<th>Resources</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permission-Based</td>
<td>• Devices (cameras, encoders, Media Servers) • User groups • Views</td>
<td>Users can access permission-based resources that are assigned to their user group location or lower (sub-location). For example, in Figure 5-2 a user assigned to a Dallas Campus user group can access the cameras at the Building 1 sub-location, but not at the Texas location. Dallas users also cannot access any California locations.</td>
</tr>
<tr>
<td>Partition-Based</td>
<td>• User roles • Schedules • Camera templates</td>
<td>User groups can access partition-based resources that are in the same location hierarchy (either higher or lower, but not in a different branch). For example, in Figure 5-3 a user assigned to a Dallas Campus user group can access the templates or schedules at any higher or lower level up to the U.S. (root) location. The user cannot, however, access templates or schedules for the Austin Campus or any of the California locations.</td>
</tr>
<tr>
<td>Global Resources</td>
<td><em>Global</em> resources can be accessed by all users who have the required access permissions.</td>
<td>For example, a user with manage users permissions access all the users in the system. The user object is not restricted to a location.</td>
</tr>
<tr>
<td>Super-admin</td>
<td>• System Settings • Audit Logs</td>
<td>Only users assigned to a super-admin user group can access these system-wide resources.</td>
</tr>
</tbody>
</table>

Table 5-2 Resource Access Summary
Simple Deployments (User Access to All Devices and Resources)

In a simple deployment (Figure 5-1), all users are assigned to a user group at the root (System) location. Users can access all cameras and resources at all sub-locations.

For example, in Figure 5-1, root (System) level users have access to the devices and resources in all sub-locations, such as California, Texas, and the associated campus and building sub-locations. A user's ability to view or configure devices and resources is based on the role assigned to their user group.

Figure 5-1  Locations and User Permissions in a Simple Deployment

Tip

User access can still be restricted based on the assigned user group. For example, an operator user group can provide access to only view video, but not configure system resources. See the “Adding Users, User Groups, and Permissions” section on page 4-1 for more information.

Permission-Based Resources: Limiting User Access to Devices

Users can access devices assigned to the same location, or lower. For example, if a user is assigned to a user group at the San Jose Campus location (Figure 5-2), the user gains access to any cameras assigned to the San Jose Campus location, and all sub-locations (such as SJ Building 1).

Note

- Users cannot access cameras assigned to higher locations (such as California in Figure 5-2), or sub-locations in a different hierarchical tree (such as the Milpitas Campus or Texas).
- A user’s location includes all of the user groups to which the user is assigned. For example, if a user is assigned to a user group for the San Jose Campus, and is also assigned to another user group for the Dallas Campus (Figure 5-2), the user gains access to the devices at both locations.
- Devices, user groups and Views are permission-based resources. All permission-based resources adhere to these same rules.
**Figure 5-2 Limiting User Access to Specific Locations**

- **Tip**
  - Media Servers should be assigned to a high-level location to provide support to devices and user groups at lower-level locations. In the Figure 5-2 example, assign the Media Servers to either the Root (System) location, or the California and Texas locations.
  - Camera Views are also assigned to a location. Users can only access the Views assigned to their location and lower. See the “Creating Pre-Defined Views” section on page 3-2.

**Partition-Based Resources: User Access to Templates, Schedules and Other Resources**

*Partition-based* resources include camera templates, schedules, and user roles. If the user belongs to a user group with access to these resources, then the user can access any partition-based resource in the same location hierarchy (locations that are higher or lower, but not in a different branch).

For example, in Figure 5-3 a user assigned to a San Jose Campus user group can access the templates or schedules at any higher level location (up to the U.S. root location). The user cannot, however, access templates or schedules for the Milpitas Campus or any of the Texas locations.

- **Tip**
  - The user must be assigned to a user groups that provides access to the resource. See the “Adding Users, User Groups, and Permissions” section on page 4-1 for more information.
Figure 5-3  Limiting User Access to Specific Locations

Understanding Permission-Based and Partition-Based Resources

Resource Location  
(Partition-Based Resources)

Device Locations  
(Permission-Based Resources)

Milpitas Campus
San Jose Campus
SJ Building 1
SJ Building 2

California

U.S. (Root)  
(super admin users)

Resource Location  
(Partition-Based Resources)

Device Locations  
(Permission-Based Resources)

Dallas Campus
Dallas Building 1
Floor 1
Floor 2

Texas

Resource Location  
(Partition-Based Resources)

Dallas Campus

Resource Location  
(Partition-Based Resources)

Austin Campus

U.S. (Root)  
(super admin users)
Examples: Locations in Simple vs. Large Deployments

Simple Deployment Example

A simple Cisco VSM deployment typically places partition-based resources (templates, roles and schedules) at the root level so they can be accessed by users at all of the sub-locations (Figure 5-4). Users must still belong to a user group that provides access to view or manage those resources.

Permission-based resources (such as cameras) can also be placed at the root level, but only users in a user group at the root level will be able to access them. You can assign both devices and users at a sub-location to restrict user access to the permission-based resources at that location.

---

**Figure 5-4 Example Locations for a Simple Deployment**

1. Assign partition-based resources (templates, roles and schedules) to a high-level or root location.
   - **Partition-based resources** (templates, roles and schedules) can be viewed and used by all users at all sub-locations.
   - Users can only modify the templates, roles, and schedules that are assigned to their location (or lower).
   - For example, in Figure 5-4 a user assigned to “Milpitas Buildings” can view partition-based resources assigned to the “U.S.” location, but only super-admin users can modify the resources.
   
   **Tip** We recommend also assigning Media Servers to a high-level location to provide support to devices and user groups at lower-level locations.

2. Assign permission-based resources (such as cameras) to sub-locations to restrict user access.
   - Users can only access permission-based resources (such as cameras) that are assigned to the user’s location and lower.
   - For example, in Figure 5-4 a user assigned to “Milpitas Buildings” can access cameras at that level and lower (such as building 1 and building 2), but cannot access cameras at an equal level (such as “San Jose Buildings”) or at higher locations (such as “California” or “US”).
   
   **Tip** Deployments with a small number of users can also assign user groups and permission-based resources to the “U.S.” (root) location.
Large Deployment Example

Larger deployments support multiple campuses or geographically distant sites. Users at different regions or campuses require a distinct set of schedules, roles and templates. For example, the deployment in Figure 5-5 includes sites in both the U.S. and India. Partition-based resources (templates, roles and schedules) assigned to the India location can only be viewed by users in the India sub-locations, (not by U.S. users). Resources assigned to the “U.S” location can only be viewed by U.S. users.

This configuration also allows “India” or “U.S.” user to modify the partition-based resources for their region without impacting other regions.

Figure 5-5  Example Locations for a Large Deployment

1. Assign partition-based resources (templates, roles and schedules) to a high-level branch location, such as “U.S.”
   - Partition-based resources (templates, roles and schedules) can be viewed and used by all users within that location hierarchy (for example, from the San Jose Campus up to the System users).
   - Users can only modify the templates, roles, and schedules that are assigned to their location (or lower).

   For example, in Figure 5-5 a user assigned to “California” can view partition-based resources assigned to the “U.S.” location, but not resources in the “India” locations.

2. Assign permission-based resources (such as cameras) to sub-locations to restrict user access.
   - Users can only access permission-based resources (such as cameras) at their location and lower.
   - For example, in Figure 5-5 a user assigned to “Chennai” can access cameras at that level and lower (such as “CH Bldg 1”), but cannot access cameras at an equal level (such as “Bangalore”) or at higher level (such as “India”).

Tip

System users (such as super-admins) can view all resources at all sub-locations. Super-admins can also access system settings and other resources. See Table 5-2 on page 5-3 for more information.
Understanding a Camera’s Installed Location Vs. the Pointed Location

A location can represent where the device is physically installed, or a logical location. For example, camera configurations include settings for both the Installed Location and the Pointed Location (Figure 5-6). In the following example, a camera is installed on Building 1 but is pointed at the Building 2 lobby doors.

Figure 5-6   Sample Camera Location Entry

Tip

This distinction is used when viewing video alarms. If an alarm occurs at Building 1, the Cisco Safety and Security desktop application will display the alarm (for Building 1) even if the camera’s installed location is Building 2 (since the camera is pointed at Building 1).
Creating and Editing the Location Hierarchy

To create or modify the locations in your deployment, do the following:

Procedure

Step 1  Log on to the Operations Manager.
   •  See the “Logging In” section on page 1-17.
   •  You must belong to a User Group with permissions for Locations & Maps.

Step 2  Select System Settings > Locations.

Step 3  Select an existing location and click Add to add a new location or sub-location (Figure 5-7).

Note  In a new system, only the System location appears.

Figure 5-7     Locations Menu

Add menu (Figure 5-7):
   – Choose Add Location (Shift-J) to add a location at the same level.
   – Choose Add Sub-Location (Shift-U) to add a sub-location to the existing location.
   – Enter the name and description.
Impact of Device Location Changes on Alerts

Because device locations rarely change, the alert location will normally be the same as the device location. However, if the device location is changed, the following will occur:

- New events show the new location, but are added to the existing (and open) alert at the old location.
- When the alert is closed by an operator, any new events create a new alert at the new location (the location reference in the alert is now consistent with the device location in the event).


Deleting a Location

Locations can be deleted only if no resources (such as cameras) are associated with the location or any of its sub-locations. See Table 5-2 on page 5-3 for a list of the resources that use locations.

Procedure
To delete a location or sub-location:

Step 1 Remove all devices and resources from the location and sub-locations.
You can reassign the devices and resources to a different location, or delete the items.

Step 2 Select System Settings > Locations.

Step 3 Select the location or sub-location.

Step 4 Click Delete.
**Step 5** If the delete operation fails and an error message appears, remove or reassign any resources that are associated with the location or sub-location and try again.
CHAPTER 6

Configuring Media Servers

A Media Server is an application that runs on physical Cisco Video Surveillance (Cisco VSM) server. Media Servers provide video streaming, recording and storage for the cameras associated with that server. You can have a single Media Server in your deployment that runs on the same physical server as the Operations Manager application, or you can have multiple Media Servers of different physical servers that are managed by the Operations Manager.

To configure Media Servers, add the server to the Operations Manager configuration and enter the server settings, such as IP address, username, location, and other settings. Once configured, the Media Server can host cameras or used in a high-availability configuration.

Refer to the following topics for more information.

Contents

- Overview, page 6-3
- Requirements, page 6-3
- Summary Steps to Add or Revise a Media Server, page 6-5
- Media Server Settings, page 6-6
  - General Information Settings, page 6-6
  - Access Information Settings, page 6-7
  - Network Information, page 6-9
  - NTP Information, page 6-10
  - High Availability Options, page 6-12
  - SMTP Management Settings, page 6-12
  - Partition Settings, page 6-13
  - Storage Management Settings, page 6-13
  - Media Out Settings, page 6-14
  - Recording Settings, page 6-16
- Adding or Editing Media Servers, page 6-17
  - Prerequisites, page 6-17
  - Adding or Editing a Single Media Server, page 6-17
  - Importing or Updating Media Servers Using a CSV File, page 6-19
- Deleting a Media Server, page 6-23
- Bulk Actions: Revising Multiple Media Servers, page 6-25
- Viewing Media Server Status, page 6-27
- Repairing the Configuration or Restarting the Server, page 6-28
- Resetting the Media Server Device State, page 6-28
Overview

A Media Server is an application that runs on a physical Cisco Multiservices Platform appliance. Media Servers perform the following functions:

- Process and store digital video streams from network cameras.
- Deliver video streams to user workstations.
- Manage the serial ports and encoders used to connect analog cameras and digitize the analog video from those cameras.

To create a Media Server, install the Cisco VSM server appliance and log on to the Cisco Video Surveillance Management Console to perform the initial setup. During the setup, you can choose to enable only the Media Server application, or both the Media Server and Operations Manager applications (also called a co-located configuration). If the server hosts only the Media Server, you must specify the IP address of the server running the Operations Manager.

Note

Co-located servers can host multiple Media Servers, but special conditions apply. See the Cisco Video Surveillance Management Console Administration Guide for more information.

After the Media Server application is enabled, log onto the Cisco VSM Operations Manager assigned to the server and add the Media Server to the Cisco VSM configuration. You can then associate cameras and other attributes to the Media Server and use the Media Server for video streaming, storage and playback.

See the “Requirements” section on page 6-3 and the “Summary Steps to Add or Revise a Media Server” section on page 6-5 for more information.

Tip

- See the Cisco Physical Security Multiservices Platform Series User Guide for instructions to physically install the appliance.
- See the Cisco Video Surveillance Management Console Administration Guide for instructions to perform the initial server setup, enable the Media Server application and upgrade the system software.

Requirements

Before you begin, verify that the following requirements are met.

<table>
<thead>
<tr>
<th>Table 6-1</th>
<th>Media Server Requirements</th>
</tr>
</thead>
</table>
| Requirements | Requirement Complete?  
 | The IP address and password the Media Server. | ☐ |
| You must belong to a user group with Media Servers & Encoders permissions. See the “Adding Users, User Groups, and Permissions” section on page 4-1 for more information. | ☐ |
Requirements

At least one Media Server and one Operations Manager must be installed on the network.

- Log in to the browser-based Cisco Video Surveillance Management Console to complete the Initial Setup Wizard and enable the Media Server and/or Operations Manager applications.
- A single physical or virtual server can host both the Media Server and Operations Manager applications (called a co-located server).
- Deployments can include multiple Media Servers.

See the following for more information:
- Cisco Video Surveillance Management Console Administration Guide.

Complete the Media Server initial configuration (including network settings) using the Setup Wizard available in the browser-based Cisco VSM Management Console.

- In dual-homed/NAT server setups where DNS is configured correctly, we recommended using the Management Console’s Initial Setup Wizard to enter the hostname of the Operations Manager used to manage the Media Server. Using the Operations Manager hostname ensures that the Media Server can connect, even if the Operations Manager IP address changes.
- Adding a Media Server directly to the Operations Manager configuration without completing the Management Console Initial Setup Wizard will cause the Media Server to use the Operations Manager IP address (instead of the hostname).

Each Media Server and Operations Manager must run the same versions of the system software and device driver packs.

See the “Understanding Cisco Video Surveillance Software” section on page 1-20 for more information.
## Summary Steps to Add or Revise a Media Server

The following steps summarize how to add or update a single Media Server.

<table>
<thead>
<tr>
<th>Step</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>Install the Media Server.</td>
</tr>
<tr>
<td></td>
<td>- Cisco Video Surveillance Management Console Administration Guide.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>Complete the Media Server <em>Initial Setup Wizard</em>.</td>
</tr>
<tr>
<td></td>
<td>Cisco Video Surveillance Management Console Administration Guide.</td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td>Log on to the Operations Manager.</td>
</tr>
<tr>
<td></td>
<td>Logging In and Managing Passwords, page 1-17.</td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
<td>Add one or more Media Servers.</td>
</tr>
<tr>
<td>a.</td>
<td>Select System Settings &gt; Media Servers.</td>
</tr>
<tr>
<td>b.</td>
<td>Click Add or select an existing Media Server.</td>
</tr>
<tr>
<td>c.</td>
<td>Complete the instructions to add or edit a single server, or to import servers from a CSV file.</td>
</tr>
<tr>
<td></td>
<td>- Media Server Settings, page 6-6</td>
</tr>
<tr>
<td></td>
<td>- Adding or Editing Media Servers, page 6-17</td>
</tr>
<tr>
<td><strong>Step 5</strong></td>
<td>(Optional) Configure the High Availability options.</td>
</tr>
<tr>
<td></td>
<td>High Availability, page 11-1</td>
</tr>
</tbody>
</table>
Media Server Settings

The following topics describe the Media Server settings:

General Tab
- General Information Settings, page 6-6
- Access Information Settings, page 6-7
- Hardware Information Settings, page 6-8
- Network Information, page 6-9
- NTP Information, page 6-10

Advanced Tab
- High Availability Options, page 6-12
- SMTP Management Settings, page 6-12
- Partition Settings, page 6-13
- Storage Management Settings, page 6-13
- Media Out Settings, page 6-14
- Recording Settings, page 6-16

General Information Settings

General settings define the Media Server name, location, and high-availability type. You can also enter a description and tags in the Find field.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>(Required) Enter a descriptive name that can help you identify the server. For example, enter the location of the server or its primary use. The name can include any combination of characters and spaces.</td>
</tr>
<tr>
<td>Install Location</td>
<td>(Required) Click the entry field to select the location where the Media Server is installed. The location determines the cameras and users that can access the Media Server. See the “Creating the Location Hierarchy” section on page 5-1 for more information.</td>
</tr>
</tbody>
</table>
Chapter 6      Configuring Media Servers

Med ia Server Settings

Table 6-2    General Media Server Settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>(Read-only) The type of server, which was defined when the server was first added to the Cisco VSM configuration:</td>
</tr>
<tr>
<td></td>
<td>• Primary—The Primary server used to service cameras.</td>
</tr>
<tr>
<td></td>
<td>• Redundant—Provides redundant services for cameras (for a Primary server). For example, video stream A can be serviced and saved by the Primary server, while video stream B is saved on the Redundant server.</td>
</tr>
<tr>
<td></td>
<td>• Failover—Acts as a hot spare for the Primary servers. If a Primary server goes down, the Failover server assumes the Primary functions.</td>
</tr>
<tr>
<td></td>
<td>– It can take up to 6 minutes for the Failover server to assumes the Primary functions.</td>
</tr>
<tr>
<td></td>
<td>– The Failover cannot assume the functions of a Redundant server if the Redundant server goes offline.</td>
</tr>
<tr>
<td></td>
<td>• Long Term Storage—Archives video files for Primary and Redundant servers.</td>
</tr>
<tr>
<td>Tags</td>
<td>Enter the tags that help identify the server using the Find function.</td>
</tr>
<tr>
<td>Description</td>
<td>Describe the purpose or use of the server.</td>
</tr>
<tr>
<td></td>
<td>For example: “Support for Building B cameras and associated video”.</td>
</tr>
</tbody>
</table>

Access Information Settings

The Access settings define the hostname and login credentials used to access the Media Server over the network.

Note

Changes to the Access Information settings do not affect the Media Server device. Change these settings only if the Media Server was reconfigured using the Cisco Video Surveillance Management Console. See your system administrator for more information.

Table 6-3    Access Information Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname/IP</td>
<td>The hostname or IP address used by the Operations Manager to access the Media Server.</td>
</tr>
<tr>
<td></td>
<td>• If your deployment includes a single server, the Media Server IP address or hostname is the same as the physical server running the Operations Manager browser-based utility to which you are logged in.</td>
</tr>
<tr>
<td></td>
<td>• If your deployment includes multiple servers, one of the servers is assigned to run the Operations Manager application (to enable the web management interface).</td>
</tr>
<tr>
<td></td>
<td>• Communication can be lost if you enter an IP address that is assigned to the Media Server by a DHCP server. This is because the Media Server may obtain a different IP address when it reboots. If this occurs, you must update the IP address in this field. To avoid this situation, we recommend using the Media Server hostname.</td>
</tr>
</tbody>
</table>
**Table 6-4 Hardware Information Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of CPUs</td>
<td>The number of CPUs running on the server.</td>
</tr>
<tr>
<td>Total Memory</td>
<td>The amount of RAM memory on the server.</td>
</tr>
<tr>
<td>Raid Controller</td>
<td>The Raid controller model, if installed.</td>
</tr>
<tr>
<td>Operating System</td>
<td>The server OS type and version.</td>
</tr>
<tr>
<td>Storage</td>
<td>The bar shows the approximate percentage use of the total storage.</td>
</tr>
<tr>
<td></td>
<td>• Blue: used storage space</td>
</tr>
<tr>
<td></td>
<td>• Green: unused storage space</td>
</tr>
</tbody>
</table>

The “Total” includes the total available storage space on the partitions even if the Recording, Clipping and Backup partitions are selected in the Advanced tab (see the “Partition Settings” section on page 6-13).
Chapter 6 Configuring Media Servers

Network Information

The Network Information settings are used to configure the Ethernet network interface cards (NIC). These settings are configured during the initial server configuration and should only be changed by a network administrator or similar user.

Caution

Incorrect network settings will cause a loss of network connectivity, loss of camera control, and the inability to view live or recorded video. Do not change these settings without a clear plan and reason. In addition, the use of certain settings, such as a static IP vs. DHCP, depends on the server applications supported on the server hardware. See the Cisco Video Surveillance Management Console Administration Guide for more information.

Click Settings next to each NIC port to change the following network settings:

Table 6-5 Network Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname</td>
<td>Enter the host name used to access the server over the network.</td>
</tr>
<tr>
<td>Domain</td>
<td>Enter the network domain name.</td>
</tr>
<tr>
<td>Configuration type</td>
<td>Select one of the following options based on the enabled server applications.</td>
</tr>
<tr>
<td></td>
<td>• Disabled—disables the interface.</td>
</tr>
<tr>
<td></td>
<td>• DHCP—the IP address and other fields will be disabled and defined by a DHCP server.</td>
</tr>
<tr>
<td></td>
<td>• Static—enter the IP address, Subnet Mask and other network settings.</td>
</tr>
<tr>
<td>Note</td>
<td>The Ethernet ports must be configured with static IP address or DHCP depending on the enabled applications. See the Overview section of the Cisco Video Surveillance Management Console Administration Guide for more information.</td>
</tr>
<tr>
<td>Gateway</td>
<td>(Static IP configuration only) Enter the IP address of the default gateway and click Add.</td>
</tr>
<tr>
<td>DNS Servers</td>
<td>(Optional) Enter up to three domain name service (DNS) servers. Separate multiple entries with a comma (,).</td>
</tr>
<tr>
<td>Searchable Domains</td>
<td>Enter the domain name. Separate multiple entries with a comma (,).</td>
</tr>
</tbody>
</table>
NTP Information

The network time protocol (NTP) server automatically sets the server time and date.

- **Media Server-only server**—Use the default (and recommended) *Automatic* mode to use the Operations Manager server as the NTP server. This ensures proper operation since all components will use the same time, date, and timezone.
  - *Automatic* mode can only be used after NTP is configured on the Operations Manager server.
  - *User Configured* mode should not be used unless necessary. See Table 6-5 for more information.

- **Co-located server** (Operations Manager and Media Server hosted on a single server)—Only the *User Configured* option is enabled. Enter NTP server hostname(s) or IP address(es), if necessary.

- **Operations Manager-only servers**—Use the Management Console interface to change the NTP settings for a Operations Manager-only server, if necessary. We strongly recommend using an NTP server (do not set the date and time manually). Go to Operations > Management Console to launch the browser-based console tool. See the Cisco Video Surveillance Management Console Administration Guide for more information.

Usage Notes

- The server time synchronizes server operations, defines recording timestamps and backup schedules. To ensure correct playback and system operation, we strongly recommend using *Automatic* mode for all Media Servers, or using the same NTP server for all Media Servers and the Operations Manager.
- *Automatic* mode can only be used after NTP is configured on the Operations Manager server.
- The Media Server will reboot if any changes are made to the Media Server NTP settings using the Operations Manager UI.
- Changes to the server time can affect video recording schedules and timestamps.
- A warning alert is generated if the time difference between the Media Server and Operations Manager is more than 2 minutes.
- A warning message is also displayed to operators when logging in if the time difference between their workstation and the server is more than 2 minutes.
- Never modify the time and NTP settings using the Linux CLI. Settings made using the Linux CLI can result in inconsistent system performance and other issues.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automatic</strong></td>
<td>(Media Server-only servers) The Operations Manager server is used as the NTP server. The Operations Manager also defines the Media Server timezone.</td>
</tr>
<tr>
<td></td>
<td>- Default and recommended for all Media Server-only servers.</td>
</tr>
<tr>
<td></td>
<td>- Disabled for co-located servers (Operations Manager and Media Server hosted on a single server). No other changes or settings are required when using Automatic mode.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>We highly recommend using <em>Automatic</em> mode for all Media Servers. This ensures proper operation since all components use the same time, date, and timezone.</td>
</tr>
</tbody>
</table>
### Table 6-6  NTP Server Settings (continued)

<table>
<thead>
<tr>
<th>Mode</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Configured</td>
<td>Allows you to enter a custom NTP server for the current server.</td>
</tr>
<tr>
<td></td>
<td>• Co-located servers—(Default and required) Enter the NTP server hostname(s) or IP address(es). Separate entries with a space or comma and select the Co-located server’s time zone.</td>
</tr>
<tr>
<td></td>
<td>• Media Server-only servers—(Optional) This option may be necessary based on proximity of the Media Servers. For example: if your deployment spans numerous countries or timezones, the Media Servers may need to use local NTP servers. Enter one or more NTP server hostnames or IP addresses separated by a space or comma and select the Media Server time zone.</td>
</tr>
<tr>
<td>Note</td>
<td>If multiple NTP servers are used, a hierarchy of servers should ensure that the times on the various components are close.</td>
</tr>
<tr>
<td>Note</td>
<td>We recommend using the same network time protocol (NTP) server on all Media Servers to ensure the time settings are accurate and identical.</td>
</tr>
</tbody>
</table>
High Availability Options

Use the **High Availability** options (under the **Advanced** tab) to define the HA servers that support the Primary and Redundant servers:

![Table 6-7 High Availability Options](image)

<table>
<thead>
<tr>
<th>Field</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failover</td>
<td>The Media Server that will assume the functionality of the Primary server if the Primary server goes offline.</td>
</tr>
<tr>
<td>Redundant Streams</td>
<td>The server used to record, store, and play back redundant video streams. For example, the Redundant Streams server can be used to manage Stream B from a camera.</td>
</tr>
<tr>
<td>Long Term Storage</td>
<td>The server used to store recorded video (continuous or motion events) for a long period of time.</td>
</tr>
</tbody>
</table>

- For complete instructions, see the “High Availability” section on page 11-1.
- The **High Availability** options are enabled only for Primary or Redundant servers. The **High Availability** button is disabled for Failover, and Redundant Streams servers.
- The server type is defined when the server is first added to the Cisco VSM configuration. See the “Adding or Editing Media Servers” section on page 6-17.
- Each physical server supports only a single server type: Primary, Failover, Redundant Streams and Long Term Storage
- Primary servers can be configured with Failover, Redundant, and Long Term Storage servers. Redundant servers can be configured with a Long Term Storage server.

SMTP Management Settings

Enter the **SMTP Management** settings (under the **Advanced** tab) to send server-generated emails. For example, the SMTP Server is used to send Health Notifications, as described in the “Health Notifications” section on page 12-12.

**Usage Notes**

- The SMTP settings are enabled and required if the Operations Manager application is enabled on the server.
- SMTP changes using the browser-based Cisco VSM Management Console Management page are reflected in the Operations Manager configuration.
- The SMTP settings are disabled if only the Media Server is enabled is enabled on the server.

**Table 6-8 SMTP Settings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMTP Server</td>
<td>The IP address or hostname if the SMTP server used to send emails.</td>
</tr>
</tbody>
</table>
Partition Settings

Select the **Partitions** options (under the **Advanced** tab) to define the type of files that are saved to each available hard disk partition.

**Table 6-9 Hard Disk Partition Usage**

<table>
<thead>
<tr>
<th>Field</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recording</td>
<td>The partition(s) used for video recordings generated by cameras associated with the Media Server.</td>
</tr>
<tr>
<td>Clipping</td>
<td>The partition(s) used for video clips created by a user.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> If multiple partitions are selected, the partition with the most available space is used to create video clips. CVA/CVX clips are downloaded immediately to the client workstation and not saved on the server. MP4 clips are saved on the server for 24 hours, and then deleted if they have not been downloaded. See the “Creating Video Clips” section on page 2-15 for more information.</td>
</tr>
<tr>
<td>Backups</td>
<td>The partition(s) used for system backup files.</td>
</tr>
</tbody>
</table>

Storage Management Settings

Select the **Storage Management** settings (under the **Advanced** tab) to define how the storage space on a volume is used.

**Table 6-10 Storage Management**

<table>
<thead>
<tr>
<th>Field</th>
<th>Settings</th>
</tr>
</thead>
</table>
| Storage (%) | The maximum amount a disk can be full before it is declared unusable for any further recording. When the disk reached this percentage, the 200 oldest media files are groomed (deleted), until the free disk space is less that the Storage (%).
|          | • The maximum (and default) value is 98% (also the default). We recommend keeping this setting at or below the default value.            |
|          | • 0% means that the repositories are not available to store video archives.                                                               |
|          | For example, if the Storage % is set to 90%, and a camera template Retain event recordings setting is **Max Possible**, event recordings will be deleted once the disk repositories are 90% full. |
Media Server Settings

Chapter 6 Configuring Media Servers

### Media Server Settings

Enter the **Media Out** settings (under the **Advanced** tab) to define the following.

<table>
<thead>
<tr>
<th>Table 6-11 Media Out Settings</th>
</tr>
</thead>
</table>

#### Media Out Settings

Enter the **Media Out** settings (under the **Advanced** tab) to define the following.

<table>
<thead>
<tr>
<th>Field</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTP Port</td>
<td>(Read-only) The port used for HTTP out connections. The default is 80.</td>
</tr>
<tr>
<td>HTTPs Port</td>
<td>(Read-only) The port used for secure (encrypted) HTTP sessions. The default is 443.</td>
</tr>
<tr>
<td>RTSP Port</td>
<td>(Read-only) The port used for Real Time Streaming Protocol (RTSP) out connections. Valid values are integers 1 through 65535. The default value is 554. If not, then recording will not start. In this example, 15 mbps of video uses approximately 2 megabytes of storage space per second, so 30 days of recording would require roughly 5 terabytes of disk storage. See the “Streaming, Recording and Event Settings” section on page 7-49 for more information on the <strong>Verify Recording Space</strong> option.</td>
</tr>
<tr>
<td>RTP Min Port</td>
<td>The lowest port number used for Real-time Transport Protocol (RTP) out connections. The default is 1024.</td>
</tr>
<tr>
<td>RTP Max Port</td>
<td>The highest port number used for Real-time Transport Protocol (RTP) sessions. The default is 65535.</td>
</tr>
</tbody>
</table>
## RTP Window Length

The maximum number of packets the Media Server buffers per stream to determine packet loss (before declaring a lost packet). This is also known as the jitter window length. This setting may need to be changed on a system with excessive packet delay on the network.

**Note** This value is normally set to 1 but may need to be increased on networks where packets can get delayed.

## Camera Control Lockout / sec

Designates the number of seconds that a lower priority user has to wait before being able to move the camera after a higher priority user stops using the PTZ controls. This value is the default for all cameras assigned to a Media Server unless the camera *When Manual PTZ idle for* setting is defined in the camera *PTZ Advanced Settings*.

For more information, see the following:
- Defining the User Group PTZ Priority, page 7-68
- PTZ Advanced Settings, page 7-75

<table>
<thead>
<tr>
<th>Table 6-11 Media Out Settings (continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTP Window Length</td>
</tr>
</tbody>
</table>
The maximum number of packets the Media Server buffers per stream to determine packet loss (before declaring a lost packet). This is also known as the jitter window length. This setting may need to be changed on a system with excessive packet delay on the network.  

**Note** This value is normally set to 1 but may need to be increased on networks where packets can get delayed.

<table>
<thead>
<tr>
<th>Camera Control Lockout / sec</th>
</tr>
</thead>
</table>
Designates the number of seconds that a lower priority user has to wait before being able to move the camera after a higher priority user stops using the PTZ controls. This value is the default for all cameras assigned to a Media Server unless the camera *When Manual PTZ idle for* setting is defined in the camera *PTZ Advanced Settings*.

For more information, see the following:
- Defining the User Group PTZ Priority, page 7-68
- PTZ Advanced Settings, page 7-75
## Recording Settings

Enter the **Recording** settings (under the **Advanced** tab) to define the following.

### Table 6-12   Recording Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recording Queue Size</td>
<td>The maximum number of frames per recording that can be in queue waiting to be written to disk.</td>
</tr>
<tr>
<td></td>
<td>The default is 150 and should only be increased if it is determined there is large I/O wait to the disk.</td>
</tr>
<tr>
<td>Maximum Event Duration / sec</td>
<td>The maximum duration for a motion or other event recording. This option should be set to the maximum number of seconds of continuous activity that any camera in a deployment might capture.</td>
</tr>
<tr>
<td></td>
<td>Valid values are integers 1 through 86400. The default value is 7200 seconds (2 hours).</td>
</tr>
<tr>
<td>Default Grooming Only</td>
<td>If selected, recordings will only be groomed (deleted) when a media partition reaches its maximum usage level (grooming will not be performed based on the expiry time).</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Use this option only if the server has adequate disk space and the recordings should be retained longer than the retention settings defined in the camera template configuration. For example, the Retain continuous recordings and Retain event recordings settings will not apply for the cameras assigned to the Media Server. See the “Streaming, Recording and Event Settings” section on page 7-49.</td>
</tr>
<tr>
<td><strong>Caution</strong></td>
<td>This option can prevent new recordings from starting if all disk space is used. See the Storage Estimation setting in the “Streaming, Recording and Event Settings” section on page 7-49.</td>
</tr>
</tbody>
</table>
Adding or Editing Media Servers

To add or edit Media Servers, select System Settings > Media Servers. Click Add to create a new entry or to import servers from a CSV file. Select an existing entry to revise an existing Media Server configuration (see the “Media Server Settings” section on page 6-6 for more information).

Refer to the following topics for more information:
- Prerequisites, page 6-17
- Adding or Editing a Single Media Server, page 6-17
- Importing or Updating Media Servers Using a CSV File, page 6-19

Prerequisites

- The Media Server(s) must be installed on a physical machine, or as a virtual machine (VM).
- Complete the Media Server initial configuration (including network settings) using the Setup Wizard available in the browser-based Cisco VSM Management Console.
  - In dual-homed/NAT server setups where DNS is configured correctly, we recommend using the Management Console’s Initial Setup Wizard to enter the hostname of the Operations Manager used to manage the Media Server. Using the Operations Manager hostname ensures that the Media Server can connect, even if the Operations Manager IP address changes.
  - Adding a Media Server directly to the Operations Manager configuration without completing the Management Console Initial Setup Wizard will cause the Media Server to use the Operations Manager IP address (instead of the hostname).
  - See the Cisco Video Surveillance Management Console Administration Guide for more information.

Adding or Editing a Single Media Server

Procedure

To add a new Media Server to the Cisco VSM configuration, complete the following procedure.

**Step 1** Install the Media Server and complete the Initial Setup Wizard using the browser-based Management Console.

- Cisco Video Surveillance Management Console Administration Guide.

**Step 2** Log on to the Operations Manager.

- See the “ Logging In and Managing Passwords” section on page 1-17.
- You must belong to a User Group with permissions for Media Servers & Encoders. See the “Adding Users, User Groups, and Permissions” section on page 4-1 for more information.

**Step 3** Select System Settings > Media Servers.

**Step 4** Click Add.
Tip

To edit a server, click an existing entry to highlight it, then refer to the “Media Server Settings” section on page 6-6.

Tip

If you are adding a Media Server that was previously configured in Cisco VSM, you will be prompted to import or discard any camera configurations or recordings that exist on the server.

Step 5  (Add only) Complete the initial server setup:

Figure 6-1  Add a Media Server

![Add Media Server Form]

Table 6-13  Media Server Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname/IP</td>
<td>The hostname or IP address used by the Operations Manager to access the Media Server.</td>
</tr>
<tr>
<td>Username</td>
<td>The default username for all Media Servers is localadmin. The username cannot be changed.</td>
</tr>
<tr>
<td>Password</td>
<td>The server password.</td>
</tr>
<tr>
<td>Server Type</td>
<td>Primary (for primary Media Server)</td>
</tr>
<tr>
<td>Name</td>
<td>Primary Server</td>
</tr>
<tr>
<td>Install Location</td>
<td>System</td>
</tr>
</tbody>
</table>

Tip

The server password is initially defined using the Cisco Video Surveillance Management Console interface. See the “General Information Settings” section on page 6-6 and the Cisco Video Surveillance Management Console Administration Guide for more information.
Table 6-13  Media Server Settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Server Type  | • **Primary server**—The server associated with cameras and templates responsible for processing, recording and storing video.  
• **Redundant server**—Provides additional video processing and storage for the Primary server. Video streams (such as Stream B) can be sent to the Redundant server, to the Primary server, or both.  
• **Failover server**—A hot standby server that can take control if the Primary server fails or goes offline.  
• **Long Term Storage (LTS) server**—A server used to store video archives and free space on the Primary and Redundant servers for newer video. |
| Name         | A meaningful name for the Media Server. For example, *Primary Server* or *Campus A Server*. |
| Install Location | The location where the Media Server is installed.  
The location determines the cameras and users that can access the Media Server. See the “Creating the Location Hierarchy” section on page 5-1 for more information. |

**Step 6**  (Optional) Enter or revise the additional Media Server settings, if necessary, as described in the “Media Server Settings” section on page 6-6.

**Step 7**  Click Save.

**Importing or Updating Media Servers Using a CSV File**

Multiple Media Servers can be imported using a *comma separated value* (CSV) file that includes configuration details for each device. This same method can be used to update existing Media Server configurations.

Complete the following procedures to import devices using a CSV file:

• Creating the CSV File, page 6-20
• Importing the CSV File, page 6-22

**Usage Notes**

• You can choose to retain the devices (cameras and encoders) that were previously associated with the Media Server, or discard them. Any discarded devices must be re-added, if required.
Adding or Editing Media Servers

- Enabled cameras and encoders associated with the Media Server are added to the Operations Manager in the pre-provisioned state. See the “Adding Cameras from an Existing Media Server” section on page 7-38 for more information.
- Soft deleted cameras are added to the Operations Manager in the soft-deleted state, which allows recordings to be accessed.
- Disabled cameras are not added to the Operations Manager configuration.
- See the “Adding and Managing Cameras” section on page 7-1 and the “Adding Encoders and Analog Cameras” section on page 10-1 for information about completing the configuration and enabling the devices.

- Entries with non-ASCII characters must be tab delimited. Entries that include only ASCII characters can be comma delimited.

Creating the CSV File

Create a file in plain text CSV format that can be opened and saved using Excel or OpenOffice Calc (Figure 6-2). Blank rows or rows beginning with “//” are ignored.

Tip

To download a sample import file, launch the import wizard as described in the “Importing the CSV File” section on page 6-22. Click the Download Sample button in the second step of the wizard to obtain a sample file (see Step 4).

Figure 6-2  Example of a Media Server Import File

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name</td>
<td>Host name or IP address</td>
<td>Install location path</td>
<td>local admin password</td>
<td>Server Role</td>
</tr>
<tr>
<td>2</td>
<td>//required</td>
<td>//required</td>
<td>//required</td>
<td>//required</td>
<td>//one of primary_server/redundant_server/ //optional</td>
</tr>
<tr>
<td>3</td>
<td>UMS-1</td>
<td>10.10.10.10</td>
<td>USA,CA,SJ,28,Lobby</td>
<td>secure4</td>
<td>primary_server</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>//Supported Delimiters - Contents that have non-ASCII characters, need to be delimited by tab. If the content contains only ASCII, comma delimiter should be used.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>//Any lines starting with “//” are treated as comments</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Adding or Editing Media Servers

The CSV file can be created in plain text using a program such as Excel or OpenOffice Calc. For example, in Excel, create the file and then choose **Save As > Other formats**. Select **CSV (Comma delimited)** for the **Save as type**.

The fields (columns) must follow a specific format, which is shown in the downloadable sample. **Table 6-14** describes the information required in each field.

**Table 6-14 Media Server Import File Field Descriptions**

<table>
<thead>
<tr>
<th>Content</th>
<th>Required/Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment //</td>
<td>Optional</td>
<td>Blank rows or lines/cells starting with &quot;//&quot; are treated as comments and ignored.</td>
</tr>
<tr>
<td>Name</td>
<td>Required</td>
<td>Enter the server name&lt;br&gt;For example: <strong>Primary Server</strong></td>
</tr>
<tr>
<td>Host name or IP address</td>
<td>Required</td>
<td>The network address for the physical or virtual machine.</td>
</tr>
<tr>
<td>Install Location Path</td>
<td>Required</td>
<td>Enter the location where the Media Server is physically installed, or the physical location of the cameras and encoders supported by the camera.&lt;br&gt;For example: <strong>USA.CA.SJ.28.Lobby</strong>&lt;br&gt;&lt;br&gt;<strong>Tip</strong> To view the location path, go to <strong>System Settings &gt; Locations</strong> and highlight the location name.</td>
</tr>
<tr>
<td>localadmin password</td>
<td>Required</td>
<td>The password configured on the Media Server to provide network access from the Operations Manager.&lt;br&gt;• This setting changes the Operations Manager’s understanding of the Media Server password. This does not change the actual server password. See the Cisco Video Surveillance Management Console Administration Guide for instructions to change the server password.&lt;br&gt;• See the “Access Information Settings” section on page 6-7 to revise the credentials after the Media Server is added to the system.&lt;br&gt;&lt;br&gt;<strong>Note</strong> The default username for all Media Servers is localadmin. The username is read-only and cannot be changed.</td>
</tr>
<tr>
<td>Server Role</td>
<td>Required</td>
<td>The high-availability role of the server. The options are:&lt;br&gt;• primary_server&lt;br&gt;• redundant_server&lt;br&gt;• failover_server&lt;br&gt;• long_term_storage_server&lt;br&gt;See the “Understanding Redundant, Failover, and Long Term Storage Servers” section on page 11-3 for more information.</td>
</tr>
<tr>
<td>Tags</td>
<td>Optional</td>
<td>Keywords used by the <strong>Find</strong> field.</td>
</tr>
</tbody>
</table>

Cisco Video Surveillance Manager Operations Manager User Guide
Importing the CSV File

Complete the following procedure to import a CSV file.

Procedure

**Step 1** Create the CSV file containing details for each Media Server.
- See the “Creating the CSV File” section on page 6-20.

**Step 2** Select System Settings > Media Servers.

**Step 3** Choose Add and Import Media Servers from file.

**Step 4** Complete each Import Step as described below:

a. **Import Step 1 - Retain Device(s)**
   (Cameras only) Select the Retain box if existing device(s) found on the Media Server during import should be retained. If selected:
   - Enabled cameras and encoders associated with the Media Server are added to the Operations Manager in the pre-provisioned state.
   - Soft deleted cameras are added to the Operations Manager in the soft-deleted state, which allows recordings to be accessed.
   - Disabled cameras are not added to the Operations Manager configuration.

Note: Cameras or encoders added to the Operations Manager in *pre-provisioned* state must be enabled once the configuration is complete. See the “Adding and Managing Cameras” section on page 7-1 and the “Adding Encoders and Analog Cameras” section on page 10-1 for information about completing the configuration and enabling the devices.

b. **Import Step 2 - Download Sample**
   (Optional) Click Download Sample to download a sample CSV import file. Use this sample to create the import file as described in the “Creating the CSV File” section on page 6-20. Click Next.

c. **Import Step 3 - File Upload**
   Click to select the CSV file from a local or network disk. Click Upload.

d. **Import Step 4 - Processing**
   Wait for the import process to complete.

e. **Import Step 5 - Results Success**:
   - If a success message appears, continue to Step 5.
   - If an error message appears, continue to Step 4 f.

f. If an error message appears (Figure 6-3), complete the following troubleshooting steps:
   - Click Download Annotated CSV, save the error file and open it in Excel or OpenOffice Calc.
   - Correct the annotated errors and save the revised file in the .CSV format.
   - Correct the CSV file in the /Error rows (Figure 6-3).
   - Click Start Over to re-import the fixed file.
   - Return to Step 3 and re-import the corrected CSV file.
Figure 6-3    Import Error File

Step 5  Click Close once the import process is complete.

Step 6  View the device status to determine if additional configuration is required. See the “Device Status: Identifying Issues for a Specific Device” section on page 12-6.

Step 7  Complete the camera and encoder configurations to enable the devices, if necessary. See the “Adding and Managing Cameras” section on page 7-1 and the “Adding Encoders and Analog Cameras” section on page 10-1 for more information.

Deleting a Media Server

To remove a Media Server you must remove all devices and other associations with the Media Server, or the job will fail.

Usage Notes
- If the Media Server is unreachable, and no HA servers are configured, the user is given an option to force-delete the server, which also deletes all camera configurations and recordings. All associated cameras must be re-added to Cisco VSM, and all recordings are lost.
- You can only delete a Media Server that is not associated with cameras or encoders.
- When a camera is moved to a different Media Server, recordings are begun again. Any existing recordings remain on the old Media Server. If the old Media Server is deleted, any associated recordings are removed.
- See the “Accessing the Camera Settings” section on page 7-42 for instructions to change a camera’s Media Server setting.

Procedure

Step 1  Log on to the Operations Manager.
- You must belong to a User Group with permissions for Media Servers & Encoders.
Deleting a Media Server

Step 2 Verify that all cameras and encoders associated with the Media Server are switched to a different Media Server.
- The camera’s existing recordings will remain on the old Media Server.
- See the “Accessing the Camera Settings” section on page 7-42 for instructions to change a camera’s Media Server setting.

Step 3 Click System Settings > Media Servers.
Step 4 Select the Media Server.
Step 5 Click Delete.
Step 6 Click OK to confirm.
Step 7 Wait for the Job to complete.
Bulk Actions: Revising Multiple Media Servers

Bulk Actions allows you to change the configuration or take actions for multiple Media Servers. For example, you can set the NTP server, set the SMTP server, repair the configurations, change the password used to access the servers, change the Media Server locations, or delete the servers.

To begin, filter the devices by attributes such as name, tags, location, status, or issue. You can then apply changes to the resulting devices.

Related Topics
- Bulk Actions: Revising Multiple Encoders, page 10-10
- Bulk Actions: Revising Multiple Cameras, page 7-87.

Procedure

**Step 1** Select System Settings > Media Servers.

**Step 2** Click Bulk Actions (under the device list) to open the Bulk Actions window (Figure 6-4).

*Figure 6-4  Bulk Actions Window*
Step 3  Click the icon next to each field to select the filter criteria.

Table 6-15  Bulk Action Filters

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search by Name</td>
<td>Enter the full or partial name and press Enter. For example, enter “Door” or “Do” to include all device names that include “Door”.</td>
</tr>
<tr>
<td>Search by Tag</td>
<td>Enter the full or partial tag string and press Enter.</td>
</tr>
<tr>
<td>Install Location</td>
<td>Select the location where the devices are installed.</td>
</tr>
<tr>
<td>Overall Status</td>
<td>Select the administrative states for the devices:</td>
</tr>
<tr>
<td></td>
<td><strong>Enabled (OK, Warning or Critical)</strong>—The device is enabled, although it may include a Warning or Critical event.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong> See the “Device Status: Identifying Issues for a Specific Device” section on page 12-6 for more information.</td>
</tr>
<tr>
<td>Issue Type</td>
<td>Select the issues that apply to the device.</td>
</tr>
</tbody>
</table>

Step 4  Click Search.

Step 5  (Optional) Click the icon to view and edit the device status and configuration settings.

Step 6  Select the devices that will be affected by the action.

- Choose the Select All check box to select ALL cameras matched by the filters, including the devices not shown in the grid.
- Use CTRL-CLICK and SHIFT-CLICK or to select multiple items.

Step 7  Click an Action button.

- For example, Set NTP Server, Set SMTP Server, Repair Configurations, Change Password, Change Location, etc.

Step 8  Follow the onscreen instructions to enter or select additional input, if necessary.

- For example, *Set SMTP Server Template* requires that you enter the server settings.

Step 9  Refer to the Jobs page to view the action status.

See the “Understanding Jobs and Job Status” section on page 12-23.
Viewing Media Server Status

To view the status of a Media Server, click the **Status** tab in the Media Server configuration page (Figure 6-5).

- Click the **Status History** tab to view detailed information regarding the events or alerts that impact the Device Status. For example, if a Synchronization mismatch occurs, and the Configuration status changes from OK to a synchronization alert, click the Status History tab to view details for the errors that caused the mismatch. See the “Viewing Device Error Details” section on page 12-11.
- Click **Reset** to clear status issues that do not automatically clear when the issue is resolved (see the “Resetting the Media Server Device State” section on page 6-28).
- See the following options to repair configuration issues or reset the device state:
  - Repairing the Configuration or Restarting the Server, page 6-28
  - Resetting the Media Server Device State, page 6-28
- See the “Viewing the Server HA Status” section on page 11-21 for more information on the Associated Servers status.

![Figure 6-5 Media Server Device Status](image)

<table>
<thead>
<tr>
<th>Status</th>
<th>General</th>
<th>Advanced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Status</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status History</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Overall Status**

- **Enabled: OK**

**Server Status**

- **Reachability**: Ok
- **Hardware**: Ok
- **Software**: Ok
- **Configuration**: Ok

**Associated Servers**

- **Failover Server**: Ok
- **Failover Status**: Not in Failover
- **Redundant Streams Server**: Ok
- **Long Term Storage Server**: Ok

**General Information**
Resetting the Media Server Device State

Click the **Reset** button on the Media Server **Status** page to clear device status and configuration issues.

- Clears status issues that do not automatically clear when the issue is resolved. For example, a Media Server issue that causes a coredump might still display a critical error in the Operations Manager even if the issue is resolved.
- Performs a **Repair Configuration** that synchronizes the Media Server configuration with the Operations Manager (mismatched configurations on the Media Server are replaced with the Operations Manager settings). See the “Repairing the Configuration or Restarting the Server” section on page 6-28.

**Note**

- Any unresolved configuration issues will reappear after the reset.
- Only the Media Server **state** is reset, not the device alerts or events. You must still acknowledge or clear any alert using the Cisco Video Surveillance Safety and Security Desktop.
- To access the Reset button, you must be a **Super User** or belong to a user group assigned to the `super_admin_role` (a super-user is anybody that has all permissions at the root location). See the “Adding Users, User Groups, and Permissions” section on page 4-1 for more information.

Repairing the Configuration or Restarting the Server

From the **General** tab, select the **Device Setting** menu and select one of the actions described in Table 6-16.

<table>
<thead>
<tr>
<th>Table 6-16 Media Server Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operation</strong></td>
</tr>
<tr>
<td>Replace Configurations</td>
</tr>
<tr>
<td>Repair Configurations</td>
</tr>
<tr>
<td>Restart</td>
</tr>
</tbody>
</table>
CHAPTER 7

Adding and Managing Cameras

Refer to the following topics for information to add, configure, and manage cameras in a Cisco VSM deployment.

- Always use the Operations Manager to configure cameras. Changes made directly to the camera are unknown to Cisco VSM and can result in incorrect device behavior.
- The camera configuration pages may not display properly if the Internet Explorer (IE) compatibility view box is checked. Deselect this option, if necessary.

Contents
- Overview, page 7-3
  - Understanding Network and Analog Cameras, page 7-3
  - Viewing Cameras, page 7-5
  - Requirements, page 7-3
  - Summary Steps, page 7-4
- Manually Adding Cameras, page 7-8
  - Overview, page 7-9
  - Manually Adding a Single Camera, page 7-12
  - Importing or Updating Cameras or Encoders Using a CSV File, page 7-17
- Discovering Cameras on the Network, page 7-22
  - Understanding Discovery and Auto-Configuration, page 7-22
  - Understanding Camera Conflicts, page 7-24
  - Enabling the Auto Configuration Defaults for a Camera Model, page 7-25
  - Discovering Non-Medianet Cameras on the Network, page 7-28
  - Cameras Pending Approval List, page 7-30
  - Discovering Medianet-Enabled Cameras, page 7-32
- Adding Cameras from an Existing Media Server, page 7-38
- Blacklisting Cameras, page 7-40
  - Blacklisting a Camera, page 7-40
– Viewing Cameras in the Blacklist, page 7-41
– Removing a Camera From the Blacklist, page 7-41

• Editing the Camera Settings, page 7-42
  – Accessing the Camera Settings, page 7-42
  – General Settings, page 7-45
  – Streaming, Recording and Event Settings, page 7-49
  – Image Settings, page 7-57
  – Configuring the High Availability Options for a Camera or Template, page 7-58

• Deleting Cameras, page 7-59

• Changing the Camera or Encoder Network Settings and/or Credentials, page 7-61

• Viewing Camera Status, page 7-63

• Configuring Camera PTZ Controls, Presets, and Tours, page 7-64
  – PTZ Requirements, page 7-65
  – PTZ Camera Configuration Summary, page 7-66
  – Defining the User Group PTZ Priority, page 7-68
  – Using Camera PTZ Controls, page 7-69
  – Configuring PTZ Presets, page 7-70
  – Configuring PTZ Tours, page 7-72
  – PTZ Advanced Settings, page 7-75

• Configuring Motion Detection, page 7-76

• Upgrading Camera and Encoder Driver Firmware, page 7-82

• Replacing a Camera, page 7-85

• Bulk Actions: Revising Multiple Cameras, page 7-87
Overview

Review the following topics for a basic understanding of camera configuration:

- Understanding Network and Analog Cameras, page 7-3
- Requirements, page 7-3
- Summary Steps, page 7-4
- Viewing Cameras, page 7-5
- Viewing a List of Supported Cameras, page 7-7

Understanding Network and Analog Cameras

Two types of cameras can be added to Cisco VSM:

- IP cameras (also called network cameras) are connect directly to the network and are added to Cisco VSM by entering the camera’s IP address and other settings.
- Analog cameras are connected to an encoder. The encoder provides network connectivity and digitizes the analog video. See the “Adding Encoders and Analog Cameras” section on page 10-1 for more information.

Requirements

Before you begin, verify that the following requirements are met.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Complete?</th>
</tr>
</thead>
<tbody>
<tr>
<td>You must belong to a user group with Cameras permission.</td>
<td>☐</td>
</tr>
<tr>
<td>See the “Adding Users, User Groups, and Permissions” section on page 4-1 for more information.</td>
<td>☐</td>
</tr>
<tr>
<td>At least one Media Server must be added to Cisco VSM.</td>
<td>☐</td>
</tr>
<tr>
<td>See the “Configuring Media Servers” section on page 6-1 for more information.</td>
<td>☐</td>
</tr>
<tr>
<td>At least one supported network or analog camera must be installed on the network.</td>
<td>☐</td>
</tr>
<tr>
<td>See the “Viewing a List of Supported Cameras” section on page 7-7 for more information.</td>
<td>☐</td>
</tr>
<tr>
<td>Analog cameras also require an encoder for network connectivity and to digitize the analog video. See the “Adding Encoders and Analog Cameras” section on page 10-1 for more information.</td>
<td>☐</td>
</tr>
<tr>
<td>The IP address used to access the device on the network.</td>
<td>☐</td>
</tr>
<tr>
<td>Note: All edge devices (such as cameras and encoders) must added to a server using a local (non-NAT) addresses.</td>
<td>☐</td>
</tr>
<tr>
<td>The camera username and password used to access the device on the network.</td>
<td>☐</td>
</tr>
</tbody>
</table>
Summary Steps

The following steps summarize how to add or update a video camera.

<table>
<thead>
<tr>
<th>Step</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Log on to the Operations Manager.</td>
</tr>
<tr>
<td></td>
<td>Logging In and Managing Passwords, page 1-17</td>
</tr>
<tr>
<td>Step 2</td>
<td>Configure recording schedules</td>
</tr>
<tr>
<td></td>
<td>Defining Schedules, page 8-1</td>
</tr>
<tr>
<td>Step 3</td>
<td>(Optional) Add camera templates.</td>
</tr>
<tr>
<td></td>
<td>Adding and Editing Camera Templates, page 9-1</td>
</tr>
<tr>
<td></td>
<td>Configuring Continuous, Scheduled, and Motion Recordings, page 9-7</td>
</tr>
<tr>
<td>Step 4</td>
<td>(Optional) Add camera encoders to support analog cameras.</td>
</tr>
<tr>
<td></td>
<td>Adding Encoders and Analog Cameras, page 10-1</td>
</tr>
<tr>
<td>Step 5</td>
<td>Add one or more cameras.</td>
</tr>
<tr>
<td></td>
<td>Understanding the Methods to Add Cameras, page 7-9</td>
</tr>
<tr>
<td></td>
<td>Manually Adding a Single Camera, page 7-12</td>
</tr>
<tr>
<td></td>
<td>Importing or Updating Cameras or Encoders Using a CSV File, page 7-17</td>
</tr>
<tr>
<td></td>
<td>Discovering Cameras on the Network, page 7-22</td>
</tr>
<tr>
<td></td>
<td>Adding Cameras from an Existing Media Server, page 7-38</td>
</tr>
<tr>
<td>Step 6</td>
<td>Edit additional camera settings.</td>
</tr>
<tr>
<td></td>
<td>Editing the Camera Settings, page 7-42</td>
</tr>
<tr>
<td>Step 7</td>
<td>(Optional) Create a custom configuration for a single camera.</td>
</tr>
<tr>
<td></td>
<td>Creating a Custom Template for a Single Camera, page 9-5</td>
</tr>
<tr>
<td>Step 8</td>
<td>Configure the Image Settings, such as PTZ, motion detection, and brightness and</td>
</tr>
<tr>
<td></td>
<td>contrast.</td>
</tr>
<tr>
<td></td>
<td>Image Settings, page 7-57</td>
</tr>
<tr>
<td></td>
<td>Configuring Camera PTZ Controls, Presets, and Tours, page 7-64</td>
</tr>
<tr>
<td></td>
<td>Configuring Motion Detection, page 7-76</td>
</tr>
<tr>
<td></td>
<td>Photographic Controls, page 7-57</td>
</tr>
<tr>
<td>Step 9</td>
<td>Configure the high availability options.</td>
</tr>
<tr>
<td></td>
<td>Configuring the High Availability Options for a Camera or Template, page 7-58</td>
</tr>
<tr>
<td>Step 10</td>
<td>Create actions that are triggered by camera events.</td>
</tr>
<tr>
<td></td>
<td>“Using Advanced Events to Trigger Actions” section on page 9-11</td>
</tr>
</tbody>
</table>
Viewing Cameras

To display cameras already configured on the system, click Cameras and then choose the Cameras tab (Figure 7-1). You can view the cameras for a location, Media Server, or template by clicking one of the icons described below Figure 7-1.

Click a camera name to view and edit the settings for that camera. Click a template name to edit the settings applied to all cameras associated with the template.

**Figure 7-1   Cameras Tab**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cameras By Location</td>
<td>Displays the cameras assigned to each location. For example, click the Cameras By Location tab and then select a location name (Figure 7-1). The cameras assigned to that location are listed by name. Click a camera name to display and edit the camera settings. <strong>Tip</strong>: See the “Creating the Location Hierarchy” section on page 5-1.</td>
</tr>
</tbody>
</table>
Overview

Note

The camera configuration pages may not display properly if the Internet Explorer (IE) compatibility view box is checked. Deselect this option, if necessary.

Cameras by Media Server
Displays the cameras assigned to each Media Server.
If only one Media Server is used, all cameras will be listed. See the “Configuring Media Servers” section on page 6-1.

Cameras By Template
Displays the cameras assigned to each template.
Tip
The number next to the template name indicates the number of cameras assigned to the template. See the “Adding and Editing Camera Templates” section on page 9-1 for more information.

Tab | Description
--- | ---
Cameras by Media Server | Displays the cameras assigned to each Media Server.
If only one Media Server is used, all cameras will be listed. See the “Configuring Media Servers” section on page 6-1.
Cameras By Template | Displays the cameras assigned to each template.
Tip | The number next to the template name indicates the number of cameras assigned to the template. See the “Adding and Editing Camera Templates” section on page 9-1 for more information.
Viewing a List of Supported Cameras

To view the camera models supported in the Cisco Video Surveillance release you are using, open the model list when adding a camera.

Procedure

Step 1   Click **Cameras** and then choose the **Cameras** tab (Figure 7-2).
Step 2   Select the Camera Type: IP Camera or Analog Camera.
Step 3   Click the **Model** field.
         • A list of supported cameras for that camera type and the Cisco Video Surveillance release is displayed (Figure 7-2).
Step 4   Expand the Manufacturer names to view the list of supported models.

Figure 7-2   Supported Cameras
Manually Adding Cameras

Cameras can be added to Cisco VSM individually, or in groups. You can add cameras that are already installed, or *pre-provision* cameras that are not yet available on the network. Network cameras can also be discovered on the network and automatically configured or held offline until approved by an administrator. In addition, if you add a Media Server that was previously installed in another VSM 6.x or 7.x deployment, you will be prompted to add or discard any cameras configured on that server.

For more information, see the following topics:

- **Overview**, page 7-9
  - Understanding the Methods to Add Cameras, page 7-9
  - Pre-Provisioning Cameras, page 7-10
  - Understanding Discovery and Auto-Configuration, page 7-22
- Manually Adding a Single Camera, page 7-12
- Importing or Updating Cameras or Encoders Using a CSV File, page 7-17
  - Creating the CSV File, page 7-18
  - Importing the CSV File, page 7-20
- Discovering Cameras on the Network, page 7-22
  - Enabling the Auto Configuration Defaults for a Camera Model, page 7-25
  - Discovering Non-Medianet Cameras on the Network, page 7-28
- Adding Cameras from an Existing Media Server, page 7-38
  - Adding Cameras From a 6.x or 7.x Media Server, page 7-38
  - Adding Unknown Cameras During a Media Server Synchronization, page 7-39
Overview

Review the following topics to understand how cameras are added to Cisco VSM.

- Understanding the Methods to Add Cameras, page 7-9
- Pre-Provisioning Cameras, page 7-10
- Cameras with Duplicate IP Addresses, page 7-10
- Understanding Discovery and Auto-Configuration, page 7-22
- Discovering Medianet-Enabled Cameras, page 7-32

Understanding the Methods to Add Cameras

You can add cameras to Cisco VSM using one or more of the following methods:

<table>
<thead>
<tr>
<th>Table 7-2 Summary of Add Camera Methods</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add Method</strong></td>
</tr>
<tr>
<td>Manually Adding a Single Camera, page 7-12</td>
</tr>
<tr>
<td>Add a single camera from the Camera configuration page. All required settings must be entered, although you can pre-provision the camera if it is not yet available on the network.</td>
</tr>
<tr>
<td>Importing or Updating Cameras or Encoders Using a CSV File, page 7-17</td>
</tr>
<tr>
<td>Multiple cameras can be imported from a comma separated value (CSV) file that defines the camera configurations. You can choose to pre-provision the cameras, and add cameras with partial configurations, if necessary. This same method can be used to update existing camera configurations.</td>
</tr>
<tr>
<td>Tip <strong>You can import network (IP) cameras, encoders and analog cameras.</strong></td>
</tr>
<tr>
<td>Discovering Cameras on the Network, page 7-22</td>
</tr>
<tr>
<td>IP cameras that are added to the network can be discovered and added to Cisco VSM. You can manually trigger the discovery process, or use Medianet to automatically discover cameras as they are added.</td>
</tr>
<tr>
<td>If the auto configuration feature is enabled for the camera model, the camera is automatically configured and enabled in Cisco VSM. If not, the camera is added to a Cameras Pending Approval list. The camera can then further configured and approved (enabled), or it can be moved to the camera blacklist, which excludes the device from future discovery.</td>
</tr>
</tbody>
</table>
Pre-Provisioning Cameras

Pre-provisioning cameras allows you to add the cameras before they are installed or available on the network. The camera is waiting to be added to Cisco VSM and is not available for use. A pre-provisioned camera can be modified, but the camera cannot stream or record video.

After the camera is installed and available on the network, you can enable the camera by choosing Enable from the Device Settings menu. The camera configuration must be complete, and Cisco VSM must be able to verify network communication or the enable action will fail.

Cameras with Duplicate IP Addresses

If a camera is added with a duplicate IP address (the address is the same as an existing camera), the new camera will display an ID collision issue. For example, cameras manually added will be placed in the Enabled: Critical state. Discovered cameras will be placed in the Pending Approval list.

To resolve the issue, do one of the following:

- Use the Operations Manager to configure the camera with an unused IP address.
- Directly connect to the camera interface and enter a unique IP address that is reachable by the Media Server, or ensure that the camera can receive a reachable address from a DHCP server.

Note

A direct camera connection may be necessary if the duplicate camera is on a different subnet than the Media Server, which causes the camera to be unreachable by the Media Server. To avoid this issue, place all devices including cameras on the same subnet. Refer to the camera documentation for instructions to revise the camera IP address or DHCP settings. The resulting IP address must be reachable by the Media Server to which it is assigned.
• Use the **Replace Camera** option to move the old camera’s settings to the new camera. See the “Replacing a Camera” section on page 7-85.

• Delete the camera and re-add it with a unique IP address. See the “Deleting Cameras” section on page 7-59).
Manually Adding a Single Camera

To manually add a single camera, open the camera configuration page and click Add. Enter the camera settings as described in the “Procedure” section on page 14.

**Figure 7-3  Manually Adding a Camera or Encoder**

![Diagram showing the process of manually adding a camera or encoder]

**Enabled:**

- **Overall Status = OK, Warning or Critical.** Device can stream and record video, unless in a critical state.

**Pre-Provisioned:**

- Device can be modified, but cannot stream live video or record new video.

**Note**

All required fields must be complete to add a camera manually. You cannot submit a partial configuration.

**Usage Notes**

- To add the camera, you must choose a pre-defined configuration template and camera location. Only users with access permissions to that same location can view video from the camera.
- To make configuration changes, users must have Camera management permissions.
- The camera must be assigned to a Media Server, Location, and camera template. See the following for more information.
  - Adding or Editing Media Servers, page 6-17
  - Creating the Location Hierarchy, page 5-1
  - Adding and Editing Camera Templates, page 9-1

**Tip**

Although you must choose a camera template when adding the camera, you can edit the camera configuration after the initial configuration to create a custom configuration. See the “Accessing the Camera Settings” section on page 7-42.

**Network (IP) Camera Rules and Settings**

The camera must be accessible on the network if the device is added in Enabled state (Figure 7-3).

- If the camera is not available on the network, you can add the camera in pre-provisioned state. The camera will be disabled until you choose Enable from the Device Settings menu (all required fields must be complete).
• If the camera is still not reachable on the network it will be in Enabled: Critical state until the network issue is resolved.

See the “Pre-Provisioning Cameras” section on page 7-10 and the “Viewing Camera Status” section on page 7-63

Table 7-3  Network Camera General Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>Enter the hostname or IP address entered in the camera configuration.</td>
</tr>
<tr>
<td></td>
<td>See the camera documentation for instructions.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> All edge devices (such as cameras and encoders) must added to a server using a local (non-NAT) addresses.</td>
</tr>
<tr>
<td>Username</td>
<td>Enter the username for accessing the camera on the network.</td>
</tr>
<tr>
<td></td>
<td>See the camera documentation for instructions to configure the camera username.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password for accessing the camera on the network.</td>
</tr>
<tr>
<td></td>
<td>See the camera documentation for instructions to configure the camera password.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a descriptive name that can help you identify the camera. The name can include any combination of characters and spaces.</td>
</tr>
<tr>
<td>Install Location</td>
<td>Click to select the location where the camera is physically installed.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> The Installed and Pointed locations define where the camera is physically installed vs. the scene that the camera is recording. For example, a camera installed on building 2 might be pointed at the lobby door of building 1. If an alert event occurs at the Building 1 lobby, it can be flagged and viewed using the Cisco Safety and Security Desktop application even though the camera is physically installed on building 2. See the “Understanding a Camera’s Installed Location Vs. the Pointed Location” section on page 5-9.</td>
</tr>
<tr>
<td>Media Server</td>
<td>Select the Media Server responsible for storing and playing video from the camera.</td>
</tr>
<tr>
<td>Model</td>
<td>Select the camera model.</td>
</tr>
<tr>
<td>Template</td>
<td>Select a camera template from the pop-up window.</td>
</tr>
<tr>
<td></td>
<td>• You must choose an existing template when the camera is added to Cisco VSM. After the camera is created, you can create a custom configuration or select a different template. See the “Accessing the Camera Settings” section on page 7-42.</td>
</tr>
<tr>
<td></td>
<td>• Templates define attributes such as video quality and schedules. Only templates that support the camera are displayed. See the “Adding and Editing Camera Templates” section on page 9-1 for more information.</td>
</tr>
</tbody>
</table>

Analog Camera Rules and Settings

Analog cameras are attached to an encoder that provides network connectivity. See the following documentation for more information

• See the encoder documentation for instructions to properly attach the serial cables to the cameras and determine the serial port and serial address for each camera.

• Verify that the encoder and analog cameras meet the requirements specified in the “Requirements” section on page 10-3.

• Single analog camera are attached to the encoder directly. Multiple cameras can be attached in a daisy chain configuration. A serial port and serial address is assigned to each camera. See the encoder documentation for more information.
Manually Adding Cameras

- See the “Adding Encoders and Analog Cameras” section on page 10-1 for additional instructions to add the encoder and analog cameras. You can add analog cameras using the encoder configuration page, or the camera configuration page.

### Table 7-4 Analog Camera General Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encoder</td>
<td>Select the encoder that supports the analog camera.</td>
</tr>
<tr>
<td>Video Port</td>
<td>The physical encoder video port where the camera video cable is attached.</td>
</tr>
<tr>
<td><strong>Tip</strong></td>
<td>Only the unused ports are displayed.</td>
</tr>
<tr>
<td>Audio Port</td>
<td>(Optional) The physical encoder audio port where the camera audio cable is attached.</td>
</tr>
<tr>
<td><strong>Tip</strong></td>
<td>Only the unused ports are displayed.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a descriptive name that can help you identify the camera. The name can include any combination of characters and spaces.</td>
</tr>
<tr>
<td>Installed Location</td>
<td>Select the location where the camera is physically installed.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>The Installed and Pointed locations define where the camera is physically installed vs. the scene that the camera is recording. For example, a camera installed on building 2 might be pointed at the lobby door of building 1. If an alert event occurs at the Building 1 lobby, it can be flagged and viewed using the Cisco Safety and Security Desktop application even though the camera is physically installed on building 2. See the “Understanding a Camera’s Installed Location Vs. the Pointed Location” section on page 5-9.</td>
</tr>
<tr>
<td>Model</td>
<td>Select the camera model.</td>
</tr>
<tr>
<td>Template</td>
<td>Select a camera template from the pop-up window.</td>
</tr>
<tr>
<td></td>
<td>- The template is based on the encoder model, not the camera model.</td>
</tr>
<tr>
<td></td>
<td>- You must choose an existing template when the camera is added to Cisco VSM. After the camera is created, you can create a custom configuration or select a different template. See the “Accessing the Camera Settings” section on page 7-42.</td>
</tr>
<tr>
<td></td>
<td>- Templates define attributes such as video quality and schedules. Only templates that support the camera are displayed. See the “Adding and Editing Camera Templates” section on page 9-1 for more information.</td>
</tr>
</tbody>
</table>

### Procedure

To manually add a camera to the Cisco VSM configuration, complete the following procedure.

**Step 1** Log on to the Operations Manager.
- See the “Logging In” section on page 1-17.
- You must belong to a User Group with permissions for Cameras.

**Step 2** (Optional) Create a camera template that defines the camera configuration, if necessary.
- You can also use an existing template, such as the default system templates for low, medium and high quality video.
- You must assign a template to the camera when adding it to Cisco VSM.
- After adding the camera, you can modify the template or create a custom configuration for the camera.
- See the “Adding and Editing Camera Templates” section on page 9-1.
Step 3 Click Cameras.

Step 4 Click Add.

Tip You can also click the Add icon and choose Add a camera manually.

Step 5 Select the camera type:
- **IP Camera**—networked IP camera
- **Analog Camera**—analog camera are attached to an encoder to provide network connectivity and digitize the analog video. See the “Adding Encoders and Analog Cameras” section on page 10-1 for more information.

Tip To use the auto-discovery option, see the “Viewing Camera Status” section on page 7-63.

Step 6 Enter the basic camera settings.
- Network (IP) Camera Rules and Settings, page 7-12
- Analog Camera Rules and Settings, page 7-13

Step 7 Click Add.

Step 8 If a camera is not found on the network (the camera is offline or the username/password are incorrect), you can choose to pre-provision the camera. Pre-provisioning allows the camera to be added to Cisco VSM as a disabled device. Select Enable from the Device Settings menu once camera network installation is complete.

Step 9 Wait for the Job to complete.
See the “Understanding Jobs and Job Status” section on page 12-23.

Step 10 (Optional) When the camera configuration page appears, update the additional General Information settings, if necessary

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pointed Location</td>
<td>Click to select the location where the camera is pointed. This is the video that will be displayed and recorded by the camera. Tip See the “Understanding a Camera’s Installed Location Vs. the Pointed Location” section on page 5-9.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the camera, if necessary.</td>
</tr>
</tbody>
</table>

Step 11 (Optional) Enter additional configurations, if necessary.
See the “Editing the Camera Settings” section on page 7-42.

Step 12 (Optional) If the camera was pre-provisioned, complete the configuration and select Enable from the Device Settings menu.

Note The Enable option is only enabled if the camera configuration is complete and the device is available on the network.
Manually Adding Cameras

Chapter 7     Adding and Managing Cameras

---

**Step 13**  Repeat Step 4 through Step 11 to add additional cameras, if necessary.
Importing or Updating Cameras or Encoders Using a CSV File

Multiple cameras or encoders can be imported using a comma separated value (CSV) file that includes configuration details for each device (Figure 7-4). This same method can be used to update existing camera configurations.

Complete the following procedures to import devices using a CSV file:

- Creating the CSV File, page 7-18
- Importing the CSV File, page 7-20

**Figure 7-4 Importing Cameras from a CSV File**

Usage Notes

- Only cameras can be pre-provisioned. Encoders can be added before they are available on the network, but they will be in Enabled: Critical state.

- Pre-provisioned cameras are waiting to be added to Cisco VSM. You can make additional configuration changes, but the camera cannot stream or record video until the configuration and network issues are resolved. Choose Enable from the Device Settings menu to enable the camera video functions. See the “Pre-Provisioning Cameras” section on page 7-10 for more information.

- If the CSV file details are accurate and complete, the cameras are added to Cisco VSM and video from the cameras is available for viewing and recording.

- If any required fields are left blank, or if any cameras in the file are not available on the network, then the devices are added to Cisco VSM in pre-provisioned state, even if the pre-provisioned option is deselected. Complete the configuration to change the status to Enabled. See Table 7-5 for the required fields.
• If any fields are inconsistent with the Cisco VSM configuration, the import action fails and an error file is created that specifies the problem(s). For example, if the CSV file specifies a Media Server or location that does not exist in your Cisco VSM configuration, an error occurs. Correct the CSV file and try again, as described in the following procedure.

• You cannot mix device types in the import file. For example, the file can include encoder devices, IP cameras, or analog cameras only.

Creating the CSV File

Create a file in plain text CSV format that can be opened and saved using Excel or OpenOffice Calc (Figure 7-5). Blank rows or rows beginning with “//” are ignored.

Tip

To download a sample import file, launch the import wizard as described in the “Importing the CSV File” section on page 7-20. Click the Download Sample button in the second step of the wizard to obtain a sample file (see Step 5). The import file is different for each device type: IP cameras, analog cameras, and encoders.

Figure 7-5 Example of a Camera Import File

Table 7-5 describes the CSV file fields for both IP and analog cameras (the fields vary for each cameras type).

The CSV file can be created in a program such as Excel or OpenOffice Calc and saved as a CSV file. For example, in Excel, create the file and then choose Save As > Other formats. Select CSV (Comma delimited) for the Save as type.

Table 7-5 Import File Field Descriptions

<table>
<thead>
<tr>
<th>Content</th>
<th>Required/Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment //</td>
<td></td>
<td>Blank rows or lines/cells starting with “//” are treated as comments and ignored.</td>
</tr>
<tr>
<td>Name</td>
<td>IP / Analog Cameras</td>
<td>Enter the camera name</td>
</tr>
<tr>
<td></td>
<td>Optional</td>
<td>For example: LOBBY INT ENTRY</td>
</tr>
</tbody>
</table>
### Manually Adding Cameras

#### Required/Optional Fields

<table>
<thead>
<tr>
<th>Content</th>
<th>Required/Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>IP / Analog Cameras Required</td>
<td>The camera model. For example: cisco_2500</td>
</tr>
<tr>
<td>IP address</td>
<td>IP cameras</td>
<td>At least one value is required (IP address, MAC or serial number).</td>
</tr>
</tbody>
</table>
| MAC address              | Required          | • New Cameras—The IP address, serial number, and MAC address must be unique for new cameras. See the “Cameras with Duplicate IP Addresses” section on page 7-10 for more information.  
  • Existing cameras—If all three entries are provided for an existing camera, the settings must match the devices existing settings. |
| Serial no                | (see description) |                                                                                                                                             |
| Media Server             | IP cameras        | Enter the Media Server name.                                                                                                                 |
|                          | Optional          | Note  The Media Server must be valid and already present in the system. See the “Adding or Editing Media Servers” section on page 6-17.          |
| Encoder Name             | Analog cameras    | Enter the name of the encoder that provides connectivity for the analog camera.                                                             |
| Encoder video port       | Required          | Enter the encoder port number used for video by the analog cameras                                                                         |
| Encoder audio in port    | Analog cameras    | Enter the encoder port number used for audio input by the analog cameras                                                                   |
| Install Location Path    | IP / Analog Cameras Optional | Enter the location where the camera is physically installed. For example camera’s installed location path.  
  For example: CA/North Campus/bldg 2  
  See the “Understanding a Camera’s Installed Location Vs. the Pointed Location” section on page 5-9. |
| Point-To Location Path   | IP / Analog Cameras Optional | Enter the location where the camera is capturing video. For example, a camera installed on building 2 can be pointed at building 1, so the camera’s video is from the pointed at location building 1.  
  For example: CA/North Campus/bldg 1  
  See the “Understanding a Camera’s Installed Location Vs. the Pointed Location” section on page 5-9. |
| Template Name            | IP / Analog Cameras Optional | The configuration template that defines the camera video quality, recording and motion parameters, and other settings.  
  Note The template must be valid and already present in the system. See the “Adding and Editing Camera Templates” section on page 9-1. |
Manually Adding Cameras

Chapter 7  Adding and Managing Cameras

Manually Adding Cameras

Importing the CSV File

Complete the following procedure to import a CSV file.

Procedure

Step 1  (Optional) Enable auto-configuration defaults for the camera model(s).

- Auto-configuration applies camera settings based on the camera model.
- See the “Enabling the Auto Configuration Defaults for a Camera Model” section on page 7-25.

Step 2  Create the camera CSV file containing details for each camera.

- See the “Creating the CSV File” section on page 7-18.

Step 3  Click Cameras.

- Or click Cameras and then Encoders to import a list of encoders.

Step 4  Choose Add and choose Import cameras from file or Import encoders from file.

Step 5  Complete each Import Step as described below:

a.  Import Step 1 - Device Type

- (Cameras only) Select IP Camera or Analog Camera.
- (Cameras only) Click the Pre-Provision box if the devices should be pre-provisioned when added to Cisco VSM. This allows you to add the devices before they are available on the network, or before they should be available to end users.

Note  If any required fields are left blank, or if any cameras in the file are not available on the network, then the devices are added to Cisco VSM in pre-provisioned state, even if the pre-provisioned option is deselected. Complete the configuration to change the status to Enabled. See Table 7-5 for the required fields.

b.  Import Step 2 - Download Sample

(Optional) Click Download Sample to download a sample CSV import file. Use this sample to create the import file as described in the “Creating the CSV File” section on page 7-18. Click Next.

c.  Import Step 3 - File Upload:

Click Choose to select the CSV file from a local or network disk. Click Upload.

Table 7-5  Import File Field Descriptions (continued)

<table>
<thead>
<tr>
<th>Content</th>
<th>Required/Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>IP Cameras Optional</td>
<td>The username configured on the camera to provide network access. See the camera documentation for instructions to define the camera credentials.</td>
</tr>
<tr>
<td>Password</td>
<td>IP Cameras Optional</td>
<td>The password configured on the camera to provide network access. • See the camera documentation for instructions to define the camera credentials. • See the “Changing the Camera or Encoder Network Settings and/or Credentials” section on page 7-61 to revise the credentials after the camera is added to the system.</td>
</tr>
</tbody>
</table>
**Chapter 7  Adding and Managing Cameras**

**Manually Adding Cameras**

**d. Import Step 4 - Processing:**
Wait for the import process to complete.

**e. Import Step 5 - Results:**
- If a *success* message appears, continue to Step 6.
- If an *error* message appears, continue to Step 5 f.

**f. If an *error* message appears (Figure 7-6), complete the following troubleshooting steps:**
- Click **Download Annotated CSV**, save the error file and open it in Excel or OpenOffice Calc.
- Correct the annotated errors and save the revised file in the *.CSV* format.
- Re-import the fixed file.
- Correct the CSV file in the //ERROR rows (Figure 7-6).
- Return to Step 4 and re-import the corrected CSV file.

**Figure 7-6   Camera Import Error File**

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Step 6  Click Close.**

**Step 7  View the camera status to determine if additional configuration is required.**
- See the “Device Status: Identifying Issues for a Specific Device” section on page 12-6.
Discovering Cameras on the Network

IP cameras that have been installed on the network can be discovered and added to Cisco VSM. Cameras that support Medianet can be discovered automatically, or you can manually trigger discovery.

See the following topics for more information:
- Understanding Discovery and Auto-Configuration, page 7-22
- Understanding Camera Conflicts, page 7-24
- Enabling the Auto Configuration Defaults for a Camera Model, page 7-25
- Discovering Non-Medianet Cameras on the Network, page 7-28
- Cameras Pending Approval List, page 7-30
- Discovering Medianet-Enabled Cameras, page 7-32
  - Medianet Requirements, page 7-32
  - Medianet Overview, page 7-33
  - Medianet Camera Discovery Procedure, page 7-36

Understanding Discovery and Auto-Configuration

Cisco VSM can discover network cameras that are added to the network using one of the following methods:

<table>
<thead>
<tr>
<th>Table 7-6</th>
<th>Camera Discovery Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discovery Method</td>
<td>Description</td>
</tr>
<tr>
<td>Automatic Discovery</td>
<td>Medianet-enabled cameras can be discovered automatically and added to Cisco VSM when added to the network. Note: Medianet cameras must be configured with an admin user.</td>
</tr>
<tr>
<td>Manually Trigger Discovery</td>
<td>Cameras that do not support Medianet can still be discovered on the network, but the discovery must be manually triggered and the cameras must support the Bonjour discovery feature.</td>
</tr>
</tbody>
</table>

Cameras Pending Approval List

Cameras discovered on the network are added to the Cameras Pending Approval list (Figure 7-7), allowing you to review the discovered cameras, add additional configuration settings if necessary, and manually approve the camera addition to Cisco VSM. See the “Cameras Pending Approval List” section on page 7-30 for more information.

Auto-Configuration Defaults
If the **Auto-configuration default** option is enabled for a camera model, then the basic configuration and template is automatically applied to the camera, and the camera is added directly to the enabled state (Figure 7-7). **Auto-configuration default** settings are accessed in the System Settings page. See the "Enabling the Auto Configuration Defaults for a Camera Model" section on page 7-25 for more information.

**Supported Cameras**

To view the camera models that support discovery, open the Auto Configuration Settings page and click on a camera manufacturer. See the Enabling the Auto Configuration Defaults for a Camera Model, page 7-25.

---

**Figure 7-7 Camera Discovery and AutoConfig Flow Chart**

---

You can also move a discovered camera to the Blacklist to prevent it from being added to Cisco VSM or from being discovered in future discovery actions (Figure 7-7).
Understanding Camera Conflicts

Cameras are identified in Cisco VSM discovery by the device IP Address, and serial number, mac address/hardware ID. If a camera is discovered with values in these fields that already exist in the Cisco VSM configuration, the camera records will either be merged, or placed in a collision state.

- If some identity fields in a discovered camera and existing camera are a perfect match, but some fields are empty, then the records are merged. For example, if a camera in Cisco VSM includes only a name and MAC address, and a discovered camera has the same MAC address plus additional fields for serial number and IP address, then the two records are merged into a single camera entry.

- If both the Cisco VSM camera and a discovered camera include identity fields that do not match, both cameras are placed in a collision state. You must replace or delete one of the cameras to remove the conflict.

Open the camera Status tab on the configuration page to view more information (see the “Viewing Camera Status” section on page 7-63).

- The device overall status is Enabled: Critical.
- Click the link next to the Hardware category to open a pop-up that details the collision.
- An Alert is generated for “identity collision”.

- If the discovered camera uses DHCP settings, and only the IP address is in conflict, then the IP address of the discovered camera is used. If the discovered camera uses a static IP address, however, then the camera entries are in conflict.

Open the camera Status tab on the configuration page to view more information (see the “Viewing Camera Status” section on page 7-63).

Note: Settings such as name, template, location, media-server associations are configurations in the Operations Manager and are not merged or overwritten by discovered settings.
Enabling the Auto Configuration Defaults for a Camera Model

The auto-configuration default settings are automatically applied to cameras that are discovered on the network. Auto-configuration is disabled for all camera models by default. You must enable the defaults for each camera model.

**Figure 7-8  Device Auto Configuration**

![Device Auto Configuration Diagram](image)

Usage Notes

- If auto-configuration is not enabled for a camera model (or if the auto-configuration fails) then the camera is placed in the Cameras Pending Approval list. See the “Cameras Pending Approval List” section on page 7-30 for more information.

- If the auto-configuration fails, cameras can also be placed Enabled –Critical state. For example, if the entered password does not match the password configured on the device.

- Medianet-enabled devices also include an **Uninitialized** option. Select this to log in to the camera using the default device credentials. Enter a password to automatically replace the device password with the new setting (the username is read-only).
Procedure
To enable auto-configuration for cameras that are discovered on the network or imported from a CSV file, complete the following procedure.

Step 1 Log on to the Operations Manager.
   • See the “Logging In” section on page 1-17.
   • You must be a Super User or belong to a user group assigned to the super_admin_role (a super-user is anybody that has all permissions at the root location). See the “Adding Users, User Groups, and Permissions” section on page 4-1 for more information.

Step 2 Select System Settings > Auto Provisioning Settings.
   • The Device Auto Configuration screen appears (Figure 7-8).

Step 3 Click a camera Vendor.

Step 4 Click a camera Model.

Step 5 Select the Enable Auto Configuration check-box.
Step 6  Enter the auto-configuration settings that will be applied to all discovered or imported cameras (of that model).

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uninitialized</td>
<td>(Medianet enabled devices only) Select this option to use the default credentials to initially access the camera. Enter a new password to change the default setting.</td>
</tr>
<tr>
<td></td>
<td>Note The change will not be implemented if the current username and password has been changed from the factory default.</td>
</tr>
<tr>
<td>Username</td>
<td>Enter the username used to access the camera over the network.</td>
</tr>
</tbody>
</table>
| Password         | Enter the password used to access the camera over the network.  
|                  | - See the camera documentation for instructions to set the credentials, or ask your system administrator for the information.                       |
|                  | - See the “Changing the Camera or Encoder Network Settings and/or Credentials” section on page 7-61 to revise the credentials after the camera is added to the system.                           |
| Template         | Select the camera template that will provide the camera configuration.                                                                                                                                        |
|                  | See the “Adding and Editing Camera Templates” section on page 9-1 for more information.                                                                                                                    |
| Media Server     | (Optional) Select the Media Server that will manage the camera (the camera will be assigned to this Media Server).                                                                                         |
|                  | See the “Configuring Media Servers” section on page 6-1 for more information.                                                                                                                              |
| Default Motion Window | (Optional) Enable motion configuration features for the entire camera view. This option is enabled only if the camera supports motion detection.          |
|                  | See the “Configuring Motion Detection” section on page 7-76 for more information.                                                                                                                          |

Step 7  Click Save.

Step 8  (Optional) Repeat this procedure to enable auto-configuration defaults for additional camera models.
Discovering Non-Medianet Cameras on the Network

Cameras that do not support Medianet can still be discovered on the network, but the discovery must be manually triggered. The cameras must also support the Bonjour discovery feature, and Bonjour must be enabled on the device.

You can also (optionally) enable the auto-configuration defaults for the camera model to automatically complete the basic camera properties and enable the camera in Cisco VSM.

Procedure

<table>
<thead>
<tr>
<th>Table 7-7</th>
<th>Manual Camera Discovery Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Task</strong></td>
<td><strong>Description and more information</strong></td>
</tr>
<tr>
<td><strong>Step 1</strong></td>
<td>Review the overview sections to understand the discovery process.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>Enable the Bonjour discovery feature on each camera, if not enabled by default.</td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td>(Optional) Enable auto-configuration presets.</td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
<td>Trigger the discovery process</td>
</tr>
<tr>
<td><strong>Step 5</strong></td>
<td>Wait for the camera to be discovered and be added to the Operations Manager.</td>
</tr>
</tbody>
</table>

**Step 1**
Review the overview sections to understand the discovery process.
- Understanding Discovery and Auto-Configuration, page 7-22
- Understanding Camera Conflicts, page 7-24
- Enabling the Auto Configuration Defaults for a Camera Model, page 7-25
- Cameras Pending Approval List, page 7-30

**Step 2**
Enable the Bonjour discovery feature on each camera, if not enabled by default.
See the product documentation for the device to determine Bonjour support and configuration.

**Step 3**
(Optional) Enable auto-configuration presets.
If auto-configuration is enabled for the camera model, the camera will automatically be added to Cisco VSM.

- Media Servers—Select the Media Server used to discover the cameras.
- Camera Make(s)—Select the camera make(s) that will be discovered. For example, select Cisco Systems, Inc. to discover all Cisco-branded cameras.
- Click Save.
See the Enabling the Auto Configuration Defaults for a Camera Model, page 7-25.

**Step 4**
Trigger the discovery process

- Click Cameras.
- Choose Add > Discover New Cameras.

**Step 5**
Wait for the camera to be discovered and be added to the Operations Manager.

- Discovery can take a few minutes based on the factors such as the camera configuration, availability of the Media Servers, and other variables.
- If a discovered camera has the same device ID fields as an existing camera entry (IP Address, and serial number, mac address/hardware ID), then the records are either merged, or placed in conflict. See Understanding Camera Conflicts for more information.
### Table 7-7 Manual Camera Discovery Steps (continued)

<table>
<thead>
<tr>
<th>Step 6</th>
<th>Task</th>
<th>Description and more information</th>
</tr>
</thead>
</table>
|        | Approve cameras that were added to the Cameras Pending Approval list. | If auto-configuration is not enabled for the camera model, the camera is added to the Cameras Pending Approval list, which allows you to apply additional configurations and approve (add) the camera.  
  a. Open the Cameras Pending Approval list to modify the camera configuration.  
  b. Approve the camera or move it to the blacklist.  
  See the “Cameras Pending Approval List” section on page 7-30 for more information. |

| Step 7 | Complete the camera configuration. | If auto-configuration was enabled for the camera:  
  a. Open the camera or camera template configuration page and modify the configuration, if necessary.  
  b. Verify that the camera was added is in the Enabled: OK state.  
  c. If the camera is in Enabled: Warning, Critical state, go to device Status page to get information, fix the problem and choose Repair Configuration from the Device Settings menu.  
  See the “Editing the Camera Settings” section on page 7-42 for more information. |

| Step 8 | Perform additional configuration, if necessary | • Editing the Camera Settings, page 7-42  
• Configuring Camera PTZ Controls, Presets, and Tours, page 7-64  
• Configuring Motion Detection, page 7-76 |
Cameras Pending Approval List

Discovered cameras that are not auto-configured are held in the Cameras Pending Approval list so they can be reviewed and updated before being added to Cisco VSM (Figure 7-10). The cameras in this list not available for streaming or recording video.

These cameras can also be added to the blacklist which deletes them from the Cisco VSM configuration and prevents them from being found in future discovery operations.

Figure 7-10 Cameras Pending Approval

Camera models that have the auto-configuration defaults enabled are added to Cisco VSM. If auto-configuration fails or is not enabled, the camera is added to Cameras Pending Approval. If the camera is in Enabled: Warning or Critical state, go to device Status page to get information, fix the problem and choose Repair Configuration from the Device Settings menu.

Procedure

To move cameras from the Cameras Pending Approval list to either Cisco VSM or to the blacklist, complete the following procedure.

You must have Manage Cameras permissions to approve or blacklist cameras. See the “Adding Users, User Groups, and Permissions” section on page 4-1 for more information.

Step 1 Click Cameras.

Step 2 Perform a camera discovery, as described in the “Discovering Cameras on the Network” section on page 7-22.

Step 3 Choose Add > Cameras Pending Approval.

Step 4 (Optional) Filter the list of discovered cameras (Figure 7-10).

For example, select a camera make or model to narrow the results.

Step 5 Select one or more cameras from the list.
Chapter 7    Adding and Managing Cameras

Discovering Cameras on the Network

Tip
Click the camera to highlight it, or use Ctrl-Click or Shift-Click to select multiple cameras.

Step 6  (Optional) Enter additional camera configurations:
- Click the buttons at the bottom of the list to edit the required fields. You can also double-click a field to edit the setting.
- Scroll the list to the right, if necessary, to display the editable fields.
- Editable fields are displayed in bold.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>The IP address assigned to the camera.</td>
</tr>
<tr>
<td>Name</td>
<td>(Optional) Double-click the entry to change the camera name. The default entry is auto-generated.</td>
</tr>
<tr>
<td>Media Server</td>
<td>(Required) select the Media Server to manage the camera.</td>
</tr>
<tr>
<td>Install Location</td>
<td>(Required) select the location where the camera is physically installed.</td>
</tr>
<tr>
<td>Pointed Location</td>
<td>(Required) select the location where the camera is pointed. This is the scene shown in the camera’s video.</td>
</tr>
<tr>
<td>Template</td>
<td>(Required) select the configuration template for the camera. See the “Adding and Editing Camera Templates” section on page 9-1 for more information.</td>
</tr>
<tr>
<td>Credential</td>
<td>(Required) enter the username and password used to access the camera over the network. See the camera documentation for instructions to set the credentials, or ask your system administrator for the information.</td>
</tr>
</tbody>
</table>

Step 7  Click Add to save the configuration and add the camera(s) to Cisco VSM.

Step 8  Verify that the camera(s) were successfully added.

Step 9  (Optional) Modify the camera settings, if necessary.
See the “Accessing the Camera Settings” section on page 7-42 to change a camera configuration.

Note  Click Blacklist to blacklist the camera. See the “Blacklisting Cameras” section on page 7-40.
Discovering Medianet-Enabled Cameras

Network (IP) cameras that support Cisco Medianet can be automatically discovered when they are added to the network. Cameras can also be discovered by a Media Server configured in a different subnet.

Refer to the following topics for more information:

- Medianet Requirements, page 7-32
- Medianet Overview, page 7-33
- Configuring a DHCP Server with Option 125, page 7-34
- Medianet Camera Discovery Procedure, page 7-36
- High Availability Impact on Medianet Cameras, page 7-37

Medianet Requirements

For cameras to be automatically discovered on the network using Medianet, the following requirements must be met:

<table>
<thead>
<tr>
<th>Requirements</th>
<th>Complete?</th>
</tr>
</thead>
<tbody>
<tr>
<td>The network (IP) camera must support Cisco Medianet.</td>
<td></td>
</tr>
<tr>
<td>- See the camera documentation for information.</td>
<td></td>
</tr>
<tr>
<td>- Examples of Medianet cameras include the Cisco models 4300, 4300E, 4500, 4500E and 26xx.</td>
<td></td>
</tr>
<tr>
<td>- See the <strong>Release Notes for Cisco Video Surveillance Manager, Release 7.0.1</strong> for a summary of supported Cisco cameras and required firmware. See also the camera product information at <a href="http://www.cisco.com/go/physicalsecurity">http://www.cisco.com/go/physicalsecurity</a> (click <strong>View All Products</strong>, and select the camera model under <strong>Video Surveillance IP Cameras</strong>).</td>
<td></td>
</tr>
<tr>
<td>A DHCP server must be installed and configured with Option 125 to return a list of Media Server IP addresses. See the “Configuring a DHCP Server with Option 125” section on page 7-34 for instructions.</td>
<td></td>
</tr>
</tbody>
</table>

Related Information

- Cisco Medianet website ([http://www.cisco.com/go/medianet](http://www.cisco.com/go/medianet))
- Cisco Medianet FAQ
- Medianet Reference Guide

A functioning Cisco VSM 7.x system must be installed and configured on the network. See the following for more information:

- Cisco Video Surveillance Management Console Administration Guide
- “Summary Steps: Basic Configuration” section on page 1-7
Medianet Overview

To enable Medianet discovery, you must install a Medianet-enabled IP camera on the network, as shown in Figure 7-11. A DHCP server must also be installed with Option 125 configured to provide a list of up to 16 Media Server IP addresses.

**Figure 7-11 Medianet Camera Discovery Summary**

**Step 1:** DHCP request returns the camera IP address and list of up to 16 Media Server IP addresses.

**Step 2:** Camera polls Media Servers in order until a connect request is accepted.

**Step 3:** Camera is added to VSM, Auto-Config settings are applied, and camera is placed in Enabled state. If Auto-Config is disabled, camera is added to Pending Approval list.

**Step 4:** Revise the camera configuration, or approve cameras placed in the Pending Approval list.

**Step 1** When the camera is added to the network, it contacts the DHCP server, which returns the camera network settings (including IP address) and a list of Media Server IP addresses.

**Note** Medianet cameras are factory-configured for DHCP by default. If the camera IP address is set to static, then the DHCP address is ignored (released).

**Step 2** The IP camera attempts to connect to the Media Servers (in order of the IP addresses). If a Media Server does not reply, then the camera attempt to connect to the next server in the list.
Chapter 7  Adding and Managing Cameras

Discovering Cameras on the Network

**Note**  The camera first tries to connect to any Media Server addresses that were manually entered on the camera. If there are no manual entries, or if none of the manually-entered Media Servers accepts the connection request, then the camera attempts to connect to the Media Server addresses sent by the DHCP server.

**Step 3**  When the camera connects to a Media Server, the camera is also added to the Operations Manager configuration.

- If Auto-Configuration is enabled for the camera model, the configuration settings (including a static IP address) are applied and the camera is placed in Enabled state. The configuration includes a camera template, Location, and Media Server assignment. See the “Enabling the Auto Configuration Defaults for a Camera Model” section on page 7-25.

- If the Auto-Configuration is disabled (default), then the camera is placed in the Cameras Pending Approval list. See the “Cameras Pending Approval List” section on page 7-30.

**Note**  When the camera configuration is applied, the IP address provided by the DHCP server is retained. You can change the IP address using the camera configuration page, if necessary.

**Step 4**  Once the camera is added to the Operations Manager, you can apply additional configurations, or approve the camera (if it was added to the Cameras Pending Approval list).

See the following for more information:

- Discovering Cameras on the Network, page 7-22
- Cameras Pending Approval List, page 7-30
- Editing the Camera Settings, page 7-42

**Tip**  You can also Blacklist a camera to remove it from Cisco VSM and prevent the device from being rediscovered. See the “Blacklisting Cameras” section on page 7-40.

---

### Configuring a DHCP Server with Option 125

Complete the following procedure to configure the DHCP Option 125 for Cisco IOS devices. This is required to support Cisco VSM Medianet-enabled camera auto-discovery.

**Procedure**

**Step 1**  Convert the Media Server IP address to a HEX value.

- The Media Server IP address is the server that the Medianet camera will register with.
- The HEX value is used in the DHCP server Option 125 configuration.

a.  Search for an online tool that can be used to convert the Media Server IP address to HEX.
   - For example, use the following URL to search for “IP to HEX Converter” tools:

b.  Convert the camera’s IP address to HEX:
For example, covert the Media Server IP address 10.194.31.1 to the HEX value 0AC21F01.

Step 2 Add additional HEX values to the Media Server HEX value, as required by your DHCP server.

Note Each DHCP server may require additional HEX strings to be added before and after the Media Server HEX value. This entire HEX string is entered in the DHCP Option 125 configuration. Be sure to use the correct HEX format, as defined in your DHCP server documentation.

For example, a Cisco IOS DHCP server requires that the following HEX values be added before and after the Media Server HEX value:

a. Prefix the following value to the Media Server HEX:
   0000.0009.0b14.0901.

b. Append the following value to the Media Server HEX:
   .0050.0001

The complete HEX string used in the DHCP server Option 125 configuration (for Cisco IOS devices) is:

0000.0009.0b14.0901. 0AC21F01.0050.0001

Step 3 Configure the DHCP server to advertise Option 125 to the endpoints.

For example, for a Cisco IOS DHCP server:

ip dhcp pool MYADDRESSPOOL
  network 10.194.31.0 255.255.255.0
  option 125 hex 0000.0009.0b14.0901. 0AC21F01.0050.0001
default-router 10.194.31.254

Note 0AC21F01 is the HEX value of the converted Media Server IP address. The entire required HEX value is 0000.0009.0b14.0901. 0AC21F01.0050.0001.

Note Other DHCP servers may require a different format for the HEX value such as prefixing x to the values or prefixing a \. See your DHCP server documentation for more information.
Medianet Camera Discovery Procedure

Complete the following procedures to discover new Medianet cameras.

**Table 7-9**  **Summary Steps: Camera Discovery**

<table>
<thead>
<tr>
<th>Task</th>
<th>Description and more information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>Verify that the <strong>Medianet Requirements</strong> are met.  &lt;br&gt;<strong>Medianet Requirements, page 7-32</strong>  &lt;br&gt;You must have:  &lt;br&gt;• A Medianet-enabled IP camera configured with DHCP.  &lt;br&gt;• At least one Media Server and Operations Manager.  &lt;br&gt;• A DHCP server configured with Option 125 to provide Media Server IP addresses to the camera during discovery. See the “<strong>Configuring a DHCP Server with Option 125</strong>” section on page 7-34 for instructions.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>Review the overview sections to understand the discovery process.  &lt;br&gt;Review the following topics to understand the discovery and auto-configuration process.  &lt;br&gt;• <strong>Understanding Discovery and Auto-Configuration, page 7-22</strong>  &lt;br&gt;• <strong>Discovering Medianet-Enabled Cameras, page 7-32</strong></td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td>Install a Medianet network camera and use the camera configuration UI to enable DHCP and add an <strong>admin</strong> user (if necessary).  &lt;br&gt;• Cisco network cameras (such as the Cisco 26xx series) have Medianet and DHCP enabled by default.  &lt;br&gt;• If a static IP addresses is configured on the camera, or if a list of Media Server IP addresses is configured on the camera, then those values configured on the camera are used and the DHCP settings are ignored.  &lt;br&gt;See the camera documentation for more information.</td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
<td>(Optional) Enable auto-configuration presets.  &lt;br&gt;If auto-configuration is enabled for the camera model, the camera will automatically be added to Cisco VSM.  &lt;br&gt;<strong>Enabling the Auto Configuration Defaults for a Camera Model, page 7-25</strong></td>
</tr>
<tr>
<td><strong>Step 5</strong></td>
<td>Wait for the camera to be discovered and be added to the Operations Manager.  &lt;br&gt;• Discovery can take a few minutes based on the factors such as the camera configuration, availability of the Media Servers, and other variables.  &lt;br&gt;• If a discovered camera has the same device ID fields as an existing camera entry (IP Address, and serial number, mac address/hardware ID), then the records are either merged, or placed in conflict. See <strong>Understanding Camera Conflicts</strong> for more information.</td>
</tr>
<tr>
<td><strong>Step 6</strong></td>
<td>Approve cameras that were added to the <strong>Cameras Pending Approval</strong> list.  &lt;br&gt;If auto-configuration is not enabled for the camera model, the camera is added to the <strong>Cameras Pending Approval</strong> list, which allows you to apply additional configurations and approve (add) the camera.  &lt;br&gt;Open the <strong>Cameras Pending Approval</strong> list to modify the camera configuration and either approve the camera or move it to the blacklist.  &lt;br&gt;See the “<strong>Cameras Pending Approval List</strong>” section on page 7-30 for more information</td>
</tr>
</tbody>
</table>
Discovering Cameras on the Network

Table 7-9  Summary Steps: Camera Discovery (continued)

<table>
<thead>
<tr>
<th>Step 7</th>
<th>Task</th>
<th>Description and more information</th>
</tr>
</thead>
</table>
|        | Complete the camera configuration. | - Open the camera or camera template configuration page and modify the configuration, if necessary.  
- Verify that the camera was added is in the Enabled: OK state.  
- If the camera is in Enabled: Warning, Critical, or pre-provisioned state, complete or correct the configuration, verify that the camera is available on the network and choose Enable from the Device Settings menu.  
See the “Editing the Camera Settings” section on page 7-42 for more information. |

| Step 8 | Perform additional configuration, if necessary | - Editing the Camera Settings, page 7-42  
- Configuring Camera PTZ Controls, Presets, and Tours, page 7-64  
- Configuring Motion Detection, page 7-76 |

High Availability Impact on Medianet Cameras

When the Primary Media Server is down and the Failover has taken over the role of the primary server, and a DHCP based Medianet discovered camera has a change of IP address, the Cisco VSM Operations Manager will not reconfigure the camera to the new IP address until the Primary Media Server comes back up. This is because Cisco VSM Operations Manager does not allow any configuration changes on the cameras when the primary server is down.
Adding Cameras from an Existing Media Server

When a Media Server from another Cisco VSM 7.x deployment is added to the configuration, any existing camera configurations (and their associated recordings) can also be added (or deleted). This can occur when a release 6.x Media Server is upgraded to 7.x, or when a Media Server was previously configured on a different Operations Manager.

See the following for more information.

- Adding Cameras From a 6.x or 7.x Media Server, page 7-38
- Adding Unknown Cameras During a Media Server Synchronization, page 7-39

Adding Cameras From a 6.x or 7.x Media Server

When an existing Media Server is added to the Cisco VSM 7.x configuration, you are prompted to keep or delete the existing camera configurations and their associated recordings (Figure 7-12). If the cameras are not available on the network, they can still be retained so the recordings can be accessed in the Monitor Video window.

Figure 7-12 Adding Cameras from a Cisco VSM 6.x Media Server
Adding Unknown Cameras During a Media Server Synchronization

In rare cases, a Media Server synchronization may discover cameras on the Media Server that are not configured in the Operations Manager. If this occurs, the cameras are added as Pre-Provisioned, and encoders are added as Enabled (Figure 7-13).

- To enable Pre-Provisioned cameras, assign a template to the camera and choose Enable from the Device Settings menu. See the “Pre-Provisioning Cameras” section on page 7-10 for more information.
- If a device is in Enabled: Warning or Enabled: Critical state, view the device Status page to resolve any additional issues (see the “Viewing Camera Status” section on page 7-63).

Figure 7-13  Adding Unknown Cameras During a Media Server Synchronization

---

**Tip**

To add a Cisco VSM 6.x Media Server, you must first migrate the server to Cisco VSM 7.x. See the *Cisco Video Surveillance Migration Guide, Release 6.3.2 to 7.0* for more information. This document is available on the Cisco Developer Network (CDN). See your Cisco support representative for more information.

---

**Note**

See the *Cisco Video Surveillance Migration Guide, Release 6.3.2 to 7.0* for more information. This document is available on the Cisco Developer Network (CDN). See your Cisco support representative for more information.
Blacklisting Cameras

Blacklisted cameras are deleted from the Cisco VSM configuration and are ignored in discovery operations. Cameras can be kept in the Blacklist indefinitely.

Refer to the following topics:
- Blacklisting a Camera, page 7-40
  - Blacklist a Discovered Camera in the Cameras Pending Approval List
  - Delete and Blacklist a Camera
- Viewing Cameras in the Blacklist, page 7-41
- Removing a Camera From the Blacklist, page 7-41

Blacklisting a Camera

Cameras can be added to the blacklist using the following methods:
- Blacklist a Discovered Camera in the Cameras Pending Approval List
- Delete and Blacklist a Camera

Blacklist a Discovered Camera in the Cameras Pending Approval List

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Click Cameras.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Choose Add &gt; Cameras Pending Approval.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Select one or more cameras from the list.</td>
</tr>
</tbody>
</table>

Tip Click the camera to highlight it, or use Ctrl-Click or Shift-Click to select multiple cameras.

Step 4 | Click Blacklist. |

Tip See the “Discovering Cameras on the Network” section on page 7-22 for more information.

Delete and Blacklist a Camera

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Click Cameras.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Select the location and camera name.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Click Delete.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Select Blacklist &amp; Full Delete.</td>
</tr>
</tbody>
</table>

Caution Full Delete permanently deletes all recordings associated with the camera.
Blacklisting Cameras

Viewing Cameras in the Blacklist

Procedure

Step 1  Click Cameras.
Step 2  Choose Add > Camera Blacklist.
Step 3  (Optional) Use the filter settings to narrow the displayed devices.

Removing a Camera From the Blacklist

To remove a camera from the blacklist so it can be re-added to Cisco VSM, do one of the following:

- Remove the device from the blacklist, as described in the following procedure.
- Manually add the camera. This removes the camera from the blacklist and adds it to Cisco VSM. See the “Manually Adding a Single Camera” section on page 7-12.

Procedure

Step 1  Click Cameras.
Step 2  Choose Add > Camera Blacklist.
Step 3  (Optional) Use the filter settings to narrow the displayed devices.
Step 4  Highlight one or more entries and click Remove From Blacklist.
Step 5  (Optional) Perform a camera discovery to re-add the camera. See the “Discovering Cameras on the Network” section on page 7-22.
Editing the Camera Settings

Camera settings are applied to cameras, camera templates, or custom configurations.

The following settings are accessed in the Camera configuration page. You can also update camera configurations by importing a CSV file that defines the settings (see the “Importing or Updating Cameras or Encoders Using a CSV File” section on page 7-17).

See each topic for detailed information.

- Accessing the Camera Settings, page 7-42
- General Settings, page 7-45
- Streaming, Recording and Event Settings, page 7-49
- Image Settings, page 7-57
- Configuring the High Availability Options for a Camera or Template, page 7-58

Accessing the Camera Settings

To revise the setting for a camera or camera template, click the Cameras tab and highlight the device (or template).

Usage Notes

- Not all settings are available for all cameras. For example, Image settings are available only if the camera supports features such as motion detection, PTZ controls, and image adjustments.
- Device configuration changes can fail if a camera firmware upgrade is in process. Make sure that a camera firmware is not being upgraded (or wait until it is complete) and try again.
- Most camera settings are applied by the template assigned to the camera. To create a configuration for a single camera, create a custom configuration for the camera. See the “Creating a Custom Template for a Single Camera” section on page 9-5.
- The camera configuration pages may not display properly if the Internet Explorer (IE) compatibility view box is checked. Deselect this option, if necessary.

Procedure

Step 1 Log on to the Operations Manager.
- See the “Logging In” section on page 1-17.
- You must belong to a User Group with permissions for Cameras.

Step 2 Click Cameras.
Step 3  Click the tabs in the top left column to view cameras and templates (see Figure 7-14):

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cameras By Location</td>
<td>Displays the cameras assigned to each location. For example, click the Cameras By Location tab and then select a location name (Figure 7-14). The cameras assigned to that location are listed by name. Click a camera name to edit the camera settings.</td>
</tr>
<tr>
<td>Cameras by Media Server</td>
<td>Displays the cameras assigned to each Media Server. If only one Media Server is used, all cameras will be listed.</td>
</tr>
<tr>
<td>Cameras By Template</td>
<td>Displays the cameras assigned to each template. Tip: The number next to the template name indicates the number of cameras assigned to the template.</td>
</tr>
</tbody>
</table>

Figure 7-14 Camera General Settings

Step 4  Revise the available settings as described in the following topics.

- General Settings, page 7-45
- Streaming, Recording and Event Settings, page 7-49
- Image Settings, page 7-57
- Configuring the High Availability Options for a Camera or Template, page 7-58

Step 5  Click Save.

Step 6  (Optional) Revise the camera template, or create a custom template.
• Creating or Modifying a Template, page 9-3
• Creating a Custom Template for a Single Camera, page 9-5
General Settings

The General Settings define camera-specific attributes. These settings are specific to the camera and are not impacted by template settings.

Table 7-10 Camera General Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General Information</strong></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>(Required) The descriptive name for the camera.</td>
</tr>
<tr>
<td>Media Server</td>
<td>(Required) The Media Server that hosts the camera.</td>
</tr>
<tr>
<td>Installed Location</td>
<td>(Required) The physical location of the camera.</td>
</tr>
<tr>
<td>Pointed Location</td>
<td>(Optional) The location shown in the camera view. For example, a camera may be physically installed on building 1, but pointed at building 2. The video displays the scene at building 2. See the “Understanding a Camera’s Installed Location Vs. the Pointed Location” section on page 5-9 for more information.</td>
</tr>
<tr>
<td>Tags</td>
<td>(Optional) Enter keywords used by the Find field.</td>
</tr>
<tr>
<td>Description</td>
<td>(Optional) The camera purpose, location or other description.</td>
</tr>
<tr>
<td><strong>Access Information</strong></td>
<td></td>
</tr>
<tr>
<td>IP Address</td>
<td>(Required for all cameras and encoders) Enter the IP address used by Operations Manager to access the device on the network. Entering an IP address in this field does not affect the settings stored on the device. (Supported devices only) Click Change to revise the network settings saved on the device and the IP address stored in the Operations Manager. The Change option is disabled if this action is not supported by the device. All changes are saved together when the device is saved. Camera and encoder network settings can include the device IP address, Gateway, Subnet Mask, DNS Server, and Domain. See the device documentation for more information on the required settings.</td>
</tr>
</tbody>
</table>

Notes

- If the Change button is disabled, you can only change the network settings stored on the device using a direct connection or other method. Refer to the device documentation or ask your system administrator for assistance.
- The IP address stored in Operations Manager must be the same as the device configuration. A mismatch between the device and Operations Manager can cause a loss of connectivity and loss of video streaming and recording.
- See the “Changing the Camera or Encoder Network Settings and/or Credentials” section on page 7-61 for more information.
Editing the Camera Settings

Username and Password
(Required for all cameras and encoders) Enter the username and password used by Operations Manager to access the device on the network. Entering a username and password in these fields does not affect the settings stored on the device.

(Supported cameras only) Click the password Change button and enter the new settings in the dialog provided. The Change option is disabled if this action is not supported by the device. All changes are saved together when the device is saved.

Notes
- You cannot change the username stored on the device using Operations Manager.
- If the password Change button is disabled, you can only change the password stored on the device using a direct connection or other method. Refer to the device documentation or ask your system administrator for assistance.
- See the “Changing the Camera or Encoder Network Settings and/or Credentials” section on page 7-61 for more information.

Serial Controller

Note
The following settings are used when a serial cable is attached from an analog camera to an encoder. The serial port connection enables the pan-zoom-tilt (PTZ) controls and/or photographic controls (brightness, contrast, etc.) on an analog camera.

Tip
The following settings can also be defined using the Encoder configuration pages. See the “Adding Encoders and Analog Cameras” section on page 10-1 for more information.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>(Analog cameras only) Enables the PTZ controls on an analog camera.</td>
</tr>
<tr>
<td>Encoder</td>
<td>(Analog cameras only) The encoder for the analog camera.</td>
</tr>
<tr>
<td>Serial Port</td>
<td>(Analog cameras only) The encoder serial port where the first analog camera is attached to the encoder. See the encoder documentation for information to determine the port number.</td>
</tr>
<tr>
<td>Serial Port Address</td>
<td>(Analog cameras only) The unique ID of the serial device (analog camera).</td>
</tr>
<tr>
<td>Model</td>
<td>(Read-only) The camera manufacturer and model number.</td>
</tr>
<tr>
<td>Encoder</td>
<td>(Analog cameras only) The encoder name.</td>
</tr>
<tr>
<td>Encoder Port</td>
<td>(Analog cameras only) The encoder port used by the analog camera.</td>
</tr>
</tbody>
</table>

Table 7-10 Camera General Settings (continued)
### Table 7-10  Camera General Settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Firmware Version | (Read-only, IP cameras only) The firmware version installed on the device.  
  - See the “Upgrading Camera and Encoder Driver Firmware” section on page 7-82.  
  - Device firmware must be upgraded to the same version in both the Media Server and Cisco VSM Operations Manager. If different versions are in the Media Server and Operations Manager, a driver pack mismatch error can occur, which prevents camera template revisions. See the Cisco Video Surveillance Management Console Administration Guide, to upgrade or downgrade the device firmware using the Cisco Video Surveillance Management Console.  
  - See the device documentation to upgrade or downgrade the device firmware directly on the device. |
| Hardware ID      | (Read-only, IP cameras only) The device MAC Address (hardware address).                                                                                                                                       |

#### Contact Closure Configuration

- **Contact Closure**
  - Select the contact closure port used to trigger an action.  
  - This field is enabled for IP and analog cameras that support contact closure.  
  - Only one contact closure port can be selected for each camera (even if the camera supports more than one contact closure).  
  - When the Operations Manager GUI is used to configure a camera’s contact closure, do not modify the Event trigger settings on the camera web UI. If the default IO port setting values for event triggers on the camera’s browser UI are changed, the results might be inconsistent when also changing the contact closure settings using the Operations Manager GUI.  
  - See the “Using Advanced Events to Trigger Actions” section on page 9-11 for instructions to define the action that occurs when the contact closure is triggered.

#### Analog Camera Support Notes

- Analog cameras must be attached to an encoder that supports contact closure. The encoder can provide contact closures for multiple cameras.  
- Only the available encoder ports are displayed (the list includes only the ports supported by the encoder that are not used by another camera attached to that encoder).  
- To view the cameras attached the encoder, select the **Connections** tab in the encoder configuration page. The **Contact Closure Configuration** field lists the contact closure ports used the analog cameras. See the “Adding External Encoders and Analog Cameras” section on page 10-4.

#### Multicast

- **Primary Multicast IP Address**  
  - (Optional) Enter the multicast IP address where the camera’s primary video stream (Stream A) should be sent.  
  - This field is enabled only if the camera’s template Stream A is configured for multicast.  
  - See the “Configuring Multicast Video Streaming” section on page 9-18 for more information.

- **Secondary Multicast IP Address**  
  - (Optional) Enter the multicast IP address where the camera’s secondary video stream (Stream B) should be sent.  
  - This field is enabled only if the camera’s template Stream B is configured for multicast.  
  - See the “Configuring Multicast Video Streaming” section on page 9-18 for more information.
Tip

See the “Synchronizing Device Configurations” section on page 12-15 for instructions to manually sync the camera configuration with the Media Server.
Chapter 7  Adding and Managing Cameras

Editing the Camera Settings

Streaming, Recording and Event Settings

The Streaming, Recording and Event settings are applied to camera templates and define video attributes for cameras associated with the template. For example, the quality of video streams, how video is recorded, and the advanced storage options for backing up video to a Redundant or Long Term Storage (LTS) server. The Advanced Events option defines the events that trigger actions. For action, when a motion event starts, send an email or trigger a URL action on an external system (such as a access control system).

Tip

The Streaming, Recording and Event settings (Table 7-11) are read-only when viewing a camera configuration. To edit the settings, edit the template associated with the camera, or create a custom configuration for the camera (click Set Template and choose Custom).

Table 7-11  Streaming, Recording and Event Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Template</td>
<td>(Cameras only) Click Set Template to select the template used for the camera:</td>
</tr>
<tr>
<td></td>
<td>1. Click Set Template to select a template from the list. Only templates for the user’s location that are supported by the camera are displayed. See the “Adding and Editing Camera Templates” section on page 9-1 for more information.</td>
</tr>
<tr>
<td></td>
<td>2. Click Custom to enter custom settings for the camera. Note Although you can enter custom settings for both video streams, the IP or analog camera must also support the settings for both streams (analog camera support is dependent on the camera’s encoder). If the camera or encoder model does not support the settings, or does not support two streams, the configuration will fail. See the camera or encoder documentation for more information regarding the stream settings supported by the device.</td>
</tr>
<tr>
<td></td>
<td>3. Click OK to continue. Tip The remaining Streaming, Recording and Event settings can be changed for a specific camera only if the Custom option is selected.</td>
</tr>
<tr>
<td>Video Format</td>
<td>(Templates only) Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• NTSC — the analog television standard primarily used in North and some countries in South America and Asia.</td>
</tr>
<tr>
<td></td>
<td>• PAL — the analog television standard primarily used in Europe, Africa and some countries in South America and Asia. Note The available quality settings depend on the camera model. For example, if a camera only supports NTSC format, only NTSC can be selected. If a camera supports both PAL and NTSC, both formats will be available.</td>
</tr>
</tbody>
</table>
Table 7-11  Streaming, Recording and Event Settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recording Schedule</td>
<td>(Templates only) Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Basic Recording: 24x7</strong>—Records 24 hours a day, every day, based on the <em>continuous</em> and <em>event</em> recording properties.</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>• Select a previously-defined schedule.</td>
</tr>
<tr>
<td></td>
<td>Recording schedules appear only if schedules are configured. See the “Configuring Continuous, Scheduled, and Motion Recordings” section on page 9-7 for instructions.</td>
</tr>
<tr>
<td></td>
<td>Recording schedules allow you to define recording properties for different times of the day, days of the week, or for special events. For example, a school might require different video surveillance actions during School hours, After school hours, School off hours, and Closed hours. Additional exceptions to the regular schedule might be required for special events, such as a Homecoming event or the Christmas holiday. A recording entry appears for each time slot included in the schedule.</td>
</tr>
<tr>
<td>Video Quality</td>
<td>(Templates only) Slide the selector to <strong>Lo</strong>, <strong>Me</strong> or <strong>Hi</strong> to select pre-defined video quality settings for stream A (primary) and stream B (if supported). Higher quality video requires more network bandwidth, processing resources, and storage space than lower video quality.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Off</strong> to disable video recording and playback.</td>
</tr>
<tr>
<td></td>
<td>• Choosing <strong>Hi</strong> on <strong>Stream A</strong> may disable <strong>Stream B</strong> if Stream A requires a high level of processing and network resources. To enable <strong>Stream B</strong>, lower the quality level of <strong>Stream A</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Click the <strong>Lo</strong>, <strong>Me</strong> or <strong>Hi</strong> header to view the pre-set values (read-only).</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Custom</strong> to choose specific settings (such as the video codec, transport, bitrate mode, resolution, framerate, bitrate, and quality). See the “Using Custom Video Quality Settings” section on page 7-55 for more information.</td>
</tr>
</tbody>
</table>

**Caution**  Switching a camera’s codec may take 30 seconds or more to complete, resulting in a temporary loss of the live video stream. Recorded video is not affected, but you cannot create recorded clips that include more than one codec.

**Tip**  See the “Configuring Multicast Video Streaming” section on page 9-18 for more information.
### Chapter 7  
**Adding and Managing Cameras**

#### Editing the Camera Settings

**Table 7-11  
Streaming, Recording and Event Settings (continued)**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recording Options</td>
<td>(Templates only) Click the recording option for each recurring schedule.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>If <strong>Basic Recording: 24x7</strong> was selected, only one row appears. If a schedule was selected, a row appears for each schedule. See the “Configuring Continuous, Scheduled, and Motion Recordings” section on page 9-7 for more information.</td>
</tr>
<tr>
<td></td>
<td>• [ ]—Select <strong>No Recording</strong> to disable recording for the stream.</td>
</tr>
<tr>
<td></td>
<td>• [ ]—Select <strong>Record on Motion</strong> to record motion events.</td>
</tr>
<tr>
<td></td>
<td>– In <strong>Retain event recordings</strong>, enter the amount of time a motion event should be retained (saved) on the system.</td>
</tr>
<tr>
<td></td>
<td>– In <strong>Padding</strong>, enter the number of seconds of recording that should be included before and after the event occurs.</td>
</tr>
<tr>
<td></td>
<td>– Motion recording is available only if the camera supports motion detection. See the “Configuring Motion Detection” section on page 7-76 for instructions to define the areas of the image that trigger motion events.</td>
</tr>
<tr>
<td></td>
<td>• [ ]—Select <strong>Continuous Recording</strong> to record video in a loop.</td>
</tr>
<tr>
<td></td>
<td>– For example, video will be recorded continuously for one day before being overridden. This allows you to view video from the past 24 hours.</td>
</tr>
<tr>
<td></td>
<td>– In <strong>Retain continuous recordings</strong> enter the amount of days that recorded video should be recorded in a loop, or if a recording schedule is selected, the amount of time recorded video should be retained on the system.</td>
</tr>
<tr>
<td></td>
<td>• [ ]—Select <strong>Record on Motion and Continuous Recording</strong> to record continuously and mark any motion events. This option is available only if motion detection is supported by the camera.</td>
</tr>
<tr>
<td>Retain continuous recordings</td>
<td>(Templates only)</td>
</tr>
<tr>
<td></td>
<td>• <strong>24x7 Recording</strong>—Defines the amount of days that recorded video should be recorded in a loop. For example, a retention of 1 day means the system will retain continuously recorded video for the past 24 hours. As new video is recorded, the equivalent amount of the oldest video is deleted.</td>
</tr>
<tr>
<td></td>
<td>• If a recording schedule is selected—Defines the amount of time recorded video should be retained on the system. For example, if a schedule is selected that records video from 2 pm to 4 pm, and you wish to retain that recording on the system for 10 days, enter 10 in the <strong>Retain continuous recordings</strong> field.</td>
</tr>
<tr>
<td></td>
<td>– This value must be a number greater than 0 (days).</td>
</tr>
<tr>
<td></td>
<td>– The default is 1 day.</td>
</tr>
<tr>
<td></td>
<td>– The maximum value is 3650 days (10 years).</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>This setting will be ignored if the <strong>Default Grooming Only</strong> setting is enabled on the Media Server that supports the camera. This can prevent new recordings from beginning if all server disk space is used. See the “Recording Settings” section on page 6-16 for more information.</td>
</tr>
</tbody>
</table>
## Chapter 7 Adding and Managing Cameras
### Editing the Camera Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retain event recordings</td>
<td>(Templates only) The amount of time a motion event should be retained (saved) on the system. For example, enter 10 to keep motion event recordings for 10 days after the event video is captured.</td>
<td>This setting also applied to Record Now recordings.</td>
</tr>
<tr>
<td></td>
<td>- Enter the number of days the video should be retained.</td>
<td>- Enter a number between 1 and 3650 days (10 years).</td>
</tr>
<tr>
<td></td>
<td>- The default is 30 days.</td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>- Select <strong>Max Possible</strong> to retain the recordings as long as disk space is available. If disk space is not available, then recordings are deleted based on the Storage (%) for the Media Server.</td>
<td>For example, if the Storage (%) is set to 90%, and a camera template Retain event recordings setting is <strong>Max Possible</strong>, event recordings may be deleted once the disk repositories are 90% full (deleted video includes the oldest regular, continuous loop or event archives).</td>
</tr>
<tr>
<td></td>
<td>Groups of the oldest 200 video archive files are deleted until the free disk space is less that the Storage (%). See the Media Server “Media Out Settings” section on page 6-14 for more information.</td>
<td>Note</td>
</tr>
<tr>
<td></td>
<td>This setting will be ignored if the Default Grooming Only setting is enabled on the Media Server that supports the camera. This can prevent new recordings from beginning if all server disk space is used. See the “Recording Settings” section on page 6-16 for more information.</td>
<td></td>
</tr>
</tbody>
</table>

| Alert Notifications    | (Templates only)                                                                                                                                                                                           | - Click **Alert Notifications** to enable or disable the alerts that are generated when a motion event occurs.                                                                                                                                                         |

| Advanced Events        | (Templates only) Use **Advanced Events** to trigger actions when an event occurs.                                                                                                                           | - **Instantaneous Trigger Events**—Events that trigger an immediate action (for example, when motion is detected).                                                                                                                                                   |
|                        |                                                                                                                                                                                               | - **States of Being**—Events that trigger an ongoing action as long as that event occurs (for example, while a contact remains open).                                                                                                                               |
|                        |                                                                                                                                                                                               | See the “Using Advanced Events to Trigger Actions” section on page 9-11.                                                                                                                                                                                               |

| Advanced Storage       | (Templates only) Defines storage options for recorded video, such as the use of redundant, failover, or long-term storage servers. Also defined advanced streaming and recording options.                                                                 | - **High Availability and Failover**—Configuring the Redundant and Failover Options, page 11-11.                                                                                                                                                                         |
|                        |                                                                                                                                                                                               | - **Long Term Storage**—Archiving Recordings to a Long Term Storage Server, page 11-15.                                                                                                                                                                                   |
|                        |                                                                                                                                                                                               | - **Recording Options**—Defining the Recording Options, page 11-19.                                                                                                                                                                                                     |
### Table 7-11 Streaming, Recording and Event Settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Audio</td>
<td>(Templates only)</td>
</tr>
<tr>
<td></td>
<td>Defines if audio should be recorded when video is being recorded.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> The audio settings is disabled if audio is not supported by the camera.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Off</strong>—(Default) Audio is disabled for both live and recorded video playback.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Live Only</strong>—Audio is enabled for live video streaming only.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Live and Recorded</strong>—Audio is enabled for live streaming and recorded video playback.</td>
</tr>
<tr>
<td>Padding</td>
<td>(Templates only)</td>
</tr>
<tr>
<td></td>
<td>Defines the number of seconds should be included in a motion event.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Pre</strong>—Enter the number of seconds before a motion event occurs that video should be retained.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Post</strong>—Enter the number of seconds after a motion event occurs that video should be retained.</td>
</tr>
</tbody>
</table>
Editing the Camera Settings

Verify Recording Space

(Templates only)

Enable

Select Enable to verify that enough storage space is available on the Media Server to complete the entire recording. The amount of required storage space is determined by the “Storage Estimation(%)” setting for the Media Server (see the “Storage Management Settings” section on page 6-13). If the required amount of storage space is not available for the entire recording, then the recording will not start.

For example, if a camera is configured to record a continuous H264 stream at 15mbps for 30 days, the Media Server would first verify that there is enough free disk space for the full recording length (30 days). If not, then recording will not start. In this example, 15 mbps of video uses approximately 2 megabytes of storage space per second, so 30 days of recording would require roughly 5 terabytes of disk storage.

Note

The verification takes into account the storage demands required by other cameras assigned to the Media Server.

Note

Enabling the Default Grooming Only setting for the Media Server assigned to the camera can cause all disk space to be used and prevent new recordings from beginning. See the “Recording Settings” section on page 6-16 for more information.

Disable

Disabling this setting will allow recording to be started even when storage is full. But it can cause the system to become oversubscribed, and critical alerts to occur as system performance is impacted.

If this setting is disabled, and insufficient disk space for new recordings, the disk will become oversubscribed and default grooming will occur when storage is full.

Frequent default disk grooming can cause the server to be slow, as the load average of the server will be high, an critical alerts can occur for the Media Server:

• Disk space usage for recordings has been over-subscribed.
• Load Average is critical.
• A “recording failure event” may also occur due to queue overflow, which can cause frame drops.

Record Now

(Templates Only)

Enables or disables the Record Now feature on the cameras assigned to the template.

Note

Recordings are retained according to the Retain event recordings setting.

See the following for more information:

• Enabling Record Now, page 3-11
• Using Record Now, page 2-22

Table 7-11  Streaming, Recording and Event Settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify Recording Space</td>
<td>(Templates only)</td>
</tr>
</tbody>
</table>
| Enable                   | Select Enable to verify that enough storage space is available on the Media Server to complete the entire recording. The amount of required storage space is determined by the “Storage Estimation(%)” setting for the Media Server (see the “Storage Management Settings” section on page 6-13). If the required amount of storage space is not available for the entire recording, then the recording will not start. For example, if a camera is configured to record a continuous H264 stream at 15mbps for 30 days, the Media Server would first verify that there is enough free disk space for the full recording length (30 days). If not, then recording will not start. In this example, 15 mbps of video uses approximately 2 megabytes of storage space per second, so 30 days of recording would require roughly 5 terabytes of disk storage. Note The verification takes into account the storage demands required by other cameras assigned to the Media Server. Note Enabling the Default Grooming Only setting for the Media Server assigned to the camera can cause all disk space to be used and prevent new recordings from beginning. See the “Recording Settings” section on page 6-16 for more information. Disable Disabling this setting will allow recording to be started even when storage is full. But it can cause the system to become oversubscribed, and critical alerts to occur as system performance is impacted. If this setting is disabled, and insufficient disk space for new recordings, the disk will become oversubscribed and default grooming will occur when storage is full. Frequent default disk grooming can cause the server to be slow, as the load average of the server will be high, an critical alerts can occur for the Media Server: • Disk space usage for recordings has been over-subscribed. • Load Average is critical. • A “recording failure event” may also occur due to queue overflow, which can cause frame drops. Record Now (Templates Only) Enables or disables the Record Now feature on the cameras assigned to the template. Note Recordings are retained according to the Retain event recordings setting. See the following for more information: • Enabling Record Now, page 3-11 • Using Record Now, page 2-22
Using Custom Video Quality Settings

Custom video quality settings allow you to define the codec, transport method, bit rate, frame rate, and other settings that are supported by the camera model, as described in Table 7-12.

Usage Notes

- Custom video quality settings can only be applied to model-specific camera templates.
- The available quality settings depend on the camera model. For example, if a camera only supports the H.264 codec, only H.264 can be selected.
- Although you can enter custom settings for both video streams, the IP or analog camera must also support the settings for both streams (analog camera support is dependent on the camera’s encoder). If the camera or encoder model does not support the settings, or does not support two streams, the configuration will fail. See the camera or encoder documentation for more information regarding the stream settings supported by the device.
- To configure multicast transmission, see the “Configuring Multicast Video Streaming” section on page 9-18.

Custom Video Quality Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Codec</td>
<td>Select the video encoding format, such as JPEG, MPEG4 or H.264.</td>
</tr>
<tr>
<td></td>
<td><strong>Caution</strong> Switching a camera’s codec may take 30 seconds or more to complete, resulting in a temporary loss of the live video stream. Recorded video is not affected, but you cannot create recorded clips that include more than one codec.</td>
</tr>
<tr>
<td>Transport</td>
<td>Select an option to stream video using either TCP or UDP.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> We recommend UDP for most networks where packet loss and high latency are not an issue.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong> Also see the “Configuring Multicast Video Streaming” section on page 9-18.</td>
</tr>
<tr>
<td>Bit rate mode</td>
<td>Select <strong>CBR</strong> (Constant Bit Rate) or <strong>VBR</strong> (Variable Bit Rate).</td>
</tr>
<tr>
<td></td>
<td>• CBR delivers video at the selected bit rate (or at that average over time), depending on the video device.</td>
</tr>
<tr>
<td></td>
<td>• VBR adjusts the video quality and/or frame rate as the scene changes. Depending on the video device, the selected bit rate may or not may be the stream’s maximum.</td>
</tr>
<tr>
<td></td>
<td>• The bit rate is reduced when there is little movement or change.</td>
</tr>
<tr>
<td></td>
<td>• The bit rate is increased when there is more change.</td>
</tr>
<tr>
<td>Frame rate</td>
<td>Select a frame rate (only frame rates supported by the device are displayed).</td>
</tr>
</tbody>
</table>
Editing the Camera Settings

**Table 7-12 Custom Video Quality Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit rate</td>
<td>Select the bit rate at which the video device will stream the selected frame rate. <strong>Note</strong> The frame rate must be specified first. Only frame rate and bit rate combinations supported by the device are displayed.</td>
</tr>
</tbody>
</table>
| Quality | (VBR Bit rate mode only) Select the priority of the video quality against the desired frame rate.  
- A high *Quality* setting may cause the video device to reduce the frame rate during periods of high motion or change (in order to maintain a higher quality image).  
- A low *Quality* setting may cause the video device to greatly reduce the image quality to maintain a higher frame rate during the periods of high motion or change in the video. |

**Procedure**

**Step 1** Create or edit a model-specific camera template, as described in the “Creating or Modifying a Template” section on page 9-3).

**Step 2** Select the **Streaming, Recording and Event** tab.

**Step 3** Click **Custom** in the **Video Quality** field.

**Step 4** Enter the settings described in Table 7-12 and click **Set**.

**Step 5** Complete the template configuration as described in the “Streaming, Recording and Event Settings” section on page 7-49 and the “Creating or Modifying a Template” section on page 9-3.
Image Settings

Image settings allow you to define where motion is detected in a camera image, the pan, tilt, and zoom settings for a camera, and the image properties such as contrast and brightness.

Motion Settings
See the “Configuring Motion Detection” section on page 7-76.

Pan Tilt and Zoom (PTZ) Settings
See the “Configuring Camera PTZ Controls, Presets, and Tours” section on page 7-64.

Photographic Controls
Click the Image tab to access the Photographic Controls (Table 7-13) that define properties such as contrast and brightness.

- Only the settings supported by the camera model are shown.
- Analog cameras support video controls only if the camera is configured for serial pass through (a serial cable must be connected from the camera to the encoder, and a serial port must be configured on the analog camera). See the “General Settings” section on page 7-45 for instructions to configure the analog camera serial port. See the “Adding External Encoders and Analog Cameras” section on page 10-4 for more information.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>White Balance</td>
<td>Adjusts the camera to compensate for the type of light (daylight, fluorescent, incandescent, etc.,) or lighting conditions in the scene so it will look normal to the human eye.</td>
</tr>
<tr>
<td>Sharpness</td>
<td>Adjusts edge contrast (the contrast along edges in a photographic image). Increase sharpness to increase the contrast only along or near the image edges without affecting the smooth areas of the image.</td>
</tr>
<tr>
<td>Contrast</td>
<td>Adjusts the separation between the darkest and brightest areas of the image. Increase contrast to make shadows darker and highlights brighter. Decrease contrast to lighten shadows and darken highlights.</td>
</tr>
<tr>
<td>Saturation</td>
<td>Adjusts the intensity and vibrancy of each color channel.</td>
</tr>
<tr>
<td>Hue</td>
<td>Adjusting hue will shift the entire color palate along a spectrum. This results in all colors being changed toward a different dominant color. Useful for adjusting the image to make it look more natural in unusual lighting conditions.</td>
</tr>
</tbody>
</table>
Configuring the High Availability Options for a Camera or Template

The Advanced Storage options allow you to define where video streams should be saved. By default, video from both streams is saved only to the Media Server associated with the camera. The Advanced Storage options allow you to also save the video streams to a **Redundant** server or to a **Long Term Storage** (LTS) server (or both). In addition, you can specify a **Failover** server that can assume the Primary functions if the Primary server goes offline (also called **hot standby**).

*Note*  
The following procedures are included in the “High Availability” section on page 11-1.

<table>
<thead>
<tr>
<th>Task</th>
<th>Related Documentation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>Install and configure the HA servers.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Understanding Redundant, Failover, and Long Term Storage Servers</strong>, page 11-3</td>
</tr>
<tr>
<td></td>
<td>• <strong>Installing and Configuring the HA Servers</strong>, page 11-8</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>Configure the Primary server to use the HA servers.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Assign the HA Server(s) to the Primary or Redundant Servers</strong>, page 11-9</td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td>Configure the HA Advanced Storage options on the camera template.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Configuring the Camera Template HA Options</strong>, page 11-11</td>
</tr>
</tbody>
</table>
Deleting Cameras

When deleting a camera, you can delete the camera and all recordings, or keep the recordings on the system. See the Delete Options for more information.

To delete one or more cameras, use the following methods:

- Delete a Single Camera
- Delete Multiple Cameras
- Delete Options

Delete a Single Camera

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click Cameras.</td>
</tr>
<tr>
<td>2</td>
<td>Select the location and camera name.</td>
</tr>
<tr>
<td>3</td>
<td>Click Delete.</td>
</tr>
<tr>
<td>4</td>
<td>Select one of the Delete Options.</td>
</tr>
</tbody>
</table>

Delete Multiple Cameras

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click Cameras.</td>
</tr>
<tr>
<td>2</td>
<td>Click Bulk Actions.</td>
</tr>
</tbody>
</table>
| 3    | Search for and select the cameras to be deleted  
  - See the “Bulk Actions: Revising Multiple Cameras” section on page 7-87 for more information. |
| 4    | Click Delete. |
| 5    | Select one of the Delete Options. |
Deleting Cameras

Delete Options
Select one of the following options from the camera or template configuration page:

Table 7-14 Delete Options

<table>
<thead>
<tr>
<th>Delete Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Blacklist &amp; Full Delete</strong></td>
<td>The camera is removed from Cisco VSM and all recordings are deleted. The camera is placed in the Blacklist, which prevents it from being discovered.</td>
</tr>
<tr>
<td></td>
<td>See the following for more information:</td>
</tr>
<tr>
<td></td>
<td>• Blacklisting Cameras, page 7-40</td>
</tr>
<tr>
<td></td>
<td>• Discovering Cameras on the Network, page 7-22</td>
</tr>
<tr>
<td><strong>Retain Recordings</strong></td>
<td>The camera configuration is removed from Cisco VSM, but the camera recordings can still be accessed in the Monitor Video page.</td>
</tr>
<tr>
<td></td>
<td>• The camera status is Soft Deleted. You can access the recorded video but cannot display live video. See the “Viewing Video” section on page 2-1.</td>
</tr>
<tr>
<td></td>
<td>• Recordings are retained on the system until removed according to the recording retention settings. See the “Configuring Continuous, Scheduled, and Motion Recordings” section on page 9-7.</td>
</tr>
<tr>
<td></td>
<td>• The camera is still included in the camera license count. See the “Installing Licenses” section on page 1-21.</td>
</tr>
<tr>
<td><strong>Full Delete</strong></td>
<td>The camera is removed from Cisco VSM and all recordings are deleted (removed from the database). The camera can be manually re-added, or added using network discovery, but all recordings will be lost.</td>
</tr>
<tr>
<td></td>
<td>See the following for more information:</td>
</tr>
<tr>
<td></td>
<td>• Manually Adding a Single Camera, page 7-12</td>
</tr>
<tr>
<td></td>
<td>• Discovering Cameras on the Network, page 7-22.</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>Cancel the operation.</td>
</tr>
</tbody>
</table>
Changing the Camera or Encoder Network Settings and/or Credentials

The camera or encoder IP address, username, and password settings stored in Cisco VSM Operations Manager are used to access the device over the network. These settings are entered into the Operations Manager when the device is first added to the system (see the “Manually Adding Cameras” section on page 7-8 and the “Adding External Encoders and Analog Cameras” section on page 10-4).

Change Options

You can use Operations Manager to change these settings in the following ways (see Figure 7-15):

- Enter a new value in the IP Address, username or password field and click Save. This only changes the settings used by Operations Manager to access the device on the network. It does not change the settings stored on the device.
- Click the Change button and enter a new setting to change the setting stored on the device, and the setting use by the Operations Manager.

Figure 7-15 Camera Access Settings
Changing the Camera or Encoder Network Settings and/or Credentials

Usage Notes

- The Change button is disabled if this action is not supported by the device, which means you must use the device UI to change the Access settings on the device. Refer to the device documentation or ask your system administrator for assistance.

- The IP address, username and password in Operations Manager must match the settings configured on the device. If a mismatch occurs, communication with the device will be lost, including new video streams and recordings.

Changing the Operations Manager Configuration Only

To change the settings used by Operations Manager to access the device over the network, do the following. The credentials configured on the device will not be affected.

Step 1
Open the camera or encoder settings page as described in the “Accessing the Camera Settings” section on page 7-42.

Step 2
Select the General tab, if necessary.

Step 3
Under Access Information, enter the new IP address, username and password.

Step 4
Click Save to apply the changes.

Changing the Device Setting and Operations Manager Configuration

If the Change button is enabled, you can change the access settings stored on the device and the Operations Manager configuration.

Step 1
Click Change next to the entry field.

Step 2
Enter the new network settings or credentials.

Step 3
Click OK to save the changes.

Step 4
(Optional) Verify the new settings:

- Click View Status to verify the Job was successfully completed.

- Click the Monitor Video tab and select the camera name to view live video from the camera. For encoders, select an analog camera associated with the encoder.
**Viewing Camera Status**

Click the camera **Status** tab (Figure 7-16) to display a snapshot of the camera health, including the camera’s ability to communicate with a Media Server, stream video over the network, or record video. If a configuration error occurs, click the icon view additional information. You can also click the **Status History** tab to view the specific system events that impact the device status.

For more information see the “Device Status: Identifying Issues for a Specific Device” section on page 12-6.

![Camera Device Status](image)

When a camera is added to Cisco VSM, it is placed in either **Enabled** or **pre-provisioned** state:

- **Enabled** means that the user intends the camera is to be functional. There are three possible sub-levels:
  - **Enabled: OK** — The device is operating normally.
  - **Enabled: Warning** — A minor event occurred that did not significantly impact device operations.
  - **Enabled: Critical** — An event occurred that impacts the device operation or configuration.

- **Pre-Provisioned** — the camera is waiting to be added to Cisco VSM and is not available for use. A pre-provisioned camera can be modified, but the camera cannot stream or record video until the configuration is complete and you choose **Enable** from the **Device Settings** menu.
Configuring Camera PTZ Controls, Presets, and Tours

Cameras that support pan (left-right), tilt (up-down) and zoom (in-out) movements can be controlled using either the on-screen PTZ controls, or a third-party joystick. PTZ control is available when viewing live video only.

In addition, you can configure PTZ cameras for the following:

- Create PTZ presets that allow operators to quickly jump to a preset position.
- Create PTZ tours that automatically cycle a camera between the PTZ preset positions.
- Create Advanced Events that automatically move the camera to a PTZ preset position when an event occurs.
- Define a Return To Home preset that automatically returns the camera to a selected Home position when idle for a specified number of seconds (see Advanced Settings).
- Define user groups that have priority for accessing PTZ controls.

Refer to the following topics for more information:

- PTZ Requirements, page 7-65
- PTZ Camera Configuration Summary, page 7-66
- Defining the User Group PTZ Priority, page 7-68
- Using Camera PTZ Controls, page 7-69
- Configuring PTZ Presets, page 7-70
- Configuring PTZ Tours, page 7-72
- PTZ Advanced Settings, page 7-75

Related information:

- Using Pan, Tilt, and Zoom (PTZ) Controls, page 2-29
- Calibrating a Joystick for Windows 7, page 2-31
- Using Advanced Events to Trigger Actions, page 9-11

Tip

See the Example in the “Defining the User Group PTZ Priority” section on page 7-68 to understand how users, events, tours and other features gain or are denied PTZ control based on their PTZ priority.
PTZ Requirements

Cameras that support PTZ controls automatically display an Image tab in the camera configuration that includes PTZ controls (choose the camera and click the Image > Pan/Tilt/Zoom).

PTZ cameras and PTZ users require the following:

<table>
<thead>
<tr>
<th>Requirements</th>
<th>Requirement Complete?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cameras must support PTZ functionality.</td>
<td></td>
</tr>
<tr>
<td>PTZ functionality must be enabled on the camera.</td>
<td></td>
</tr>
<tr>
<td>See the camera documentation for more information.</td>
<td></td>
</tr>
<tr>
<td>To use PTZ controls, you must belong to a user group with Perform PTZ permissions.</td>
<td></td>
</tr>
<tr>
<td>To configure PTZ presets, PTZ tours, and Advanced Events, you must belong to a user group with Cameras permissions.</td>
<td></td>
</tr>
<tr>
<td>To configure the PTZ Priority and Lockout Period, you must belong to a user group with Users &amp; Roles permissions.</td>
<td></td>
</tr>
</tbody>
</table>
PTZ Camera Configuration Summary

Cameras with PTZ functionality display a **Pan/Tilt/Zoom** tab under the **Image** tab of the Camera configuration page (Figure 7-17). Use the **Pan/Tilt/Zoom** tab to create PTZ presets, and PTZ tours. You can also use the Advanced Events to automatically trigger PTZ presets when an event occurs.

**Figure 7-17 Camera PTZ Configuration**

The following procedure summarizes the PTZ configuration options.

**Procedure**

<table>
<thead>
<tr>
<th>Task</th>
<th>Related Documentation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>Install the PTZ camera and enable PTZ functionality, if necessary.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>Add the camera to the Cisco VSM configuration.</td>
</tr>
</tbody>
</table>
| **Step 3** | (Optional) Connect a PTZ joystick to a USB port on your PC and calibrate the device for Windows 7. | • See the joystick documentation for more information.  
• See the “Calibrating a Joystick for Windows 7” section on page 2-31. |
| **Step 4** | Open the camera PTZ configuration page to verify the camera PTZ controls are available:  
  a. Select **Cameras** and select a camera name.  
  b. Click the **Image** tab and verify that the **Pan/Tilt/Zoom** tab is selected (Figure 7-17). | Accessing the Camera Settings, page 7-42 |
### Configuring Camera PTZ Controls, Presets, and Tours

#### Chapter 7      Adding and Managing Cameras

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Related Documentation</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>(Optional) Configure the camera PTZ presets.</td>
<td>Configuring PTZ Presets, page 7-70</td>
</tr>
<tr>
<td></td>
<td>Presets are used to quickly adjust a camera view to a</td>
<td></td>
</tr>
<tr>
<td></td>
<td>pre-defined PTZ setting.</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>(Optional) Configure the camera PTZ tours.</td>
<td>Configuring PTZ Tours, page 7-72</td>
</tr>
<tr>
<td></td>
<td>PTZ tours are used to cycle the camera view between PTZ</td>
<td></td>
</tr>
<tr>
<td></td>
<td>presets.</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>(Optional) Define if the camera should return to a selected</td>
<td>PTZ Advanced Settings, page 7-75</td>
</tr>
<tr>
<td></td>
<td>Home position when idle for a specified number of seconds.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> If a PTZ tour is enabled, then the <em>Return to Home</em> setting is ignored</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>(Optional) Enter the camera PTZ <em>idle</em> time that defines the</td>
<td>PTZ Advanced Settings, page 7-75</td>
</tr>
<tr>
<td></td>
<td>following:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• PTZ Tour—the number of seconds after a manual PTZ</td>
<td></td>
</tr>
<tr>
<td></td>
<td>movement or event action before the PTZ tour can resume.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Return to Home—the number of seconds after a manual PTZ movement or event action before the camera returns to the <em>Return to Home</em> preset position.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• User PTZ control (priority lockout or camera controls lockout)—the number of seconds that a lower priority user has to wait before being able to move the camera after a higher priority user stops using the PTZ controls.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> PTZ tours and Return to Home have the lowest priority, allowing users and Advanced Events to assume PTZ control when necessary.</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>(Optional) Define the user groups that have priority over</td>
<td>Defining the User Group PTZ Priority, page 7-68</td>
</tr>
<tr>
<td></td>
<td>other users for controlling PTZ cameras.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> By default, all user groups have the highest priority (100).</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>(Optional) Configure the <em>Advanced Events</em> that trigger a PTZ</td>
<td>Using Advanced Events to Trigger Actions, page 9-11</td>
</tr>
<tr>
<td></td>
<td>preset position.</td>
<td></td>
</tr>
</tbody>
</table>

---

**Step 5** (Optional) Configure the camera PTZ presets. Presets are used to quickly adjust a camera view to a pre-defined PTZ setting.

**Step 6** (Optional) Configure the camera PTZ tours. PTZ tours are used to cycle the camera view between PTZ presets.

**Step 7** (Optional) Define if the camera should return to a selected Home position when idle for a specified number of seconds. **Note** If a PTZ tour is enabled, then the *Return to Home* setting is ignored.

**Step 8** (Optional) Enter the camera PTZ *idle* time that defines the following:

- PTZ Tour—the number of seconds after a manual PTZ movement or event action before the PTZ tour can resume.
- Return to Home—the number of seconds after a manual PTZ movement or event action before the camera returns to the *Return to Home* preset position.
- User PTZ control (priority lockout or camera controls lockout)—the number of seconds that a lower priority user has to wait before being able to move the camera after a higher priority user stops using the PTZ controls. **Note** PTZ tours and Return to Home have the lowest priority, allowing users and Advanced Events to assume PTZ control when necessary.

**Step 9** (Optional) Define the user groups that have priority over other users for controlling PTZ cameras. **Note** By default, all user groups have the highest priority (100).

**Step 10** (Optional) Configure the *Advanced Events* that trigger a PTZ preset position.
Defining the User Group PTZ Priority

A conflict can occur if multiple users attempt to use the PTZ controls for the same camera. For example, if a security incident occurs, a security officer may need to assume control over lower-priority users. To resolve this, each user group is assigned a PTZ priority number from 1 to 100. Users in a group with a higher number are given PTZ priority over users that belong to a group with a lower number. If the PTZ controls are in use by a lower-priority user, the higher-priority user can assume control immediately.

When a higher priority user assumes control of a PTZ camera, lower priority users are denied access to the PTZ controls. The lockout continues until the higher-priority user stops accessing the PTZ controls, plus the number of idle seconds defined in the PTZ idle setting (see the “PTZ Advanced Settings” section on page 7-75).

Usage Notes

- By default, all user groups have the highest priority (100).
  - See the “Defining the User Group PTZ Priority Level” section on page 7-69 to define a lower value.
  - Users that belong to multiple user groups gain the highest priority from any assigned group.
- If a higher-priority user is using the PTZ controls, the PTZ controls remain locked and you cannot control the PTZ movements until released by the higher priority user (and the idle time has expired).
- If users belong to user groups with the same priority, they will be able to access the PTZ controls at the same time. This can result in conflicting movements.
- Advanced Events that trigger a PTZ preset position are assigned a priority of 50. This setting cannot be changed.
  - Event-triggered PTZ presets will take control from any user group members that have a priority lower than 50 (user groups with a higher priority can take control or will maintain control).
  - The camera remains at the PTZ preset unless a PTZ tour is enabled or a user accesses the PTZ controls.
  - See the “Using Advanced Events to Trigger Actions” section on page 9-11 for more information
- PTZ tours and Return to Home are assigned the lowest priority by default. This allows users to assume control of any camera that is configured with a rotating PTZ tour. Event-triggered PTZ movements also override PTZ tours.
- When all users stop accessing the PTZ controls and idle time expires, the camera PTZ Tour or Return to Home position will resume, if configured (the PTZ tour continues). The lockout idle time is reset each time the higher-priority user accesses the PTZ controls. See the “PTZ Advanced Settings” section on page 7-75.
- If the When manual PTZ idle for field is not defined, then cameras use the number of seconds in their associated Media Server’s Camera Control Lockout field (see the “Media Out Settings” section on page 6-14).

Example

The following example is based on this scenario:

- A PTZ tour is configured
- user1 is in a user group with PTZ priority 60
- user2 is in a user group with PTZ priority 100
- The PTZ idle time (lockout) is 30 seconds
A PTZ tour is enabled and rotating the camera between PTZ presets. *User1* can access the PTZ controls and interrupt the tour. However, if higher-priority *user2* also accesses the camera PTZ controls, then *user2* will take control and *user1*'s PTZ commands will be ignored. This is because *user2* is in a user group with priority 100 while *user1* is in a user group with priority 60 (PTZ tours have the lowest priority).

When the higher-priority *user2* stops moving the camera, *user1* must still wait the number of seconds defined in the camera *When Manual PTZ idle for* setting before they can move the camera again. If *user2* uses the PTZ controls within that idle time, then the timer is reset and *user1* must continue to wait.

Advanced Event PTZ movement is the same as a user with priority 50 moving the camera. If lower priority users (0-49) are moving the camera, those lower priority users will lose control of the camera and the event will PTZ move the camera. If higher priority users (51-100) are using the camera then the event PTZ movement will not happen.

If the event PTZ successfully moved the camera, then the camera's idle time lockout is set preventing lower priority users from moving the camera until it expires.

When all users stop accessing the PTZ controls, the PTZ tour continues (after the *idle* time expires).

### Defining the User Group PTZ Priority Level

**Step 1** Define the PTZ priority for each user group.

a. Select *Users*, and then select the *User Groups* tab.

b. Select a user group or create a new group (see the “Adding User Groups” section on page 4-10 for more information).

c. In the *PTZ priority over other user groups* field, select a number from 1 to 100 (the default is 100—highest priority).

d. Click *Save*.

**Step 2** (Optional) Enter the camera *idle* time to define the number of seconds a lower-priority user must wait after a higher-priority user stops using the PTZ controls. See the “PTZ Advanced Settings” section on page 7-75 for more information.

### Using Camera PTZ Controls

Camera PTZ movements can be controlled using a mouse or joystick. See the “Using Pan, Tilt, and Zoom (PTZ) Controls” section on page 2-29 for more information.
Configuring PTZ Presets

PTZ *presets* allow operators to quickly jump to a preset position.

- To access the PTZ preset, go to the **Monitor** page, display the camera video, right-click the image and choose **Presets** from the **Pan, Tilt, and Zoom** menu. Choose a preset to move the camera to the defined position.

- To trigger presets with a USB joystick, press the joystick button that corresponds to the PTZ preset number. For example, joystick button 1 triggers PTZ preset 1, joystick button 2 triggers PTZ preset 2, etc.

- You can also create PTZ **tours** that automatically cycle a camera between the PTZ preset positions, or Advanced Events that automatically move the camera to a PTZ preset position when an event occurs.

- PTZ presets cannot be deleted if they are being used in a PTZ tour.

- If a camera is replaced, you must re-define the PTZ presets since the coordinates will not match the new device.

**Related Topics**

- Using Pan, Tilt, and Zoom (PTZ) Controls, page 2-29
- Configuring PTZ Tours, page 7-72
- PTZ Advanced Settings, page 7-75
- Using Advanced Events to Trigger Actions, page 9-11

To configure PTZ presets, use the PTZ controls to adjust the live video stream, enter a preset name, and click **Set**.

**Figure 7-18**  **PTZ Preset Configuration**
**Procedure**

To define PTZ presets, do the following:

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Open the camera PTZ configuration page:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>a.</td>
<td>Click <strong>Cameras</strong>.</td>
<td></td>
</tr>
<tr>
<td>b.</td>
<td>Click a location or Media Server and select a camera.</td>
<td></td>
</tr>
<tr>
<td>c.</td>
<td>Click the <strong>Image</strong> tab and then click <strong>Pan/Tilt/Zoom</strong> (Figure 7-18).</td>
<td></td>
</tr>
<tr>
<td>d.</td>
<td>Verify that the PTZ controls are enabled (if disabled, click the icon to enable PTZ controls).</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 2</th>
<th>Position the camera using the following controls:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Using a Mouse</td>
<td>– Pan and Tilt—<em>Left-click</em> the image and drag the mouse right, left, up and down.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– Zoom—<em>Shift-click</em> the image and drag the mouse up and down to zoom in and out.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Using a USB Joystick</th>
<th>– Pan—move the joystick bar horizontally.</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>– Tilt—move the joystick bar vertically.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– Zoom —twist the joystick.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 3</th>
<th>Enter a PTZ Preset name.</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>• For example: <em>Lobby Door Close-up</em>.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| Step 4 | Click **Set**. |  |

| Step 5 | (Optional) Click **Test** to move the camera position between different preset positions. |  |

| Step 6 | Repeat **Step 2** through **Step 5** to define additional PTZ presets. |  |

| Step 7 | Click **Save** to save the camera settings. |  |
Configuring PTZ Tours

PTZ tours automatically rotate a camera’s view between PTZ presets in a specified order, pausing at each position according to the specified dwell time. The camera will continue to rotate between the presets until interrupted or disabled by an operator or Advanced Event. When the last preset in the list is reached, the tour starts over at the beginning.

Usage Notes

- Any camera that supports PTZ presets also supports PTZ tours. At least two PTZ presets must be available to create a PTZ Tour.
- You can enable a single PTZ tour for each camera.
- PTZ tours have the lowest priority for PTZ camera movements. For example, operators can manually take PTZ control of the camera, or an Advanced Event can move the camera to a PTZ preset. Both users and events have priority PTZ access to the camera. See the “Defining the User Group PTZ Priority” section on page 7-68 for more information.
- Operators can interrupt the tour by manually changing the PTZ position. The camera will stay at the user-selected position for the number of seconds configured in the Advanced Setting “When manual PTZ idle for”, and then resume the tour with the next preset. For more information, see:
  - PTZ Advanced Settings, page 7-75
  - Using Pan, Tilt, and Zoom (PTZ) Controls, page 2-29
- To stop the PTZ tour, deselect Enable PTZ Tour. The camera will return to the first PTZ preset in the tour list.
- If a PTZ tour is enabled, then the Return to Home setting is ignored (see the “PTZ Advanced Settings” section on page 7-75).
- If the PTZ tour is disabled, the camera will stay at the current position, or go to the Return to Home setting, if configured.

Procedure

Step 1 Define at least two PTZ presets for the camera, as described in the “Configuring PTZ Presets” section on page 7-70.

Step 2 Define the PTZ presets included in the tour:
  a. Click Add or Edit (Figure 7-20) to open the PTZ Tour Configuration window (Figure 7-19).
Figure 7-19  PTZ Tour Configuration

- Select the Transition Time (the time that a camera stays at each preset position before changing to the next preset).
- Use the right-left arrows to move the presets from Available to Selected.
  
  **Note**  At least two presets must be included in the Selected column.

- Use the up-down arrows to move the presets up or down in the list to define the order of the preset rotation.
- Click Save.

**Step 3**  (Optional) Select Enable PTZ Tour to turn on the PTZ tour for the camera (Figure 7-20).
- The camera will display the PTZ tour whenever live video is displayed. To stop the PTZ tour, you must deselect Enable PTZ Tour.
Step 4  (Optional) Define the camera PTZ idle time to define the amount of time the number of seconds after a manual PTZ movement or event action before the PTZ tour can resume. See the “PTZ Advanced Settings” section on page 7-75 for more information.
**PTZ Advanced Settings**

Use the camera PTZ Advanced Settings to define if the camera should return to a selected Home position when idle for a specified number of seconds.

The idle setting also defines the number of seconds before a PTZ tour resumes (after a manual or event override), and the number of seconds a lower priority PTZ user must wait after a higher-priority user stops using the camera PTZ controls.

**Table 7-16 Camera PTZ Advanced Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>When manual PTZ idle for</td>
<td>The number of seconds the camera can be idle (no PTZ commands) before the camera returns to the home PTZ preset or continues a PTZ tour (see the Return to Home setting). By default, the idle time is defined by the Media Server’s Camera Control Lockout setting (see the “Media Out Settings” section on page 6-14). Use the When manual PTZ idle for field to override the server setting for the current camera.  • PTZ Tour—the number of seconds after a manual PTZ movement or event action before the PTZ tour can resume. The timer is reset whenever the camera PTZ controls are used by an operator or event action. See the “Configuring PTZ Tours” section on page 7-72.  • Return to Home—the number of seconds after a manual PTZ movement or event action before the camera returns to the Return to Home preset position. The timer is reset whenever the camera PTZ controls are used by an operator or event action.  • User PTZ control (priority lockout or camera controls lockout)—the number of seconds that a lower priority user has to wait before being able to move the camera after a higher priority user stops using the PTZ controls. See the “Defining the User Group PTZ Priority” section on page 7-68.</td>
<td></td>
</tr>
<tr>
<td>Enable Home Preset</td>
<td>If enabled, the camera will move to the Return to Home preset location if idle for the number of seconds in the When manual PTZ idle for setting. Deselect this option to disable the Return to Home feature. If a PTZ tour is enabled, then the Return to Home setting is ignored.</td>
<td></td>
</tr>
<tr>
<td>Return to Home</td>
<td>Select the PTZ preset used as the Home position.</td>
<td></td>
</tr>
</tbody>
</table>
Configuring Motion Detection

Cameras that support motion detection can trigger actions or record video when motion occurs in the camera’s field of view. For example, a camera pointed at the rear door of a building can record a motion event if a person walks into the video frame. A motion event can also trigger alert notifications, a camera’s PTZ controls, or a URL action on a third party system.

- Motion detection is supported for analog cameras only if the encoder supports motion detection.
- Motion detection is supported only for the primary (Stream A) video.
- Motion can be detected for a camera’s entire field of view, or for specified areas. If the camera or encoder supports exclusion areas, you can also exclude areas where motion should be ignored.
- Motion detection must be configured for each camera (motion detection is not defined by camera templates). Use Bulk Actions to locate cameras without motion detection and add motion detection for the cameras’ entire field of view (see Enabling Motion Detection on All Existing Cameras (Bulk Actions), page 7-81).
- Alerts can be configured for motion events, contact closures, analytic events, or soft triggers. Always configure these features carefully to avoid overwhelming operator(s) with an excessive number of alerts. If an excessive amount of alerts are generated, the system may ignore new alerts while deleting old entries.

Refer to the following topics for more information.

- Motion Detection Overview, page 7-77
- Motion Detection Settings, page 7-78
- Configuring Motion Detection, page 7-79
- Enabling Motion Detection on All Existing Cameras (Bulk Actions), page 7-81

Related Documentation
Using Advanced Events to Trigger Actions, page 9-11—Define additional actions that are triggered when motion events start or stop.
Motion Detection Overview

Cameras that support motion detection display a Motion tab under the camera Image settings (Figure 7-21).

Figure 7-21 Configuring Motion Detection

To enable motion events, you must define the areas in the camera image that should detect motion. You can define the entire field of view, or use the Include Area to draw a box where motion will be detected (Figure 7-21). Motion outside of the include box(es) is ignored. Add exclude areas within include boxes to also ignore motion in a portion of the included areas.

Tip
See the “Enabling Motion Detection on All Existing Cameras (Bulk Actions)” section on page 7-81 to include the entire field of view for multiple cameras.

See the “Configuring Motion Detection” section on page 7-79 for more information. Use the settings to the right of the preview window to define additional motion detection settings, as described in the Motion Detection Settings, page 7-78.
Motion Detection Settings

Use the settings described in Table 7-17 to define the portions of the camera image to include or exclude, and how sensitive the included areas should be (see the example in Figure 7-21). Refer to the “Configuring Motion Detection” section on page 7-79 for information to access and save these settings.

Table 7-17     Motion Detection Settings

<table>
<thead>
<tr>
<th>Setting/Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Area</td>
<td>Drag and drop the Include Area box onto the image to define a window where motion should be detected.</td>
</tr>
<tr>
<td>Exclude Area</td>
<td>Drag and drop the Exclude Area box onto the image to exclude portions of the included area. For example, if the include area covers an entire room, you can exclude an area where regular motion occurs, such as a clock or fan. Exclude areas are used to reduce unwanted motion events.</td>
</tr>
<tr>
<td>Persistence</td>
<td>The amount of time that motion must occur (within the selected window) for a motion event start to occur. The recommended value is 0 (default): motion of any duration results in a motion start event. Select a higher number if the motion duration should continue longer before a motion event is triggered.</td>
</tr>
<tr>
<td>Stop Trigger Time</td>
<td>Determines how many seconds to delay when a motion event is considered to have stopped (after the actual motion has ended). Recommended value is 0 (default): the event stops immediately when the motion ends. Select a higher number to define a motion event delay. This setting prevents multiple motion events from being triggered when motion reoccurs in a short period of time. Select a time that will result in only one event for the “burst of motion activity”.</td>
</tr>
<tr>
<td>Window Name</td>
<td>The name of the selected motion window. Click an include or exclude area, and enter a meaningful name.</td>
</tr>
<tr>
<td>Detection Threshold and Sensitivity (Include Areas only)</td>
<td>• Detection Threshold—The size of object needed to trigger a motion start. • Sensitivity—Determines the degree of susceptibility to motion. The more sensitive, the less motion is needed to trigger a motion start. These values are set by default based on the recommended settings for the camera model. For example: • Cisco 26xx: Threshold = 10, Sensitivity = 80 • Cisco 29xx: Threshold = 10 Sensitivity = 80 • Cisco 45xx: Threshold = 10 Sensitivity = 80 • Cisco 60xx: Threshold = 1, Sensitivity = 85 (The maximum value is 100. The minimum value is 0.)</td>
</tr>
</tbody>
</table>
Configuring Motion Detection

Procedure

Step 1 Verify that the camera or encoder supports motion detection.
See the camera or encoder documentation for more information.

Step 2 Log on to the Operations Manager.
You must belong to a User Group with permissions for Cameras. See the “Adding Users, User Groups, and Permissions” section on page 4-1 for more information.

Step 3 (Optional) Complete the “Enabling Motion Detection on All Existing Cameras (Bulk Actions)” section on page 7-81.

Step 4 Open the camera configuration page:
   a. Click Cameras.
   b. Select the camera’s location, Media Server or template.
   c. Select the camera from the list in the lower left column.

Step 5 Click the Image tab.

Step 6 Click the Motion tab.
The current camera image appears (Figure 7-21).

Step 7 Add green Include Areas (windows) where motion should be detected in the image.
   a. Drag the green Include Area box onto the video image (Figure 7-21).
   b. (Optional) Enter a name in the Window Name field.
   c. Move and resize the motion window.
      – To move the window, click and hold within the window, then use the move cursor  
        to drag the window to a new location.
      – To resize the window, click and hold the corner or edge to change the size and shape.
   d. Repeat these steps to create additional Include Areas in the video frame.

Step 8 Define the motion detection settings for each Include Area.
   a. Click the motion window to select it.
   b. Change the motion detection settings, as necessary, as described in Figure 7-21 on page 7-77.

Step 9 (Optional) Add a red Exclude Area box within an include box to define where motion should be ignored (Figure 7-21).

Table 7-17 Motion Detection Settings (continued)

<table>
<thead>
<tr>
<th>Setting/Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Motion Configs</td>
<td>Saves the changes to the cameras motion detection settings.</td>
</tr>
<tr>
<td>Restore Motion Configs</td>
<td>Restores the settings to the previous saved values.</td>
</tr>
</tbody>
</table>

Cisco Video Surveillance Manager Operations Manager User Guide
Note: All areas outside of the *include* boxes are ignored by default. Add *exclude* areas within *include* boxes to also ignore motion within the included areas.

a. Drag the red **Exclude Area** box onto the video image (Figure 7-21).
b. (Optional) Enter a name in the Window Name field.
c. Move and resize the motion window.

**Step 10** Click **Save Motion Configs**.

Tip: Click **Restore Motion Configs** to return the settings to the previously saved value.

**Step 11** (Optional) Configure motion event recordings for a camera or template.

See the following for more information:

- **Editing the Camera Settings**, page 7-42
- **Configuring Continuous, Scheduled, and Motion Recordings**, page 9-7

**Step 12** (Optional) Configure actions that are triggered when a motion event occurs.

See the “Using Advanced Events to Trigger Actions” section on page 9-11.
Enabling Motion Detection on All Existing Cameras (Bulk Actions)

Use the Bulk Actions feature to discover all cameras where motion detection is unconfigured, and add a default motion window that includes the entire field of view (Figure 7-22).

This process selects the entire camera view to be included in the motion window. Use the camera configuration page to make further refinements or define excluded areas (see the “Configuring Motion Detection” section on page 7-79).

Figure 7-22   Bulk Actions

Procedure

Step 1 Click Cameras to open the camera configuration page.
Step 2 Click Bulk Actions.
Step 3 Expand Issue Type and select Motion Unconfigured.
Step 4 Click Search.
Step 5 Select the cameras from the listed results.
Step 6 Click Default Motion Window and confirm the change.
Step 7 (Optional) Use the camera configuration page to refine the motion detection areas and sensitivity for each camera.
   - Motion Detection Settings, page 7-78
   - Configuring Motion Detection, page 7-79
Upgrading Camera and Encoder Driver Firmware

Firmware for Cisco cameras and encoders can be upgraded using the Operations Manager as described in the following procedure. You can upgrade a single device, or multiple devices at a time.

See the “Understanding Cisco Video Surveillance Software” section on page 1-20 for information about firmware, driver packs and system software.

Usage Notes

- Upgrade firmware for non-Cisco devices using a direct connection. See device documentation for more information.
- The Cisco devices must be available on the network and enabled in Cisco VSM. If the device is not available to Cisco VSM, connect directly to the device to upgrade the drivers using a direct connection (see the device documentation for instructions).
- The firmware image file must be a valid file format. Because the file format is different for each camera vendor, the Operations Manager will initially accept any file format, even if invalid. However, invalid files will cause the upgrade or downgrade to fail after 2-3 minutes.
- The upgrade can fail if device configuration changes are in process when the upgrade begins. If a device configuration is started during the upgrade, then the configuration change can fail. To avoid this, verify that no device configuration changes are running or started during the firmware upgrade (open the device Status page; the Jobs in Progress field should be No).
- The firmware version column in the Manage tab is only shown after the firmware has been applied to a set of devices.
- Each Media Server can update five devices at a time.
- Only one upgrade can be executed at a time. Wait until all devices are upgraded before initiating a new request.
- The vendor and device list includes the models that support firmware upgrades using the Operations Manager.
- To downgrade device firmware, select a previous version (the device must support downgrades).

Before You Begin

Before you begin, obtain the driver firmware for your device(s).

- To obtain firmware for Cisco devices, see the Release Notes for Cisco Video Surveillance Manager, Release 7.0.1 for more information.
- To obtain firmware for non-Cisco products, go to the product website or contact your sales representative.
- Verify that the firmware version is supported in Cisco Video Surveillance Manager, Release 7.0.1. See the Release Notes for Cisco Video Surveillance Manager, Release 7.0.1.

Procedure

Step 1
Download the firmware image from the Cisco website or device manufacturer.

See the Release Notes for Cisco Video Surveillance Manager, Release 7.0.1 for more information.
Chapter 7  Adding and Managing Cameras

Upgrading Camera and Encoder Driver Firmware

Note
The firmware image file must be a valid file format for the camera model. Although the Operations Manager will initially accept an invalid file format, the upgrade or downgrade will fail after 2-3 minutes.

Step 2
Choose System Settings > Firmware Management.
- You must belong to a User Group with manage permissions for Cameras and Images.
  - See the “Adding Users, User Groups, and Permissions” section on page 4-1.
  - Specifically, see the “Understanding Permissions” section on page 4-4.

Step 3
Select the camera or encoder model:
- Select the tab for Camera Firmware Upgrade or Encoder Firmware Upgrade.
- Select the Vendor.
  - Example, Cisco Systems, Inc.
- Select the Model.
  - Example, Cisco HD IP Camera 4300E Series.

Step 4
Add the firmware images:
- Select the Manage tab.
- Click Add to upload a new firmware image.
  - Select From Local or From Remote FTP.
  - Select the location of the firmware file, or enter the FTP connection details.
  - Enter a firmware tag that includes the firmware device model.
  - Click OK.
  - Select an the star next to a firmware image to indicate the recommended version for the device model. This image will be used in the upgrade/downgrade.

Note
The Firmware version column is only displayed after the firmware has been applied to a set of devices.

Step 5
Upgrade the device firmware:
- Select the Camera Firmware Upgrade tab.
- Select Not in Recommended Firmware to view only the devices that do not have the recommended firmware version (as defined by the star in the Manage tab in Step 4)
- Select the cameras to be upgraded.
- Click Upgrade Firmware.

Tip
You can also downgrade devices by selecting a previous version, if the device supports downgrades.

- Click Recommended Version or Another Version.
  If you select Another Version, or if a Recommended Version was not chosen in Step 4, select the firmware version for the upgrade.
Step 6  Update the driver software to the same version using the Media Server Management Console browser-based utility.

See the Manage Drivers section of the *Cisco Video Surveillance Management Console Administration Guide.*
Replacing a Camera

Replacing a camera allows you to exchange the physical camera hardware while retaining the configurations, associations and historical data of the original device. The replacement camera also uses the original camera name and device unique ID (used in API calls).

After the camera is replaced, only the hardware-specific details are changed, including the device MAC address, IP address, and camera make and model.

**Camera Attributes That Are Retained**

For example replacing a network or analog camera allows you to use new hardware while retaining the following:

- Existing recordings are retained.
- The new camera continues to stream video using the original camera name.
- Alert and audit records are retained.
- The camera association in maps, Views and locations is retained, allowing users to continue to access the camera based on the user’s access permissions and available features.

**Configurations That Must Be Reapplied On the New Camera**

When a network or analog camera is replaced, you must re-configure the contact closure, PTZ preset and motion detection settings (see Step 7). Analog cameras must also reconfigure the serial connection.

**Usage Notes**

- Both network and analog cameras can be replaced (network cameras require the username and password configured on the device).
- Any network (IP) camera can be replaced by any other network (IP) camera, even if the devices are a different make and model (be sure to select the appropriate template for the new camera model). Network (IP) cameras cannot be replaced by an analog camera or encoder (or vice-versa).

**Camera Replacement Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Step 1** | Add the replacement camera to Cisco VSM.  
- The replacement camera can be in *pre-provisioned* or *Enabled* states. |
| **Step 2** | Open the camera configuration page for the existing camera (the camera to be replaced). See the “Accessing the Camera Settings” section on page 7-42. |
| **Step 3** | Select **Device Settings > Replace Camera**. |
| **Step 4** | Enter the settings for the replacement camera |

**Table 7-18 Replace Camera Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera</td>
<td>(Read-only) The name of the existing camera.</td>
</tr>
</tbody>
</table>
Table 7-18  Replace Camera Settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace With</td>
<td>(Required) Select the new (replacement) camera. The replacement camera must be in either pre-provisioned or Enabled state (cameras that are soft-deleted or blacklisted are unavailable). The name, historical data, unique ID and configurations of the existing camera will be transferred to the replacement camera. Only hardware information such as MAC ID, IP address and make and model will be changed in the camera configuration.</td>
</tr>
<tr>
<td>Template</td>
<td>(Required) Select the camera template. The template is populated if defined when the replacement camera was added. You can choose a different template, if necessary. Select a template that is appropriate for the new make and model.</td>
</tr>
<tr>
<td>Username/ Password</td>
<td>(Required for IP Cameras Only) Enter the credentials used to access the replacement camera on the network. These fields are populated if defined when the replacement camera was added. You can modify the username and password, if necessary, but the entries must match the credentials that were configured on the camera. This field is required for IP cameras only. Analog cameras do not require a password since they are connected to an encoder.</td>
</tr>
</tbody>
</table>

**Step 5**  Click Replace.

**Step 6**  Wait for the page to reload.

**Tip**  When the page returns, the new camera will appear with the same name as the old camera, and will include all configurations, recordings, and event histories. Associations with locations, maps, and Views are also the same.

**Step 7**  Re-configure the contact closure, PTZ preset and motion detection settings. See the following topics for more information. Analog cameras must also reconfigure the serial connection.

- Editing the Camera Settings, page 7-42
- Configuring PTZ Presets, page 7-70
- Configuring Motion Detection, page 7-76
- Adding External Encoders and Analog Cameras, page 10-4
Bulk Actions: Revising Multiple Cameras

Bulk Actions allows you to change the configuration or take actions for multiple cameras. For example, you can enable, disable, or delete the devices. You can also change the template, repair the configurations, change the location or change the password used to access the device.

To begin, filter the devices by attributes such as name, tags, model, Media Server, location, status, or issue. You can then apply changes to the resulting devices.

Related Topics
- Bulk Actions: Revising Multiple Encoders, page 10-10
- Bulk Actions: Revising Multiple Media Servers, page 6-25.

Procedure

Step 1  Select Cameras > Cameras.
Step 2  Click Bulk Actions (under the device list) to open the Bulk Actions window (Figure 7-23).

Figure 7-23  Bulk Actions Window
Step 3  Click the icon next to each field to select the filter criteria (Table 7-19).

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search by Name</td>
<td>Enter the full or partial device name. For example, enter “Door” or “Do” to include all device names that include “Door”.</td>
</tr>
<tr>
<td>Search by Tag</td>
<td>Enter the full or partial tag string and press Enter.</td>
</tr>
<tr>
<td>Make/Model</td>
<td>Select the device model(s). For example, “Cisco HD IP Camera 4300E Series”.</td>
</tr>
<tr>
<td>Server</td>
<td>Select the Media Server associated with the devices.</td>
</tr>
<tr>
<td>Install Location</td>
<td>Select the location where the devices are installed.</td>
</tr>
<tr>
<td>Template</td>
<td>Select the templates assigned to the device.</td>
</tr>
<tr>
<td>Overall Status</td>
<td>Select the administrative states for the devices. For example:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Enabled (OK, Warning or Critical)</strong>—The device is enabled, although it may include a <strong>Warning or Critical</strong> event.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Disabled</strong>—The device is disabled and unavailable for use. The configuration can be modified, and any existing recordings can be viewed, but cameras cannot stream or record new video.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Pre-provisioned</strong>—The device is waiting to be added to the network and is not available for use. A pre-provisioned camera can be modified, but the camera cannot stream or record video until you choose <strong>Enable</strong> from the <strong>Device Settings</strong> menu.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Soft Deleted</strong>—The device is removed from Cisco VSM but the recordings associated with that device are still available for viewing (until removed due to grooming policies).</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong> See the “Device Status: Identifying Issues for a Specific Device” section on page 12-6 for more information.</td>
</tr>
<tr>
<td>Issue Type</td>
<td>Select the issues that apply to the device. For example:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Configuration Mismatch</strong>—the camera configuration on the Media Server is different than the camera configuration in the Operations Manager.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong> Always use the Operations Manager to configure cameras. Changes made directly to the camera are unknown to Cisco VSM and can result in incorrect behavior.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Capability Mismatch</strong>—the capabilities on the camera do not match the Cisco VSM configuration.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Identity Collision</strong>—the camera has an IP address or hostname that is the same as another device.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Motion Unconfigured</strong>—motion is not configured on the camera.</td>
</tr>
</tbody>
</table>

Step 4  Click Search.

Step 5  (Optional) Click the icon to view and edit the device status and configuration settings.

Step 6  Select the devices that will be affected by the action.

• Choose the **Select All** check box to select ALL cameras matched by the filters, including the devices not shown in the grid.

• Use CTRL-CLICK and SHIFT-CLICK or to select multiple items.
Step 7  Click an Action button.
  • For example, Enable, Disable, Delete, Change Template, Change Location, etc.

Step 8  Follow the onscreen instructions to enter or select additional input, if necessary.
  • For example, Reapply Template requires that you select the template.

Step 9  Refer to the Jobs page to view the action status.
  • See the “Understanding Jobs and Job Status” section on page 12-23.
Defining Schedules

Schedules are used to define what type of video recording should be used at different times of the day. For example, a school administrator might want continuous recording for all lobby doors during school hours on weekdays, but only motion recording at night and on weekends. In addition, special events (such as an evening concert) or holidays (such as Christmas) might require different recording rules.

Procedure

Complete the following procedure to add or edit schedules.

Tip

To apply a schedule to a camera or template configuration, see the “Adding and Managing Cameras” section on page 7-1.

Step 1

Select System Settings > Schedules.

Step 2

Add or edit a schedule:

- Click Add, or
- Select an existing schedule to edit the settings.

Step 3

(Required) Enter a schedule Name and Location.

The location defines the following:

- The users who can update or delete the schedule. Only users assigned to the same location can access the schedule.
- The users who can use the schedule in cameras and templates configurations. Users assigned to the same location, or a child location, can assign the schedule to a camera or template configuration.

For example, if a schedule is assigned the California location, a user must also have access to the same location (California) to manage the schedule. However, users who have access to child locations (such as San Jose, San Francisco or Milpitas) can use the schedule for camera and template configurations.

Step 4

(Optional) Enter a Description for the schedule.

For example: School campus when in session.

Step 5

Click Create.

Step 6

Click the Recurring Weekly Patterns tab.

Step 7

Define the Time Slots for the schedule (Figure 8-1).

In the camera or template configuration, each time slot can be assigned a different set of recording and alert rules.
a. Click a Time Slot entry field.
b. Enter a descriptive name.
   
   For example: School Hours
c. Edit additional Time Slot fields, if necessary.
   
   For example, a school might require different video surveillance actions during the following:

<table>
<thead>
<tr>
<th>Time Slot</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>School Hours</td>
<td>Hours when school is in session.</td>
</tr>
<tr>
<td>After School</td>
<td>Hours outside of the regular school schedule.</td>
</tr>
<tr>
<td>School Off</td>
<td>Hours when school or other activities are not in session.</td>
</tr>
<tr>
<td>Closed</td>
<td>Hours when the school is closed.</td>
</tr>
</tbody>
</table>

- Changes are saved when entered.
- Define time slots for Special Events and Holidays if your site requires different recording rules during those occasions.
- Time Slots cannot be added or deleted if the schedule is used by a camera template or other Cisco VSM feature. Existing time slots can be renamed, however, and the schedule can be changed. For example, Work Hours could change from 9-5 Monday-Friday to 8-6 Monday-Saturday.
- You can change the schedule used by a camera template at any time.

### Step 8

Define the Active Pattern for each day of the week (Figure 8-2).

Active Patterns are the recurring schedule for each day. Paint the appropriate time slot over the hours that the time slot should be active.

a. Select a time slot paint brush (the selected icon turns solid).
b. Click the day of the week (on the Active Pattern calendar) where the time slot should be used.
   
   A 1-hour block of time is painted with the selected Time Slot color.
c. Drag the right and left edges of the time slot color to the appropriate start and end times.
   
   This process paints over any existing time slot color.
d. Repeat these steps to complete the recurring weekly patterns for each day of the week.
e. Click Save.

### Tip

The shortest time-block that can be created is 15 minutes.
A time slot must be defined for all hours and days.

For example, different recording rules can be applied when a school is in session, during after school activities, or when the school is closed. Each of these different time slots can be assigned different recording and alert properties (in the template configuration screen).

The example in Figure 8-2 defines the following schedule:

- **School Hours** are from 8 a.m. to 3 p.m. Monday through Friday.
- **After School** hours are 3 p.m. to 6 p.m. Monday through Friday.
- **School Off** hours are 6 p.m. to 8 a.m. Monday through Friday.
- The school is **Closed** Saturday and Sunday.

**Step 9** (Optional) Click **Preview in Calendar** to view a monthly calendar of the recurring schedule.

**Step 10** (Optional) Click **Create Upcoming** to define a second schedule that will become active on a specified date (Figure 8-3).

**Tip** When an **Upcoming Pattern** becomes active, the old schedule is deactivated and renamed **Expired Pattern**. Expired patterns cannot be reactivated.

- Each Schedule can define two weekly recurring patterns: the **Active Pattern** and the **Upcoming Pattern**.
- **Active Patterns** are active indefinitely unless an **Upcoming Pattern** is defined.
- To create a new pattern, you must first delete one of the existing patterns. To remove a pattern, select the pattern tab and click **Delete**.
- When the **Upcoming Pattern** takes effect, the following occurs:
  - The **Upcoming Pattern** becomes the **Active Pattern**.
The previous Active Pattern becomes an Expired Pattern. Click the Expired Pattern tab to delete it.

Figure 8-3 Defining an Upcoming Recurring Weekly Pattern

- Click Create Upcoming (Figure 8-2) to create an Upcoming Pattern (Figure 8-3). An Upcoming Pattern tab is added and pre-populated with the calendar from the Active Pattern.
- Click the Effective Date to select the date when the Upcoming Pattern will take effect.
- Define the time slots for each day of the week (as described in Step 8).

Tip The default Upcoming Pattern is a copy of the Active Pattern. Modify the recurring pattern as necessary.

- (Optional) Click Preview in Calendar to verify that the weekly recurring schedule changes on the time and date desired.
- Click Save.

For example, in Figure 8-3, the school hours are extended to 4 p.m. (16:00) on Monday and Friday (beginning on the Effective Date).

Step 11 (Optional) Define Special Dates to override the normal recurring schedule (Figure 8-4).

Special dates can be created for holidays, vacations, or other one-time events that require different recording or Advanced Event settings. For example, a special schedule may be required for a few hours (during an evening event), a single day (such as a Homecoming), or an entire week (such as the Christmas holiday).

For example, in Figure 8-4, the entire week of Christmas is defined as a Holiday. Homecoming and an evening concert, however, require a different time slot for only a few hours of the day. Any time left blank will use the Recurring Schedule definitions.
Figure 8-4     Defining Special Dates

![Figure 8-4 Defining Special Dates](image)

- Click the **Special Dates** tab (Figure 8-4).
- Click **Add**.
- Enter the event **Name**.
- Enter the **Start Date** and **End Date**.
- Add time slots to define the time when the recurring schedule should be overridden (as described in Step 8).

  For example, add the Special Event time slot from 1 to 3 p.m. to override the recurring schedule at that time. Any times left blanks will use the recurring schedule definitions.

  - Click a time slot paint brush icon to highlight it (the selected icon turns solid).
  - Click the time of day when the time slot should be used (Figure 8-4).
  - Click and drag the right and left edges of the time slot color to define the start and end times.
  - This process paints over any existing time slot color.

**Tip**

- Click **Clear Cells** and then click a time of day to delete the time slots defined for that time. Any time left blank will use the recurring schedule definitions.

- Repeat these steps to define the time slot used for each hour of the day.

**Tip**

- Click the trash icon to delete a Special Date entry. Click **Yes** to confirm the change.

- (Optional) Click **Preview in Calendar** to see the special date in a monthly calendar (Figure 8-5).
Step 12  Click **Save**.

Step 13 Use the schedules to define recording schedules, alerts, or advanced events as described in the following topics:

- “Streaming, Recording and Event Settings” section on page 7-49
- “Configuring Video Recording” section on page 9-7
- “Using Advanced Events to Trigger Actions” section on page 9-11
CHAPTER 9

Adding and Editing Camera Templates

Templates simplify camera configuration by defining the image quality, recording schedule and other attributes used by a set of cameras.

Contents

- Overview, page 9-2
- Creating or Modifying a Template, page 9-3
- Creating a Custom Template for a Single Camera, page 9-5
- Configuring Video Recording, page 9-7
- Using Advanced Events to Trigger Actions, page 9-11
  - Configuration Overview, page 9-12
  - Trigger and Action Descriptions, page 9-13
  - Configuration Summary, page 9-12
  - Configuring Soft Triggers, page 9-15
- Configuring Multicast Video Streaming, page 9-18

Note

See also the “Enabling Record Now” section on page 3-11.
Overview

Templates simplify camera configuration by defining the image quality, recording schedule and other attributes used by a set of cameras. Any template changes are applied to all cameras associated with that template, allowing you to easily configure and modify groups of cameras that serve a similar purpose. You can also create Custom Templates that apply to a single camera.

- **Model Specific** templates are used for a specific make and model of camera.
- **Generic** templates can be applied to a mixture of camera models.
- **Custom Templates** apply to a single camera.

Figure 9-1 shows a sample template configuration page. The number of cameras associated with a template is shown next to the template name.

- System defined templates are locked and cannot be modified. Click **Save As** to create a new template under a different name.
- User-defined templates are displayed in bold and can be revised. See the “Creating or Modifying a Template” section on page 9-3.

**Figure 9-1 Camera Templates**
Creating or Modifying a Template

Procedure
To create or modify a template, complete the following procedure.

Step 1
Log on to the Operations Manager.
- See the “Logging In” section on page 1-17.
- You must belong to a User Group with permissions for Templates. See the Adding Users, User Groups, and Permissions, page 4-1 for more information.

Step 2
Select Cameras > Templates (Figure 9-2).

Figure 9-2

Templates

Step 3
Edit or add a template:
- Click Add to create a new template.
- To edit a template, select a location and template name.

Note
System defined templates are locked and cannot be modified.

Step 4
Enter or revise the General settings:
- Template Name—(Required) Enter a descriptive name for the template.
- Description—(Optional) Enter the purpose of the template, or other description.
- Associated Location—(Required) Select the location for the template. This can be used to restrict access to a template to a specific location. For example, to administrators located on Campus 1.
Creating or Modifying a Template

- Template Type—(Required for new templates) Select Generic or Model Specific. Model specific templates are available for use only by the specific camera model. Generic templates can be assigned to any camera model.
- Model name—(Model specific templates only) select a camera model from the pop-up window.

**Step 5** Click the **Streaming, Recording and Events** tab to define the streaming, recording and other properties.
- For example, define the quality of video from stream A and B, the recording schedule, and advanced events and storage options.
- See the following topics for more information.
  - Configuring Video Recording, page 9-7
  - Streaming, Recording and Event Settings, page 7-49

**Step 6** Click Create, Save or Save As.

**Step 7** Wait for the Job to complete.
- If you are modifying an existing template, the changes are applied to each camera associated with the template. A Job Step is created for each camera impacted by the template change.
- If a large number of cameras are affected, the Job can take a significant amount of time to complete.
- See the “Understanding Jobs and Job Status” section on page 12-23 for more information.
- Device configuration changes can fail is a camera firmware upgrade is in process. Make sure that a camera firmware is not being upgraded (or wait until it is complete) and try again.
Creating a Custom Template for a Single Camera

Although templates are usually applied to multiple cameras, you can also create a custom configuration for a specific camera using the Custom template option (Figure 9-3).

Procedure

Step 1
Select a camera name.
- See the “Editing the Camera Settings” section on page 7-42. For example, click the Cameras By Location tab, select a location and camera name.
- You must belong to a User Group with permissions for Cameras. See the Adding Users, User Groups, and Permissions, page 4-1 for more information.

Step 2
Click the Streaming, Recording and Event tab.

Step 3
Click Set Template.

Step 4
Select the Custom box and click OK (Figure 9-3).

Step 5
Revise the camera settings as described in the “Editing the Camera Settings” section on page 7-42 and the “Configuring Video Recording” section on page 9-7.
Creating a Custom Template for a Single Camera

Step 6  Click Save.
Configuring Video Recording

Video recording schedules and features are usually configured to occur automatically in a continuous loop or according to a schedule. Recordings can also be triggered when certain events (such as motion events) occur.

See the following topics for more information:

<table>
<thead>
<tr>
<th>Table 9-1 Configuring Video Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Topic</strong></td>
</tr>
<tr>
<td>Configuring Continuous, Scheduled, and Motion Recordings, page 9-7</td>
</tr>
<tr>
<td>Using Advanced Events to Trigger Actions, page 9-11</td>
</tr>
<tr>
<td>Enabling Record Now, page 3-11</td>
</tr>
</tbody>
</table>

Configuring Continuous, Scheduled, and Motion Recordings

Scheduled recordings allow you to define recording properties for different times of the day, days of the week, or for special events.

For example, a school might require that cameras associated with a template record video differently during School hours, After school hours, School off hours, and Closed hours. Additional exceptions to the regular recording schedule might be required for special events, such as a Homecoming event or the Christmas holiday.

The following procedure describes how to apply schedules to a camera template or custom configuration.

Procedure

1. **Step 1** Create the recording schedule.
   See the “Defining Schedules” section on page 8-1 for instructions.

2. **Step 2** Edit or add a camera template:
   a. Click Cameras.
   b. Select Templates.
   c. Add or edit a template:
      - Click Add to create a new template.
      - To edit a template, select a location and then click a template name.
Tip
You can also create a custom template for an individual camera. See the “Creating a Custom Template for a Single Camera” section on page 9-5

Step 3  Click the **Streaming, Recording and Events** tab (Figure 9-4).

**Figure 9-4  Recording Schedule**

Step 4  Select a recording schedule (Figure 9-4).

- **Basic Recording: 24x7**—Records 24 hours a day, every day, based on the *continuous* and *event* recording properties.

  or

- Select a previously-defined schedule.

  A row of icons appears for each *Time Slot* in the schedule.
Recording schedules appear only if schedules are configured. See the “Defining Schedules” section on page 8-1 for instructions.

Recording schedules allow you to define recording properties for different times of the day, days of the week, or for special events. For example, a school might require different video surveillance actions during School hours, After school hours, School off hours, and Closed hours. Additional exceptions to the regular schedule might be required for special events, such as a Homecoming event or the Christmas holiday. A recording entry appears for each time slot included in the schedule.

Step 5
Click the recording icons for each Time Slot.

The options are:

- **No Recording**—Disable recording for the stream.
- **Record on Motion**—Record motion events. Motion recording is available only if the camera supports motion detection. See the “Configuring Motion Detection” section on page 7-76 for instructions to define the areas of the image that trigger motion events.
- **Continuous Recording**—Record video in a loop.
- **Record on Motion and Continuous Recording**—Record continuously and mark any motion events. This option is available only if motion detection is supported by the camera.

Tip
The icons turn dark when selected.

Step 6
Define how long the recordings are retained:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retain continuous recordings</td>
<td>Enter the amount of time recorded video should be retained (saved) on the system.</td>
</tr>
<tr>
<td>Retain event recordings</td>
<td>Enter the amount of time a motion event should be retained (saved) on the system.</td>
</tr>
<tr>
<td>Padding</td>
<td>Enter the number of seconds of recording that should be included before and after the event occurs.</td>
</tr>
</tbody>
</table>

Step 7
Click the Alert Notifications icon 📣 to enable or disable the alerts that are generated when a motion event occurs (stop or start).

Tip
Use the Cisco Video Surveillance Safety and Security Desktop (Cisco SASD) application to view alerts, comment and close alerts. See the Cisco Video Surveillance Safety and Security Desktop User Guide for more information.

Tip
Use the Advanced Events feature to trigger alerts only when motion stops, or when motion starts. You can also trigger other actions, such as recordings or moving the camera to a PTZ preset position. See the “Using Advanced Events to Trigger Actions” section on page 9-11.
Step 8 Configure the optional recording options:

**Table 9-2 Optional Recording Options**

<table>
<thead>
<tr>
<th>Recording Option</th>
<th>Description</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Events</td>
<td>Define events that can trigger video recording for a specified amount of time. For example, recording can be triggered when an analytic event occurs, when a contact is closed or opened, or when a soft trigger occurs.</td>
<td>Using Advanced Events to Trigger Actions, page 9-11</td>
</tr>
<tr>
<td>Advanced Storage</td>
<td>Define the high-availability and failover server options for streams, the long term storage (LTS) server options, and other recording options. For example, recordings can be simultaneously recorded on a redundant server, or saved to a long term storage (LTS) server.</td>
<td>Configuring the Camera Template HA Options, page 11-11.</td>
</tr>
<tr>
<td>Record Audio</td>
<td>Define if audio should be recorded.</td>
<td>Streaming, Recording and Event Settings, page 7-49</td>
</tr>
<tr>
<td>Verify Recording Space</td>
<td>Select Enable to verify that enough storage space is available on the Media Server to complete the entire recording.</td>
<td>Streaming, Recording and Event Settings, page 7-49</td>
</tr>
</tbody>
</table>
| Record Now             | The Record Now feature allows operators to trigger recordings that are retained according to the Retain event recordings setting. | • Enabling Record Now, page 3-11  
                          |                                                              | • Using Record Now, page 2-22                                      |

**Step 9** Click Create, Save or Save As.

**Step 10** Wait for the Job to complete.

- If you are modifying an existing template, the changes are applied to each camera associated with the template. A Job Step is created for each camera impacted by the template change.
- If a large number of cameras are affected, the Job can take a significant amount of time to complete.
- Click View Status in the Jobs window to view additional details for the Job Steps.
- See the “Understanding Jobs and Job Status” section on page 12-23 for more information.
Using Advanced Events to Trigger Actions

Use Advanced Events to trigger an immediate one-time action when a specified event occurs. For example, when motion starts or a contact is closed, the system can trigger an alert, aim the camera to a PTZ preset position, or trigger an action on an external system.

Tip

Multiple actions can be triggered for the same event.

Configure advanced events for camera templates to apply the rules to multiple cameras, or for a custom template to apply the trigger to a single camera.

This section includes the following topics:

- Configuration Overview, page 9-12
- Configuration Summary, page 9-12
- Trigger and Action Descriptions, page 9-13
- Configuring Soft Triggers, page 9-15

Note

- Advanced events are different from device health events. See the “Device Status: Identifying Issues for a Specific Device” section on page 12-6 for more information.
- Some cameras do not support sending motion or contact-closure events to a redundant server. See the “Configuring the Redundant and Failover Options” section on page 11-11 for more information.
Configuration Overview

Figure 9-5 describes the main elements of the Advanced Events configuration screen.

Figure 9-5 Configuring Advanced Events

1. The trigger and resulting action configured on the camera or template.
   Tip To define multiple actions for a single trigger, add the trigger multiple times but define a different action. See the Configuration Summary, page 9-12 for more information.

2. The event that triggers an action.
   See Trigger and Action Descriptions, page 9-13 for more information.

3. The options for the selected trigger.

4. The one-time action that occurs when an event is triggered.
   See Trigger and Action Descriptions, page 9-13 for more information.

5. The options for the selected action.

Configuration Summary

Procedure
To configure Advanced Events for a template or camera, do the following:

Step 1 Log on to the Operations Manager.
   • See the “Logging In” section on page 1-17.
You must belong to a User Group with permissions for Templates or Cameras. See the Adding Users, User Groups, and Permissions, page 4-1 for more information.

**Step 2** Select a template or camera.

**Step 3** Click the Streaming, Recording and Events tab.

**Step 4** Click Advanced Events.

**Step 5** Click Add.

**Step 6** Select a Trigger and then select the additional options as described in the “Trigger and Action Descriptions” section on page 9-13.

**Step 7** Select a Timeslot when the event should trigger an action.

See the “Defining Schedules” section on page 8-1 to create timeslots.

**Step 8** Select a Resulting Action for the event, as described in the “Trigger and Action Descriptions” section on page 9-13.

**Step 9** Click Add to add additional entries.

To trigger multiple actions for an event, add an entry for the same trigger or state, and then select a different action.

**Step 10** Click OK to save the changes.

---

**Trigger and Action Descriptions**

**Triggers**—Table 9-3 describes the events that immediately trigger a one-time action.

**Actions**—Table 9-4 describes the resulting actions.

<table>
<thead>
<tr>
<th>Event (Trigger)</th>
<th>Event Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analytic</td>
<td>Analytic policies (such as trip wire or counting) must be configured on the camera using the camera UI. Analytics are supported for Cisco cameras only. See the camera documentation for more information. When the analytic event occurs, the associated action is triggered.</td>
</tr>
<tr>
<td></td>
<td>• Timeslot—the time span when the event should trigger an action. See the “Defining Schedules” section on page 8-1.</td>
</tr>
<tr>
<td>Contact Closed or Opened</td>
<td>An electrical contact (such as a door sensor) that is monitored by a camera can trigger an action when the contact is opened or closed.</td>
</tr>
<tr>
<td></td>
<td>• Timeslot—the time span when the event should trigger an action. See the “Defining Schedules” section on page 8-1.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> See the camera and contact device documentation for instructions to connect and configure the contact.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong> See the Contact Closure settings described in the “General Settings” section on page 7-45 for instructions to select a camera contact closure port.</td>
</tr>
</tbody>
</table>
### Table 9-3 Advanced Event Triggers (continued)

<table>
<thead>
<tr>
<th>Event (Trigger)</th>
<th>Event Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motion Started or Stopped</td>
<td>Motion events are triggered when motion occurs within a camera’s include areas (according to the motion sensitivity settings). See the “Configuring Motion Detection” section on page 7-76 for more information.</td>
</tr>
<tr>
<td></td>
<td>• Timeslot—the time span when the event should trigger an action. See the “Defining Schedules” section on page 8-1.</td>
</tr>
<tr>
<td>Soft Trigger</td>
<td>Soft Triggers are used by external systems to trigger an action on a Cisco VSM camera.</td>
</tr>
<tr>
<td></td>
<td>For example, when a door is opened, an external access control system can post a URL that causes a Cisco VSM camera to aim the camera (using a PTZ preset).</td>
</tr>
<tr>
<td></td>
<td>See the “Configuring Soft Triggers” section on page 9-15 for more information.</td>
</tr>
<tr>
<td></td>
<td>• Name—the name of the Soft Trigger. A URL with this name will be created for each camera associated with the template.</td>
</tr>
<tr>
<td></td>
<td>• Timeslot—the time span when the event should trigger an action. See the “Defining Schedules” section on page 8-1.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> System integrators can add custom fields to alerts generated by a soft trigger event. See the <em>Cisco Video Surveillance API Programming Guide</em> available on the Cisco Developers Network (CDN) for more information.</td>
</tr>
</tbody>
</table>

### Table 9-4 Resulting Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert</td>
<td>Generates an alert. Select the alert <em>Severity</em> and enter a <em>Message</em>. For example, if a contact is opened, an alert is triggered.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong> This option is not available for motion events. To trigger an alert for motion events, click the Alert Notifications icon in the Recording Options section of the camera or template configuration.</td>
</tr>
<tr>
<td></td>
<td>See the “Streaming, Recording and Event Settings” section on page 7-49.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> System integrators can add custom fields to alerts generated by a soft trigger event. See the <em>Cisco Video Surveillance API Programming Guide</em> available on the Cisco Developers Network (CDN) for more information.</td>
</tr>
<tr>
<td>Aim Camera</td>
<td>Select the pan, tilt and zoom (PTZ) preset that is triggered when the event occurs.</td>
</tr>
<tr>
<td></td>
<td>• PTZ Preset Number—Enter the PTZ preset number. All cameras associated with the template will use this number, so the PTZ preset numbers for all cameras should be coordinated. For example, use PTZ preset #5 to zoom all Lobby Doors cameras to the door. See the “Configuring PTZ Presets” section on page 7-70.</td>
</tr>
<tr>
<td></td>
<td>• You can also view PTZ preset numbers by right clicking the camera video image. See the “Using Pan, Tilt, and Zoom (PTZ) Controls” section on page 2-29.</td>
</tr>
<tr>
<td></td>
<td>• <em>Aim Camera</em> actions are assigned a access priority of 50. This setting cannot be changed. See the “Defining the User Group PTZ Priority” section on page 7-68 for more information.</td>
</tr>
<tr>
<td></td>
<td>• The camera remains at the PTZ preset unless a PTZ tour is enabled or a user accesses the PTZ controls.</td>
</tr>
<tr>
<td>Invoke URL</td>
<td>Enter a valid Get or Post URL to trigger action on an external system. For example, if motion occurs at a certain time, a URL can be invoked to lock a door on an external access control system.</td>
</tr>
</tbody>
</table>
Table 9-4  Resulting Actions (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record for Some Time</td>
<td>The number of minutes that video should be recorded when the event occurs.</td>
</tr>
<tr>
<td></td>
<td>• Stop After (Min.)—The number of minutes to record.</td>
</tr>
<tr>
<td></td>
<td>• Stream Number</td>
</tr>
<tr>
<td></td>
<td>• Select 1 for the primary stream.</td>
</tr>
<tr>
<td></td>
<td>• Select 2 for the secondary stream.</td>
</tr>
<tr>
<td>Push to Video Wall</td>
<td>Displays live or recorded video (from the camera that triggered the event)</td>
</tr>
<tr>
<td></td>
<td>on all instances of a Video Wall.</td>
</tr>
<tr>
<td></td>
<td>For example, if the lobby receptionists are all viewing the same Video Wall</td>
</tr>
<tr>
<td></td>
<td>Lobby, then the video would be replaced by video according to the following</td>
</tr>
<tr>
<td></td>
<td>settings:</td>
</tr>
<tr>
<td></td>
<td>• Video Wall—The Video Wall where the video will be displayed. See the</td>
</tr>
<tr>
<td></td>
<td>“Configuring Video Walls” section on page 3-9 for more information.</td>
</tr>
<tr>
<td></td>
<td>• Live—Displays live video from the camera that triggered the event.</td>
</tr>
<tr>
<td></td>
<td>• Recorded—Displays recorded video of the event.</td>
</tr>
<tr>
<td></td>
<td>• Pre-Event—(recorded video only) the amount of seconds to include</td>
</tr>
<tr>
<td></td>
<td>before the event began</td>
</tr>
<tr>
<td></td>
<td>• Loop/Post-Event—(recorded video only) plays recorded video of the</td>
</tr>
<tr>
<td></td>
<td>event in a loop. Enter the number of seconds of recorded video that should</td>
</tr>
<tr>
<td></td>
<td>play after the event occurred.</td>
</tr>
<tr>
<td>Note</td>
<td>The Video Wall will rollback to default view when the rollback time</td>
</tr>
<tr>
<td></td>
<td>elapses. If a default view and rollback time are not configured, then the</td>
</tr>
<tr>
<td></td>
<td>event video pushed to the Video Wall will be displayed indefinitely.</td>
</tr>
<tr>
<td>Note</td>
<td>Select both Live and Recorded to display a 2-pane (1x2) Video Wall with</td>
</tr>
<tr>
<td></td>
<td>both live and recorded video.</td>
</tr>
<tr>
<td>Tip</td>
<td>See the Cisco Video Surveillance Safety and Security Desktop User Guide</td>
</tr>
<tr>
<td></td>
<td>for more information on viewing Video Walls, and changing the Video Wall</td>
</tr>
<tr>
<td></td>
<td>view.</td>
</tr>
</tbody>
</table>

Configuring Soft Triggers

Soft Triggers are used by external systems to trigger an action on a Cisco VSM camera.
For example, when a door is opened, an external access control system can post a URL that causes a
Cisco VSM camera to aim the camera (using a PTZ preset).

Summary Steps

1. Create a Soft Trigger entry for a template (in Advanced Events).
   For example, create a Soft Trigger entry “Door Open” with the resulting action “Aim Camera”.
   A unique URL with the same name is created for each camera associated with that template.

2. Copy the URL for the Soft Trigger entry from the camera’s configuration page.

3. (Optional) Configure an external system to add additional informational fields to soft trigger alerts.
   See the Cisco Video Surveillance API Programming Guide available on the Cisco Developers
   Network (CDN) for more information.

4. Add the URL to the external system’s configuration.

5. Whenever the URL is posted by the external system, the Cisco VSM camera will perform the action.
Detailed Procedure

Step 1 Create the Soft Trigger for a template:
   a. Log on to the Operations Manager.
   b. Select a template.
   c. Click the Streaming, Recording and Events tab.
   d. Click Advanced Events.
   e. Click Add.
   f. Select Soft Trigger and enter a name for the trigger.
   g. Select the Timeslot when the soft trigger will be enabled.
   h. Select a Resulting Action for the event, as described in the “Trigger and Action Descriptions” section on page 9-13.
   i. Click Add.

   Tip To trigger multiple actions, add an additional soft trigger entry.

   j. Click Save to save the settings and close the Advanced Events window.
   k. Click Save again to save the template changes.

Step 2 Copy the camera URL for use on the external system:

Figure 9-6 Copying Soft Trigger URLs from the Camera Configuration Page

   a. Select Cameras and select the camera that is to be triggered by the external system.
   b. Click the Streaming, Recording and Events tab.
- The Soft Trigger URLs are displayed in the Camera Events table (Figure 9-6).
- An entry appears for each Soft Trigger configured in Step 1.

c. Click a URL to copy the Soft Trigger entry to the clipboard.

**Step 3** (Optional) Configure an external system to add additional alert fields, see the *Cisco Video Surveillance API Programming Guide* for more information.

**Step 4** Configure the external system use the URL to trigger the camera action.

**Tip**
- Soft Trigger alerts can be viewed and managed using a monitoring application such as the Cisco Video Surveillance Safety and Security Desktop (Cisco SASD) application. See the *Cisco Video Surveillance Safety and Security Desktop User Guide* for more information.
- System integrators can add custom fields to alerts generated by a soft trigger event. See the *Cisco Video Surveillance API Programming Guide* available on the Cisco Developers Network (CDN) for more information.
Configuring Multicast Video Streaming

Multicast allows cameras to send the same video stream to multiple destinations using a single transmission. A multicast transmission uses less network bandwidth than a unicast transmission to multiple destinations.

To configure multicast streams, you must configure your network for multicast streaming, create custom stream settings for the camera template, and specify the multicast IP address in each camera that supports multicast.

**Usage Notes**
- Cisco Video Surveillance uses a port value of 16000 to listen to the primary video stream from cameras. For secondary stream for certain cameras, other ports are used.
- Audio is unicast even if multicast video is enabled.
- Multicast is performed between the supported encoding device and the Media Servers that are listening. The Media Server does not multicast video to clients.

**Procedure**

**Step 1** Configure your network to support multicast or ask your systems administrator for the multicast IP address(es) used by the cameras.

**Step 2** Configure the template to support multicast streams.

a. Select Cameras > Templates.

b. Select a location and template name.

c. Select the Streaming, Recording and Events tab.

d. Click the Custom option for either Video Stream A or Video Stream B.

e. Select UDP_Multicast from the Transport field.

f. Complete the remaining custom stream settings.

g. Click Save.

**Tip**
To configure a single camera for multicast, you can also create a custom template for that camera and enter the same settings. See the “Creating a Custom Template for a Single Camera” section on page 9-5.

**Step 3** Enter the Multicast IP address in the camera configuration page.

a. Select Cameras.

b. Select a location and camera name.

c. From the General tab, enter the Multicast IP Address for the Primary and Secondary video streams.

   - See your systems administrator for the correct multicast address.

   - Primary and Secondary Multicast IP Address fields are enabled only if the corresponding template Stream A and Stream B Custom settings are configured for multicast.

d. Click Save.
Adding Encoders and Analog Cameras

Encoders provide network connectivity for analog cameras, and digitize the analog video so it can be saved and transmitted by the Cisco VSM system. Refer to the following topics to add and configure encoders and analog cameras:

Contents

- Overview, page 10-2
- Requirements, page 10-3
- Adding External Encoders and Analog Cameras, page 10-4
- Bulk Actions: Revising Multiple Encoders, page 10-10

Tip

See also the “Upgrading Camera and Encoder Driver Firmware” section on page 7-82.

Note

Encoders are not required for IP (networked) cameras.
Overview

Cisco VSM 7 supports external encoders that are added to the same network as the server, and configured with an IP address, username and password. Analog cameras are then attached to the encoder with a video cable, and multiple cameras can be connected to a single encoder (Figure 10-1). In addition, serial port connections can be used between the camera and encoder to provide PTZ and other control features.

Tip

See the encoder documentation for more information on the number of supported video ports, physical connections, supported features and configuration.

Figure 10-1 shows an external encoder configuration.
## Requirements

Analog cameras attached to an encoder require the following:

### Table 10-1  Analog Camera Requirements

<table>
<thead>
<tr>
<th>Requirements</th>
<th>Requirement Complete?</th>
</tr>
</thead>
<tbody>
<tr>
<td>The wiring between the cameras and the encoder must adhere to the protocol requirements, including:</td>
<td>![Complete]</td>
</tr>
<tr>
<td>- The correct number of wires.</td>
<td>![Complete]</td>
</tr>
<tr>
<td>- The correct polarity.</td>
<td>![Complete]</td>
</tr>
<tr>
<td>- The cable length does not exceed the maximum allowable length.</td>
<td>![Complete]</td>
</tr>
<tr>
<td>- The maximum number of devices in a daisy chain is not exceeded.</td>
<td>![Complete]</td>
</tr>
<tr>
<td>See the device documentation for more information.</td>
<td>![Complete]</td>
</tr>
<tr>
<td>The encoder serial ports must be correctly configured:</td>
<td>![Complete]</td>
</tr>
<tr>
<td>- All devices on the serial line must be configured with the same settings, baud rate, data/stop bits, parity, etc.</td>
<td>![Complete]</td>
</tr>
<tr>
<td>- All devices must support the same protocol.</td>
<td>![Complete]</td>
</tr>
<tr>
<td>- All cameras must support the same protocol as the encoder serial port.</td>
<td>![Complete]</td>
</tr>
<tr>
<td>See the device documentation for more information.</td>
<td>![Complete]</td>
</tr>
<tr>
<td>The camera serial port must be correctly configured:</td>
<td>![Complete]</td>
</tr>
<tr>
<td>- All cameras must be properly terminated.</td>
<td>![Complete]</td>
</tr>
<tr>
<td>- All cameras must have unique serial addresses.</td>
<td>![Complete]</td>
</tr>
<tr>
<td>See the device documentation for more information.</td>
<td>![Complete]</td>
</tr>
</tbody>
</table>

To add and configure encoders and analog cameras in Cisco VSM, you must belong to a User Group with permissions for Media Servers & Encoders. See the Adding Users, User Groups, and Permissions, page 4-1 for more information.
Adding External Encoders and Analog Cameras

To add external encoders to the Cisco VSM configuration, complete the following procedure.

**Pre-Provisioning Encoders**

Encoders can be added to the system before they are available on the network. If you add an encoder that cannot be reached, a message will appear asking if you want to pre-provision the device. If yes, then the device is added in *Enabled:Critical* state. You can modify the settings, but the encoder will not be available for video processing.

Once the device is available on the network, you must enable the device by selecting **Repair Config** from the **Device Settings** menu (in the device configuration page). The device status will change to *Enabled:OK* unless other issues are present.

**Procedure**

**Step 1** Install and configure the encoder so it can be accessed on the network:

a. Physically install the encoder so it can access the same network as Cisco VSM.

b. Configure the network settings on the device.

c. Ping the device to verify it can be accessed on the network.

**Tip** Refer to the encoder documentation for instructions.

**Step 2** Log on to the Operations Manager.

- See the “Logging In” section on page 1-17.
- You must belong to a User Group with permissions for **Media Servers & Encoders**. See the Adding Users, User Groups, and Permissions, page 4-1 for more information.

**Step 3** Click the **Cameras** tab.

**Step 4** Click the **Encoders** icon.

**Step 5** Click **Add**.
Step 6  Enter the basic encoder connectivity settings (Table 10-2).

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name for the encoder.</td>
</tr>
<tr>
<td></td>
<td>Enter a name that helps identify the device location or primary use. Use any</td>
</tr>
<tr>
<td></td>
<td>combination of characters and spaces.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Enter the IP address configured on the device.</td>
</tr>
<tr>
<td></td>
<td>• See the encoder documentation for instructions to configure the device</td>
</tr>
<tr>
<td></td>
<td>settings.</td>
</tr>
<tr>
<td></td>
<td>• See the “Changing the Camera or Encoder Network Settings and/or Credentials” section on page 7-61 for more information.</td>
</tr>
<tr>
<td></td>
<td>• All edge devices (such as cameras and encoders) must added to a server</td>
</tr>
<tr>
<td></td>
<td>using a local (non-NAT) addresses.</td>
</tr>
<tr>
<td></td>
<td>• Internal encoders are automatically configured and do not need to be</td>
</tr>
<tr>
<td></td>
<td>added to the system.</td>
</tr>
<tr>
<td>Install Location</td>
<td>(Required) Select a location where the device is physically installed.</td>
</tr>
<tr>
<td></td>
<td>• See the “Understanding a Camera’s Installed Location Vs. the Pointed Location” section on page 5-9 for more information.</td>
</tr>
<tr>
<td>Model</td>
<td>The encoder make and model.</td>
</tr>
<tr>
<td>Media Server</td>
<td>The Media Server where the encoder is physically installed.</td>
</tr>
<tr>
<td>Username/Password</td>
<td>The credentials used to access the device over the network.</td>
</tr>
<tr>
<td></td>
<td>• See the encoder documentation for instructions to configure the device</td>
</tr>
<tr>
<td></td>
<td>network settings.</td>
</tr>
<tr>
<td></td>
<td>• See the “Changing the Camera or Encoder Network Settings and/or Credentials” section on page 7-61 for more information.</td>
</tr>
</tbody>
</table>

Step 7  Click **Add**.

- If the validation is successful, continue to Step 8.
- If the encoder cannot be found on the network, an error message appears asking if you want to pre-provision the server.
  - Click **Yes** to pre-provision the encoder. The encoder is added to Cisco VSM but is not available for video processing. The encoder is automatically enabled when it comes online. See the “Pre-Provisioning Encoders” section on page 10-4.
  - Click **No** to cancel the operation. Verify the encoder hostname and login credentials and return to Step 5 to try again.
  - Once the device is available on the network, you must enable the device by selecting **Repair Config** from the **Device Settings** menu (in the device configuration page). The device status will change to **Enabled:OK** unless other issues are present.
Step 8  (Optional) Add the analog camera(s) attached to the encoder (Figure 10-2).

Tip You can also add analog cameras from the camera configuration page. See the “Manually Adding Cameras” section on page 7-8 for more information.

Figure 10-2  Adding Analog Cameras to an Encoder

a. Click the Connections tab.
b. Click the Add icon.
c. Enter the analog camera settings (Table 10-3).

Table 10-3  Analog Camera Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encoder</td>
<td>(Read-Only) The encoder that is physically attached to the camera.</td>
</tr>
<tr>
<td>Video Port</td>
<td>The physical encoder video port where the camera video cable is attached.</td>
</tr>
<tr>
<td></td>
<td>Tip Only the unused ports are displayed.</td>
</tr>
</tbody>
</table>
Step 9  Click Add.

If the camera is pre-provisioned, complete the configuration. Once the device is available on the network you can select Enable from the Device Settings menu in the camera configuration page.

Step 10  (Optional) Click Change (in the Serial Ports section) to revise the encoder serial port settings, if necessary.

For example, protocol, baud rate, data bits, stop bit and parity.

- The serial port connection is used for control features such as PTZ movements and contact closure events. Both the camera and encoder must support serial ports.
- See the encoder documentation for instructions to connect multiple analog camera serial connections and define the serial port addresses for those cameras.
- See the “Requirements” section on page 10-3 for information on the serial port setting requirements between encoders and attached cameras.

---

**Table 10-3  Analog Camera Settings (continued)**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Audio Port | (Optional) The physical encoder audio port where the camera audio cable is attached.  
*Tip* Only the unused ports are displayed. |
| Name | The camera name that will appear in Cisco VSM. |
| Install Location | The physical location of the camera. |
| Model | The camera model. |
| Template | The template that defines the camera settings.  
- You must choose an existing template when the camera is added to Cisco VSM. After the camera is created, you can create a custom configuration or select a different template. See the “Accessing the Camera Settings” section on page 7-42.  
- Templates define attributes such as video quality and schedules. Only templates that support the camera are displayed. See the “Adding and Editing Camera Templates” section on page 9-1 for more information. |
Step 11  (Optional) Click the Connections button (in the Serial Ports section) to define the analog camera serial port connections (Figure 10-3).

The following settings are used when a serial cable is attached from an analog camera to an encoder. The serial port connection enables the pan-zoom-tilt (PTZ) controls and/or photographic controls (brightness, contrast, etc.) on an analog camera. See the “General Settings” section on page 7-45 for more information.

Figure 10-3  Serial Port Connections

- Expand the location tree and select the camera’s Install Location (see Table 10-3).
- Select a camera name from the list.
- Click the add icon.
- Enter the serial port connection settings (Table 10-4) and click Add.

Table 10-4  Analog Camera Serial Port Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encoder</td>
<td>The encoder for the analog camera.</td>
</tr>
</tbody>
</table>
### Table 10-4  Analog Camera Serial Port Settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial Port</td>
<td>The encoder serial port where the first analog camera is attached to the encoder.</td>
</tr>
<tr>
<td></td>
<td>See the encoder documentation for information to determine the port number.</td>
</tr>
<tr>
<td>Serial Port Address</td>
<td>The unique ID of the serial device (analog camera).</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Every device on a serial bus must have a unique ID (also called a “Serial Port Address”).</td>
</tr>
<tr>
<td></td>
<td>This unique ID/address is configured on most analog cameras using physical switches.</td>
</tr>
<tr>
<td></td>
<td>See the camera documentation for more information.</td>
</tr>
</tbody>
</table>

**Step 12**  Click **Save**.

**Step 13**  Verify that the camera appears under Attached Devices.

**Step 14**  Click **Close**.

**Step 15**  Click **Save** to save the encoder settings.

**Step 16**  (Optional) Enter additional camera configurations, if necessary.

See the “Editing the Camera Settings” section on page 7-42.

**Step 17**  (Optional) If the camera was Pre-Provisioned, complete the configuration and select **Enable** from the **Device Settings** menu.

**Note**  The **Enable** option is only enabled if the camera configuration is complete and the device is available on the network.
Bulk Actions: Revising Multiple Encoders

Bulk Actions allows you to change the configuration or take actions for multiple encoders. For example, you can delete the devices, repair the configurations, change the location or change the password used to access the device.

To begin, filter the devices by attributes such as name, tags, model, Media Server, location, status, or issue. You can then apply changes to the resulting devices.

Related Topics
- Bulk Actions: Revising Multiple Cameras, page 7-87
- Bulk Actions: Revising Multiple Media Servers, page 6-25.

Procedure

Step 1 Select Cameras > Encoders.
Step 2 Click Bulk Actions (under the device list) to open the Bulk Actions window (Figure 10-4).

Figure 10-4 Bulk Actions Window
Step 3  Click the ✪ icon next to each field to select the filter criteria (Table 10-5).

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search by Name</td>
<td>Enter the full or partial device name. For example, enter “Door” or “Do” to include all device names that include “Door”.</td>
</tr>
<tr>
<td>Search by Tag</td>
<td>Enter the full or partial tag string and press Enter.</td>
</tr>
<tr>
<td>Make/Model</td>
<td>Select the device model(s). For example, “Cisco HD IP Camera 4300E Series”.</td>
</tr>
<tr>
<td>Server</td>
<td>Select the Media Server associated with the devices.</td>
</tr>
<tr>
<td>Install Location</td>
<td>Select the location where the devices are installed.</td>
</tr>
<tr>
<td>Overall Status</td>
<td>Select the administrative states for the devices. For example:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Enabled (OK, Warning or Critical)</strong>—The device is enabled, although it may include a Warning or Critical event.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Disabled</strong>—The device is disabled and unavailable for use. The configuration can be modified, and any existing recordings can be viewed, but cameras cannot stream or record new video.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Pre-provisioned</strong>—The device is waiting to be added to the network and is not available for use. A pre-provisioned camera can be modified, but the camera cannot stream or record video until you choose Enable from the Device Settings menu.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Soft Deleted</strong>—The device is removed from Cisco VSM but the recordings associated with that device are still available for viewing (until removed due to grooming policies).</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong> See the “Device Status: Identifying Issues for a Specific Device” section on page 12-6 for more information.</td>
</tr>
<tr>
<td>Issue Type</td>
<td>Select the issues that apply to the device. For example:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Configuration Mismatch</strong>—the configuration on the Media Server is different than the configuration in the Operations Manager.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Capability Mismatch</strong>—the capabilities on the device do not match the Cisco VSM configuration.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Identity Collision</strong>—the camera has an IP address or hostname that is the same as another device.</td>
</tr>
<tr>
<td>Encoders Filters</td>
<td>Click the ✪ icon to select one or more encoders and limit the search to that encoder and associated cameras.</td>
</tr>
</tbody>
</table>

Step 4  Click Search.

Step 5  (Optional) Click the ✈ icon to view and edit the device status and configuration settings.

Step 6  Select the devices that will be affected by the action.

• Choose the Select All check box to select ALL cameras matched by the filters, including the devices not shown in the grid.

• Use CTRL-CLICK and SHIFT-CLICK or to select multiple items.

Step 7  Click an Action button.

For example, Delete, Change Location, etc.
Step 8  Follow the onscreen instructions to enter or select additional input, if necessary.
For example, Change Location requires that you select the new location.

Step 9  Refer to the Jobs page to view the action status.
See the “Understanding Jobs and Job Status” section on page 12-23.

Using “Split Model” Multi-Port Multi-IP Encoders

In “split model encoders”, each video input is a separate network encoder, and the functionality on input 1 is different from the other inputs. Cisco VSM 7.0 handles these different port functions by using a model name on input 1 that is different than the name on inputs 2+. In addition, when certain model encoders are installed in a supported chassis, the available ports on the chassis determines what each blade supports.

Summary
1. Axis 243Q and Q7406 are Multi-Port Multi-IP encoder blades. These blades are installed into the supported chassis: Axis 291 1U and Axis Q7900 4U.
2. Each port on these encoder blades is configured with its own IP. And each port has its own set of supported features (such as serial PTZ and/or contact closure).
3. When the encoder blade is installed into a chassis, the available ports on the chassis determines what each blade supports.
4. To support this model, Cisco introduced the concept of two kinds of models for each Multi-Port Multi-IP encoder:
   - axis243q_1 and axis243q_2_n
   - axisq74061 and axisq7406_2_n
   - axisq7404_1 and axisq7404_2_n
5. The _1 model represents different set of features as compared to _2_n model. For example:
   - axis243q_1 and axis243q_2_n, axisq74061 and axisq7406_2_n: only the _1 model supports Serial PTZ.
   - axisq7404_1 and axisq7404_2_n: only _1 model supports audio.

Constraints
The constraints are as follows:

- If the chassis being used is Axis 291 1U Chassis and serial PTZ is working, then irrespective of Axis 243Q or Axis Q7406 being the blade, it has to be the serial port on Channel 1 (The physical port 1 on the blade encoder). For example, when importing this device it has to be _1 device model.
- If the chassis is Axis Q7900 4U and the encoder blade is Axis 243Q has PTZ working already: it still has to be Channel (Port on the encoder blade) 1 (Physical Port 1 on the blade encoder).
- If the blade is Q7406 and PTZ is already working, then it may be any of the ports on the blade (because the chassis exposes all the serial ports on this blade through the connectors on the back side). But Cisco VSM release 7.0 supports PTZ through the first port on the blade only. So the device representing the first port on this encoder has to imported using 1 device model and the rest of the ports as the 2_n device model.
High Availability

High Availability (HA) in Cisco VSM entails the use of one or more *Failover, Redundant, or Long Term Storage* servers. These HA servers provide HA support, including hot standby, redundant stream storage and playback, and long term storage of video recordings.

*Note* Each Media Server can be assigned a single role. Once the server is added to the Cisco VSM configuration, the server role (*type*) cannot be updated. To change the role, delete the Media Server, and then re-add it with a different role.

Review the following information to understand the roles and functions of the different servers, and for instructions to install and configure the HA servers.

**Contents**

- Overview, page 11-2
  - Requirements, page 11-2
  - Summary Steps, page 11-3
  - Understanding Redundant, Failover, and Long Term Storage Servers, page 11-3
  - Understanding Failover, page 11-6
- Installing and Configuring the HA Servers, page 11-8
  - Add the HA Servers to Cisco VSM, page 11-8
  - Assign the HA Server(s) to the Primary or Redundant Servers, page 11-9
- Configuring the Camera Template HA Options, page 11-11
  - Configuring the Redundant and Failover Options, page 11-11
  - Archiving Recordings to a Long Term Storage Server, page 11-15
  - Defining the Recording Options, page 11-19
- Viewing the Server HA Status, page 11-21
Overview

Review the following information to understand the HA server types, and how they support the HA features for the Primary server.

- Requirements, page 11-2
- Summary Steps, page 11-3
- Understanding Redundant, Failover, and Long Term Storage Servers, page 11-3
- Understanding Failover, page 11-6

Requirements

Before you begin, verify that the following requirements are met.

**Table 11-1 Requirements**

<table>
<thead>
<tr>
<th>Requirements</th>
<th>Requirement Complete?</th>
</tr>
</thead>
<tbody>
<tr>
<td>You must belong to a User Group with permissions for Media Servers &amp; Encoders.</td>
<td>□</td>
</tr>
<tr>
<td>See the “Adding Users, User Groups, and Permissions” section on page 4-1 for more information.</td>
<td>□</td>
</tr>
<tr>
<td>At least two Media Servers must be installed on the network: one Primary server and one HA server. Install additional Media Servers to enable additional HA features. See the “Understanding Redundant, Failover, and Long Term Storage Servers” section on page 11-3.</td>
<td>□</td>
</tr>
<tr>
<td>At least one media repository must be available in the Media Server, or the Media Server cannot be added to the Operations Manager.</td>
<td>□</td>
</tr>
<tr>
<td>The time on all servers must be in sync, which requires NTP configuration. We recommend using the same network time protocol (NTP) server on all Media Servers to ensure the time settings are accurate and identical. See the “NTP Information” section on page 6-10 for more information.</td>
<td>□</td>
</tr>
<tr>
<td>Co-located—The Operations Manager and a single Media Server are enabled on the same server. The following rules apply:</td>
<td>□</td>
</tr>
<tr>
<td>- The co-located Media Server can only be a primary Media Server (co-located Media Servers do not support other HA roles such as Standby or Redundant).</td>
<td>□</td>
</tr>
<tr>
<td>- Failover or redundant Media Servers cannot be associated with the co-located primary Media Server (only a long term storage (LTS) server can be associated with the co-located primary Media Server).</td>
<td>□</td>
</tr>
</tbody>
</table>
Summary Steps

To configure HA, add the Media Servers to Cisco VSM, assign the HA servers to a Primary server, and configure the camera templates with the HA Advanced Storage options.

<table>
<thead>
<tr>
<th>Task</th>
<th>Related Documentation</th>
</tr>
</thead>
</table>
| Step 1 | Install the physical servers and add the Media Servers to Cisco VSM. | • Cisco Multiservices Platform for Physical Security User Guide  
• Understanding Redundant, Failover, and Long Term Storage Servers, page 11-3  
• Add the HA Servers to Cisco VSM, page 11-8 |
| Step 2 | Add the HA servers to the Primary server configuration. | • Assign the HA Server(s) to the Primary or Redundant Servers, page 11-9 |
| Step 3 | Configure the HA Advanced Storage options on the camera template. | • Configuring the Camera Template HA Options, page 11-11 |

Understanding Redundant, Failover, and Long Term Storage Servers

Table 11-2 describes the different server types. The Server Type is selected when the Media Server is added to Cisco VSM and cannot be changed unless you delete and re-add the server. See the “Adding or Editing Media Servers” section on page 6-17.

<table>
<thead>
<tr>
<th>Server Type</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
</table>
| Primary server| ![Diagram](http://example.com/diagram.png) | Both streams are sent to the Primary server only  
The server assigned to the camera or template. The Primary server processes the camera video feeds, stores and plays back recorded video, among other tasks.  
• A co-located Media Server can only be a primary Media Server (co-located Media Servers do not support other HA roles such as Standby or Redundant). |
### Table 11-2  HA Server Types (continued)

<table>
<thead>
<tr>
<th>Server Type</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
</table>
| Redundant server | Stream A to Primary, Stream B to Redundant: | A Redundant server provides additional computing power for the cameras associated with a Primary server.  
- Unicast—The camera’s video streams are sent to different servers. For example, stream A is sent to the Primary server, and stream B to the Redundant server. If the Primary server goes down, the video from Stream B is still saved to the Redundant server.  
- Multicast—Both camera video streams are simultaneously sent to both servers.  
A Redundant server can support multiple Primary servers. You must ensure that the Redundant server contains the disk and processing capacity to support all cameras that send video streams to the server.  
See the “Configuring Multicast Video Streaming” section on page 9-18 for more information. |
|                  | All Streams to Both Servers: | Note  
The Record Now feature is not available on redundant servers. The Record Now feature is available on the primary server, or on the failover server if the primary is down. |
| Failover server  | | A Failover server is a hot standby server that assumes system control if the Primary server fails or goes offline.  
Note  
The Failover server does not provide hot-standby functionality for the Redundant server.  
See the “Understanding Failover” section on page 11-6 for more information. |
Long Term Storage (LTS) server

A Long Term Storage (LTS) server is used to back up continuous and motion event recordings to a separate server.

- Both stream A and stream B can be backed up.
- Backups are performed on an automatic schedule (for example, once a week at midnight).

**Usage Notes**

**Note**

See the “Archiving Recordings to a Long Term Storage Server” section on page 11-15 for more information.

- An LTS server can be associated with both the Primary and Redundant servers. If video stream B is sent only to the Redundant server, that stream can also be archived to the LTS server.
- A LTS server can support multiple Primary and Redundant servers. You must ensure that the server contains the disk and processing capacity to support all associated servers and cameras.
- If the Primary server fails over, the Failover server continues to archive recordings to the LTS server.
- Click **Backup Now** from the Primary or Redundant server **Advanced** tab to immediately back up the recordings to the LTS server.
- Recordings remain in the Primary and Redundant servers even if they are archived to an LTS server. The recordings are removed from the Primary and Redundant servers based on the Retain settings available in the camera or template configuration page (Retain continuous recordings and Retain event recordings). See the “Streaming, Recording and Event Settings” section on page 7-49.
- Recordings are retained on the LTS server according to the settings described in the “Archiving Recordings to a Long Term Storage Server” section on page 11-15 (if the disk capacity of the LTS server is exceeded, the oldest recording is deleted to provide room for the newest recording).
- To access the LTS recordings, right-click the camera’s video and choose **Select Streams** from the menu. See the “Using the Pop-Up Menu” section on page 2-23.
- Only a LTS server can be associated with the co-located primary Media Server (failover or redundant Media Servers cannot be associated with the co-located primary Media Server).
Understanding Failover

When a Failover server is associated with a Primary server, the Failover polls the primary every two minutes to verify connectivity. If the failover does not receive a response after three successive tries, the Primary is assumed to be down or offline and the Failover assumes the Primary role.

- A few minutes of recording may be lost between the loss of the Primary server and the Failover assuming control.
- A Failover server can only stand in for one Primary server at a time (if a Failover server is already acting as the primary for a Media Server that is down, the Failover cannot assume control for a second Primary Media Server.
- When the Primary Media Server is down and the Failover has taken over the role of the primary server, and a DHCP based Medianet discovered camera has a change of IP address, the Cisco VSM Operations Manager will not reconfigure the camera to the new IP address until the Primary Media Server comes back up. This is because Cisco VSM Operations Manager does not allow any configuration changes on the cameras when the primary server is down.

Failover status is indicated in the server Status page (Figure 11-1). The possible Failover Status values are:

- In Failover
- Not In Failover
- Could Not Failover (this occurs if a different Primary server already failed over to the same Failover server.)

For example, Figure 11-1 displays a primary Media Server with a critical configuration error that causes a failover.

- The Failover Server status is OK (green), indicating that the server is up and ready to assume control.
- The Failover Status is Failed Over, indicating that a failover occurred.
- The Failover server Status page also displays Failed Over.

See the Viewing the Server HA Status, page 11-21 for more information.
When a user attempts to access live or recorded video from a camera that is associated with the Primary server, the request will time out and be forwarded to the Failover server, which completes the request and sends the requested video.

Because the Failover server maintains the same configuration as the Primary server (in real time), users will not encounter a change in network behavior other than a slight delay while communication is established with the Failover server.

Once the Primary server comes back online, it will automatically resume control from the Failover server. The Failover server will revert to hot standby status.

**Note**

Polling between the servers is coordinated based on the system time in each server. Use a NTP time source to ensure server synchronization.
Installing and Configuring the HA Servers

Complete the following procedures to install and configure the HA servers:

- Requirements, page 11-2
- Add the HA Servers to Cisco VSM, page 11-8
- Assign the HA Server(s) to the Primary or Redundant Servers, page 11-9

Note

The HA server type (Primary, Redundant, Failover, or Long Term Storage) can only be defined when the server is first added to Cisco VSM. Once added, you cannot change the server type (you must delete and re-add the server).

Add the HA Servers to Cisco VSM

Complete the following procedure to install the HA servers and add them to Cisco VSM. After completing these steps, continue to the “Assign the HA Server(s) to the Primary or Redundant Servers” section on page 11-9.

Procedure

Step 1
Install and configure the Media Server.


b. Log on to the Cisco Video Surveillance Management Console and complete the initial setup wizard.

c. Configure the server as a Media Server only (do not enable the Operations Manager on the server). See the Cisco Video Surveillance Management Console Administration Guide for more information.

Step 2
Add the HA server to Cisco VSM.

a. Log in to the Operations Manager.
   - You must belong to a User Group with permissions for Media Servers & Encoders.

b. Choose System Settings > Media Servers.

c. Click Add.

d. Enter the server hostname, username, password, name and location.

e. Select the Server Type Redundant, Failover, or Long Term Storage.
   - See the “Understanding Redundant, Failover, and Long Term Storage Servers” section on page 11-3.

f. Click Add.

Tip

Also see the “Configuring Media Servers” section on page 6-1.

Step 3
Continue to the next section: “Assign the HA Server(s) to the Primary or Redundant Servers”.

Assign the HA Server(s) to the Primary or Redundant Servers

After the HA servers are added to Cisco VSM, you must associate the Failover, Redundant, or Long Term Storage servers with the Primary server.

- You can also assign a Long Term Storage server to the Redundant server.
- The following procedure applies only to the Primary and Redundant servers. The High Availability Options are not available and cannot be configured for a Failover or Long Term Storage server.
- You can configure the HA settings in a camera template even if the HA servers are not installed or configured. However, a configuration error and alert will be generated. Once the server configuration is complete, the errors will be removed.

Procedure

**Step 1**
Open the Primary or Redundant server configuration page.

a. Click **System Settings > Media Servers**.

b. Select the server location.

c. Select the Media Server.

**Step 2**
Click the **Advanced** tab.
Step 3  Select the **Failover**, **Redundant Streams** or **Long Term Storage** servers (Figure 11-2).

<table>
<thead>
<tr>
<th>Server Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failover</td>
<td>(Primary server only) The Media Server that will assume the functionality of the Primary server if the Primary server goes offline.</td>
</tr>
<tr>
<td>Redundant Streams</td>
<td>(Primary server only) The server used to record, store, and server Redundant video streams. For example, the Redundant Streams server can be used to manage Steam B from a camera.</td>
</tr>
<tr>
<td>Long Term Storage</td>
<td>(Primary and Redundant servers only) The server used to store recorded video (continuous or motion events) for a long period of time.</td>
</tr>
</tbody>
</table>

**Note** See the “Understanding Redundant, Failover, and Long Term Storage Servers” section on page 11-3 for more information.

Step 4  Click **Save**.
Configuring the Camera Template HA Options

Each camera is assigned to a **Primary** Media Server which processes, stores, and plays back the camera’s live and recorded video. Use the **Advanced Storage** options to also send the camera video to Redundant, Failover, and/or Long Term Storage servers.

**Tip**

Use a camera template to apply the **Advanced Storage** options to multiple cameras, or a custom template to apply the HA settings only to a single camera.

**Note**

You can configure the camera **Advanced Storage** settings if the HA servers are not available, but a configuration error and alert will be generated. Once the server configuration is complete, the errors will be removed.

**Summary Steps**

<table>
<thead>
<tr>
<th>Task</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>Verify that the HA <strong>Requirements</strong> are met, and review the “Summary Steps” section on page 11-3.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>Complete the “Configuring the Redundant and Failover Options” section on page 11-11.</td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td>(Optional) Complete the “Archiving Recordings to a Long Term Storage Server” section on page 11-15.</td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
<td>(Optional) Complete the “Defining the Recording Options” section on page 11-19.</td>
</tr>
</tbody>
</table>

Configuring the **Redundant and Failover** Options

The **High Availability and Failover** options allow you to select the type of stream redundancy for the camera or template.

By default, live and recorded video from a camera is sent to a single **Primary** server. If the Primary server goes down, then the live and recorded video cannot be processed, saved or displayed(Figure 11-3).

- If a **Redundant** server is installed and configured, however, a camera’s video streams can also be sent to the **Redundant** server.

**Note** Some cameras do not support sending motion or contact-closure events to a redundant server.

- A **Failover** server can also be added as a hot standby server, ready to assume **Primary** server functionality if the Primary server goes down or is offline (the **Failover** server only serves the **Primary** server, not the **Redundant** server).
Configuring the Camera Template HA Options

Figure 11-3  High Availability and Failover Options

Table 11-3 describes the Stream Redundancy and Failover options for a camera or camera template. Select a Stream Redundancy option (as shown in Figure 11-3), and then turn the Failover option On or Off.

Table 11-3  Stream Redundancy Options With and Without a Failover Server

<table>
<thead>
<tr>
<th>Option</th>
<th>Stream Redundancy</th>
<th>Failover Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>All live and recorded streams are sent to a single Primary server. If the Primary server fails, camera control, recording, and playback is disabled.</td>
<td>If the Primary server fails or goes offline, the Failover server immediately assumes control (hot standby).</td>
</tr>
</tbody>
</table>
Chapter 11      High Availability

Configuring the Camera Template HA Options

Table 11-3  Stream Redundancy Options With and Without a Failover Server (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Stream Redundancy</th>
<th>Failover Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stream A to Primary, Stream B to Redundant</td>
<td>A camera’s stream A video is sent to the Primary server. Stream B is sent to the Redundant server. If the Primary server fails, the Redundant server still supports the camera stream B video, although it may be lower resolution.</td>
<td>If the Primary server fails or goes offline, the Failover server continues to support the camera’s stream A video.</td>
</tr>
<tr>
<td>All Streams to All Servers</td>
<td>Both stream A and stream B (if configured) are sent to both the Primary and Redundant server. If the Primary server fails, both video streams are still supported by the Redundant server.</td>
<td>If the Primary server fails or goes offline, both stream A and stream B continue to be supported by two servers (the Failover and Redundant).</td>
</tr>
</tbody>
</table>

Procedure
The following procedure summarizes how to configure a redundant and/or failover server for a camera or camera template.

Note: The Primary server associated with the camera(a) must be configured with a Redundant and/or Failover server. See the “Assign the HA Server(s) to the Primary or Redundant Servers” section on page 11-9.

Step 1  Install and configure the HA servers for the Primary Media Server associated with the camera(s).
   - Installing and Configuring the HA Servers, page 11-8
   - Assign the HA Server(s) to the Primary or Redundant Servers, page 11-9
Step 2  Choose Cameras and select a camera or camera template.
Step 3  Select the Streaming, Recording and Events tab.
Step 4  Click Advanced Storage (Figure 11-3 on page 11-12).
Step 5  Select a Stream Redundancy option, as described in Table 11-3.
Step 6  Turn the Failover option On or Off, as described in Table 11-3.
Step 7  Click Save.
Archiving Recordings to a Long Term Storage Server

A Long Term Storage (LTS) server allows you to automatically transfer recorded video from the Primary server to a LTS server. This frees the limited space on the Primary server, and provides a dedicated resource to store and play back old recordings.

- Recordings remain in the Primary and Redundant servers even if they are archived to an LTS server. The recordings are removed from the Primary and Redundant servers based on the Retain settings available in the camera or template configuration page (Retain continuous recordings and Retain event recordings).
- Recordings are removed from the LTS server according to the settings described in Figure 11-5.

Tip
You can also click Backup Now from the Primary or Redundant server to immediately back up the recordings to the LTS server. Select the Advanced tab and click Backup Now.

Refer to the following topics for more information:
- Prerequisite: Enable the Media Server Backup Partition, page 11-15
- Configuring the LTS Server, page 11-16

Prerequisite: Enable the Media Server Backup Partition

To archive recordings to an LTS server, you must enable a partition on the Media Server to store the backups.

Note
The Backup partition is used only to backup recordings on a Long Term Storage server.

Procedure

Step 1 Click the Media Servers icon.
Step 2 Select the location and then select the LTS Media Server.
Step 3 Click the Advanced tab.
Step 4 Under Partitions (Figure 11-4), select the Backups check box for the /media1 or /media0 repository.
Step 5 This setting specifies which hard disk partition will be used to store the archived recordings files.
Step 6 Click Save.
Configuring the LTS Server

Click the Advanced Storage option in a camera or template and select Long Term Storage (Figure 11-5). The LTS options are available only if the Primary server is configured with an LTS server and the camera or camera template is configured to record video. For example, in Figure 11-5, Video Stream B is disabled since the template is not configured to record video.
The following table describes the Long Term Storage Settings:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>What to Archive</td>
<td>Select the following for video stream A and B:</td>
</tr>
<tr>
<td></td>
<td>• —Do not transfer any recorded video to the LTS server.</td>
</tr>
<tr>
<td></td>
<td>• —Transfer only video that is recorded on a motion event (if configured on the</td>
</tr>
<tr>
<td></td>
<td>camera/template).</td>
</tr>
<tr>
<td></td>
<td>• —Transfer both continuous and motion event recordings (if configured on the</td>
</tr>
<tr>
<td></td>
<td>camera/template).</td>
</tr>
<tr>
<td>Retain archive for</td>
<td>The number of days that the recorded video will be retained on the LTS. The video will be deleted from the LTS when the specified number of days are exceeded. Once deleted, the video is no longer be available for playback.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> If the disk capacity of the LTS server is exceeded, the oldest recording is deleted to provide room for the newest recording.</td>
</tr>
<tr>
<td>When to Archive</td>
<td>The frequency and time of day when all recorded video on the Primary server (based on “What to Archive”) will be transferred to the LTS server.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Daily</strong>—Transfers all recorded video every day at the specified time, every day of the week. For example, every day at midnight.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Weekly</strong>—Transfers all recorded video on the specified day of the week and time. For example, every Sunday at 11 p.m.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Monthly</strong>—Transfers the past month of recorded video every month at the specified day and time. For example, on the first day of every month at 1 a.m.</td>
</tr>
</tbody>
</table>

**Procedure**

The following procedure summarizes how to archive recordings to a LTS server.

**Note:** The Primary server associated with the cam(a) must be configured with an LTS server. See the “Assign the HA Server(s) to the Primary or Redundant Servers” section on page 11-9.

**Step 1** Install and configure the LTS server for the Primary Media Server associated with the camera(s).
- Installing and Configuring the HA Servers, page 11-8
- Assign the HA Server(s) to the Primary or Redundant Servers, page 11-9

**Step 2** Configure the Store Partition on the LTS Server.
- Prerequisite: Enable the Media Server Backup Partition, page 11-15

**Step 3** Choose Cameras and add or edit a camera or camera template.
- Adding and Managing Cameras, page 7-1

**Step 4** Select the Streaming, Recording and Events tab and configure recording.
- Configuring Continuous, Scheduled, and Motion Recordings, page 9-7

**Step 5** Click Advanced Storage.
Step 6  Click the **Long Term Storage** tab (Figure 11-5 on page 11-16).

Step 7  Select the options for Stream A and Stream B (Figure 11-5 on page 11-16).

Step 8  Click **Save**.
Chapter 11  High Availability

Defining the Recording Options

The Recording Options can be used to reduce the bandwidth and processing requirements for streaming and recording video (Figure 11-6). Select a template and click Advanced Storage > Recording Options to define the following options.

- Economical Streaming, page 11-19
- Recording Options, page 11-20

Figure 11-6  Camera/Template HA Recording Options

Economical Streaming

Select the Economical Streaming option to place the secondary stream in suspended mode. The stream will be active only when requested by a user (on-demand).

By default this feature is deselected and video is streamed at all times and is instantly available for viewing.

Usage Notes

- When selected, video playback will be delayed while the request is being processed.
- When Economical Streaming is enabled, motion event alerts and other Advanced Event processing is disabled since video is only sent when requested by a user. Do not configure these features on Stream B when Economical Streaming is enabled.
- Scheduled recordings can be configured with Economical Streaming enabled since streaming is automatically begun when the recording is scheduled.
Supported Configurations

- Economical Streaming is available only on Stream B.
- This option is only available when Stream A is sent to the Primary Media Server and Stream B is sent to the redundant Media Server (Figure 11-7).

Figure 11-7 Economical Streaming

Unsupported Configurations

Economical Streaming is not supported in the following configurations:

- Both Stream A and Stream B are sent to the Primary server.
- Both Stream A and Stream B are sent to both the Primary and Redundant servers.

Recording Options

- iFrame Only for H264/MPEG—Use the iFrame format only when recording H264/MPEG video.
- Lower framerate for JPEG—Specify a lower frame rate to reduce the bandwidth, processing, and storage requirements of video recorded from Stream B. A lower framerate number requires less network and server resources, but results in lower quality video.
Viewing the Server HA Status

Open the camera status page to view the servers associated with that camera. For example, if the Primary server that services a camera is configured with a Failover, Redundant, or Long Term Storage server, the status of those servers is displayed.

Procedure
To view the HA server status, do the following:

Step 1 Log on to the Operations Manager.
- See the “Logging In” section on page 1-17.

Step 2 Select the Media Server or camera to edit (click Cameras or System Settings > Media Servers and select the device).

Step 3 Click the Status tab.

Step 4 Review the status of the current server and associated servers. For example:
- Figure 11-8: An example of a Primary Server and associated HA servers
- Figure 11-9: Examples of the Status Pages for each HA Server Type.
- See also Figure 11-1 on page 11-6 for an example of the Primary and Failover Status pages when a failover occurs.
### Viewing the Server HA Status

#### Figure 11-8 Primary Server Status Including Associated Servers

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Overall Status</strong></td>
<td>The status of the current server.</td>
</tr>
<tr>
<td></td>
<td>See the “Understanding the Overall Status” section on page 12-6 for more information.</td>
</tr>
<tr>
<td><strong>Associated Servers</strong></td>
<td></td>
</tr>
<tr>
<td>Failover Status</td>
<td>The Overall Status of the failover server.</td>
</tr>
<tr>
<td></td>
<td>See the “Understanding the Overall Status” section on page 12-6 for more information.</td>
</tr>
<tr>
<td></td>
<td>Open the Status page of the associated failover server to view additional details about the server status.</td>
</tr>
<tr>
<td>Failover Status</td>
<td>The HA status of the Failover server. The possible values are:</td>
</tr>
<tr>
<td></td>
<td>• <em>In Failover</em></td>
</tr>
<tr>
<td></td>
<td>• <em>Not In Failover</em></td>
</tr>
<tr>
<td></td>
<td>• <em>Could Not Failover</em> (this occurs if a different Primary server already failed over to the same Failover server.)</td>
</tr>
<tr>
<td></td>
<td>See the “Understanding Failover” section on page 11-6 for more information.</td>
</tr>
<tr>
<td>Redundant Streams Server</td>
<td>The Overall Status of the Redundant server that is associated with the Primary server.</td>
</tr>
<tr>
<td></td>
<td>A <em>Redundant</em> server can support multiple Primary servers. You must ensure that the Redundant server contains the disk and processing capacity to support all cameras that send video streams to the server.</td>
</tr>
</tbody>
</table>
Open the **Status** page for each HA server to view additional information about the overall status and HA status of that server (Figure 11-9).

### Figure 11-9  Examples of HA Server Status

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Long Term Storage Server | The Overall Status of the Long Term Storage server associated with the Primary or Redundant server.  
**A Long Term Storage server** can support multiple Primary and Redundant servers. You must ensure that the server contains the disk and processing capacity to support all associated servers and cameras. |

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Server Status          | The status of the HA servers associated with the Primary server.  
**A Failover server** can provide hot standby support for multiple Primary servers. If one primary server fails over, however, the Failover server will be unavailable to support the other Primary, and the Failover Status will be “Could Not Failover”.  
See the “Understanding Failover” section on page 11-6 (and Figure 11-1) for more information. |
### Viewing the Server HA Status

<table>
<thead>
<tr>
<th>Server Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Redundant server</strong></td>
<td>The Failover server status, and the LTS server status.</td>
</tr>
<tr>
<td></td>
<td><em>A Redundant server can support multiple servers. You must ensure that the Redundant server contains the disk and processing capacity to support all associated Primary servers.</em></td>
</tr>
<tr>
<td><strong>Long Term Storage server</strong></td>
<td>The Failover server status.</td>
</tr>
<tr>
<td></td>
<td><em>A Long Term Storage server can support multiple Primary and Redundant servers. You must ensure that the server contains the disk and processing capacity to support all associated servers.</em></td>
</tr>
</tbody>
</table>
Monitoring System and Device Health

Refer to the following topics for information to monitor the health of the system or of a specific device, to view the status of user-initiated jobs, a record of user actions (Audit Logs), and other features.

Contents

- Overview, page 12-2
- Health Dashboard: Viewing a Summary of Device Health for a Location, page 12-4
- Device Status: Identifying Issues for a Specific Device, page 12-6
- Health Notifications, page 12-12
- Reports, page 12-14
- Synchronizing Device Configurations, page 12-15
- Viewing the Server Management Console Status and Logs, page 12-22
- Understanding Jobs and Job Status, page 12-23
- Viewing Audit Logs, page 12-29

Note

Alert, audit and event records are automatically pruned according to the system settings. See the “Records Settings” section on page 13-3 for more information.
Overview

The **Health Dashboard** displays a summary of all device errors in your deployment, allowing you to quickly view the health of all cameras, encoders and Media Servers in your deployment. You can also click a link for any affected device to open the device configuration page.

From the device configuration page, click the **Status** tab to locate the category where the error occurred (such as configuration or hardware), and the alert messages that provide additional details regarding the cause of the error. If a configuration mismatch occurs (where the device configuration is different than the Operations Manager configuration), you can open a pop-up window for more details.

To resolve the issue, revise the device configuration, or click **Repair** or **Replace Config** to replace the device configuration with the Operations Manager version.

If the system or server is performing poorly, use the diagnostic tools available in the server Management Console to view performance, hardware and system information.

Table 12-1 summarizes the Operations Manager monitoring features.

<table>
<thead>
<tr>
<th>Monitoring Feature</th>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Health Dashboard: Viewing a Summary of Device Health for a Location, page 12-4</td>
<td>Operations --&gt; Health Dashboard</td>
<td>Open the <strong>Health Dashboard</strong> to view a summary of Warning or Critical errors for all configured devices. Click on an entry to open the device configuration page and further identify the issue.</td>
</tr>
</tbody>
</table>
| Device Status: Identifying Issues for a Specific Device, page 12-6 | Cameras --> Status System Settings --> Media Server --> Status System Settings --> Encoder --> Status | Click the **Status** tab in the device configuration page to view the specific type of error for a device. The status categories show where the error occurred.  
  - Click the **Status History** to view the alert messages for the device.  
  - Click the **Affecting Current Status** radio button to view only the alerts that are causing the |
| Health Notifications, page 12-12 | Operations --> Health Notifications | Send emails to specified recipients when a critical device error occurs. |
| Reports, page 12-14 | Operations --> Reports | Generate and download information about the Cisco Video Surveillance user activity, device configuration, and other information. |
| Synchronizing Device Configurations, page 12-15 | Device configuration page. Click the **Repair** or **Replace Config** button. | If a configuration mismatch error occurs, you can click the device **Repair** button to replace the configuration settings on the device with the settings in Operations Manager. |
Overview

Viewing the Server Management Console Status and Logs, page 12-22

Operations --> Management Console

Displays logs, hardware status, and system trend information for the Cisco Video Surveillance server. The Management Console is a separate browser-based interface that requires a separate localadmin password.

See the Cisco Video Surveillance Management Console Administration Guide for more information.

Understanding Jobs and Job Status, page 12-23

System Settings --> Jobs

Displays a summary of current and completed jobs triggered by user actions.

Viewing Audit Logs, page 12-29

Operations --> Audit Logs

Displays successful configuration changes. You can sort or filter the results by user, device, and other categories.

Table 12-1 Monitoring Features

<table>
<thead>
<tr>
<th>Monitoring Feature</th>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
</table>
| Viewing the Server Management Console Status and Logs, page 12-22 | Operations --> Management Console | Displays logs, hardware status, and system trend information for the Cisco Video Surveillance server. The Management Console is a separate browser-based interface that requires a separate localadmin password.  
See the Cisco Video Surveillance Management Console Administration Guide for more information. |
| Understanding Jobs and Job Status, page 12-23 | System Settings --> Jobs | Displays a summary of current and completed jobs triggered by user actions.                                                                 |
| Viewing Audit Logs, page 12-29         | Operations --> Audit Logs | Displays successful configuration changes. You can sort or filter the results by user, device, and other categories.                         |
Health Dashboard: Viewing a Summary of Device Health for a Location

Open the Health Dashboard (from the Operations page) to view a summary of Media Servers, encoders and cameras that are experiencing a critical x or warning ▲ fault (Figure 12-1). Devices are displayed for the selected location. Click the number next to a category (such as Configuration) to view the affected devices, and then double-click a device to open the device configuration page.

**Tip**

Refresh the Health Dashboard page to view updated results. The dashboard does not automatically refresh.

---

**Figure 12-1 System Health Dashboard**

1. Location.
   Click a location to view a summary of devices assigned to that location.

2. Device health summary for the selected location.
   Each device type shows the number of critical x or warning ▲ faults.
   **Tip** Click a number to display the devices that are experiencing the fault. For example, if a Media Server has a network fault, click the number 1 next to Network.

3. The devices for a selected fault category.
   **Tip** Double-click an entry in the list (or click the icon) to open the device’s configuration page. See the “Device Status: Identifying Issues for a Specific Device” section on page 12-6 for more information.

---

**Tip**

Device errors are cleared automatically by the system or manually cleared by an operator. Refresh the page to view the latest information. Some alerts cannot be automatically reset. For example, a Media Server I/O write error event.
Chapter 12      Monitoring System and Device Health

Health Dashboard: Viewing a Summary of Device Health for a Location

Procedure
Complete the following procedure to access the Health Dashboard:

Step 1  Click the Operations tab.

Step 2  Click Health Dashboard (Figure 12-1).

Step 3  Choose a location to view a summary of the faulty devices at that location. Locations with one or more faulty devices display a critical or warning icon.

Table 12-2    Device Health Fault Types

<table>
<thead>
<tr>
<th>Icon</th>
<th>Error Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Warning Icon]</td>
<td>Warning</td>
<td>Warnings are based on activity that occurs without incapacitating a component, for example, interruptions in operation due to packet losses in the network. These activities do not change the overall state of the component, and are not associated with “up” and “down” health events.</td>
</tr>
<tr>
<td>![Critical Icon]</td>
<td>Critical</td>
<td>Critical errors are health events that impact the device operation or render a component unusable. For example, a Media Server that cannot be contacted on the network, or a configuration error. Components in the critical state remain out of operation (“down”) until another event restores them to normal operation (“up”). Critical errors also affect other components that depend upon the component that is in the error state. For example, a camera in the critical error state cannot provide live video feeds or record video archives. See the “Health Notifications” section on page 12-12 for instructions to send emails when a critical event occurs.</td>
</tr>
</tbody>
</table>

Step 4  Review the number of devices experiencing an error for each device type.

The number represents the number of devices experiencing that error. For example, 3 Media Servers might be experiencing a network error.

Step 5  Click a number to display the specific devices experiencing the fault.

Step 6  Double click a device entry or click the icon) to open the device configuration and status pages.

Step 7  Continue to the “Device Status: Identifying Issues for a Specific Device” section on page 12-6 for more information.

Step 8  Take corrective action to restore the device to normal operation, if necessary.

Step 9  For example, if a configuration mismatch occurs, see the “Synchronizing Device Configurations” section on page 12-15.
Device Status: Identifying Issues for a Specific Device

Cameras, encoders, and Media Server include a Status tab that displays health information for the device and associated servers (Figure 12-2). While the Overall Status summarizes the device health, the status categories specify if an error has occurred with the network connection, configuration, hardware, or other category. Click the Status History tab to view device events, including any specific events that are affecting the device status.

See the following topics for more information:

- Understanding the Overall Status, page 12-6
- Understanding Device Status, page 12-9
- Viewing Device Error Details, page 12-11

Understanding the Overall Status

Click the device Status tab to view the overall operational state (Figure 12-2).

Figure 12-2 Overall Status Camera Device Status

Table 12-3 describes the overall device states:

<table>
<thead>
<tr>
<th>Status</th>
<th>Color</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled: OK</td>
<td><img src="image" alt="Green" /></td>
<td>Green</td>
<td>The device is operating normally.</td>
</tr>
<tr>
<td>Enabled: Warning</td>
<td><img src="image" alt="Yellow" /></td>
<td>Yellow</td>
<td>A minor event occurred that did not significantly impact device operations.</td>
</tr>
</tbody>
</table>
### Table 12-3 Overall Status (continued)

<table>
<thead>
<tr>
<th>Status</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled: Critical</td>
<td>Red</td>
<td>An event occurred that impacts the device operation or renders a component unusable. See the “Health Notifications” section on page 12-12 for instructions to send automatic email notifications when a critical device issue occurs.</td>
</tr>
<tr>
<td>Pre-Provisioned</td>
<td>Brown</td>
<td>The camera is waiting to be added to the network and is not available for use. A pre-provisioned camera can be modified, but the camera cannot stream or record video until you choose <strong>Enable</strong> from the <strong>Device Settings</strong> menu.</td>
</tr>
<tr>
<td>Disabled</td>
<td>Brown</td>
<td>The device is disabled and unavailable for use. The configuration can be modified, and any existing recordings can be viewed, but the camera cannot stream or record new video.</td>
</tr>
<tr>
<td>Soft Deleted (Keep Recordings)</td>
<td>Brown</td>
<td>The device configuration is removed from the Operations Manager but the recordings associated with that device are still available for viewing (until removed due to grooming policies). To view the recordings, select the camera name in the <strong>Monitor Video</strong> page. Soft-deleted cameras are still included in the camera license count. See the “Installing Licenses” section on page 1-21.</td>
</tr>
<tr>
<td>Hard Deleted (Delete Recordings)</td>
<td>None</td>
<td>The device and all associated recordings are permanently deleted from Cisco VSM.</td>
</tr>
</tbody>
</table>

**Note** You can also choose to place the camera in the Blacklist. See the “Blacklisting Cameras” section on page 7-40.

---

**Note** Devices states can change due to changes in the device configuration, or by manually changing the status in the device configuration page (Figure 12-3).
Device Status: Identifying Issues for a Specific Device

Figure 12-3  Device Status

Enabled:
Overall Status = OK, Warning or Critical.
Device can stream and record video, unless in a critical state.

Pre-Provisioned

"Enable"

"Disable" or "Enable"

 Disabled

"Disable"

Soft Delete (Keep Recordings)    Hard Delete (Delete Recordings)
Understanding Device Status

Click the Status tab (from the device configuration page) to identify where a device error occurred. For example, if a critical configuration error occurs (Figure 12-4), the Configuration entry displays a Critical message in red. Click the icon to view additional details about the error.

Table 12-4 describes the status categories. The categories are different for each type of device. For example, Media Servers include a Software category to indicate the health of server processes. An encoder does not include streaming or recording categories.

<table>
<thead>
<tr>
<th>Category</th>
<th>Devices</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall Status</td>
<td>All Devices</td>
<td>The aggregated status of all categories included for the device. See the &quot;Understanding the Overall Status&quot; section on page 12-6.</td>
</tr>
<tr>
<td>Note</td>
<td></td>
<td>The Associated Servers status does not impact the Overall Status. For example, if the associated Media Server or Redundant Server is down, but the camera Network status is Enabled: OK, then the camera Overall Status is also Enabled: OK.</td>
</tr>
</tbody>
</table>

Device Status
Chapter 12      Monitoring System and Device Health

Device Status: Identifying Issues for a Specific Device

Reachability  All Devices  Indicates the health of the network connection. For example, a warning or critical event indicates that a device is unreachable on the network.

Streaming  Cameras only  Indicates if the Media Server can stream live video from the camera.

Recording  Cameras only  Indicates if the Media Server can successfully record video from the camera.

Configuration  Media Servers  Indicates if the configuration was successfully applied to the device, and that the device configuration is the same on the Media Server and in Operations Manager. Configuration errors also display an icon. Click the icon to view additional details about the error (see the “Viewing Device Error Details” section on page 12-11).

Configuration  Cameras  For example, if a template is modified in the Operations Manager, but the configuration is not applied to the camera configuration, a synchronization mismatch occurs. See the “Synchronizing Device Configurations” section on page 12-15 for more information.

Configuration  Encoders  

Hardware  All Devices  Status of the physical device components, such as temperature.

Software  Media Servers only  Indicates the status of services hosted by a Media Server.

Jobs in Progress  All Devices  Indicates if the device has one or more Jobs running.

Associated Servers

Note  The status of failover, redundant and LTS servers does not affect the overall status of a device.

Server  Cameras and Encoders only  Indicates that the device can communicate with a Media Server.

Failover Server  HA server configurations only  Indicates the state of the failover Media Server, when HA is enabled.

Failover Status  HA server configurations only  Indicates if the HA servers are in failover mode.

Redundant Streams Server  HA server configurations only  Indicates if a redundant server is available for streaming live video.

Long Term Storage Server  HA server configurations only  Indicates if a server is available to store recorded video beyond a specified date for archiving purposes.

Table 12-4  Device Status Categories (continued)
Viewing Device Error Details

If a device error is displayed in the Status page (Figure 12-4), do one of the following:

- A Configuration error indicates that a configuration mismatch occurred (the configuration on the device is different than the Operations Manager settings). Click the icon to view additional details and refer to the “Synchronizing Device Configurations” section on page 12-15 for instructions to correct configuration errors.

- Click the Status History tab (Figure 12-5) to view the specific events that determine device status. Click Affecting Current Status to view only the items that are currently affecting the summaries in the Device Status tab.

Use the information in these entries to take corrective action.

FIGURE 12-5 Camera Status History
Health Notifications

Health notifications are emails sent to one or more users when a critical device error occurs. Critical errors are health events that impact the device operation or render a component unusable. For example, a Media Server that cannot be contacted on the network, or a camera that does not stream or record video.

Note

Configuration errors do not trigger health notification emails.

Tip

See the “Health Dashboard: Viewing a Summary of Device Health for a Location” section on page 12-4 and the “Device Status: Identifying Issues for a Specific Device” section on page 12-6 for more information.

Usage Notes

- Emails are sent using the SMTP server address configured for the Operations Manager server using the Cisco VSM Management Console. The SMTP server settings must be accurate or the emails will not be sent (no error or warning is given. See the “SMTP Management Settings” section on page 6-12 for more information. To apply the settings to multiple servers, see the “Bulk Actions: Revising Multiple Media Servers” section on page 6-25.
- Health Notifications are created for a location. If a critical device health error occurs for any device at that location (or sub-location), an email is sent to the specified recipients.
- Email recipients can be specified for different locations (and sub-locations) by creating a new Health Notification rule. Health Notifications operate independently so the recipient will receive emails for each rule, even if the notifications are for the same issue.
- Use the settings described in Table 12-5 to avoid unnecessary and excessive email traffic.

Table 12-5 Health Notifications

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial time</td>
<td>The time between the first alert and the email being sent. This avoids emails for temporary issues that cause a device to briefly go offline and come back online. For example, when a camera configuration is revised, the camera may go down briefly while being reset.</td>
</tr>
<tr>
<td>Wait time</td>
<td>The time between the first email and any subsequent email. This prevents multiple emails being sent for the same issue within a short period of time.</td>
</tr>
</tbody>
</table>

Procedure

Step 1 Verify that the SMTP server settings are configured correctly for each Media Server.
  - See the “SMTP Management Settings” section on page 6-12 for more information.
• To update SMTP server settings for multiple Media Servers, see the “Bulk Actions: Revising Multiple Media Servers” section on page 6-25.

Step 2  
Select Operations > Health Notifications.

Step 3  
Click Add.

Step 4  
Click the Location icon to select the location.

All devices from this location and sub-locations will generate a health notification.

Tip  
Select the root location (for example, “System”) to include all devices from all locations. If additional rules are added for sub-locations, both rules will apply and multiple emails will be generated.

Step 5  
Enter a valid email address and click the Add Email icon (or press Enter).

Step 6  
Add additional email addresses, if necessary.

Step 7  
Select the Initial Time and Wait Time as described in Table 12-5.

Step 8  
Click Add.

Step 9  
Create additional entries for additional locations and recipients, if necessary.
Reports

Use Reports to generate and download summary information about the Cisco Video Surveillance user activity, device configuration. For example, you can create Audit reports that summarize user actions, or Camera and Media Server reports that summarize device configuration and status.

Create a Report

Procedure

1. Select Operations > Reports.
2. Create one or more reports.
   a. Click Add.
   b. Select the General settings and click Next.
      - Report Type—The device or user information to be included in the report. For example, Audit, Camera, or Media Server.
      - Report Format—The file format for the downloadable report. For example, a CSV Format (comma-separated value) file.
   c. Select the report Filters and click Next.
      For example, you can include cameras based on the camera name, make/model, the Media Server associated with the camera, template assigned to the camera(s), etc.
   d. Use the Preview window to select or deselect the devices or users to be included in the report.
   e. Click Finish.
   f. Wait for the report to be generated, and then click Close.
3. Select one or more reports from the list and click Download.

Delete a Report

Procedure

1. Select Operations > Reports.
2. Select the check-box for one or more existing reports.
   Tip: Click the select all box to remove all reports.
3. Click Download and confirm the deletion.
Synchronizing Device Configurations

Device synchronization ensures that the device configuration on the Media Server, camera or encoder is identical to the Operations Manager settings. Synchronization also ensures that no device has the same unique ID (such as a MAC address) as another device. Synchronization is automatically performed when certain events occur, such as when a Media Server goes offline and comes back online, when the Operations Manager is restarted, when drivers are upgraded, and other events.

Synchronization errors can be resolved either automatically, or manually. Refer to the following topics for more information:

- Overview, page 12-15
- Viewing Device Synchronization Errors, page 12-17
- Repairing a Mismatched Configuration, page 12-19
- Manually Triggering a Media Server Synchronization, page 12-20
- Device Data That Is Synchronized, page 12-20
- Synchronization During a Media Server Migration, page 12-21

Overview

The Operations Manager configuration is the master configuration (Figure 12-6). A mismatch occurs if the configuration on the Media Server is different.

For example, if a synchronization event determines that the setting for a camera’s video resolution is different between the Operations Manager and the Media Server, a configuration mismatch occurs.

- If the Autocorrect Synchronization Errors system setting is enabled, the configuration is automatically replaced with the Operations Manager setting.
- If the Autocorrect Synchronization Errors system setting is disabled, a configuration error is displayed on the camera Status page. Click the icon to view additional details about the mismatch and then select Repair Configurations or Replace Configurations from the Device Settings menu to replace the camera setting with the Operations Manager setting (see the “Device Status: Identifying Issues for a Specific Device” section on page 12-6 for more information).
Synchronizing Device Configurations

Figure 12-6  Device Synchronization

Operations Manager
(Master Configuration)

Repair or Replace Configurations

IP Camera

Encoder

Media Server
Viewing Device Synchronization Errors

A Configuration error appears on the device Status page if a synchronization error is not automatically corrected. To view details about the error, open the device Status page.

Procedure

**Step 1** Open the device configuration page:
- Click Cameras and select a camera or encoder
- or
- Click System Settings > Media Server and select a Media Server.

**Step 2** Click the device Status tab.

**Step 3** Click the icon next to Configuration (Figure 12-7).

---

**Note** The icon appears only if a configuration error occurred.

*Figure 12-7 Camera Configuration Mismatch*
Step 4  (Optional) Close the window and click Status History to view more information regarding the synchronization events (Figure 12-8).

Figure 12-8 Camera Status History

Tip  Click Affecting Current Status to narrow the results.

Step 5  To resolve the configuration mismatch, do one of the following:
- (Recommended) Continue to the “Repairing a Mismatched Configuration” section on page 12-19.
- Manually resolve the configuration issue on the device, or in the Operations Manager configuration.
Repairing a Mismatched Configuration

Select **Repair Configurations** or **Replace Configurations** from the **Device Settings** menu (in a device configuration page) to manually replace the device configuration with the Operations Manager settings.

---

**Note**

Devices include the Media Servers, encoders and cameras.

---

**Procedure**

**Step 1** (Optional) Review the configuration mismatch errors, as described in the “Viewing Device Synchronization Errors” section on page 12-17.

**Step 2** Select the device configuration **General** tab.

**Step 3** Click one of the following options.

- **Replace Configurations**—Pushes the entire device configuration from the Operations Manager to the Media Server. The Media Server data is replaced.

- **Repair Configurations**—Pushes only the configuration changes required correct a mismatched field. Changes are pushed from the Operations Manager to the Media Server.

**Step 4** (Optional) Complete the following optional troubleshooting steps:

- Wait for the synchronization **Job** to complete. In the Job window, click **View Status** to view any failed steps and click the error message to view additional information. See the “Understanding Jobs and Job Status” section on page 12-23 for more information.

- Open the **Status** page for the affected device to view additional details and take corrective action, if necessary. See the “Viewing Device Synchronization Errors” section on page 12-17.
Manually Triggering a Media Server Synchronization

The Media Server configuration is automatically synchronized when certain events occur (such as when the Media Server offline and comes back online).

If synchronization errors are found, select the Repair Configurations or Replace Configurations options from the Device Settings menu to replace the Media Server settings with the Operations Manager settings (Figure 12-9).

Device Data That Is Synchronized

Table 12-6 describes the data synchronized between the Operations Manager and devices (Media Server, cameras, and encoders).

<table>
<thead>
<tr>
<th>Device Data Type</th>
<th>Master Configuration Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>Operations Manager</td>
<td>The device template, name, IP address, and other settings.</td>
</tr>
<tr>
<td>User-provided administrative</td>
<td>Operations Manager</td>
<td>The device status (enabled, disabled, or pre-provisioned).</td>
</tr>
<tr>
<td>information</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 12-6  Synchronized Device Data (continued)

<table>
<thead>
<tr>
<th>Device Data Type</th>
<th>Master Configuration Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System-derived operational states</td>
<td>Media Server</td>
<td>For example:&lt;br&gt;• the device is reachable or unreachable&lt;br&gt;• there is a mismatch between devices&lt;br&gt;• the last operation status&lt;br&gt;• the device health&lt;br&gt;• other status information</td>
</tr>
<tr>
<td>Device exists in the Operations Manager but not in the Media Server</td>
<td>Operations Manager</td>
<td>The device configuration is pushed to the Media Server. See the “Cameras Pending Approval List” section on page 7-30 for more information.</td>
</tr>
<tr>
<td>Device exists in the Media Server but not in the Operations Manager</td>
<td>Media Server</td>
<td>IP/Analog cameras are added in pre-provisioned state with a basic configuration. Encoders are added as enabled. You must add additional settings such as camera template, location and others settings then enable the device. See the “Adding Cameras from an Existing Media Server” section on page 7-38 and the “Cameras Pending Approval List” section on page 7-30 for instructions to approve the device. Note The device can also be placed in the blacklist or deleted.</td>
</tr>
</tbody>
</table>

Synchronization During a Media Server Migration

When an existing Media Server is migrated from an existing Cisco VSM 6.x or 7.x deployment, you have the option of keeping or deleting any configured cameras or encoders and their associated recordings.

For more information, see the “Adding Cameras from an Existing Media Server” section on page 7-38.
Viewing the Server Management Console Status and Logs

The Cisco Video Surveillance Management Console is a browser-based interface that provides additional monitoring and troubleshooting features for the physical server that runs both the Operations Manager and Media Server.

To access the Management Console, click **System Settings > Management Console**.

See the [Cisco Video Surveillance Management Console Administration Guide](#) for more information.
Understanding Jobs and Job Status

Many user actions (such as editing a camera template) trigger a Job that must be completed by the Cisco VSM system. These Jobs are completed in the background so you can continue working on other tasks while the Job is completed. Although most Jobs are completed quickly, some actions (such as modifying a camera template) may take longer to complete if they affect a large number of devices.

A pop-up window appears when a Job is triggered, allowing you to view additional details about the Job, if necessary. You can also use the Jobs page to view a summary and additional details of all Jobs in the system.

Note

Jobs are pruned (removed) automatically on a regular basis.

Refer to the following topics for more information:

- Viewing Job Status and Details, page 12-23
- Understanding Job Status, page 12-25
- Viewing All Jobs in the System, page 12-26
- Viewing Audit Logs, page 12-29

Viewing Job Status and Details

A job status dialog appears when a user action triggers a job (Figure 12-10).

Figure 12-10  Job Status Bar

The window automatically closes when the job completes successfully.

See the “Understanding Job Status” section on page 12-25 for a description of the status bar colors and states.

- Click View Status to view additional details (Figure 12-11).
- Navigate to a different menu. If the Job is in-progress, you can navigate to other Operations Manager menus and features while the Job continues to process in the background. If you return to the screen where the Job was performed, the Job status bar will reappear if the Job has not been completed.
- To view all Jobs in the system, open the Jobs window (see the “Viewing All Jobs in the System” section on page 12-26). The Jobs window displays Jobs initiated by the current user. Super-Admins can also view Jobs initiated by other users.
Chapter 12  Monitoring System and Device Health

Understanding Jobs and Job Status

Figure 12-11  “View Status” Details

You can take one of the following actions from the Job Details dialog:

- **Click refresh** to renew the display.
- **Click an Error Message** (failed job steps only) to view additional information regarding the error.
- **Click Stop** (pending job steps only) to cancel steps that have not begun (see the “Understanding Job Status” section on page 12-25 for more information).

If a Job is stopped, any completed or failed Job Steps remain completed or failed (the action is not undone). Only the pending Job Steps are cancelled. In addition, any Job Step are already running will continue until it completes or fails.

**Tip**

- If a user has at least one management permission, the Jobs status icons appear at the top of the page if there is at least one Job pending or running. Click the icons to open the Jobs page.
- A second user cannot edit a resource (such as a camera or Media Server) if that resource has a pending Job. If the second user logs in and accesses the resource, the Job loading message is displayed and prevents the user from editing or viewing the resource.
Understanding Job Status

Each Job and Job Step has a status as shown in Figure 12-12.

**Figure 12-12  Job Status**

<table>
<thead>
<tr>
<th>Status</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>Gray</td>
<td>A Job or Job Step that has not begun to process. Only Pending Jobs or Job Steps can be stopped.</td>
</tr>
<tr>
<td>Running</td>
<td>Orange</td>
<td>The Job or Job Step has begun to process. The action cannot be stopped and will continue until it either succeeds or fails.</td>
</tr>
<tr>
<td>Stopped</td>
<td>Blue</td>
<td>A pending Job or Job Step that was stopped by the user.</td>
</tr>
<tr>
<td>Completed</td>
<td>Green</td>
<td>A Job or Job Step that was successfully completed.</td>
</tr>
<tr>
<td>Failed</td>
<td>Red</td>
<td>A Job or Job Step that failed to complete. Click the Error Message for more information regarding.</td>
</tr>
</tbody>
</table>
Viewing All Jobs in the System

Click System Settings > Jobs (Figure 12-13) to view a summary of recent Jobs, filter and sort the Job entries, and view detailed Job Steps and error messages.

For example, if you modify a camera template that is assigned to 100 cameras, the revised configuration must be applied each device and the cameras may need to be restarted. Although a single Job is created, there will be 100 Job Steps (one step for each affected camera). If the action fails for a single camera, there will be 99 Completed steps, and one Failed step. Click the error message for the failed step to view additional information that can help you resolve the issue.

Tip: Click the number under the Steps or Failed columns to display Job Step information in the bottom pane.

Figure 12-13  Jobs

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Filter</td>
</tr>
<tr>
<td>Select a filter to limit the Job types displayed. For example, click Failed to display only failed Jobs.</td>
<td></td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Click My Jobs to view only the Jobs you initiated. This option is only available to super-admin. Most users can only view their own Jobs by default.</td>
</tr>
</tbody>
</table>
## Understanding Jobs and Job Status

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| 2    | **Job events** Lists the Jobs in the system. Use the filter to narrow the Jobs displayed, or click the column headings to sort the information.  
**Note** The Job list automatically refreshes to display up-to-date status information.  
Each Job includes the following information:  
- **Start Time**—The date and time when the Job was initiated by the user.  
- **End Time**—The date and time when the Job ended. A Job can end when it is completed or fails. Jobs with at least one pending Job Step can be stopped (click the **Stop** button). See the “Understanding Job Status” section on page 12-25 for more information.  
- **Status**—Indicates the Job status. Refer to the *legend* for a description of each color. See the “Understanding Job Status” section on page 12-25.  
- **Steps**—The number of **Job Steps** required to complete the Job. Click the number to display the step details in the bottom pane.  
- **Failed**—The number of Failed **Job Steps**. Click the number to display only the failed Job Steps in the bottom pane.  
- **Action**—The action or system change performed by the Job.  
- **Resources Affected**—The resources affected by the Job. For example, name of the Media Server or the template that is modified by the Job.  
- **User**—The user who triggered the Job. |
| 4    | **Job Steps** Lists the sub-steps performed for a Job (click the **Steps** number to display Job details). |
| 5    | **Job Steps filter** Select a filter to limit the steps displayed. For example, click **Running** to display only Job Steps that are still in progress. |
| 6    | **Job Steps detail** Lists each sub-step that is performed for the selected Job. Click the number under the Step or Failed column to display the steps for a Job.  
**Note** The Job Step list does not automatically refresh. Click the refresh icon 🔄 to renew the display and view up-to-date information.  
Use the filter to narrow the Jobs steps displayed, or click the column headings to sort the information. Each Job Step includes the following information:  
- **Start Time**—The date and time when the step began to process.  
- **End Time**—The date and time when the step ended. A step can end when it is completed or fails.  
- **Status**—Indicates the Job Step status. Refer to the *legend* for a description of each color. See the “Understanding Job Status” section on page 12-25.  
- **Action**—The action or system change performed by the Job Step.  
- **Device**—The resources affected by the Job Step. For example, a camera.  
- **Server**—The server affected by the Job Step. |
<p>| 7    | <strong>Error Message</strong> Click the error message (if available) to open a pop-up window with additional details. |
| 8    | <strong>Refresh icon</strong> Click the refresh icon 🔄 to renew the display and view up-to-date Job Step status. The Last Update field shows when the information was last updated. |</p>
<table>
<thead>
<tr>
<th>Legend</th>
<th>Describes the meaning of each status color. For example, a green Job status bar means the Job was successfully completed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legend:</td>
<td>![Completed] [Completed]  ![Failed] [Failed]  ![Pending] [Pending]  ![Running] [Running]  ![Stopped] [Stopped]</td>
</tr>
</tbody>
</table>

See the “Understanding Job Status” section on page 12-25 for more information.
Viewing Audit Logs

Audit Logs display a history of user configuration actions in the Cisco Video Surveillance deployment. The most common operations are the creation or revision of resources (such as cameras and users), but the Audit Logs also record numerous other activities.

To access the Audit Logs, click Operations and then Audit Logs (Figure 12-14).

Note

- Users must belong to a User Group with super-admin permissions to access the Audit Logs (the user must be added to a user group that is associated with the super-admin role). See the Adding Users, User Groups, and Permissions, page 4-1.
- Audit records are automatically pruned according to the system settings. See the “Records Settings” section on page 13-3 for more information.

Figure 12-14  Audit Logs Detail Window

Take one or more of the following actions

- Use the Search By fields to filter the items displayed in the list.
  You can narrow the results by Time Range, Activity Type, Object Type, Object Name (enabled only when an Object type is selected), Object Location, User Name and/or User IP address.

  For example, you can select a time range 24 hours and Activity Type Create_Role to view all roles that were created in the last 24 hours. Click Reset Filter to clear your selections.

- Click the Change Details link (if available) to view additional information about the event (see the example in Figure 12-14).
- Click the Job Reference link (if available) to view the related Jobs summary.

See the “Understanding Jobs and Job Status” section on page 12-23 for more information.
• Click the column headings to sort the list.
CHAPTER 13

System Settings and Downloads

Revising the System Settings

Choose System Settings > Settings to define basic parameters for user passwords, record storage, and other settings.

Tip
The default settings are sufficient for a basic setup, but you should review and revise the settings to meet the needs of your deployment. System setting can only be modified by super-admin users.

- General System Settings, page 13-1
- Password Settings, page 13-2
- Records Settings, page 13-3

General System Settings

The General settings define user sessions, backup storage rules, and other settings.

Table 13-1 General Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Timeout</td>
<td>The number of minutes before a user is automatically logged out due to inactivity. After this period, users must reenter their username and password to log back in. Note: The maximum value is 10080 minutes (168 hours / 7 days).</td>
</tr>
<tr>
<td>Autocorrect Synchronization</td>
<td>Device synchronization ensures that the device configuration on the Media Server, camera or encoder is identical to the Operations Manager settings. Synchronization is automatically performed when certain events occur, such as when a Media Server goes offline and comes back online. Select Autocorrect Synchronization Errors to automatically correct any configuration mismatches that are discovered during a synchronization. If this option is disabled, the configuration mismatch is not corrected and the device Configuration status displays a Critical state. You can then manually correct the error by clicking either the Repair or Replace Config button in the device configuration page. See the “Synchronizing Device Configurations” section on page 12-15.</td>
</tr>
<tr>
<td>Errors</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 13  System Settings and Downloads

Revising the System Settings

Password Settings

The password settings define the rules for user passwords.

Table 13-2  Password Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Expiry Months</td>
<td>The number of months before a user password automatically expires. At the end of this period, users are required to enter a new password.</td>
</tr>
<tr>
<td>Minimum Password Length</td>
<td>The minimum number of characters for a valid password. Passwords with less characters than the entered value are rejected.</td>
</tr>
<tr>
<td>Maximum Password Length</td>
<td>The maximum number of characters for a valid password. Passwords with more characters than the entered value are rejected.</td>
</tr>
<tr>
<td>Identical Password/Username Allowed</td>
<td>If selected, user passwords can be the same as their username. If de-selected, user passwords must be different than their username.</td>
</tr>
<tr>
<td>3 Password Groups Required</td>
<td>If selected, user passwords must include characters from at least three different types of characters, including:</td>
</tr>
<tr>
<td></td>
<td>• lower case letters</td>
</tr>
<tr>
<td></td>
<td>• upper case letters</td>
</tr>
<tr>
<td></td>
<td>• symbols</td>
</tr>
<tr>
<td></td>
<td>• numbers</td>
</tr>
<tr>
<td></td>
<td>If de-selected, user passwords can include only one type of character (for example, all lower case letters).</td>
</tr>
<tr>
<td>Repeat Characters</td>
<td>If selected, user passwords can repeat the same 3 characters.</td>
</tr>
<tr>
<td></td>
<td>If de-selected, user passwords can not repeat the same 3 characters.</td>
</tr>
</tbody>
</table>

Medianet discovery enabled  Allows Medianet-enabled cameras to be automatically discovered by Cisco VSM Operations Manager when the cameras are added to the network. See the “Discovering Medianet-Enabled Cameras” section on page 7-32

Low QOS                      The QoS value used for video between Media Server and client.

Medium QOS                   

High QOS                     

Record Now Duration          Enter the number of seconds that video will be recorded for all Record Now requests. The minimum value (and default) is 300 seconds (5 minutes). See the following for more information:

• Enabling Record Now, page 3-11
• Using Record Now, page 2-22
**Records Settings**

Enter the number of days that alert, audit and event records are saved before they are deleted.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert: Retention</td>
<td>Enter the number of days that alert records are saved before they are deleted.</td>
</tr>
<tr>
<td>Audit Log: Retention</td>
<td>Enter the number of days that audit records are saved before they are deleted.</td>
</tr>
<tr>
<td>Events: Retention</td>
<td>Enter the number of days that event records are saved before they are deleted.</td>
</tr>
</tbody>
</table>

**Software Downloads**

Go to the Operations page to download video monitoring software and to access the Cisco VSM Management Console:

**Software**

Download the desktop monitoring software, including:
- Cisco Video Surveillance Safety and Security Desktop
- Cisco Video Surveillance Review Player

See the “Understanding the Video Viewing Options” section on page 2-2 for more information.

**Management Console**

Access the browser-based Cisco Video Surveillance Management Console used to configure and monitor the server that runs the Operations Manager and Media Server applications.

**Note**

The Management Console requires a separate password.

**Tip**

Click the Help links to download PDFs of the Cisco Video Surveillance documentation. See the “Related Documentation” section on page A-1 for more information.
Backup and Restore

Refer to the following topics to backup the Operations Manager configuration and video recording files.

Contents

- Backing Up and Restoring the Operations Manager Configuration, page 14-2
  - Manually Backing Up the Operations Manager Configuration, page 14-4
  - Scheduling Automatic Backups, page 14-5
  - Backup and Restore Settings, page 14-3
  - Restoring the Operations Manager Configuration, page 14-6
  - Deleting a Backup File, page 14-7
- Backing Up the Media Server Configuration, page 14-7
- Backing Up Recordings, page 14-9
Backing Up and Restoring the Operations Manager Configuration

Use Backup & Restore to backup the configurations and historical data stored on the Operations Manager. There are two backup options:

- **Configuration Only**—Backs up the user-defined configuration, including device settings (for cameras, encoders, and Media Servers), user accounts, and other attributes. Also includes installed licenses.
- **Configuration Plus Historical Data**—(Default) Backs up the configuration plus events, health notifications, logs, and other data containing information regarding the status, use and health of the system.

**Usage Notes**

- We recommend backing up the Operations Manager data on a regular basis to ensure configuration and event data is not lost if a hardware failure occurs. Backups are also used to restore configurations and historical data when upgrading or moving to a new system.
- We also highly recommend that you also back up the Media Server application data using the Cisco Video Surveillance Management Console. The Media Server application backup is separate from the Operations Manager backup and includes critical server settings and data necessary to restore the system in the event of a hardware failure. See the “Backing Up the Media Server Configuration” section on page 14-7 for instructions.
- 500 Mb disk space is the default amount of storage space allocated for Operations Manager backups, and cannot be changed.
- When the maximum number is reached, the oldest backup file will be deleted when a new backup is created.
- The backup partition is used by Long Term Storage servers. See the “Archiving Recordings to a Long Term Storage Server” section on page 11-15.

**Contents**

Refer to the following topics:

- Backup File Format, page 14-3
- Backup and Restore Settings, page 14-3
- Manually Backing Up the Operations Manager Configuration, page 14-4
- Scheduling Automatic Backups, page 14-5
- Restoring the Operations Manager Configuration, page 14-6
- Deleting a Backup File, page 14-7
Backup File Format

Backup files are saved using the following formats:

<table>
<thead>
<tr>
<th>Table 14-1 Backup File Formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup Data</td>
</tr>
<tr>
<td>Config and Historical</td>
</tr>
<tr>
<td>Config Only</td>
</tr>
</tbody>
</table>

- **HostName**—the host name of the server running the Cisco VSM Operations Manager application.
- **yyyyMMdd_HHmmss**—the date and time when the backup file was created.

For example, if the PSBU-ENG14 server configuration and historical data was backed up on August 17, the resulting filename would be: `VSOM_psbu-eng14_backup_20120817_174250.tar.gz`

Backup and Restore Settings

Table 14-2 describes the Operations Manager backup and restore settings.

<table>
<thead>
<tr>
<th>Table 14-2 Operations Manager Backup Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Destination</td>
</tr>
<tr>
<td>On VSOM—(Default) Saves the backup file to the Operations Manager server hard drive.</td>
</tr>
<tr>
<td>Remote—Saves the backup file to a network server (click the Configure tab and scroll down to Remote Storage)</td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Configuration Only—Backs up the user-defined configuration, including device settings (for cameras, encoders, and Media Servers), user accounts, and other attributes.</td>
</tr>
<tr>
<td>Configuration Plus Historical Data—(Default) Backs up the configuration plus events, health notifications, logs, and other data containing information regarding the status, use and health of the system.</td>
</tr>
<tr>
<td>Disk Usage for Backups</td>
</tr>
<tr>
<td>Automatic—The amount of available storage used for automatic backups. The number of backups available on the system is shown in parenthesis ().</td>
</tr>
<tr>
<td>Manual and Transferred—The amount of storage used for manual backups. The number of backups available on the system is shown in parenthesis ().</td>
</tr>
<tr>
<td>Free— disk space.</td>
</tr>
<tr>
<td>Automatic Backups</td>
</tr>
<tr>
<td>Select the check box to enable or disable the automatic backup schedule.</td>
</tr>
<tr>
<td>Frequency</td>
</tr>
</tbody>
</table>
Chapter 14  Backup and Restore

Backing Up and Restoring the Operations Manager Configuration

Manually Backing Up the Operations Manager Configuration

To perform a manual, one-time backup of the Operations Manager configuration and (optional) historical data, do the following:

**Note** Configuration data includes user-configured devices and settings, such as Media Servers, cameras, users, user groups, etc. Historical data includes all user entered data plus audit logs, event histories, and health information.

**Tip** See Table 14-2 for complete field descriptions.

**Procedure**

**Step 1** Click System Settings > Backup/Restore.

**Step 2** Under Manual Backup, select the Destination and Type (see Table 14-2).

**Destination:**
- **On VSOM**—save the backup file on the Operations Manager server.
- **On Remote**—save the backup file on a remote FTP server.

**Backup Type:**
- **Configuration Only**—backup only the user-configured devices and settings, such as Media Servers, cameras, users, user groups, etc.
- **Configuration Plus Historical Data**—backup the user-configured devices and settings plus audit logs, event histories, and health information.

### Table 14-2  Operations Manager Backup Settings (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Select the day of the week or day of the month when automatic backups will</td>
</tr>
<tr>
<td></td>
<td>occur.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>This field is disabled for daily backups. Select the time from the <strong>At</strong> field.</td>
</tr>
<tr>
<td>At</td>
<td>Enter the time of day the backups will occur.</td>
</tr>
</tbody>
</table>

**Remote Storage**

**Note** These settings define the remote server used to store backup files if the **Remote** option is selected for an automatic or manual backup. Click **Test** to verify the settings are correct and the remote server can be accessed. If the server cannot be accessed on the network, or the login credentials fail, the backup will not be performed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Protocol</strong></td>
<td>Select the type of remote server. For example, <strong>FTP</strong>.</td>
</tr>
<tr>
<td><strong>Address</strong></td>
<td>Enter the server network address.</td>
</tr>
<tr>
<td><strong>Username</strong></td>
<td>Enter the username used to access the server.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>Enter the server password.</td>
</tr>
<tr>
<td><strong>Path</strong></td>
<td>Enter the directory path where the backup file will be stored</td>
</tr>
</tbody>
</table>
Step 3 If backing up to a remote server, enter the server settings.
   a. Click the Configure tab.
   c. Select the server Protocol: For example, FTP.
   d. Enter the server address, username, password, and directory path where the backup file will be saved (see Table 14-2).
   e. (Optional) Click Test to verify the network connection with the remote server.
   f. Click Save.

Step 4 Click Backup Now (Operate tab).

Step 5 When the backup is complete, click OK and verify that the backup appears in the Restore/Manage list.

Step 6 (Optional) Click the Transfer menu (bottom right) to copy the backup file to your local PC or a remote server.
   • To PC—select the location where the backup file will be copied.
   • To Remote—the file will be transferred to the location specified in the Remote Storage section of the Configure tab. See the “Backup and Restore Settings” section on page 14-3 for more information.

Scheduling Automatic Backups

To automatically back up the Operations Manager configuration on a pre-defined schedule, do the following:

Note See Table 14-2 for complete field descriptions.

Procedure

Step 1 Click System Settings > Backup/Restore.
Step 2 Click the Configure tab.
Step 3 Click Enable.
Step 4 Select the Destination:
   • On VSOM—save the backup file on the Operations Manager server.
   • On Remote—save the backup file on a remote FTP server.
Step 5 Select the Backup Type:
   • Configuration Only—backup only the user-configured devices and settings, such as Media Servers, cameras, users, user groups, etc.
   • Configuration Plus Historical Data—backup the user-configured devices and settings plus audit logs, event histories, and health information.
Step 6 Select the backup schedule, including the frequency and time when the backups will occur (see Table 14-2).
Step 7  If backing up to a remote server, enter the server settings.
   b. Select the server Protocol: For example, FTP.
   c. Enter the server address, username, password, and directory path where the backup file will be saved (see Table 14-2).
   d. (Optional) Click Test to verify the network connection with the remote server.
   e. Click Save.

Step 8  Click Save.

Step 9  (Optional) After an automatic backup occurs, you can copy the backup file to your local PC or a remote server.
   a. Select the backup file in the Restore/Manage list (Operate tab).
   b. Click Transfer (bottom right) and select an option.
      - To PC—select the location where the backup file will be copied.
      - To Remote—the file will be transferred to the location specified in the Remote Storage section of the Configure tab. See the “Backup and Restore Settings” section on page 14-3 for more information.

Tip  You can also transfer a file from a PC or remote location to the Operations Manager. Select From Remote or From PC.

---

**Restoring the Operations Manager Configuration**

To restore the Operations Manager configuration from a backup, do the following.

Caution  Restoring a backup deletes any existing configurations, settings and historical data.

Procedure

Step 1  Click System Settings > Backup/Restore.
Step 2  Click the Operate tab (default).
Step 3  Select the backup file and click Restore (bottom right).
Step 4  (Optional) If the backup file does not appear in the list, you can copy a backup file stored on a PC or remote server.
   a. Select Transfer > From Remote or From PC.
   b. Select a backup file stored on a PC or remote server.

Note  To transfer a file from a remote server, enter the Remote Storage settings in the Configure tab. See the “Backup and Restore Settings” section on page 14-3 for more information.
Step 5 Click Restore.

Step 6 Click OK to confirm.

Step 7 Click OK when the restore process is complete.

Step 8 Re-login to Operations Manager.

Deleting a Backup File

Deleting a backup file permanently removes the file from the system. The file can not be used to restore the database.

To archive the backup for later use, save the backup file to your PC or a remote server before deleting it from Operations Manager.

Procedure

Step 1 Click System Settings and then Backup/Restore.

Step 2 Select the backup file in the Restore/Manage list (Operate tab).

Step 3 (Optional) To save the file to a PC disk or remote server, click Transfer and then To Remote or To PC.

  - To PC—select the location for the backup file.
  - To Remote—the file will be transferred to the location specified in the Remote Storage section of the Configure tab. See the “Backup and Restore Settings” section on page 14-3 for more information.

Step 4 Click Delete (bottom left).

Step 5 Click OK to when the confirmation messages appear.

Backing Up the Media Server Configuration

The Media Server application backup is separate from the Operations Manager backup and includes critical server settings and data necessary to restore the system in the event of a hardware failure.

Usage Notes

  - Use the browser-based Cisco VSM Management Console to back up the Media Server configuration data.
  - The Management Console does not support automatically scheduled backups.
  - See the Cisco Video Surveillance Management Console Administration Guide for instructions and more information.
  - Media Server backups do not include recordings. See the “Backing Up Recordings” section on page 14-9 for instructions to back up recordings to a Long Term Storage (LTS) server.
Accessing the Media Server Backup and Restore Screen

Step 1 Select System Settings > Management Console.

Step 2 Enter your Management Console password to log in.

Tip The console password is different from your Operations Manager password. The default console username localadmin cannot be changed.

Step 3 Click the Administration tab.

Step 4 Select Back up or Restore (under the Maintenance heading).

Step 5 Select the Media Server application.

Step 6 Complete the backup or restore process as described in the Cisco Video Surveillance Management Console Administration Guide.
Backing Up Recordings

Recordings can be backed up to a redundant Media Server or a Long Term Storage (LTS) server (or both). To do so, you must configure cameras and camera templates for Stream Redundancy and Long Term Storage.

See the following topics for more information:

- Configuring the Redundant and Failover Options, page 11-11
- Archiving Recordings to a Long Term Storage Server, page 11-15

For overview information, see the following:

- “High Availability” section on page 11-1
Related Documentation

Use one of the following methods to access the Cisco Video Surveillance (Cisco VSM) documentation:

- Click Help at the top of the screen to open the on-line help system.
- Download PDF versions at Operations > Help.
- Go to the Cisco Video Surveillance documentation web site.
- See the Cisco Video Surveillance 7 Documentation Roadmap for descriptions and links to Cisco Video Surveillance documentation, server and storage platform documentation, and other related documentation.
## Revision History

### Table B-1  Revision History

<table>
<thead>
<tr>
<th>Release</th>
<th>Date</th>
<th>Change Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release 7.0.0</td>
<td>October, 2012</td>
<td>Initial draft. See the Release Notes for Cisco Video Surveillance Manager for more information.</td>
</tr>
</tbody>
</table>
| Release 7.0.1 | February, 2013 | Maintenance Update, including various bug fixes and edits. New and revised features including the following:  
  - Support for additional LDAP server configurations. See “Adding Users from an LDAP Server”.  
  - Added “Importing or Updating Media Servers Using a CSV File”  
  - Support for custom fields in soft triggers alert URLs. See “Configuring Soft Triggers”.  
  - Added support for 64-bit version of Internet Explorer. See the “Requirements” for more information.  
  - Added “Using “Split Model” Multi-Port Multi-IP Encoders”.  
  - Numerous minor revisions, updates and edits.  
  See the Release Notes for Cisco Video Surveillance Manager, Release 7.0.1 for more information. |